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From: Cassandra Koenig and Trevor Crozier Date: August 26, 2015 

Subject: Ajax Project EA – Ajax South Groundwater and Surface Water Site 
Investigation 

Project No.: 1125-007-02-04   

1.0 INTRODUCTION  

In accordance with the work plan and proposal submitted to KGHM Ajax Mining Inc. (KAM) on 
October 18, 2013 (BGC 2013a), BGC Engineering Inc. (BGC) has prepared this memorandum 
summarizing the 2014 groundwater and surface water investigations conducted for the Ajax 
project.  Field work for these investigations was completed by BGC between February 11 and 
June 6, 2014.   

The purpose of the investigation was to design and implement a baseline groundwater and 
surface water monitoring system to collect data during 2014 that will be used to support the 
Ajax project Environmental Assessment (EA).  Data collected from the baseline monitoring 
system will be included in the baseline groundwater and surface water reports being completed 
for the EA.  Baseline data will also be integrated into the groundwater flow model and water 
balance model (WBM) currently being updated as part of the EA studies.   

The project general arrangement (GA) was revised in late 2013 with the relocation of proposed 
site facilities to the south of Jacko Lake (Ajax South Project).  The 2014 investigation program 
was therefore designed around the new locations for the proposed open pit, the tailings storage 
facility (TSF) footprint, and west mine rock storage facilities (WMRSF) located south of Jacko 
Lake.  The East and South Mine Rock Storage Facilities (EMRSF and SMRSF) were also 
considered in the monitoring system design. 

2.0 SCOPE OF WORK 

The scope of work completed as part of the 2014 site investigation included the following tasks: 
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 Optimized the planned locations and installations of previously selected groundwater 
monitoring points as defined in the scope of work (BGC, 2013a); 

 Observing borehole drilling and designing and observing monitoring well installations 
(including borehole logging and airlift testing) for 29 installations at 17 locations; 

 Development and hydraulic testing of newly installed monitoring wells; 
 Installing pressure transducers in all of the new wells;  
 Completing two snowpack surveys  prior to the 2014 snowmelt within the Keynes Creek 

and Peterson Creek (Upper) watersheds; 
 Establishing a streamflow monitoring station and installing streamflow gauging 

instrumentation (i.e., pressure transducers in still well) at Keynes Creek, and; 
 Collecting manual streamflow measurements and training KGHM Ajax staff on 

conducting manual streamflow measurements at all of the established streamflow 
gauging sites. 

The results of these site investigation tasks are summarized in the following sections.   

3.0 OBJECTIVES AND RATIONALE 

Monitoring well locations were initially selected based on the following site investigation 
rationale: 

 To supplement baseline groundwater level data collection from the previously existing 
monitoring network on site around the revised arrangement of mine facilities; 

 To monitor seasonal groundwater levels and vertical gradients in specific areas of 
interest (i.e., potential recharge and discharge zones, interpreted groundwater divides, 
within mapped and interpreted hydrostratigraphic units);  

 To evaluate hydrogeologic conditions for siting of proposed EMRSF, SMRSF and TSF 
seepage and runoff collection facilities; 

 To establish possible compliance and water quality monitoring locations between the 
proposed project and existing off-site (i.e., privately owned) domestic wells located 
upstream from Jacko Lake; 

 To investigate soil and rock hydraulic properties below proposed dam foundations and 
within and/or down-gradient from the proposed TSF; and, 

 To investigate the potential for regional geologic structure (i.e., the Edith Lake Fault 
Zone, ELFZ) to influence groundwater flow, pressures and quality. 

The originally proposed locations and installations in BGC (2013a) were revised and optimized 
throughout the field program based on discussions with KAM staff and available 
archaeological, ecological and land ownership clearances.  Site specific conditions and 
materials likely to be intersected during drilling were also considered as part of the optimization 
process so that the proposed monitoring rationale for the program was achieved and target 
aquifer(s) were intercepted.  Any revisions made to the proposed network were communicated 
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to and approved by KAM at the time field work was completed.  Table 1 summarizes the final 
groundwater monitoring wells installed as part of the 2014 field program.  The proposed 
monitoring rationale and completion rationale for each groundwater monitoring installation are 
also included in Table 1.  Monitoring well locations are shown on Drawing 01; drilling and 
installation details are discussed in Section 3. 

To obtain surface water data representative of undisturbed (i.e., existing) site conditions 
downstream of Jacko Lake, a streamflow monitoring station was established at Keynes Creek.  
Keynes Creek is a tributary watershed to Peterson Creek that will be affected by construction 
of the proposed TSF (Drawing 01).   

4.0 2014 FIELD WORK 

4.1. Borehole Drilling, Airlift Testing and Monitoring Well Installation 

A total of 29 boreholes were drilled for the groundwater monitoring program at 17 locations 
around the proposed TSF, WMRSF, SMRSF and EMRSF footprints (Drawing 01).  Drilling was 
completed between February 11 and March 10, 2014.  Drill hole logs are provided in Appendix 
A.  Nested (shallow and deep) completions were installed at the majority of drilling locations.  
The monitoring wells include either a “D” or an “S” designation that refers to either a deep (D) 
or a shallow (S) installation.  An intermediate installation was installed at BGC14-003, which is 
identified with a letter “I”.  Eighteen (18) of the monitoring wells were completed in bedrock and 
11 monitoring wells were completed in overburden.  As-built installation diagrams are provided 
in Appendix B.  Separate boreholes were drilled for each well at all monitoring locations. 

Drilling services were provided by JR Drilling Central Ltd. (JR), out of Kamloops, BC, using a 
dual rotary drill rig equipped with a 900 cubic feet per minute (cfm)/350psi air compressor.  No 
drilling additives or muds were used during the drilling process.  The boreholes were drilled by 
advancing a 152 mm (6-inch) dia. steel casing with drive shoe and tricone bit into the ground.  
Stratigraphic horizons were logged from drill return materials.  Grab samples of drill returns 
were collected at approximately 1.5 m (5 ft) intervals and/or when notable changes in lithology 
and borehole moisture were encountered.  Bedrock lithology was interpreted based on the 
mapping of Massey et al., (2005) and lithologies logged in previously existing drillholes near 
each drilling location (Table 1).  Drill cutting samples were provided to KAM geologists at the 
end of the field program and are currently being stored on site1.  After groundwater was 
encountered, airlift testing was conducted at approximately 10 to 20 m depth intervals as 
drilling progressed.  

                                                 

 
1 Logged bedrock lithology in the BGC14 boreholes should be verified by KAM geologists using the drill cuttings currently being 
stored on site. 
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Monitoring wells consisting either of 51 or 102 mm (2 or 4-inch) diameter schedule 40 PVC 
piping with 010-slot screens were installed into all boreholes2.  Well screens were completed 
with 10/20 silica sand packs placed around the screened intervals.  Final screened intervals 
were determined based on conditions encountered in the field; screens were either placed at 
the bottom of boreholes, or boreholes were backfilled to specified horizons with bentonite chips 
and capped by a 1 to 1.5 m (3 to 5 ft) top layer of silica sand before well screens were placed.  
Boreholes were filled with approximately 1.5 m (5 ft) of silica sand above well screen tops.  
Coated bentonite pellet seals (1.5 to 2 m or 5 to 6 ft thick) were placed above sand packs to 
confirm that targeted monitoring intervals were isolated.  The boreholes were subsequently 
grouted to the ground surface using a tremie placement method and grout mixture comprised 
of a 10:4:1 ratio of water:cement:bentonite by weight.  The steel drill casings were gradually 
retracted during the well installation process to facilitate sandpack, bentonite and grout 
placement through unstable formation materials.  Various lengths of steel casing were kept in 
the ground to provide surface completions for the monitoring wells, together with locking well 
caps.  The boreholes were revisited within 2 to 3 weeks following drilling and any grout 
settlement observed was topped up to the ground surface by placing bentonite chips between 
the casing and drill hole.  The chips were hydrated to attain an adequate surface seal in the 
borehole. 

Drill hole and well construction details, the proposed monitoring rationale and optimized 
completion rationale (as determined in the field) for each borehole are summarized in Table 1.  
Airlift testing results are provided in Table 2.  General conditions encountered during drilling, 
airlift testing results, and well construction activities are described in detail in the following 
sections.  Well locations are shown in plan on Drawing 01 and borehole log and well completion 
details are provided in Appendix A.   

4.1.1. TSF Monitoring Wells 

The TSF groundwater monitoring points consist of 15 wells installed at 8 locations around the 
proposed TSF footprint.  The subsurface conditions encountered at these locations consisted 
of between 2 to 20 m of overburden overlying bedrock interpreted to belong to the Nicola 
Volcanics based on the bedrock geology mapped by the BCGS (Massey et al., 2005).  Thicker 
accumulations of overburden were noted in the north near Jacko Lake and the Peterson Creek 
valley (i.e., in boreholes BGC14-002 and 003 at approximately 15 and 20 m, respectively).   

The number of monitoring well installations and depths were adjusted based on conditions 
encountered in the field (i.e., observed static water levels, borehole moisture conditions, the 

                                                 

 

2  The majority of monitoring wells were constructed with 81 mm (2-inch) schedule 40 PVC piping.  Monitoring wells installed at 

BGC14-004, 005, 006, 007 and 008 were installed with 102 mm (4-inch) schedule 40 PVC piping. Previous mapping and 
borehole data indicated that some holes would intersect high yielding fluvial/glaciofluvial deposits, thus larger diameter wells 
were planned to facilitate sampling these wells with a submersible pump.   
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degree of bedrock weathering interpreted from drill returns and drilling conditions as noted by 
JR).  Shallow installation depths of monitoring wells around the TSF footprint varied from 3 to 
20 m below ground surface (bgs), and deep installations varied from 17 to 58 m bgs. Details 
summarizing the rationale for monitoring well completion at specific boreholes are provided in 
Table 1.  Groundwater inflows to boreholes through overburden were not measurable from 
airlift tests in the TSF footprint area.  Estimated well yields to bedrock boreholes in this area 
ranged from less than 1 US GPM (0.06 L/s) at BGC14-016 and 017D to 4 US GPM (0.25 L/s) 
at BGC14-003D (Table 2). 

In general, shallow monitoring well installations within overburden were completed at the first 
encounter with groundwater or to target moisture zones noted during drilling.  A shallow 
completion was included at BGC14-001 despite a lack of observed moisture in the borehole.  
This completion was included in order to monitor potential seasonal fluctuations that may be 
associated with surface water.  An intermediate installation was added to the program at 
BGC14-003 to target a confined gravel and sand layer (up to 4 m thick) noted at the base of 
the overburden that may be associated with the Peterson Creek Aquifer.  During the grouting 
process of BGC14-003I, a bentonite pellet bridge formed.  Approximately 37 feet of steel 
casing was left in the ground in order to preserve the well.  The shallow installation at BGC14-
012 targets a thin, saturated sand and gravel layer, approximately 1 m thick, (from 2 to 3 m 
bgs) overlying silt above bedrock.   

Deep installations into bedrock were generally completed across observed water bearing 
zones, or intervals of increased weathering as interpreted from drilling-return materials (i.e., 
gravelly sub-rounded particles and/or evidence of oxidation).  Variable degrees of bedrock 
weathering were noted during drilling; drill returns from bedrock encountered within BGC14-
001D, 003D and 010 were unweathered to slightly weathered, whereas zones of weathered 
bedrock within BGC14-002D, 011D, 012D and 016 were interpreted at depths between 22 and 
28 m bgs.  A weathered zone within bedrock (water producing and with trace gravel in drill 
returns) at BGC14-011S was noted at approximately 15 m bgs.  Increasing weathering with 
depth was noted at BGC14-017D below a depth of approximately 18 m.  No water bearing 
zones were noted during drilling of BGC14-010.  As such, a 12 m (40 ft) well screen was 
installed into the borehole targeting a potential zone of moisture (at approximately 47 m bgs) 
and the depth horizon of a nearby water body (at approximately 940 m asl). 

Average water levels measured in the wells installed around the TSF footprint as of October 
2014 vary from 0.9 m above ground (i.e., mild artesian conditions) at BGC14-017D to 10.4 m 
bgs at BGC14-001D.   

4.1.2. SMRSF Monitoring Wells  

Ten monitoring wells were installed into boreholes at six locations around the proposed 
SMRSF footprint.  The overburden overlying bedrock in this area was between 11 and 24 m 
thick.  Bedrock in some holes was interpreted to belong to the Nicola Volcanics (i.e., BGC14-
007D and 015D) and the Iron Mask Hybrid Diorite (BGC14-008) based on the geologic 
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mapping of Massey et al., (2005).  As noted in the boreholes drilled around the TSF footprint, 
thicker accumulations of overburden were noted in the SMRSF boreholes to the north near the 
Peterson Creek valley.  Overburden materials encountered at BGC14-007 consist of 
glaciofluvial sands and gravels to an approximate depth of 6 m underlain by 10 m of silty sands 
and silts.  At BGC14-008, glaciofluvial materials are limited to approximately 3 m deep and are 
underlain by 21 m of gravelly silt interpreted as till.  Overburden ranging between 11 and 19 m 
thickness consisting primarily of silts and silty sands were also noted adjacent Humphrey 
Creek in BGC14-013, 014 and 015.  Shallow installation depths of monitoring wells around the 
SMRSF footprint varied from approximately 4.5 to 19 m bgs, and deep installations varied from 
23 to 54m bgs.   

Groundwater inflow to boreholes through overburden during drilling was generally 
unmeasurable around the SMRSF footprint, with a maximum estimated rate of 1 US GPM 
(0.06 L/s) at BGC13-013 from airlift tests.  Estimated well yields to bedrock boreholes in this 
area ranged from 1 US GPM (0.06 L/s) at BGC14-009 to 3 US GPM (0.19 L/s) at BGC14-013 
(Table 2). 

Overall, overburden drilling conditions were dry to moist within the boreholes drilled around the 
SMRSF footprint.  With the exception of BGC14-007S and BGC14-015S, shallow installations 
in this area targeted zones of moisture noted within overburden during drilling.  Drilling 
conditions at BGC14-007 were dry. However, as the intent of monitoring at this location was 
to monitor potential bedrock/overburden gradients at the limits of the mapped Peterson Creek 
aquifer, a groundwater monitoring well was installed between 14 and 17 m into the silt unit at 
this location.  At BGC14-015, saturated glaciofluvial sands and gravels were encountered at 
approximately 9 m bgs.  A 6 m (20 ft) screen was installed from 9 to 15 m bgs at BGC14-015S 
to target these materials.   

As with the overburden boreholes, drilling conditions at many of the deeper bedrock boreholes 
drilled around the SMRSF footprint were dry to moist.  Deep installations into bedrock targeted 
zones of moisture and/or increased weathering noted during drilling.  A minimal degree of 
weathering was interpreted from drilling and moisture conditions and cuttings recovered at 
BGC14-007, 008, and 015.  With the exception of the saturated glaciofluvial sands noted at 
BGC14-015 above, drilling of the borehole for BGC14-015D (i.e., into bedrock) was dry.  The 
bedrock at BGC14-009 was interpreted as unweathered down to approximately 48 m bgs, 
where moisture was noted and sub-rounded drill cuttings were noted.  Zones of weathered 
bedrock within BGC14-014D and BGC14-013 were noted at depths of approximately 22 and 
28 m bgs, respectively.  The weathered zone at BGC14-014D was only slightly moist whereas 
the zone encountered at BGC14-013 was saturated. 

Average water levels measured in the wells installed around the SMRSF footprint as of October 
2014 vary from 0.8 m above ground (i.e., mild artesian conditions) at BGC14-015D to 22.8 m 
bgs at BGC14-007D. 
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4.1.3. EMRSF Monitoring Wells 

Four monitoring wells were installed into boreholes at three locations around the proposed 
EMRSF footprint.  Subsurface conditions encountered in this area consisted of 43 and 63 m 
of overburden at BGC14-005 and BGC14-004, respectively, and 14 m of overburden at 
BGC14-006.  Approximately 47 m fluvial/glaciofluvial sand and gravel interpreted to belong to 
the mapped Peterson Creek Aquifer was encountered at BGC14-004.  At BGC14-005, 
approximately 15 m of fluvial/glaciofluvial sand was encountered during drilling.  The sand 
units were intercepted below 15-20 m of tills consisting of sand and silt.  Subsurface conditions 
at BGC14-006 consisted of 14 m of alternating sands and silts, with a minor layer of sand and 
gravel.  Bedrock around the footprint of the EMRSF footprint is interpreted to belong to the Iron 
Mask Hybrid Diorite based on the geologic mapping of Massey et al., (2005).   

One shallow installation (i.e., BGG14-006S) was completed around the EMRSF footprint.  
Shallow standpipe piezometers were previously installed at two of the target drilling locations 
for the EMRSF (i.e., BGC13-021 near BGC14-004 and BGC14-022 near BGC14-005) as a 
part of a drilling program completed by BGC in 2013.  Groundwater level data collected from 
the piezometers installed in 2013 will be paired with data collected from BGC14-004 and 
BGC14-005 to support the project EA.  In the initial work plan (BGC, 2013a), it was proposed 
that BGC14-006 (planned hole ED-5) would be paired with data from monitoring wells installed 
into boreholes drilled as a part of companion (i.e., condemnation and/or geotechnical) drilling 
programs planned for 2014.  BGC14-006S was added to the BGC drilling program during the 
optimization process, because plans for companion drilling programs were not yet available.  
The installation completed at BGC14-006S was screened from approximately 11 to 14 m within 
a silty sand unit above the bedrock contact.  No measureable groundwater inflow was noted 
while drilling this borehole. 

The installations at BGC14-004 and 005 were intended to target the mapped Sugarloaf 
Bedrock aquifer below the glaciofluvial sands of the Peterson Creek aquifer.  The glaciofluvial 
sands encountered above bedrock at BGC14-004 were highly productive (i.e., estimated up to 
100 US GPM (6.3 L/s) from airlift tests), whereas bedrock at the end of the hole was found to 
produce groundwater at approximately 4 US GPM (0.25 L/s).  As no weathered zones or 
weathered cuttings were observed at BGC14-004 during drilling, the well was screened at the 
bottom of the borehole.  In both BGC14-005 and BGC14-006D, water was first encountered 
near the bedrock contact.  The screen for BGC14-005 was completed into bedrock near the 
bottom of the borehole, which produced groundwater at approximately 1 US GPM (0.06 L/s) 
when airlift tested.  The screen for BGC14-006D was completed within a moist weathered zone 
noted between approximately 19 and 27 m bgs.  Groundwater inflow to this zone is estimated 
at less than 1 US GPM (0.06 L/s) based on an airlift test conducted at the bottom of the 
borehole.   

Average water levels measured in the wells installed around the EMRSF footprint as of June, 
2014 vary from 7.0 m bgs in BGC4-006D m to 14.9 m bgs in BGC14-005.   



KGHM Ajax Mining Inc., Ajax Project EA August 26, 2015 

Ajax South Groundwater and Surface Water Site Investigation Project No.: 1125-007-02-04 

1125007_Ajax_South_Site_Investigation_Memo_08262015_FINAL.docx Page 8 

BGC ENGINEERING INC. 

4.2. Monitoring Well Development  

The newly installed monitoring wells were developed between March 1 and June 5, 2014.  At 
the request of KAM, two additional wells (KAX-14-114 and 128S) drilled by Klohn Crippen 
Berger Limited (KCBL) near Jacko Lake were added to the development program on May 30, 
2014.  Initial project scheduling delays in January due to permitting constraints (and a resultant 
delayed drilling start date) postponed the well development schedule to partially coincide with 
the spring thaw, which began in early March, 2014.  This resulted in challenging and/or 
potentially unsafe access to many of the well sites.  Access limitations combined with specific 
well conditions (i.e., increased sediment load and/or slow recoveries in some wells) further 
prolonged the well development component of the program.  Well development was completed 
as a joint effort between BGC, KAM and Knight Piesold (KP) field staff.  Daily communication 
between BGC, KAM and KP was maintained in order to prioritize the development of wells for 
the water quality sampling program (being completed by KP) and to optimize the schedule and 
criteria for well development completion given the above constraints.  

The well development procedure involved the removal of approximately 10 well volumes of 
water from the boreholes.  Wells that were dry after installation were not developed.  Well 
development was conducted through gentle surging of well screens using a Waterra and 
footvalve with surge block pumping system.  A Waterra inertial hydrolift electric pump was used 
to assist with actuation of tubing at the well heads.  Physicochemical parameters (i.e., pH, 
electrical conductivity, temperature, dissolved oxygen, colour and turbidity) of the outflow water 
were monitored using a Horiba U-52 water quality system that was calibrated at the beginning 
of each shift.  Depth to water was also monitored with a water level tape throughout the 
development process.  Water removed from the monitoring wells during well development was 
discharged into the sumps constructed for borehole drilling. 

Footvalves and surge blocks were passed fully across the well screens at least twice during 
the development process, raising or lowering the assembly at 0.5 to 1.0 m intervals.  In wells 
with partially saturated screens, surging was only completed between the static water level 
and screen bottom.  In general, surging of an interval within a well screen was considered to 
be complete once physicochemical parameters were stable and turbidity values were less than 
250 NTU.  Following the second pass of the well screen, a final “polish” was completed to 
remove residual sediment from the bottom of each well.  This was completed by removing the 
surge block from the pumping assembly and purging approximately 20 L of water with the 
footvalve. 

It was determined that 7 wells would not meet the 250 NTU criteria as a result of slow water 
level recovery (i.e., on the order of several days to weeks) or excessive amounts of silt within 
the well creating blockages in the Waterra tubing.  As a result of discussions between BGC, 
KAM and KP about these well conditions, the development criteria were relaxed in the interest 
of keeping to the data collection (i.e., water quality sampling) schedule.   

Monitoring wells for which criteria were relaxed included BGC14-006S, BGC14-008D, BGC14-
014D, BGC14-015S, BGC14-017S, BGC14-017D and KAX-14-128S.  During the development 



KGHM Ajax Mining Inc., Ajax Project EA August 26, 2015 

Ajax South Groundwater and Surface Water Site Investigation Project No.: 1125-007-02-04 

1125007_Ajax_South_Site_Investigation_Memo_08262015_FINAL.docx Page 9 

BGC ENGINEERING INC. 

of KAX-14-128S and BGC14-006S, the Wattera tubing became clogged with sediment.  Bailers 
were used to develop these two wells to overcome the sediment load.  After removal of more 
than 10 well volumes of water from BGC14-014D, BGC14-015S and BGC14-017D, the 
turbidity of water removed was still greater than 250 NTU.  However, the field measured 
chemical parameters were stable and well development was considered complete; dissolved 
and total metals concentrations for samples collected from these wells will need to be 
interpreted carefully.   

Wells BGC14-004 and BGC14-008D may be contaminated with grout, both wells have 
elevated pH values (i.e., 11.28 and 13.46, respectively) and the water recovered was cloudy 
or light grey. BGC14-008D and BGC14-017S were found to recover very slowly and it was not 
practical to continue development at these monitoring wells.   

A summary of well development observations is provided in Table 3. 

4.3. Well Response Tests 

Well response (i.e., falling and rising head) tests were completed in the monitoring wells 
between March 5 and June 6, 2014 to assess the hydraulic conductivity of the saturated 
materials intersected by the well screens.  Tests were completed as soon as possible following 
well development and/or water quality sampling, depending upon schedule priority as noted 
above.  Well response tests were also completed in the two wells installed by KCB (noted in 
Section 3.2), at the request of KAM. 

Rising and falling head tests were conducted in the majority of wells using solid slugs 
constructed of 0.04 m (1.5-inch) or 0.05 m (2-inch) diameter PVC pipe filled with sand and 
capped at both ends.  Water level recovery was monitored using data loggers and a water 
level tape.  Both falling head (FH) and rising head (RH) tests were carried out in each of the 
wells tested with solid slugs.  The slugs were de-contaminated using phosphate-free detergent 
and tap water, and subsequently rinsed with de-ionized water before test initiation at each well. 

Single rising head hydraulic tests were conducted in a number of wells (i.e., BGC14-006S, 
008D, 014D, 015S, 017S and 017D) due to long water level recovery times.  Single rising head 
tests were initiated between May 28 and June 1, 2014 and involved bailing between 9.5 and 
95 L (2.5 and 25 USG) of water from the PVC well casings.  Water level recoveries were 
monitored both manually and with dataloggers for the first hour following test initiation.  Longer 
term recovery data were collected using dataloggers, which were retrieved from the wells 
between two and 28 days following the tests.  As the recovery time for the water level in 
BGC14-008D was expected to take several weeks, rising head test data were not available 
immediately after water was bailed from this well.  Rising head test data for BGC14-008D was 
provided to BGC by KGHM field staff in July, 2014. .   

Well response tests were not completed in BGC14-001S, 007S, 007D, 008S and 014S as 
these wells were dry (or water levels were near the well screen bottom) during the field 
monitoring program.  A slug test was completed in KAX-14-128S on June 6, 2014.  Datalogger 
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measurements were corrected for fluctuations in barometric pressure recorded by transducers 
located at the well heads.  Test results are discussed in Section 4.1. 

4.4. Datalogger Installations into Groundwater Monitoring Wells 

Solinst-brand pressure transducers were deployed at all of the newly installed groundwater 
monitoring wells to collect groundwater levels at a set frequency during the baseline monitoring 
period.  Loggers were deployed between approximately 2 and 8 m below static water levels 
with the wells and programmed to collect synchronous measurements with the transducers 
installed within the existing network on site (i.e., 4 times per day at 6AM, 12PM, 6PM and 
12AM).  Loggers were also installed at monitoring wells BGC14-001S, 007S, 007D, 008S and 
014S, which were dry at installation.  The rationale for deploying loggers at dry locations was 
to monitor potential interactions with surface water following snowmelt.  Datalogger 
deployment details are summarized in Table 4.  The Solinst Levelogger Manual is included in 
Appendix C.  

4.5. Snowpack Surveys 

BGC conducted snow surveys in the Keynes Creek watershed and upper watershed of 
Peterson Creek on two separate dates: February 26-27, 2014 and March 18-19, 2014.  The 
objective of the snow survey was to measure snow water equivalence (SWE) at distributed 
locations in the two watersheds.  The snow survey of February 26-27, 2014 was restricted to 
the Keynes Creek watershed, as the Upper Peterson Creek watershed was inaccessible (the 
access road was impassable by snowmobile due to fallen trees).  The subsequent survey 
included Upper Peterson Creek, but much of the snow in Keynes Creek had melted by this 
point.  Measured SWE on the two survey dates is summarized in Table 5.    For the February 
survey, snow was observed to be often missing on south facing slopes and the tops of hills 
and deepest in valley bottoms on north aspects.  A wind slab had formed on most aspects and 
the snowpack was faceted below.  Average SWE observed in the Keynes Creek watershed in 
February was 66 mm, although this value does not account for snow-free areas in the 
watershed.  Further discussion of snow-free areas is provided in BGC (2015). 

4.6. Streamflow Measurements and Establishment of Gauging Stations 

There are five (5) streamflow gauging stations located at Ajax:  

 JACINF – Monitors the primary inflow to Jacko Lake (Peterson Creek) and provides a 
record of natural unregulated flows in the study area. 

 JACLAKE – Monitors the water level in Jacko Lake and flow over the spillway, if there 
is any.  

 PETER – Monitors the flows in Peterson Creek downstream of Jacko Lake, and 
includes flows from JACLAKE and JACSEEP.  



KGHM Ajax Mining Inc., Ajax Project EA August 26, 2015 

Ajax South Groundwater and Surface Water Site Investigation Project No.: 1125-007-02-04 

1125007_Ajax_South_Site_Investigation_Memo_08262015_FINAL.docx Page 11 

BGC ENGINEERING INC. 

 JACSEEP – Monitors the seepage and low level outlet release from Jacko Lake 
through the earth-fill embankment (flows from JACLAKE and JACSEEP combine to 
give an indication of the total flows leaving Jacko Lake).  

 KEYNES – Established near the mouth of Keynes Creek in 2014 by BGC to evaluate 
runoff from the proposed TSF watershed.  Keynes Creek is at a significantly lower 
average elevation than JACINF, therefore it will be used to evaluate runoff for the small, 
lower elevation tributaries around the proposed mine site.  

With the exception of KEYNES, manual streamflow measurements were completed at the 
gauging stations by KP from 2008 to 2011.  These measurements were used to generate rating 
curves for each of the stations, which is a fixed relation between water level and discharge at 
a point in a stream.  The rating curves allow the water levels measured by the station pressure 
transducers to be converted to streamflow.  The primary means of measuring discharge 
employed by KP was the velocity-area method.  However, the frequent occurrence of 
extremely low flows required the use of the volumetric method also.  With this method, 
streamflow is measured by recording the volume of water entering a container over a set period 
of time.  KEYNES had not been established as a gauging station at the time of KP’s data 
collection. 

In 2014, BGC and KAM staff continued the streamflow measurements.  During the period from 
May to October 2014, eleven measurements were taken at PETER and JACINF, nine at 
JACLAKE, and five at KEYNES.  A majority of the streamflow measurements were taken with 
an OTT MF Pro current meter.  This current meter automatically calculates discharge and its 
electromagnetic sensor head is ideal for use in low-flow environments.  Streamflows in 
KEYNES were minimal throughout this period, as such only the volumetric method was 
employed at this station.  No measurements were taken at JACSEEP in 2014, as the lake was 
overflowing through the spillway through much of the summer and as such, the low level outlet 
was not operating.  

BGC installed dataloggers in March 2014 at each of the gauging stations.  The loggers were 
programmed to collect measurements at 10 minute intervals.  With the exception of KEYNES, 
the loggers installed at all stream gauging stations are Solinst-brand Leveloggers.  A HOBO® 
data logger and barometric logger were installed at the KEYNES station.  Logger installation 
details are included in Table 4.  Each station is also equipped with a fully surveyed one meter 
staff gauge plate, within a stable gauging pool.  These were installed by BGC in March 2014 
at KEYNES and by KP in August 2008 at the other four stations (Photos 01 to 05).  Loggers 
were downloaded by BGC staff on May 6, 2014 and by KAM staff at regular intervals the 
remainder of the year.  The Solnist Levelogger Manual is provided in Appendix C and the Hobo 
data logger manual is in Appendix D. The OTT MF pro manual is provided in Appendix E. 

The Solinst and HOBO® pressure transducers are non-vented.  Therefore, both water and 
atmospheric pressure are recorded by the dataloggers, and the resulting water levels need to 
be corrected for atmospheric pressure.  The barometric logger installed at KEYNES will be 
used for this correction. 



KGHM Ajax Mining Inc., Ajax Project EA August 26, 2015 

Ajax South Groundwater and Surface Water Site Investigation Project No.: 1125-007-02-04 

1125007_Ajax_South_Site_Investigation_Memo_08262015_FINAL.docx Page 12 

BGC ENGINEERING INC. 

5.0 ANALYSIS AND RESULTS 

5.1. Well Response Tests 

The guidelines for analyses of slug tests prescribed by Butler (1998) were used to help select 
the appropriate analytical method for interpretation of well response data. In general, the KGS 
(Hyder et al., 1994) unconfined solution for wells screened below the water table was used to 
estimate hydraulic conductivity (K) and, where appropriate, the aquifer storage coefficient (S), 
(i.e., in cases where S was not implausibly low for the materials being tested).  The Hvorslev 
(1951) unconfined method was used to estimate K from test data where a reasonable match 
to the KGS (1998) solution could not be obtained.  The Cooper et al., (1967) analytical solution 
for a confined aquifer was used for the analysis of test data from monitoring wells BGC14-
015S, 015D, 017S and 017D, as these wells are artesian.   

The results of the analyses are summarized in Tables 6 and 7 together with logged geology 
and the interpreted hydrostratigraphic unit (HSU) of screened intervals.  Type curve fits to test 
data are provided in Appendix F. 

With the exception of BGC14-012S (which is interpreted to be screened within colluvium), the 
best fit values for K estimated at the Ajax South monitoring wells fall within the range of 
previously compiled estimates for similar materials in the project area (BGC (2013b) and Table 
7).  Table 7 shows that:  

 The geometric mean K value estimated for the Nicola Group (8E-08 m/s) is slightly 
lower than values from previously compiled results (1E-07); 

 The geometric mean K value estimated for fluvial/glaciofluvial sands (3E-06 m/s) is 
lower than values from previously compiled results (2E-05 m/s); 

 The geometric mean K values estimated for the Iron Mask Hybrid (2E-07 m/s) is slightly 
higher than values from previously compiled results (6E-08 m/s), and; 

 The geometric mean K value estimated for the glacial till deposits (1E-07 m/s) is similar 
to the value from previously compiled results (2E-07 m/s). 

The above values are considered acceptable estimates of K as each is within the range of 
standard values reported by Freeze and Cherry (1979) for the respective material types.  
Previous estimates for colluvium or lacustrine deposits in the project area are not available; 
however a value of 9E-04 m/s is considered acceptable for colluvium (i.e., at BGC14-012S) 
and a value of 1E-07 m/s is considered acceptable for lacustrine deposits (i.e., in the upper 
component of the screened materials logged by KCBL in KAX-14-128S) based on standard 
values for these types of materials (Freeze and Cherry, 1979). 

The range of best estimates for S from the well response tests, along with previously compiled 
S estimates are also provided in Table 6.  Previous estimates of S at the site are limited to 
values calculated from the results of the pumping test conducted at the west side of the 
proposed pit and north west from Jacko Lake (BGC, 2011) and best fit estimates to hydraulic 



KGHM Ajax Mining Inc., Ajax Project EA August 26, 2015 

Ajax South Groundwater and Surface Water Site Investigation Project No.: 1125-007-02-04 

1125007_Ajax_South_Site_Investigation_Memo_08262015_FINAL.docx Page 13 

BGC ENGINEERING INC. 

head data in the numerical groundwater model developed for the project feasibility study (FS).  
Table 7 shows that:  

 The geometric mean of S values estimated from test data collected from the current 
program for the Nicola Group (2E-04 m-1), the Iron Mask Hybrid unit (8E-05 m-1) and 
for glacial till deposits (3E-03 m-1) are higher than geometric mean values from 
previously compiled results (1E-06, 1E-06 and 1E-08 m-1, respectively), and; 

 The S value estimated from test data conducted as part of the current program at 
BGC14-003I (2E-05 m-1), is lower than the estimated value for glaciofluvial deposits 
from previously compiled results (1E-04 m-1). 

Estimates of S values were not obtained for colluvium or lacustrine deposits (i.e., from test 
data at BGC14-012S and KAX-14-128S) due to the uncertainty with fitting the analysis type 
curves to the test data.  

With the exception of the S value obtained for BGC14-003I, the above estimates are above 
the range of representative specific storage values reported by Maidment (1993) for various 
sediment or rock types (i.e., 1E-5 to 1E-07 m-1 for igneous and metamorphic rocks as well as 
for compacted sediments).  These results should therefore be interpreted with caution and 
verified against aquifer test data that may become available in the future.    

5.2. Edith Lake Fault Zone Wells 

With the revised project layout that includes positioning the TSF near to, and upgradient from 
the interpreted surface expression of the ELFZ, some investigation of the hydraulic character 
of this fault is warranted to support the EA.  Therefore, part of the rationale for installing 
monitoring wells BGC14-001S/D, 002S/D, 013 and 015S/D was to collect data to assist with 
evaluations of the existing and potential hydraulic effect(s) of the ELFZ on the adjacent 
groundwater flow system.  

The well locations were planned based on regional mapping of the ELFZ by the British 
Columbia Geological Survey (Logan and Mihalynuk, 2005). Monitoring wells BGC14-002S/D 
and 015S/D were installed on the hanging wall (HW) side and BGC14-001S/D and 013 were 
installed on the foot wall (FW) side of the mapped trace of the fault.  The purpose of installing 
wells on either side of the mapped trace of the fault was to investigate potential differences in 
hydrogeology on either side of the feature (e.g., significant differences in geology, degrees of 
weathering, hydraulic conductivity, groundwater levels, hydraulic gradients, and/or water 
quality) that could influence groundwater flow in the area.  A summary of the observations 
made during the site investigation and groundwater data collected to date for these wells is 
provided in Table 8.  Based on this information, the following observations are made: 

 Estimated yields from wells installed on the FW side (i.e., wells BGC14-001D, 001S 
and 013) range from 2.4 to 3.2 US GPM (0.15 to 0.20 L/s);  
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 Estimated yields from airlift tests in wells installed on the HW side (i.e., wells 002S, 
002D 015S and 015D) were low (0.8 US GPM or 0.05 L/s in BGC14-002D) or 
unmeasurable 

 The K values estimated at wells installed into bedrock around the mapped trace of the 
fault near the TSF (BGC14-001D and 002D at 2E-06 and 4E-06 m/s, respectively) are 
higher than the K values estimated at wells installed into bedrock around the mapped 
trace of the fault near the SMRSF (BGC14-013 and 015 at 2E-08 and 9E-09 m/s, 
respectively); 

 Hydraulic conductivity does not appear to be dependent on location relative to the fault 
zone (i.e. K is similar on both the FW and HW sides of the fault), and;  

 During drilling of monitoring wells BGC14-002D and 013, distinct yellowish-brown 
coloured drill cuttings were noted coincident with softer drilling conditions, potentially 
indicating horizons of preferential weathering or gouge associated with the ELFZ.  In 
BGC14-002D this zone was encountered at approximately 20 m bgs (or 904 m asl) and 
at approximately 29 m bgs (or 962 m asl) in BGC14-013. 

The above observations do not provide conclusive evidence that the ELFZ is present and was 
intersected by the groundwater monitoring wells; however, these observations may indicate 
the presence of gouge and/or more advanced weathering associated with a fault structure(s).  
Detailed mapping and intrusive site investigations to evaluate the presence/absence and, if 
present, the orientation, thickness and hydraulic character of the fault were recommended by 
BGC in 2014.  Preliminary structural mapping work was completed around the fault trace in 
the fall of 2014 and geotechnical drilling around the fault trace under the direction of BGC is 
planned for 2015.  The results of these investigations have been provided to KAM under 
separate cover.   

5.3. Monitoring Wells Near or Within the Peterson Creek Aquifer 

Several boreholes in the drilling program were planned to target the Peterson Creek Aquifer 
partially with the intent of delineating the aquifer thickness near the southern extent (near the 
SMRSF footprint) as well as to the northern extent (near the EMRSF footprint) of its mapped 
limits.  These boreholes include BGC14-007D/S and 008D/S in the south and BGC14-004 and 
005 in the north. 

In the south, only shallow (i.e., within 6 m bgs) and thin (2-3 m thick) accumulations of sand 
potentially associated with the Peterson Creek Aquifer were intercepted at BGC14-007D/S and 
008D/S.  An installation was not completed within these materials at BGC14-007S because 
drilling conditions were dry.  BGC14-008S was screened within these materials for monitoring 
of vertical gradients.  

In the north, BGC14-004 and 005 encountered 63 and 43 m thicknesses of saturated aquifer 
sands, respectively.  Both wells were screened within the bedrock below the sand and gravel 
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aquifer, to be monitored in conjunction with shallower wells previously installed by BGC at 
these locations (i.e., BGC13-021 at BGC14-004 and BGC13-022 at BGC14-005).   

6.0 SUMMARY OF DATA COLLECTION FOR BASELINE ASSESSMENTS 

6.1. Groundwater Level Monitoring  

Groundwater levels (manual measurements and data downloads) from the Ajax South 
monitoring wells were collected by KAM field staff on 3 occasions in 2014 (i.e., mid-February, 
mid-August and early October).  Manual measurements and data downloads were provided to 
BGC in electronic format following each monitoring event.  Upon receipt of the data, BGC 
completed quality assurance/quality control (QA/QC) reviews of the data to identify general 
instrument maintenance needs and actively troubleshoot with KAM field staff through the 
baseline data collection period to ensure these needs are met.  Following each QA/QC review, 
data were integrated into BGC’s existing database for the project for use in numerical 
groundwater flow model updates and baseline groundwater quantity assessment.  As per the 
approved scope of work, groundwater level data synthesis and compilation for the BGC14-
series monitoring wells will be completed and included in the hydrogeology baseline report. 

6.2. Surface Water Monitoring 

Flow measurements were collected twice a month by KAM staff until the beginning of October 
2014.  Data were downloaded from all loggers at gauging stations at this time.  These logger 
data and manual streamflow measurements were sent electronically to BGC for incorporation 
into the baseline hydrology and water balance modeling studies being completed for the EA.  
As per the approved scope of work, data synthesis and compilation for all of the streamflow 
gauges will be completed and included in the surface water baseline report. 
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7.0 CLOSURE 

BGC Engineering Inc. (BGC) prepared this document for the account of KGHM Ajax Mining 
Inc. (KAM).  The material in it reflects the judgment of BGC staff in light of the information 
available to BGC at the time of document preparation.  Any use which a third party makes of 
this document or any reliance on decisions to be based on it is the responsibility of such third 
parties. BGC accepts no responsibility for damages, if any, suffered by any third party as a 
result of decisions made or actions based on this document. 

As a mutual protection to our client, the public, and ourselves, all documents and drawings are 
submitted for the confidential information of our client for a specific project.  Authorization for 
any use and/or publication of this document or any data, statements, conclusions or abstracts 
from or regarding our documents and drawings, through any form of print or electronic media, 
including without limitation, posting or reproduction of same on any website, is reserved 
pending BGC’s written approval.  If this document is issued in an electronic format, an original 
paper copy is on file at BGC and that copy is the primary reference with precedence over any 
electronic copy of the document, or any extracts from our documents published by others. 

Yours sincerely, 

BGC ENGINEERING INC. 
per: 

Cassandra Koenig, M.Sc., P.Geo. (BC, ON) 
Hydrogeologist 

Reviewed by: 

Trevor Crozier, M.Eng., P.Eng. (BC, ON) 
Senior Hydrogeological Engineer 

CK/TRWC/ma/lw 
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TABLES 



KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 1.    Summary of 2014 Ajax South Monitoring Well Installations.

Location Well ID
Proposal 
Hole ID

Easting 

(m)1

Northing 

(m)1

Ground 
Elevation 

(m asl)1

Hole 
Depth 

(m bgs)

Depth to 
Bedrock
(m bgs)

Screen 
Bottom 
(m bgs)

Screen Top 
(m bgs)

Sandpack 
Bottom 
(m bgs)

Sandpack 
Top 

(m bgs)

PVC Stickup 
(m ags)

PVC Dia 
(in)

Target Hydrostratig-
raphy (HSU)

Logged Lithology 
at Well Screen

Interpreted 
HSU Based 
on Mapping 

and Log data3

Proposed Monitoring Rationale Optimized Completion Description

TSF BGC14-001D T-2 682286 5608796 934 29.6 5.2 24.1 18.0 24.7 17.1 0.83 2 Nicola Volcanics
Bedrock (Nicola 

Volcanics)
Nicola Group

Potential GW discharge location; compliance monitoring and 
evaluations for seepage collection/interception down gradient of 
TSF; evaluate GW levels and on ELFZ foot wall.

6 m (20 ft) screen installed from 18 to 24 m (60 to 80 ft) bgs to 
target potential permeable zone within bedrock below static 
water level.

TSF BGC14-001S T-2 682286 5608796 934 6.4 5.5 5.5 4.0 6.4 3.7 0.84 2
Till/Undivided 

deposits
Silt, sand and gravel 

(Fluvial/Till)
Glacial Till 
Deposits

Potential GW discharge location; compliance monitoring and 
evaluations for seepave collection/interception down gradient of 
TSF; Evaluate GW levels and quality on ELFZ foot wall.

Dry well, however, 1.5 m (5 ft) screen installed above bedrock to 
target zone of gravel and potential surface water interactions. 
Monitor well with datalogger to determine whether gravel zone 
becomes saturated over the course of the year.

TSF BGC14-002D T-3 682756 5608900 923 29.9 15.2 22.9 16.8 23.8 15.9 0.73 2 Nicola Volcanics
Weathered Bedrock 
(Nicola Volcanics)

Nicola Group
Potential GW discharge location; compliance monitoring and 
evaluations for seepave collection/interception down gradient of 
TSF; Evaluate GW levels and quality on ELFZ hanging wall.

6 m (20 ft) screen installed into bedrock, targeting two moisture 
zones.  Target roughly coincides with creek level.

TSF BGC14-002S T-3 682756 5608900 923 15.7 15.2 15.2 9.1 15.7 8.5 0.85 2
Till/Undivided 
deposits/Fluvi-
al/Glaciofluvial

Silt with gravel, trace 
sand and clay (Till)

Glacial Till 
Deposits

Potential GW discharge location; compliance monitoring and 
evaluations for seepave collection/interception down gradient of 
TSF;  Evaluate GW levels and quality on ELFZ hanging wall.

6 m (20 ft) screen installed into silt targeting moisture zones 
noted during drilling.

TSF BGC14-003D T-4 683544 5608858 896 32.3 22.0 31.4 28.4 32.3 26.2 1.20 2 Nicola Volcanics
Bedrock (Nicola 

Volcanics)
Nicola Group

Vertical hydraulic gradients and water level fluctuations in 
potential GW discharge location.

3 m (10 ft) screen installed into bedrock targeting bedrock 
interactions with overburden aquifer system. 

TSF BGC14-003I NA 683544 5608858 896 22.0 20.1 19.8 16.8 20.4 15.5 0.82 2 N/A
Gravel and sand 

(Fluvial/Glaciofluvial)

Fluvial and 
Glaciofluvial 

Sands

Vertical hydraulic gradients and water level fluctuations in 
potential GW discharge location.

3 m (10 ft) screen installed into confined gravel and sand layer, 
for potential interactions with Peterson Creek Aquifer

TSF BGC14-003S T-4 683544 5608858 896 11.3 - 11.3 9.8 11.3 9.1 0.80 2 Fluvial/Glaciofluvial Silt (Till)
Glacial Till 
Deposits

Vertical hydraulic gradients and water level fluctuations in 
potential GW discharge location.

1.5 m (5 ft) screen installed in silt unit, targeting shallow system 
and interactions with surface water.

TSF BGC14-010 T-9 681730 5607414 978 78.3 11.0 58.2 46.0 59.7 44.2 0.89 2
Till/Undivided 

deposits
Bedrock Nicola Group

Compliance monitoring and evaluations for seepage 
collection/interception down gradient of TSF.

Groundwater not encountered within overburden. 12 m (40 ft) 
screen installed from 46 to 58 m (157 to 197 ft) bgs into bedrock 
targeting zone of moisture at approx. 47 m bgs and depth 
horizon of nearby water body at approx. 57 m bgs. 

TSF BGC14-011D T-5A 682796 5605945 1027 29.6 5.5 29.6 23.5 29.6 22.6 0.88 2
Till/Undivided 
deposits/Fluvi-
al/Glaciofluvial

Bedrock Nicola Group
Vertical hydraulic gradients and water level fluctuations in 
potential GW divide location.

6 m (20 ft) screen installed into weathered zone of bedrock 
containing trace gravel in drill returns.  

TSF BGC14-011S T-5A 682796 5605945 1027 18.3 5.5 18.3 15.2 18.3 14.3 0.91 2
Till/Undivided 
deposits/Fluvi-
al/Glaciofluvial

Weathered Bedrock 
(Nicola Volcanics)

Nicola Group
Vertical hydraulic gradients and water level fluctuations in 
potential GW divide location.

3 m (10 ft) screen installed into weathered bedrock from 15 to 
18 m (50 to 60 ft) bgs at first encounter with GW, targeting 2 
GPM water producing zone.

TSF BGC14-012D T-1 681950 5608373 924 29.6 5.2 25.0 20.4 26.2 19.2 0.91 2 Nicola Volcanics
Bedrock (Nicola 

Volcanics)
Nicola Group

Potential GW discharge location; compliance monitoring and 
evaluations for seepage collection/interception down gradient of 
TSF.

4.5 m (15 ft) screen installed over first encounter with water in 
bedrock. Screen targeting oxidized and potentially high 
permeability and weathered zone.

TSF BGC14-012S T-1 681950 5608373 924 3.4 - 3.4 2.7 3.4 2.1 0.89 2 Colluvium
Gravel and sand 

(Glaciofluvial)
Colluvium

Potential GW discharge location; compliance monitoring and 
evaluations for seepage collection/interception down gradient of 
TSF.

0.6 m (2 ft) screen installed into sand and gravel and first 
encounter with water in overburden.  Monitoring for potential 
surface water interactions within shallow sand and gravel. 
Screened unit is underlain by silt, water possibly perched.

TSF BGC14-016 SD-6 685348 5607041 1038 29.6 1.8 29.6 23.5 29.6 22.6 0.89 2 Nicola Volcanics Bedrock Nicola Group
Potential GW discharge zone from TSF to SMRSF; evaluations 
for SMRSF seepage and runoff collection facilities.

6 m (20 ft) screen instaled into bedrock upon first encounter with 
GW.  

TSF BGC14-017D T-4A 685540 5605928 1038 29.6 4.0 29.6 23.5 29.6 22.6 0.91 2 Colluvium/Till Bedrock Nicola Group
Compliance monitoring and evaluations for seepage 
collection/interception down gradient of TSF.

6 m (20 ft) screen installed in weathered bedrock zone targeting 
zones of moisture. 

TSF BGC14-017S T-4A 685540 5605928 1038 5.2 4.6 4.6 3.0 5.2 2.7 0.89 2 Colluvium/Till Silt (Till)
Glacial Till 
Deposits

Compliance monitoring and evaluations for seepage 
collection/interception down gradient of TSF.

1.5 m (5 ft) screen installed in colluvium/till, targeting moisture 
zones.
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Table 1.    Summary of 2014 Ajax South Monitoring Well Installations.

Location Well ID
Proposal 
Hole ID

Easting 

(m)1

Northing 

(m)1

Ground 
Elevation 

(m asl)1

Hole 
Depth 

(m bgs)

Depth to 
Bedrock
(m bgs)

Screen 
Bottom 
(m bgs)

Screen Top 
(m bgs)

Sandpack 
Bottom 
(m bgs)

Sandpack 
Top 

(m bgs)

PVC Stickup 
(m ags)

PVC Dia 
(in)

Target Hydrostratig-
raphy (HSU)

Logged Lithology 
at Well Screen

Interpreted 
HSU Based 
on Mapping 

and Log data3

Proposed Monitoring Rationale Optimized Completion Description

SMRSF BGC14-007D SD-1 685324 5608722 924 29.6 24.4 29.6 26.5 29.6 25.9 0.76 4 Nicola Volcanics
Bedrock (Nicola 

Volcanics)
Nicola Group

Vertical hydraulic gradients between Peterson Creek Aquifer 
and underlying bedrock; evaluations for SMRSF seepage and 
runoff collection facilities.

Dry well, however, 3 m (10 ft) screen installed into bedrock 
targeting potential bedrock aquifer system. Monitor well with 
datalogger to understand if gravel zone becomes saturated over 
the course of the year.

SMRSF BGC14-007S SD-1 685324 5608722 924 17.4 - 17.4 14.3 17.4 12.8 0.89 4
Fluvial/Glaciofluvial 

or Till (Peterson 
Creek Aquifer)

Silt with gravel (Till)
Glacial Till 
Deposits

Vertical hydraulic gradients between Peterson Creek Aquifer 
and underlying bedrock; evaluations for SMRSF seepage and 
runoff collection facilities.

Dry well, however, 3 m (10 ft) screen installed into colluvium/till 
an increased gravel zone. Glaciofluvial sediments limited to top 
2.5 m of borehole. Monitor well with datalogger to understand if 
gravel zone becomes saturated over the course of the year.

SMRSF BGC14-008D SD-2 686107 5608923 877 29.6 15.9 29.6 26.5 29.6 25.0 0.81 4
Iron Mask Hybrid 

Diorite
Bedrock (Iron Mask 

Hybrid)
Iron Mask 

Hybrid

Potential GW discharge zone; vertical hydraulic gradients 
between Peterson Creek Aquifer and underlying bedrock; 
evaluations for SMRSF seepage and runoff colection facilities.

3 m (10 ft) screen installed into bedrock targeting potential 
bedrock aquifer system.

SMRSF BGC14-008S SD-2 686107 5608923 877 6.1 - 6.1 4.6 6.1 3.7 0.86 4
Fluvial/Glaciofl-uvial 

(Peterson Creek 
Aquifer)

Sand and gravel 
(Glaciofluvial)

Fluvial and 
Glaciofluvial 

Sands

Potential GW discharge zone; vertical hydraulic gradients 
between Peterson Creek Aquifer and underlying bedrock; 
evaluations for SMRSF seepage and runoff colection facilities.

1.5 m (5 ft) screen installed in zone of moisture within gravel 
unit, targeting shallow system and interactions with surface 
water.

SMRSF BGC14-009 SD-3 686799 5608547 901 54.0 4.0 54.0 47.9 54.0 46.9 0.89 2
Iron Mask Hybrid 

Diorite
Bedrock (Iron Mask 

Hybrid)
Iron Mask 

Hybrid
Water level fluctuations in slope; evaluations for SMRSF 
seepage and runoff collection facilities.

6 m (20 ft) screen installed into bedrock targeting zone of 
moisture (possible fracture zone).

SMRSF BGC14-013 SD-5 686466 5606777 984 30.5 11.3 30.5 27.4 30.5 26.5 0.75 2 Nicola Volcanics Weathered Bedrock Nicola Group Evaluate GW levels and quality on ELFZ foot wall.
3 m (10 ft) screen installed into bedrock targeting highly 
weathered zone with silty, clayey, yellowish brown drill returns, 
with highest yield in hole (2.7 GPM).

SMRSF BGC14-014D SD-4A 686672 5607810 984 29.6 18.9 29.6 23.5 29.6 22.6 0.89 2 Nicola Volcanics Weathered Bedrock Nicola Group
Vertical hydraulic gradients and water level fluctuations in slope; 
seepage water quality.

6 m (20 ft) screen installed into moderately weathered bedrock, 
targeting moisture zones encountered near end of borehole 
("breaks in dust" described by driller). 

SMRSF BGC14-014S SD-4A 686672 5607810 984 18.9 - 18.9 12.8 18.9 12.2 0.89 2
Till/Undivided 
deposits or 

Fluvial/Glaciofluvial

Silt, sand and trace 
gravel (Till)

Glacial Till 
Deposits

Vertical hydraulic gradients and water level fluctuations in slope; 
seepage water quality.

6 m (20 ft) screen installed into silt unit, targeting zones of 
moisture.  Glaciofluvial materials in hole limited to 3 m bgs at this 
location.

SMRSF BGC14-015D SD-4 686773 5606920 976 29.6 11.6 29.6 23.5 29.6 22.3 0.94 2 Nicola Volcanics
Bedrock (Nicola 

Volcanics)
Nicola Group

Evaluate GW levels and quality on ELFZ hanging wall; seepage 
water quality monitoring well down gradiend from SMRSF.

6 m (20 ft) screen installed into bedrock targeting moisture 
zones encountered near end of borehole ("break in dust" 
described by driller).

SMRSF BGC14-015S SD-4 686773 5606920 976 11.3 - 11.3 8.2 11.3 7.6 0.89 2
Fluvial/Glaciofluvial 

or Till  
Sand with trace silt to 

silty (Glaciofluvial)
Glacial Till 
Deposits

Evaluate GW levels and quality on ELFZ hanging wall; seepage 
water quality.

6 m (20 ft) screen installed into gravel and sand, targeting 
saturated materials.

EMRSF BGC14-004 ED-1 687746 5609526 869 78.3 63.7 78.3 72.2 78.3 68.3 0.86 4
Iron Mask Hybrid 
Diorite (Sugarloaf 
Bedrock Aquifer)

Bedrock
Iron Mask 

Hybrid
Vertical hydraulic gradients between Peterson Creek Aquifer 
and underlying Sugarloaf Hill Bedrock Aquifer.

6 m (20 ft) screen installed into bedrock, targeting mapped 
Sugarloaf bedrock aquifer.  Data from this location will be paired 
with data collected from BGC13-021.

EMRSF BGC14-005 ED-2 687161 5609519 877 50.5 43.3 50.5 47.2 50.5 46.0 0.86 4
Iron Mask Hybrid 
Diorite (Sugarloaf 
Bedrock Aquifer)

Bedrock (Iron Mask 
Hybrid)

Iron Mask 
Hybrid

Vertical hydraulic gradients between Peterson Creek Aquifer 
and underlying Sugarloaf Hill Bedrock Aquifer.

3 m (10 ft) screen installed into bedrock, targeting mapped 
Sugarloaf bedrock aquifer.  Data from this location will be paired 
with data collected from BGC13-022.

EMRSF BGC14-006D ED-5 687288 5610779 940 29.6 14.0 26.5 20.4 29.6 19.2 0.76 4
Iron Mask Hybrid 

Diorite
Weathered Bedrock 
(Iron Mask Hybrid)

Iron Mask 
Hybrid

Evaluate seasonal GW fluctuations at topographic divide; data 
to support Aberdeen Effects Assessment.

6 m (20 ft) screen installed into weathered bedrock. 

EMRSF BGC14-006S NA 687288 5610779 940 14.3 - 14.0 11.0 14.3 9.5 0.80 4 NA Silty sand (Till)
Glacial Till 
Deposits

Evaluate seasonal GW fluctuations at topographic divide; data 
to support Aberdeen Effects Assessment.

3 m (10 ft) installed into colluvium/till above bedrock contact. 

Notes:

1. UTM Easting and Northing estimated from handheld GPS; Elevations estimated from compiled DEM; Drillhole collars should be surveyed accurately by KGHM as soon as possible.

2. TSF=Tailings Storage Facility; EMRSF=East Mine Rock Storage Facility; SMRSF=South Mine Rock Storage Facility; GW=Groundwater; HSU=Hydrostratigraphic unit; ELFZ=Edith Lake Fault Zone; NA=Not Applicable.

3. Interpreted bedrock unit based on mapping by Massey et al., (2005) and previously existing drillholes nearby.

\\Bgc-tor-file1\torprojects\Projects\1125 KGHM\006 GW SW Program Design\02 Site Investigation\10 Reporting\02 Tables\1125007_Ajax_South_Site_Investigation_Tables_08262015.xlsx

BGC ENGINEERING INC.



KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 2.    Summary of 2014 Ajax South Monitoring Well Airlift Test Results.

Location Hole ID
Depth to Bedrock (m 

bgs)
Surface Casing Depth   

(m bgs)
Hole Drill Depth at Time of Test 

(m bgs)
Approximate Yield          (US 

gpm)

19.2 3.1

29.0 3.0

BGC14-001S 6.4 1.5 N/A nm

29.0 0.5

29.9 0.8

BGC14-002S 15.2 4.6 N/A nm

BGC14-003D 22.0 3.0 17.1 3-4

BGC14-003I 20.1 11.3 N/A nm

BGC14-003S - 30.4 N/A nm

BGC14-010 11.0 4.6 N/A nm

16.8 1.9

29.6 1.8

BGC14-011S 5.5 5.2 16.8 1.2

BGC14-012D 5.2 5.2 29.6 1.0

BGC14-012S - 0.9 N/A nm

BGC14-016 1.8 5.2 29.6 0.2

BGC14-017D 4.0 5.2 29.0 0.2

BGC14-017S 5.2 1.5 N/A nm

BGC14-007D 24.4 4.6 N/A nm

BGC14-007S - 4.6 N/A nm

BGC14-008D 15.9 4.6 4.3 0.03

BGC14-008S - 0.9 N/A nm

BGC14-009 4.0 4.6 54.0 1.0

9.8 1.4

18.3 2.8

23.7 2.5

30.5 2.7

BGC14-014D 18.9 5.2 N/A nm

BGC14-014S - 5.2 N/A nm

BGC14-015D 11.6 5.2 N/A nm

BGC14-015S - 2.1 N/A nm

16.8 10
29.0 80-100
40.0 30
54.0 50
78.3 4.20

BGC14-005 63.7 4.6 48.9 0.83
BGC14-006D 14.0 4.6 26.6 0.04 1

BGC14-006S - 4.6 N/A nm
Notes:
1. Inflow may be from unit above test zone.

5.2

BGC14-004 43.3 4.6

BGC14-001D 5.2 3.0

BGC14-002D 15.2 4.6

BGC14-011D 5.5 5.2

TSF

SMRSF

EMRSF

BGC14-013 11.3
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 3.    Summary of 2014 Ajax South Well Development Details.

Hole Name
Development 

Start Date
Development 

Complete Date

Total 
Gallons 
Purged

Turbidity of 
Final Well 
Volume 
(NTU)

pH of Final 
Well Volume

Approx. 
Number of 

Well 
Volumes 

Removed1

Visual Description 
of Final Well 

Volume
Logged Lithology Comments

Development 
Completed by

BGC14-001D 12-Mar 12-Mar 75 56 8.85 9 Clear Bedrock (Nicola Volcanics) BGC

BGC14-001S - - DRY - - - -
Silt, sand and gravel 

(Fluvial/Till)
N/A

BGC14-002D 6-Mar 8-Mar 110 143 9.23 12 Murky light Brown
Weathered Bedrock (Nicola 

Volcanics)
BGC

BGC14-002S 3-Mar 6-Mar 50 18 8.73 17 Clear
Silt with gravel, trace sand 

and clay (Till)
BGC

BGC14-003D 11-Mar 17-May 300 211 9.54 19 Murky Bedrock (Nicola Volcanics) BGC / KGHM

BGC14-003I 2-Mar 10-Mar 200 20 9.93 20 Clear
Gravel and sand 

(Fluvial/Glaciofluvial)
BGC

BGC14-003S 1-Mar 10-Mar 109 132 9.71 55 Murky Brown Silt (Till) BGC

BGC14-004 22-Mar 4-Jun 540 239 11.28 4 Cloudy Bedrock
Well possibly affected by grout; Last reliable turbidity 

reading 5/26/2014
BGC / KGHM

BGC14-005 24-Mar 29-Mar 170 122 8.39 2 Light Brown Bedrock (Iron Mask Hybrid) BGC / KGHM

BGC14-006D 22-Mar 20-May 806 122 8.23 20 Light Brown
Weathered Bedrock (Iron 

Mask Hybrid)
BGC / KGHM

BGC14-006S 17-Mar 1-Jun 27 106 6.93 2 Clear Silty sand (Till)
Development criteria revised due to well conditions1; 
Silt in well caused tubing blockages; Bailers used to 

overcome sediment load
BGC / KGHM

BGC14-007D - - DRY - - - - Bedrock (Nicola Volcanics) N/A

BGC14-007S - - DRY - - - - Silt with gravel (Till) N/A

BGC14-008D 25-Mar 30-May 45 272 13.46 4 Light Grey Bedrock (Iron Mask Hybrid)

Development criteria revised due to well conditions1; 
Continuing development not practical due to slow 

recovery (i.e., over weeks); Well possibly affected by 
grout

BGC / KGHM

BGC14-008S - - DRY - -
Sand and gravel 

(Glaciofluvial)
N/A

BGC14-009 26-Mar 29-Mar 190 37 8.12 9 Clear Bedrock (Iron Mask Hybrid) BGC

BGC14-010 11-Mar 13-Mar 270 102 7.15 13 Light Grey/Brown Bedrock KP

BGC14-011D 14-Mar 16-Mar 90 50 8.41 9 Cloudy Bedrock KP

BGC14-011S 14-Mar 14-Mar 90 92 9.38 11 Light Brown
Weathered Bedrock (Nicola 

Volcanics)
KP

BGC14-012D 17-Mar 17-Mar 110 29 8.93 7 Clear Bedrock (Nicola Volcanics) BGC / KGHM

BGC14-012S 15-Mar 17-Mar 130 27 9.29 65 Clear
Gravel and sand 

(Glaciofluvial)
BGC

BGC14-013 18-Mar 21-Mar 70 83 8.53 5 Clear Weathered Bedrock KGHM

BGC14-014D 23-Mar 28-May 29 708 6.73 7 Brown Weathered Bedrock
Development criteria revised due to well conditions2; 

Final turbidity value >250 NTU but other 
physicochemical parameters stable.

BGC / KGHM

BGC14-014S 18-Mar - 4 1495 8.66 - Very Brown
Silt, sand and trace gravel 

(Till)
Dry on March 31, 2014; Water level close to well 

bottom throughout remainder of program
N/A

BGC14-015D 18-Mar 7-May 280 210 8.34 16 Slightly Milky Bedrock (Nicola Volcanics) BGC / KGHM
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 3.    Summary of 2014 Ajax South Well Development Details.

Hole Name
Development 

Start Date
Development 

Complete Date

Total 
Gallons 
Purged

Turbidity of 
Final Well 
Volume 
(NTU)

pH of Final 
Well Volume

Approx. 
Number of 

Well 
Volumes 

Removed1

Visual Description 
of Final Well 

Volume
Logged Lithology Comments

Development 
Completed by

BGC14-015S 13-Mar 28-May 363 373 7.62 52 Grey
Sand with trace silt to silty 

(Glaciofluvial)

Development criteria revised due to well conditions2; 
Final turbidity value >250 NTU but other 

physicochemical parameters stable.

BGC / KGHM

BGC14-016 19-Mar 21-Mar 145 64 7.95 10 Clear Bedrock KGHM

BGC14-017D 21-Mar 29-May 168 135 8.21 10 Murky Bedrock
Development criteria revised due to well conditions2; 

Final turbidity value >250 NTU but other 
physicochemical parameters stable.

BGC / KGHM

BGC14-017S 20-Mar 28-May 3 >800 7.59 1 Brown Silt (Till)
Development criteria revised due to well conditions2; 

Continuing development not practical due to slow 
recovery (i.e., over weeks)

BGC / KGHM

KAX-14-114S 2-Jun 2-Jun 110 0 8.62 6 Clear Sand and gravel
Well installed by KCB3; Added to development 

program at the request of KGHM Ajax on May 30, 
2014.

BGC

KAX-14-128S 2-Jun 5-Jun 40 >800 7.74 13 Brown
Silt, clay, sand and gravel 

(Till)

Well installed by KCB3; Added to development 
program at the request of KGHM Ajax on May 30, 

2014; Development criteria revised due to well 

conditions1; Silt in well caused tubing blockages; 
Bailers used to overcome sediment load

BGC

Notes:

3. Drill hole logs for KAX-14-114S and 128S prepared by KCBL (2014).

1. Well volumes calculated based on water levels observed after drilling and may not represent static conditions.

4. N/A = Not Applicable.

2. Some wells would not meet the 250 NTU criteria as a result of slow water level recovery (i.e., several days to weeks) or excessive amounts of silt in the well screen.  Development criteria were relaxed in these wells in order to keep 
with the water quality sampling schedule.  
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 4.    Summary of 2014 Ajax South Datalogger Deployment Details.

Location ID UTM Easting UTM Northing Logger Serial Number
Water depth at installation       

(m bTOC)
Logger Deployment Depth        

(m bTOC)

BGC14-001D 682286 5608796 32031138 11.73 14.72

BGC14-001S 682286 5608796 32031137 DRY 5.94

BGC14-002D 682756 5608900 32031107 7.21 12.89

BGC14-002S 682756 5608900 32031106 7.40 12.34

BGC14-003D 683544 5608858 32031141 3.90 6.98

BGC14-003I 683544 5608858 32031125 4.45 9.34
BGC14-003S 683544 5608858 32031131 4.47 9.43
BGC14-004 687746 5609526 32031180 8.23 12.50
BGC14-005 687161 5609519 32031187 16.19 17.84

BGC14-006D 687288 5610779 2032062 8.69 11.50
BGC14-006S 687288 5610779 2031130 4.48 10.80
BGC14-007D 685324 5608722 32031184 DRY 30.83
BGC14-007S 685324 5608722 32031112 DRY 18.46
BGC14-008D 686107 5608923 32031097 DRY 26.71
BGC14-008S 686107 5608923 32030360 DRY 6.74
BGC14-009 686799 5608547 32031189 16.23 19.88
BGC14-010 681730 5607414 32030361 9.36 12.31

BGC14-011D 682796 5605945 32031105 5.26 7.56

BGC14-011S 682796 5605945 32032109 5.29 8.54
BGC14-012D 681950 5608373 32031110 1.21 5.37
BGC14-012S 681950 5608373 32032117 1.64 4.17
BGC14-013 686466 5606777 32030366 3.24 8.27

BGC14-014D 686672 5607810 32031188 21.92 29.16
BGC14-014S 686672 5607810 32031132 DRY 19.87
BGC14-015D 686773 5606920 32031104 0.87 2.97

BGC14-015S 686773 5606920 32017719 0.88 9.07
BGC14-016 685348 5607041 32031183 5.17 7.76

BGC14-017D 685540 5605928 32032511 3.48 10.48
BGC14-017S 685540 5605928 32030627 0.90 3.94

Location ID UTM Easting UTM Northing Logger Serial Number
Water depth at installation       

(m)
Water depth on staffing gauge (m)

PETER 685667 5609299 32031095 0.11 0.19

JACSEEP 683266 5609103 32031186 0.17 0.17

JACLAKE 683124 5609098 32030359 0.38 0.08

JACINF 681084 5608693 32031102 0.09 0.12

KEYNES 682975 5608965 10434196 - 0.11
Notes:

Surface Water Monitoring Stations

Groundwater Monitoring Wells

1. m bTOC = metres below top of casing.
2. Barometric loggers located at KEYNES monitoring station and at previously existing monitoring well MW11-03S (678891E, 5611179N).
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 5.    Summary of 2014 Ajax South Snowpack Surveys.

Site Date UTM East (m) UTM North (m) Aspect
Snow 
Depth 
(mm)

SWE     
(mm)

Comments

34 26-Feb-14 682525 5609114 310 130 10 Wind packed and sugary snow

35 26-Feb-14 682303 5608203 240 100 20
Wind packed and sugary. Top of slope has no snow, opposite side of the road 
has more snow

36 26-Feb-14 682231 5608146 11 210 100 Sugary, windpacked
37 26-Feb-14 682843 5607653 140 65 10 Small, local depression - average of the area
38 26-Feb-14 682826 5608116 84 80 10 Grassland location, snow is sublimating. Snow is compact and sugary
39 26-Feb-14 682949 5608136 84 180 80 Grassland. Bottom of small gully.
40 26-Feb-14 682848 5608791 240 210 90 Glades on hill, benched area

41 26-Feb-14 682358 5606425 33 310 110
Small conifers on grass slope. Loose snow (drift) with ice crystal texture. Wind 
packed snow nearby.

42 26-Feb-14 682353 5606380 320 100 40 Grassland. Top of hill. Sublimating.
43 26-Feb-14 682305 5606326 234 290 100 Bottom of hill next to the road. Within a stand of deciduous trees
44 26-Feb-14 684808 5606369 234 210 80 Location is approximately midslope. Slope is dry below
45 26-Feb-14 684800 5606352 234 250 110 Grassed slope with intermittent conifers.  Wind crust and sugary below.
46 26-Feb-14 684649 5606407 n/a 320 100 Goose Lake. Wind slab - loose and hollow below.
47 26-Feb-14 684317 5605665 0 80 20 Under forest canopy, on the side of the road adjacent to the barbed wire fence

48 26-Feb-14 682887 5604518 290 300 100
Side of plateau, semi-treed area. Thicker snow on the plateau and thinner 
snow under trees

49 26-Feb-14 682061 5603807 0 260 90 heavily treed
50 27-Feb-14 681714 5604464 10 70 30 Treed area near the road at the top of a hill, fairly flat
51 27-Feb-14 681115 5605488 0 240 80 Edge of the open area, next to the trees
52 27-Feb-14 678994 5606146 60 260 80 Directly on the road
53 27-Feb-14 678992 5606136 40 160 70 In trees adjacent to the road

681 18-Mar-14 680148 5603429 30 350 110 Under trees, slope forms the side of a swale.
682 18-Mar-14 678001 5602933 240 600 140 Sugary snow adjacent to trail edge.
683 18-Mar-14 676931 5603107 45 630 180 Adjacent to road, sugary, compact snow.
684 18-Mar-14 679306 5605013 50 380 120 Sugary snow adjacent to trail edge.
685 18-Mar-14 678726 5604780 20 580 90 Sugary snow, under trees adjacent to the trail edge.
686 18-Mar-14 677489 5603983 25 430 140 -

687 19-Mar-14 674532 5602500 45 910 160
Deep snow in cutblock adjacent to trees. Crust with unconsolidated snow 
bellow

688 19-Mar-14 674533 5603296 80 760 90 Windblown snow crust, onconsolidated and hollow beneath.
689 19-Mar-14 674580 5602844 0 540 130 Sugary snow crust over unconsolidated snow.

Peterson Creek

Keynes Creek
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 6.    Ajax South Monitoring Well Response Test Results.

Analysis Method K (m/s) S (m-1)

BGC14-001D 1 FH KGS [1994] Unconfined Aquifer 2 E-06 5 E-03
BGC14-001D 2 RH KGS [1994] Unconfined Aquifer 3 E-06 4 E-03

2 E-06 4 E-03
BGC14-002S 1 FH KGS [1994] Unconfined Aquifer 1 E-07 -
BGC14-002S 2 RH KGS [1994] Unconfined Aquifer 1 E-07 -

1 E-07 -
BGC14-002D 1 FH Hvorslev [1951] Unconfined Aquifer 4 E-06 -
BGC14-002D 2 RH Hvorslev [1951] Unconfined Aquifer 4 E-06 -
BGC14-002D 3 FH Hvorslev [1951] Unconfined Aquifer 4 E-06 -
BGC14-002D 4 RH Hvorslev [1951] Unconfined Aquifer 4 E-06 -

4 E-06 -
BGC14-003S 1 FH KGS [1994] Unconfined Aquifer 3 E-07 6 E-03
BGC14-003S 2 RH KGS [1994] Unconfined Aquifer 3 E-07 3 E-03

3 E-07 5 E-03
BGC14-003I 1 FH KGS [1994] Unconfined Aquifer 6 E-06 7 E-06
BGC14-003I 2 RH KGS [1994] Unconfined Aquifer 7 E-06 4 E-05

6 E-06 2 E-05
BGC14-003D 1 FH KGS [1994] Unconfined Aquifer 2 E-08 1 E-03
BGC14-003D 2 RH KGS [1994] Unconfined Aquifer 2 E-08 1 E-03

2 E-08 1 E-03
BGC14-004 1 FH KGS [1994] Unconfined Aquifer 2 E-07 8 E-04
BGC14-004 2 RH KGS [1994] Unconfined Aquifer 8 E-07 1 E-05

4 E-07 1 E-04
BGC14-005 1 FH KGS [1994] Unconfined Aquifer 9 E-08 2 E-04
BGC14-005 2 RH KGS [1994] Unconfined Aquifer 5 E-08 3 E-03

7 E-08 9 E-04

BGC14-006S 1
Single Rising 

Head
KGS [1994] Unconfined Aquifer 1 E-08 6 E-04 12.5 Silty sand (Till) Glacial Till Deposits

BGC14-006D 1 FH KGS [1994] Unconfined Aquifer 8 E-08 9 E-04
BGC14-006D 2 RH KGS [1994] Unconfined Aquifer 2 E-07 5 E-06

1 E-07 7 E-05

BGC14-008D 1
Single Rising 

Head
Hvorslev [1951] Unconfined Aquifer 1 E-09 - 28.0 Bedrock (Iron Mask Hybrid) Iron Mask Hybrid

BGC14-009 1 FH KGS [1994] Unconfined Aquifer 2 E-07 8 E-06
BGC14-009 2 RH KGS [1994] Unconfined Aquifer 2 E-07 6 E-06

2 E-07 7 E-06
BGC14-010 1 FH KGS [1994] Unconfined Aquifer 6 E-08 7 E-04
BGC14-010 2 RH KGS [1994] Unconfined Aquifer 4 E-08 1 E-03

5 E-08 1 E-03

Iron Mask Hybrid

Nicola Group

Iron Mask Hybrid

Iron Mask Hybrid

Iron Mask Hybrid

Nicola Group

Nicola GroupBedrock (Nicola Volcanics)

Logged Lithology
Interpreted HSU Based on 

Mapping and Log data

Glacial Till Deposits

Nicola Group

Glacial Till Deposits

Fluvial and Glaciofluvial 
Sands

Silt with gravel, trace sand 
and clay (Till)

Silt (Till)

Weathered Bedrock (Nicola 
Volcanics)

Bedrock (Iron Mask Hybrid)

Bedrock

Representative Value = 

19.8

Representative Value = 

75.3
Representative Value = 

48.9
Representative Value = 

23.5

50.9
Representative Value = 

52.1
Representative Value = 

Observation Point
Test 
No. 

Type of Test
Average Depth of Screened 

Interval           (m bgs)

Best Fit to Slug Test Data1

21.0
Representative Value = 

12.1
Representative Value = 

Representative Value = 

18.3
Gravel and sand 

(Fluvial/Glaciofluvial)
Representative Value = 

Representative Value = 

10.5

29.9 Bedrock (Nicola Volcanics)

Bedrock

Bedrock (Iron Mask Hybrid)

Weathered Bedrock (Iron 
Mask Hybrid)
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 6.    Ajax South Monitoring Well Response Test Results.

Analysis Method K (m/s) S (m-1)
Logged Lithology

Interpreted HSU Based on 
Mapping and Log data

Observation Point
Test 
No. 

Type of Test
Average Depth of Screened 

Interval           (m bgs)

Best Fit to Slug Test Data1

BGC14-011S 1 FH KGS [1994] Unconfined Aquifer 1 E-06 4 E-03
BGC14-011S 2 RH KGS [1994] Unconfined Aquifer 2 E-06 8 E-04

1 E-06 2 E-03
BGC14-011D 1 FH KGS [1994] Unconfined Aquifer 3 E-07 1 E-03
BGC14-011D 2 RH KGS [1994] Unconfined Aquifer 4 E-07 2 E-04

3 E-07 5 E-04
BGC14-012S 1 FH Hvorslev [1951] Unconfined Aquifer 6 E-04 -
BGC14-012S 2 RH KGS [1994] Unconfined Aquifer 1 E-03 -
BGC14-012S 3 FH Hvorslev [1951] Unconfined Aquifer 9 E-04 -
BGC14-012S 4 RH KGS [1994] Unconfined Aquifer 1 E-03 -

9 E-04 -
BGC14-012D 1 FH KGS [1994] Unconfined Aquifer 9 E-07 7 E-05
BGC14-012D 2 RH KGS [1994] Unconfined Aquifer 6 E-07 3 E-04
BGC14-012D 3 FH KGS [1994] Unconfined Aquifer 1 E-06 3 E-05
BGC14-012D 4 RH KGS [1994] Unconfined Aquifer 1 E-06 3 E-05

8 E-07 6 E-05
BGC14-013 1 FH KGS [1994] Unconfined Aquifer 1 E-08 4 E-03
BGC14-013 2 RH KGS [1994] Unconfined Aquifer 2 E-08 9 E-05

2 E-08 6 E-04

BGC14-014D 1
Single Rising 

Head
KGS [1994] Unconfined Aquifer 1 E-09 - 26.5 Bedrock (Nicola Volcanics) Nicola Group

BGC14-015S 1
Single Rising 

Head
Cooper et al. [1967] Confined Aquifer 1 E-07 - 9.8

Sand with trace silt to silty 
(Glaciofluvial)

Glacial Till Deposits

BGC14-015D 1 FH Cooper et al. [1967] Confined Aquifer 2 E-08 -

BGC14-015D 2 RH Cooper et al. [1967] Confined Aquifer 4 E-09 1 E-05
9 E-09 1 E-05

BGC14-016 1 FH KGS [1994] Unconfined Aquifer 6 E-08 -
BGC14-016 2 RH KGS [1994] Unconfined Aquifer 3 E-08 2 E-04

5 E-08 2 E-04

BGC14-017S 1
Single Rising 

Head
Cooper et al. [1967] Confined Aquifer 2 E-07 2 E-02 3.8 Silt (Till) Glacial Till Deposits

BGC14-017D 1
Single Rising 

Head
KGS [1994] Confined Aquifer 4 E-09 5 E-07 26.5 Bedrock Nicola Group

KAX-14-114S 1 FH Hvorslev [1951] Unconfined Aquifer 1 E-06 -
KAX-14-114S 2 RH Hvorslev [1951] Unconfined Aquifer 2 E-06 -

1 E-06 -

KAX-14-128S 13 FH Hvorslev [1951] Unconfined Aquifer 2 E-06 -

KAX-14-128S 23 RH Hvorslev [1951] Unconfined Aquifer 2 E-06 -
2 E-06 -

KAX-14-128S 1A3 FH Hvorslev [1951] Unconfined Aquifer 1 E-07 -

KAX-14-128S 2A3 RH Hvorslev [1951] Unconfined Aquifer 1 E-07 -
1 E-07 -

Notes:

2. Weathered bedrock indicated for materials logged as moderately to highly weathered.
3. Well screened across units with variable hydraulic conductivity.  K estimated for early and late time response data.

Representative Value = 

14.0

Representative Value = 

26.5

Representative Value = 

Nicola Group

Nicola Group

Bedrock (Nicola Volcanics) Nicola Group

Bedrock Nicola Group

Weathered Bedrock Nicola Group

Nicola Group

Gravel and sand 
(Glaciofluvial)

Colluvium

Bedrock (Nicola Volcanics)

Weathered Bedrock (Nicola 
Volcanics)

26.5
Representative Value = 

26.5
Representative Value = 

16.8

29.0
Representative Value = 

3.0

Representative Value = 

26.5

1. At locations where multiple tests were conducted, representative hydraulic conductivity and storage paramaters have been calculated as the geometric mean value of individual analysis results.

14.0

Representative Value = 

Gravel and Sand

Silty Sands (Glaciolacustrine 
Till)

Fluvial and Glaciofluvial 
Sands

Lacustrine Deposits

Sand and gravel
Fluvial and Glaciofluvial 

Sands

Bedrock
Representative Value = 

Representative Value = 

23.3
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Minimum Maximum Geomean Minimum Maximum Geomean Minimum Maximum Geomean

Nicola Group 1E-09 4E-06 8E-08 2E-11 3E-05 1E-07 5E-07 4E-03 2E-04 1E-06
Iron Mask Hybrid 7E-08 4E-07 2E-07 2E-10 2E-05 6E-08 7E-06 9E-04 8E-05 1E-06
Glacial Till Deposits 1E-08 2E-02 1E-06 1E-10 1E-04 2E-07 6E-04 2E-02 3E-03 1E-05
Fluvial and Glaciofluvial Sands 1E-06 6E-06 3E-06 1E-09 1E-03 2E-05 1 E -04

Colluvium4 NA NA NA NA NA NA NA

Lacustrine Deposits4 NA NA NA NA NA NA NA
Notes:
1. At locations where multiple tests were conducted, representative hydraulic conductivity and storage paramaters have been calculated as the geometric mean value of individual analysis results.
2. Previous  estimates compiled in BGC (2013b).
3. Preliminary estimates, include assigned numerical model parameters and pumping test results compiled in BGC (2011).
4. Previous test data not available for colluvium or lacustrine deposits.

Table 7.    Summary of Ranges in Estimated Hydraulic Parameters in the Ajax South Monitoring Wells.

1E-07

Interpreted HSU Based on Mapping 
and Log data

Storage (m-1)

Previous Estimates3

9E-04

Ajax South Wells1 Previous Estimates2 Ajax South Wells1

2E-05

Hydraulic Conductivity (m/s)
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KGHM Ajax Mining Inc., Ajax Project Environmental Assessment
Ajax South Groundwater and Surface Water Site Investigation

August 26, 2015
Project No.: 1125007-02-04

Table 8.    Summary of Observations at Wells drilled near the mapped trace of the ELFZ.

Well ID Location
Hanging Wall / 

Foot Wall1
Screened Material

Yield from Airlift 
Tests          

(US GPM)2
K (m/s)

Static Water 
Level        

(m bgs)3

Date and Time of 
Static Water Level 

Measurement

Notable Weathered Bedrock 
Zone(s) During Drilling

General Drilling Observations

BGC14-001D TSF FW Bedrock (Nicola Volcanics) 3.2 2E-06 10.39 17-Jun-04 11:14 None Water encountered at 19.2 m

BGC14-001S TSF FW
Silt, sand and gravel 

(Fluvial/Till)
3.0 Not Tested >15.2 17-Jun-04 11:38 None Dry during drilling

BGC14-002D TSF HW
Weathered Bedrock (Nicola 

Volcanics)
0.8 4E-06 5.79 17-Jun-04 12:37

Bedrock moderately weathered with 
distinct yellowish brown returns at 20.1 

m bgs
Softer drilling at 20.1 m

BGC14-002S TSF HW
Silt with gravel, trace sand 

and clay (Till)
nm 1E-07 5.89 17-Jun-04 12:10

Bedrock slightly to moderately 
weathered

-

BGC14-013 SWRSF FW Weathered Bedrock 2.4 2E-08 2.09 07-Jul-14 15:26
Bedrock moderately weathered with 

distinct yellowish brown returns at 28.7 
m bgs

-

BGC14-015D SWRSF HW Bedrock (Nicola Volcanics) nm 9E-09 > 0.94 03-Jul-14 13:12 None Dry during drilling

BGC14-015S SWRSF HW
Sand with trace silt to silty 

(Glaciofluvial)
nm 1E-07 0.43 26-Jul-14 16:22 None -

Notes:
1. Location of borehole in relation to the mapped fault by Logan and Mihalynuk (2005).
2. nm = not measurable.
3. BGC14-001S dry at time of measurement; BCG14-015D water level at top of PVC at time of measurement; Levels for BGC14-015S and 015D reported in metres above ground surface.
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Photo 1. 

JacInf Gauging Station  

May 29, 2014 

 

Photo 2. 

JacLake Gauging Station  

May 29, 2014  

Photo 3. 

JacSeep Gauging Station  

June 1, 2014  
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Photo 4. 

Keynes Creek Gauging Station  

June 1, 2014  

Photo 5. 

Peterson Creek Gauging Station  

June 1, 2014  
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APPENDIX A 
BOREHOLE LOGS AND MONITORING WELL COMPLETION 

DETAILS 



LEGEND FOR WELL LOGS 
 
The various parameters depicted on the well logs are described below according to the select headings 
found on the form.  
 
Location 
 
TSF – Tailings Storage Facility 
EMRSF – East Mine Rock Storage Facility 
SMRSF – South Mine Rock Storage Facility 
 
Depth 
 
Depth below ground surface is measured in metres. 
 
Water Levels 
 
Groundwater levels are represented by the symbols shown below. First encountered water levels were 
obtained during drilling progress, static water levels were measured after drilling and piezometer 
installation is complete. 
 

 
 
Sample Type and Sample Number 
 
Samples were collected to permit cross-checking of logged geology by the KGHM Ajax site geologist 
and were limited to grab samples collected from the Dual Rotary drill cuttings.  Samples are numbered 
and represented graphically by the symbol shown below. All samples collected from test holes are 
shown on the logs; however, will not be tested, as they are considered to be “disturbed” due to 
aggressive drilling methods.  
 

 
 
  



Symbol 
 
Sediment types and rock are represented graphically by the following symbols: 
 
GRAVEL   

Silt/Gravel  
(GM) 

 
Sand/Gravel 

(GSP) 
Poorly-graded 

Gravel 
(GP) 

Well-graded Gravel  
(GW) 

 

   

SAND   

Silt/Sand  
(SM) 

Poorly-graded 
Sand 
(SP) 

Well-graded Sand 
(SW) 

  

   
SILT CLAY OTHER 

High Plastic Silt 
(MH) 

Low Plastic Silt 
(ML) 

High Plastic Clay 
(CH) 

Low Plastic Clay 
(CI/CL) 

 
Boulders and Cobbles    

(BLDRCBBL) 
   

BEDROCK   

 
Ironmask Hybrid 

 
Nicola Group 

 
Undifferentiated Bedrock 

  

 
  



Lithologic Description  
 
Due to the aggressive nature of Dual Rotary drilling, sediments and lithology are considered to be of 
disturbed nature, and are described using simplified observations, where possible.  
Disturbed sediments are classified according to the Unified Soil Classification System (USCS), and are 
described typically by the following features: primary constituent; particle size range; secondary 
constituents; gradation; colour; particle shape and angularity; maximum particle size; moisture content; 
presence of foreign materials.   
Disturbed bedrock cuttings are described according to the International Society for Rock Mechanics 
(ISRM 1978). The following descriptions are typically listed for each main lithological unit on the logs: 
grain size; colour; alteration and weathering; vein and faulting characteristics.  
 
  



Weathering Grade  
 
Weathering and alteration of the rock mass is described according to Bieniawski 1976 parameters 
defined below.  
 
Alteration and Weathering Rating (Bieniawski 1976) 
Degree of Alteration/Weathering  Description  Rating 

Fresh Alteration may result in an improvement in rock 
competency (e.g. silicification)  

W1 

Slightly Weathered/Altered Rock strength unchanged; weathering on joints only  W2 
Moderately Weathered/Altered Rock is discoloured but rock strength only slightly 

affected; discontinuities are weathered  
W3 

Highly Weathered/Altered Rock is discoloured and strength is significantly 
reduced by weathering  

W4 

Completely Weathered/Altered Original fabric and relict structures remain but rock is 
decomposed and friable  

W5 

Residual Soil Original fabric destroyed  W6 
 
Note: If alteration/weathering is > W4 or UCS grade ≤R0, then RQD is 0% for that section. Also, if the UCS grade ≤R0, the number of 
discontinuities is recorded as the default 99. 
 
Instrument Details  
 
Fill materials placed in the test holes are graphically represented by the symbols below. All test holes 
contain standpipe piezometers. These instruments are shown below in a default filter sand fill. 
 
MATERIALS PLACED DOWN HOLE 
 
 

 
 
INSTRUMENTATION SHOWN IN FILTER SAND 
 

 
 

 



SAND AND GRAVEL (GM)
Silty, sand is fine, well graded, light greyish brown, trace rootlets and organics.
[TOPSOIL]

SAND (SM)
Fine, some silt, uniformly graded, light brown.

SILT (ML)
Some sand, some clay, trace gravel, well graded, dark brown with grey clasts.
[TILL]

GRAVEL AND SAND (GM)
Some silt, sand is medium, gravel is fine, well graded, dark brown with grey clasts.
[FLUVIAL]

BEDROCK
Drill cuttings:  fine to medium grained, angular to subrounded, dark to light grey,
unweathered to slightly weathered.
[NICOLA VOLCANICS]
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DRILL HOLE # BGC14-001D

Water
Notes
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Time
Comments

Page 1 of 4

Coordinates (m): 682286E - 5608796N

Final Depth (m): 29.56Survey Method: Handheld GPS

S
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 3.04

Logged By: SLP

Depth to Top of Rock (m): 5.18

Start Date: 11 Feb 2014

Finish Date: 13 Feb 2014

Lithologic Description
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Reviewed By: TWC

Stick-up (m): 0.83
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment

0

1

2

3

4

5

6

7

8

9

10

935

934

933

932

931

930

929

928

927

926

Logged from sump.

Nearing bedrock?

11/02/2014 12:25

11/02/2014 12:30

11/02/2014 12:30

11/02/2014 12:40

11/02/2014 12:42

At grade, dry

Dry

Dry

Dry

Dry



Below 10.67 m - fine, light grey.

14.63

17.07

17.98

DRILL HOLE # BGC14-001D

Water
Notes

Date
+

Time
Comments

Page 2 of 4

Coordinates (m): 682286E - 5608796N

Final Depth (m): 29.56Survey Method: Handheld GPS

S
ym
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l

(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 3.04

Logged By: SLP

Depth to Top of Rock (m): 5.18

Start Date: 11 Feb 2014

Finish Date: 13 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.83
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment

10

11

12

13

14

15

16

17

18

19

20

925

924

923

922

921

920

919

918

917

916

At 11.71 m - static
water level,
measured
3/12/2014 9:55.

Drill returns are
very dry, dusty.

At 19.20 m -water
encountered.
AIRLIFT #1
2.6 US GPM
3.2 US GPM

11/02/2014 12:53

11/02/2014 13:15

11/02/2014 13:34

Dry

Dry

Wet, light grey



Below 22.86 m - fine, smaller clast size than above, dark green.

At 25.90 m - colour change to brownish red.

At 26.52 m - colour change to grey.

END OF HOLE AT 29.56 m

24.08

24.69

DRILL HOLE # BGC14-001D

Water
Notes

Date
+

Time
Comments

Page 3 of 4

Coordinates (m): 682286E - 5608796N

Final Depth (m): 29.56Survey Method: Handheld GPS

S
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l

(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 3.04

Logged By: SLP

Depth to Top of Rock (m): 5.18

Start Date: 11 Feb 2014

Finish Date: 13 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.83
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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28
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30

915

914

913

912

911

910

909

908

907

906

3.4 US GPM
Average 3.1 US
GPM

Possible
chloritization.

AIRLIFT #2
3.4 US GPM
2.9 US GPM
2.6 US GPM
Average 3.0 US
GPM

11/02/2014 13:42

11/02/2014 13:50

11/02/2014 13:53

11/02/2014 14:00

Wet, green

Wet

Wet

Wet



NOTES:
1.  2" PVC standpipe piezometer installed with screen from 17.98 to 24.08 metres.
2.  Filter sand placed from 17.07 to 24.69 metres.
3.  Bentonite seal placed from 14.63 to 17.07 metres.
4.  Hole backfilled from 24.69 m to 29.56 m with bentonite chips.
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Coordinates (m): 682286E - 5608796N

Final Depth (m): 29.56Survey Method: Handheld GPS
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 3.04

Logged By: SLP

Depth to Top of Rock (m): 5.18

Start Date: 11 Feb 2014

Finish Date: 13 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.83
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Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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SAND AND GRAVEL (GM)
Silty, well graded, light greyish brown.
[TOPSOIL]

SAND (SM)
Fine, trace silt, uniformly graded, light brown, no odour.
[TILL]

SILT (ML)
Some sand, some gravel, trace clay, gap graded, dark brown, no odour.
[TILL]

SAND AND GRAVEL (GM)
Some silt, well graded, light brown with grey clasts.
[FLUVIAL]

BEDROCK
Drill cuttings:  fine to medium grained, angular to subrounded, light grey to light
brown.
[NICOLA VOLCANICS]

END OF HOLE AT 6.40 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 3.96 to 5.49 metres.
2.  Filter sand placed from 3.66 to 6.40 metres.
3.  Bentonite seal placed from 1.83 to 3.66 metres.

0

1.83

3.66

3.96

5.49
G1

DRILL HOLE # BGC14-001S

Water
Notes
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Time
Comments

Page 1 of 1
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SAND (SW)
Fine to medium, some gravel, trace silt, well graded, dark brown with grey clasts.
[FILL]

SAND AND GRAVEL (GW)
Silty, sand is fine to medium, gravel is fine to coarse, well graded, light brown with
grey clasts,  gravel size range from 3 mm to 20 mm.
[FLUVIAL]

SILT (ML)
Gravelly, some fine sand, gravel is multilithic, well graded, angular to subrounded,
grey, light greyish brown matrix.
[TILL]

GRAVEL (GM)
Silty, some fine sand, trace clay, gravel  is multilithic, angular to subrounded, grey to
purple, gravel size range from 2 mm to 15 mm.
[FLUVIAL]

SILT (ML)
Some sand, some gravel, trace clay, uniformly graded, low plasticity, light brown with
grey clasts.
[TILL]

Below 9.14 m - increase in clay content to some, colour change to dark grey.
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Below 12.19 m - decrease in gravel content, dark greyish brown.

BEDROCK
Drill cuttings:  fine to coarse grained, light reddish brown to organish brown, slightly to
moderately weathered, some oxidation.
[NICOLA VOLCANICS]

Below 16.76 m - fine, dark grey.

Below 18.29 m - colour change to dark bluish grey.
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At 20.12 m - significant colour change to light yellowish brown.

At 20.42 m - colour change to dark grey.

At 22.56 m - colour change to dark brown.

At 22.86 m - colour change to dark bluish grey.

At 26.21 m - colour change to orangish brown.

At 26.52 m - colour change to grey.
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END OF HOLE AT 29.87 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 16.76 to 22.86 metres.
2.  Filter sand placed from 15.85 to 23.77 metres.
3.  Bentonite seal placed from 14.02 to 15.85 metres.
4. Hole backfilled from 23.77 m to 29.87 m with bentonite chips.
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SAND (SW)
Fine to medium, some fine gravel, some silt, light brown.
[FILL]

GRAVEL (GP)
Fine, some medium to coarse sand, trace silt, poorly graded, light brown with grey
clasts, maximum particle size is 10 mm.
[FLUVIAL]

SILT (ML)
Some gravel, trace fine sand, trace clay, well graded, low plasticity, dark brown with
dark grey clasts.
[TILL]

Below 7.62 m - increase in gravel content to gravelly, clasts are dark to light grey.

Below 9.14 m - significant decrease in gravel content to trace, increase in clay
content to some, increase in moisture content.
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Below 10.67 m - colour change of matrix from dark brown to dark grey.

Below 14.78 m - slight increase in moisture content.

BEDROCK
Drill cuttings:  fine to coarse grained, light reddish brown to organish brown, slightly to
moderately weathered, some oxidation.
[NICOLA VOLCANICS]

END OF HOLE AT 15.70 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 9.09 to 15.19 metres.
2.  Filter sand placed from 8.53 to 15.70 metres.
3.  Bentonite seal placed from 6.71 to 8.53 metres.
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SAND (SW)
Gravelly, silty, well graded, light brown with grey clasts, trace organics (rootlets 1 mm
diameter).
[TOPSOIL]

SILT (ML)
Some gravel, some fine sand, trace to some clay, low plasticity, dark brown matrix
with grey pockets and grey clasts.
[TILL]

Below 4.57 m - decrease in clay content.

Below 5.79 m - colour change to dark greyish brown.
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air
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Depth to Top of Rock (m): 21.95

Start Date: 14 Feb 2014
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Below 10.36 m - decrease in gravel content to trace, colour change to dark brown.

SAND (SM)
Coarse, some silt, trace gravel, dark greyish brown.
[TILL]

Below 13.72 m - sand is medium, increase in silt content to silty, medium plasticity.

SILT (ML)
Clayey, some fine sand, dark grey, low plasticity.
[TILL]

Below 16.76 m - trace gravel, decrese in clay content to some.

GRAVEL AND SAND (GM)
Silty, sand is coarse, gravel is coarse to fine, dark grey.
[FLUVIAL]

Below 19.81 m - increase in clay content to trace, sand is coarse, slight colour
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change to lighter greyish brown.

SILT (ML)
Gravelly, sandy, sand is fine to medium, grey with pockets of brown silt.
[TILL]

WEATHERED BEDROCK
Drill cuttings:  sandy, sand is fine to medium, some coarse gravel, uniform light
greyish green.
[NICOLA VOLCANICS]

BEDROCK
Drill cuttings:  fine grained, angular to subrounded, light grey, maximum particle size
is 10 mm, fresh and unweathered.
[NICOLA VOLCANICS]
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logged as a soil.

Highly chloritized
bedrock?

Competent
bedrock surface.
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END OF HOLE AT 32.34 m

NOTES:
1.  2"PVC sandpipe piezometer installed with screen from 28.35 to 31.39 metres.
2.  Filter sand placed from 26.21 to 32.34 metres.
3.  Bentonite seal placed from 24.38 to 26.21 metres.
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SAND (SW)
Gravelly, silty, well graded, light brown with grey clasts, trace organics (rootlets 1 mm
diameter).
[TOPSOIL]

SILT (ML)
Some gravel, some fine sand, trace clay, low plasticity, dark brown with grey clasts.
[TILL]

Below 6.10 m - decrease in sand content to trace, colour change of matrix to dark
grey.

0

DRILL HOLE # BGC14-003I

Water
Notes

Date
+

Time
Comments

Page 1 of 3

Coordinates (m): 683544E - 5608858N

Final Depth (m): 21.95Survey Method: Handheld GPS

S
ym

bo
l

(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 11.28

Logged By: SLP

Depth to Top of Rock (m): 20.11

Start Date: 17 Feb 2014

Finish Date: 17 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.82

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: TSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  897

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment

0

1

2

3

4

5

6

7

8

9

10

896

895

894

893

892

891

890

889

888

887

Logged from sump.

At 4.43 m - static
water level,
measured 3/2/2014
8:00.
Welding time 8:23
to 8:52.

17/02/2014 08:11

17/02/2014 08:15

17/02/2014 08:17
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17/02/2014 08:21
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Below 10.36 m - decrease in gravel content to trace, colour change of matrix to light
brown.

SAND (SM)
Fine to coarse, some silt, trace clay, dark greyish brown.
[TILL]

SILT
Sandy, some clay to clayey, sand is fine, medium plasticity, dark grey.
[TILL]

Below 16.76 m - gravelly, some clay.

GRAVEL AND SAND (GM)
Silty, sand is coarse, dark grey.
[FLUVIAL/GLACIOFLUVIAL]

Below 18.29 m - increase in clay content to trace.

Below 19.81 m - decrease in silt content to trace, sand is coarse, gravel is fine,
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Print Date:  5/28/2015
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Welding time 9:03
to 9:25.

At 16.67 m - water
encountered at unit
change.

Welding time 9:41
to 10:06.

17/02/2014 09:01

17/02/2014 09:02

17/02/2014 09:27

17/02/2014 09:28

17/02/2014 09:34

17/02/2014 09:35

17/02/2014 09:38

17/02/2014 10:10

17/02/2014 10:16

Slightly moist
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Moist

Moist

Moist

Moist

Moist

Wet

Wet
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maximum particle size is 5 mm.

BEDROCK
Drill cuttings: fine grained, light grey, fresh and unweathered.
[NICOLA VOLCANICS]

END OF HOLE AT 21.95 m

NOTES:
1. 2" PVC standpipe piezometer installed with screen from 16.76 to 19.81 metres.
2. Filter sand placed from 15.54 to 20.42 metres.
3. Bentonite seal placed from 14.02 to 15.54 metres.
4. Hole backfilled from 20.42 m to 21.95 m with bentonite chips.

20.42

DRILL HOLE # BGC14-003I

Water
Notes

Date
+

Time
Comments

Page 3 of 3

Coordinates (m): 683544E - 5608858N

Final Depth (m): 21.95Survey Method: Handheld GPS

S
ym

bo
l

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 11.28

Logged By: SLP

Depth to Top of Rock (m): 20.11

Start Date: 17 Feb 2014

Finish Date: 17 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.82

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: TSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  897

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment

20

21

22

23

24

25

26

27

28

29

30

876

875

874

873

872

871

870

869

868

867

Cuttings are dry,
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SAND (SW)
Gravelly, some silt, well graded, light brown with grey clasts, trace organics (rootlets
<2 mm diameter).
[TOPSOIL]

SILT
Some gravel, some fine sand, trace clay, dark brown with grey clasts.
[TILL]

Below 4.57 m - increase in sand content to sandy, light brown with grey clasts.

Below 6.10 m - decrease in sand content, dark brown with grey clasts.

Below 7.62 m - decrease in sand content to trace.

Below 9.75 m - decrease in gravel content to trace.
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air
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Depth to Top of Rock (m): N/A
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At 4.43 m - static
water level,
measured
3/11/2014 9:20.
Welding time 15:05
to 15:25.

14/02/2014 14:54
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END OF HOLE AT 11.28 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 9.75 to 11.28 metres.
2.  Filter sand placed from 9.14 to 11.28 metres.
3.  Bentonite seal placed from 7.32 to 9.14 metres.
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SAND (SW)
Medium, some silt, some gravel, well graded, light brown, trace organics (rootlets).
[TILL]

Below 1.52 m - organics no longer present.

Below 3.04 m - increase in silt content, trace gravel, slightly darker brown matrix.

Below 4.57 m - decrease in silt content, decrease in gravel content, sand is fine,
uniform.

SILT (MH)
Sandy, some gravel, sand is coarse, gravel is fine, well graded, dark brown matrix
with grey clasts.
[TILL]

Below 7.67 m - sand is medium to coarse, gravel is fine to coarse, increase in
moisture.

Below 9.14 m - clayey, sand is fine, low plasticity.
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Start Date: 18 Feb 2014

Finish Date: 19 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: EMRSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  871

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.
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Welding time 7:56
to 8:18.

At 8.23 m - static
water level,
measured
5/13/2014 14:44.
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Below 12.19 m - decrease in sand content.

Below 13.72 m - increase in gravel content to gravelly.

At 15.24 m - sand is medium, colour change to dark greyish brown.

GRAVEL (GP)
Sandy, sand is medium to coarse, poorly graded, subrounded to subangular, dark
brown.
[FLUVIAL]

Below 18.29 m -  sand no longer present, gravel is multilithic.

Below 19.81 m - coarse sand present in cuttings.
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Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Welding time 8:24
to 8:43.

Welding time 8:54
to 9:20.

At 17.37 m - water
encountered.
AIRLIFT #1
10 US GPM
10 US GPM
11 US GPM
Average 10 US
GPM
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Dry to moist
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At 21.34 m - gravel size range from 4 to 20 mm.

At 22.86 m - maximum particle size is 30 mm.

Below 24.38 m - sand no longer present.

At 25.91 m - trace silt.

Below 27.43 m - silt no longer present, gravel is dark grey to black, multilithic.

Below 28.96 m - sandy, coarse.
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Wet, clean

Wet, clean
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At 36.58 m - sandy, coarse.
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Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Welding time 10:31
to 10:49.

Welding time 11:10
to 11:40.

19/02/2014 10:26

19/02/2014 10:29

19/02/2014 10:30

19/02/2014 10:50

19/02/2014 10:51

19/02/2014 11:04

19/02/2014 11:09

Wet

Wet, clean

Wet, clean

Wet, clean

Wet, dark grey

Wet, clean

Wet, clean



G14

DRILL HOLE # BGC14-004

Water
Notes

Date
+

Time
Comments

Page 5 of 8

Coordinates (m): 687746E - 5609526N

Final Depth (m): 78.33Survey Method: Handheld GPS

S
ym

bo
l

(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 63.70

Start Date: 18 Feb 2014

Finish Date: 19 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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831

830

829

828

827

826

825

824

823

822

AIRLIFT #3
33 US GPM
30 US GPM
27 US GPM
Average 30 US
GPM

Welding time 11:58
to 12:16.

19/02/2014 11:41

19/02/2014 11:43

19/02/2014 11:50

19/02/2014 11:55

19/02/2014 11:57

19/02/2014 12:20

Wet, clean

Wet

Wet, clean

Wet

Wet, clean

Wet, light grey



At 56.39 m  - driller described as tough, cohesive drilling, resembled compacted
gravel.

DRILL HOLE # BGC14-004

Water
Notes

Date
+

Time
Comments

Page 6 of 8

Coordinates (m): 687746E - 5609526N

Final Depth (m): 78.33Survey Method: Handheld GPS

S
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 63.70

Start Date: 18 Feb 2014

Finish Date: 19 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Location: Ajax Project Site
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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821

820

819

818

817

816

815

814

813

812

Welding time 12:36
to 12:55.

AIRLIFT #4
50 US GPM
60 US GPM
43 US GPM
Average 50 US
GPM

Welding time 13:09
to 13:32.

19/02/2014 12:23

19/02/2014 12:26

19/02/2014 12:29

19/02/2014 12:30

19/02/2014 12:57

19/02/2014 13:01

19/02/2014 13:05

19/02/2014 13:08

Wet, clean

Wet, clean

Wet, dark grey

Wet, clean

Wet

Wet

Wet, clean

Wet, clean



At 62.48 m  - maximum particle size is 40 mm.

BEDROCK
Drill cuttings:  fine to medium grained, angular to subrounded, dark grey, fresh and
unweathered.

Below 65.53 m - green with orangish speckling, slightly weathered to unweathered.

Below 67.06 m - orangish brown mineralization (not iron staining), angular.

Below 68.58 m - grey.

66.9

68.28

G15

G16

G17

DRILL HOLE # BGC14-004

Water
Notes

Date
+

Time
Comments

Page 7 of 8

Coordinates (m): 687746E - 5609526N

Final Depth (m): 78.33Survey Method: Handheld GPS
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 63.70

Start Date: 18 Feb 2014

Finish Date: 19 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Changing drill bit
13:53 to 14:30.

19/02/2014 13:43

19/02/2014 13:48

19/02/2014 13:51

19/02/2014 14:34

19/02/2014 14:37

19/02/2014 14:40

Wet

Wet

Wet, clean water

Wet, light grey, silty

Wet, light grey

Wet, cleaner than
above



Below 73.15 m - dark green.

Below 74.68 m - grey to dark grey.

END OF HOLE AT 78.33 m

NOTES:
1.  4" PVC standpipe piezometer installed with screen from 72.24 to 78.33 metres.
2.  Filter sand placed from 68.28 to 78.33 metres.
3.  Bentonite seal placed from 66.90 to 68.28 metres.

72.24

G18

G19

G20

G21

G22

G23

DRILL HOLE # BGC14-004

Water
Notes

Date
+

Time
Comments
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Coordinates (m): 687746E - 5609526N

Final Depth (m): 78.33Survey Method: Handheld GPS
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 63.70

Start Date: 18 Feb 2014

Finish Date: 19 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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AIRLIFT #5
4 US GPM
4.4 US GPM
4.2 US GPM
Average US 4.2
GPM

19/02/2014 14:49

19/02/2014 14:47

19/02/2014 14:50

19/02/2014 14:55

19/02/2014 15:03

19/02/2014 15:08

19/02/2014 15:10

Wet, light grey

Wet, light grey

Wet

Wet, grey

Wet, light grey

Wet

Wet



SILT (ML)
Sandy, some gravel, sand is fine, well graded, nonplastic, gravel is rounded, light
brown with grey clasts.
[TILL]

CLAY (CI)
Silty, some fine sand, trace gravel, medium plasticity, light greyish brown.
[TILL]

SILT (ML)
Sandy, some clay, trace gravel, sand is fine, light brown with grey clasts.
[TILL]

SAND (SW)
Fine, silty, some gravel, well graded, light brown.
[TILL]

0

G1

G2

G3

G4

DRILL HOLE # BGC14-005

Water
Notes

Date
+

Time
Comments

Page 1 of 6

Coordinates (m): 687161E - 5609519N

Final Depth (m): 50.46Survey Method: Handheld GPS

S
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 43.28

Start Date: 19 Feb 2014

Finish Date: 20 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Location: Ajax Project Site
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Welding time 15:30
to 15:50.

19/02/2014 15:22

19/02/2014 15:24

19/02/2014 15:26

19/02/2014 15:28

19/02/2014 15:52

19/02/2014 15:55

19/02/2014 15:59

Dry

Dry

Dry

Dry to moist

Dry

Dry

Dry



Below 10.67 m - decrease in silt.

SAND (SP)
Trace gravel, trace silt, uniformly graded, light brown.
[GLACIOFLUVIAL]

Below 15.24 m - increase in gravel content.

Below 16.76 m - slight increase in silt content.

Below 18.29 m - silty, dark greyish brown.

G5

DRILL HOLE # BGC14-005

Water
Notes

Date
+

Time
Comments

Page 2 of 6

Coordinates (m): 687161E - 5609519N

Final Depth (m): 50.46Survey Method: Handheld GPS

S
ym

bo
l

(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 43.28

Start Date: 19 Feb 2014

Finish Date: 20 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Location: EMRSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  878
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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867

866

865

864
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862
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Welding time 16:05
to 16:28.

At 16.08 m - static
water level,
measured
3/24/2014 15:50.

19/02/2014 16:02

19/02/2014 16:31

19/02/2014 16:35

19/02/2014 16:38

19/02/2014 16:42

20/02/2014 07:33

20/02/2014 07:37

Dry

Dry

Dry

Dry

Dry

Dry to moist

Dry



SAND (SM)
Fine, some silt, uniformly graded, light brown.
[GLACIOFLUVIAL]

Below 27.86 m - colour change to grey.

SILT (ML)
Sandy, sand is fine, uniformly graded, low plasticity, grey to dark grey.
[TILL]

G6

G7

DRILL HOLE # BGC14-005

Water
Notes

Date
+

Time
Comments

Page 3 of 6

Coordinates (m): 687161E - 5609519N

Final Depth (m): 50.46Survey Method: Handheld GPS
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 43.28

Start Date: 19 Feb 2014

Finish Date: 20 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Location: EMRSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Colour change.
Welding time 7:45
to 8:05.

Welding time 8:19
to 8:36.

20/02/2014 07:40

20/02/2014 07:43

20/02/2014 08:07

20/02/2014 08:11

20/02/2014 08:13

20/02/2014 08:15

Dry

Dry to moist

Dry

Dry

Dry

Dry



Below 30.48 m - trace to some clay, increase in moisture content.

Below 32.00 m - slight increase in clay to some.

Below 33.53 m - slight increase in moisture content.

G8

G9

DRILL HOLE # BGC14-005

Water
Notes

Date
+

Time
Comments

Page 4 of 6

Coordinates (m): 687161E - 5609519N

Final Depth (m): 50.46Survey Method: Handheld GPS
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 43.28

Start Date: 19 Feb 2014

Finish Date: 20 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Location: Ajax Project Site
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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847

846

845

844

843

842
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840

839

838

Slightly more moist
than above.

Welding time 8:54
to 9:14.
At 35.66 m - water
encountered.
Inadequate
quantity of water to
complete Airlift test.

20/02/2014 08:39

20/02/2014 08:43

20/02/2014 08:47

20/02/2014 08:52

20/02/2014 08:54

20/02/2014 09:18

20/02/2014 09:24

20/02/2014 09:28

Moist

Moist

Moist

Moist

Wet

Wet, dark grey, silty

Wet, dark grey, silty

Wet, dark grey, silty



Below 41.15 m - decrease in moisture content.

BEDROCK
Drill cuttings:  fine to medium grained, angular to subrounded, dark grey, slightly
weathered.
[IRONMASK HYBRID]

Below 45.72 m - fine to coarse, dark grey to orangish brown, multilithic.

Below 47.24 m - light greenish grey.

44.5

46.02

47.24

G10

G11

G12

G13

DRILL HOLE # BGC14-005

Water
Notes

Date
+

Time
Comments

Page 5 of 6

Coordinates (m): 687161E - 5609519N

Final Depth (m): 50.46Survey Method: Handheld GPS
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(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 43.28

Start Date: 19 Feb 2014

Finish Date: 20 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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837

836

835

834

833

832

831

830

829

828

Welding time 9:33
to 10:00.

Changing drill bit
10:15 to 10:45.

AIRLIFT #1
0.7 US GPM
1.0 US GPM
0.8 US GPM
Average 0.8 US
GPM

20/02/2014 09:32

20/02/2014 10:05

20/02/2014 10:10

20/02/2014 10:11

20/02/2014 10:49

20/02/2014 10:51

20/02/2014 10:53

Moist

Wet, dark grey, silty

Wet

Wet

Wet, light grey

Wet, light grey

Wet, light greenish
grey



END OF HOLE AT 50.46 m

NOTES:
1.  4" PVC standpipe piezometer installed with screen from 47.24 to 50.46 metres.
2.  Filter sand placed from 46.02 to 50.46 metres.
3.  Bentonite seal placed from 44.50 to 46.02 metres.

DRILL HOLE # BGC14-005

Water
Notes

Date
+

Time
Comments
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Coordinates (m): 687161E - 5609519N

Final Depth (m): 50.46Survey Method: Handheld GPS
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 43.28

Start Date: 19 Feb 2014

Finish Date: 20 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.86
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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SAND (SW)
Fine, silty, some fine to coarse gravel, well graded, light brown with grey and brown
clasts.
[TOPSOIL]

SILT (ML)
Sandy, trace to some clay, trace gravel, sand is fine, well graded, low plasticity, light
brown with grey clasts.
[TILL]

SAND (SP)
Fine, gravelly, gravel is fine to coarse, trace silt, uniformly graded, light brown with
grey clasts.
[TILL]

GRAVEL (GP)
Fine to coarse, trace fine sand, trace silt, uniformly graded, light brown and grey
clasts.
[GLACIOFLUVIAL]

SAND AND GRAVEL (GM)
Some silt, trace clay, sand is fine to medium, gravel is fine to coarse, well graded,
light brown.
[TILL]

SAND (SM)
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Fine, silty, some fine to coarse gravel, well graded, light grey
[TILL]

BEDROCK
Drill cuttings:  fine to medium grained, greyish green and reddish brown, slightly to
moderately weathered.
[IRONMASK HYBRID]

Below 15.24 m - fine, angular, light grey, fresh and unweathered.

From 19.20 m to 27.43 m  - brown fine sand and silt present in cuttings, gravel is
subangular to rounded, moderately weathered.
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encountered.

Changing drill bit
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AIRLIFT #1
1 drop/sec

Possible fault.
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Below 21.34 m - slight decrease in sand content.

Below 22.86 m - colour change to reddish purple.

Below 22.86 m - reddish brown, silt and fine sand present in cuttings, clasts are
subrounded, slight increase in moisture, indicated by darker colour.

At 27.43 m - end of weathered zone, colour change back to light grey, angular,
unweathered.

END OF HOLE AT 29.56 m
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NOTES:
1.  4" PVC standpipe piezometer installed with screen from 20.42 to 26.52 metres.
2.  Filter sand placed from 19.20 to 29.56 metres.
3.  Bentonite seal placed from 17.37 to 19.20 metres.
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SAND(SW)
Fine, silty, some fine to coarse gravel, well graded, light brown with grey clasts.
[TOPSOIL]

SILT (ML)
Sandy, trace clay, trace gravel, sand is fine, well graded, low plasticity, light brown to
brown with grey clasts.
[TILL]

SAND (SP)
Fine, gravelly, trace silt, gravel is fine to coarse, uniformly graded, brown with grey
clasts, clasts are subangular.
[TILL]

GRAVEL (GP)
Fine to coarse, trace to some fine sand, trace silt, uniformly graded, light brown with
grey clasts.
[GLACIOFLUVIAL]

SAND AND GRAVEL (GM)
Some silt, trace clay, sand is fine to medium, gravel is fine to coarse, well graded,
light greyish brown.
[TILL]

SAND (SW)
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Fine, silty, some fine to coarse gravel, well graded, light grey.
[TILL]

Below 12.19 m -  increase in gravel content to gravelly.

Below 13.11 m - colour change to light greyish brown.

BEDROCK
Drill cuttings:  fine to medium grained, greyish green and reddish brown cuttings,
slightly to moderately weathered.
[IRONMASK HYBRID]

END OF HOLE AT 14.33 m

NOTES:
1.  4" PVC standpipe piezometer installed with screen from 10.97 to 14.02 metres.
2.  Filter sand placed from 9.45 to 14.33 metres.
3.  Bentonite seal placed from 7.62 to 9.45 metres.
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SAND (SW)
Gravelly, silty, well graded, organics (rootlets, grasses)
[TOPSOIL]

GRAVEL (GP)
Some sand, uniformly graded, angular to subrounded, grey, multilithic gravel
cuttings.
[GLACIOFLUVIAL]

SILT (ML)
Gravelly, some fine sand, gravel is fine to coarse, low plasticity, light brown to brown
with grey clasts.
[TILL]

Below 4.27 m - decrease in gravel content, slightly darker brown.

Below 6.10 m - dark brown with grey clasts, increase in moisture content.

Below 7.62 m - dark greyish brown.
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air
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Below 10.67 m - decrease in gravel content, dark grey.

Below 12.19 m - decrease in gravel to trace.

Below 15.24 m - slight increase in gravel content.

BOULDER
Drill cuttings:  fine, unweathered, angular, dark grey.

SILT (ML)
Gravelly, gravel is fine to coarse, uniformly graded, light brown with brown and grey
clasts.
[TILL]
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BEDROCK
Drill cuttings:  fine grained, angular, dark grey, fresh and unweathered.
[NICOLA VOLCANICS]

Below 25.91 m - darker grey.

Below 27.43 m - light grey.

END OF HOLE AT 29.56 m
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NOTES:
1.  4" PVC standpipe piezometer installed with screen from 26.52 to 29.56 metres.
2.  Filter sand placed from 25.91 to 29.56 metres.
3.  Bentonite seal placed from 24.03 to 25.91 metres.
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Project: Ajax Project Environmental Assessment
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SAND (SW)
Gravelly, silty, well graded, organics.
[TOPSOIL]

GRAVEL (GP)
Fine to coarse, some coarse sand, gravel is  grey, angular, multilithic.
[FLUVIAL]

SILT (ML)
Gravelly, gravel is fine to coarse, uniformly graded, low plasticity, light brown with
grey and brown clasts.
[TILL]

Below 6.10 m - decrease in gravel content, trace clay, darker brown.

Below 9.14 m - dark greyish brown.
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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At 10.67 m - decrease in gravel content, slight increase in clay.

Below 12.19 m - increase in gravel content.

Below 13.72 m - increase in gravel content.

END OF HOLE AT 17.37 m

NOTES:
1.  4" PVC standpipe piezometer installed with screen from 14.33 to 17.37 metres.
2.  Filter sand placed from 12.80 to 17.37 metres.
3.  Bentonite seal placed from 10.97 to 12.80 metres.

10.97

12.8

14.33

DRILL HOLE # BGC14-007S

Water
Notes

Date
+

Time
Comments

Page 2 of 2

Coordinates (m): 685324E - 5608722N

Final Depth (m): 17.37Survey Method: Handheld GPS

S
ym

bo
l

Drilling Contractor: JR Drilling Central Ltd.
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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SAND
Gravelly, dark brown, grasses, rootlets.
[TOPSOIL]

SAND (SP)
Fine to medium, some silt, trace coarse gravel, uniformly graded, light brown.
[GLACIOFLUVIAL]

GRAVEL (GM)
Coarse to fine, silty, some fine sand, well graded, angular, brown with brown and
grey clasts.
[GLACIOFLUVIAL]

GRAVEL AND SAND (GW)
Gravel is coarse, sand is coarse, trace silt, well graded, subangular, dark brown with
brown and grey clasts.
[GLACIOFLUVIAL]

SAND (SM)
Fine to medium, silty, some fine to coarse gravel, well graded, greyish brown with
grey clasts.
[TILL]

At 7.62 m - decrease in gravel content.
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Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Moist from snow.

At 4.57 - water
encountered.
AIRLIFT #1
0.03 US GPM
Welding time 12:38
PM to 12:59 PM.
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At 10.67 m - increase in gravel content.

SILT (ML)
Sandy (fine), trace to some fine to coarse gravel, well graded, greyish brown.
[TILL]

At 15.24 m - sand is coarse, increase in gravel content, increase in moisture.

WEATHERED BEDROCK
Drill cuttings: fine gravel, subrounded to subangular, light green, moderately to highly
weathered.
[IRONMASK HYBRID]

Below 18.29 m - dark greenish grey.

Below 19.81 m - dark grey.
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary
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Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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BEDROCK
Drill cuttings: fine to medium grained, dark grey to light green, fresh and unweathered
to slightly weathered.
[IRONMASK HYBRID]

Below 22.86 m - fine, angular, dark grey.

Below 24.38 m - slightly lighter grey than above.

END OF HOLE AT 29.56 m
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 15.85
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Finish Date: 25 Feb 2014

Lithologic Description
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Client: KGHM Ajax Mining Inc.
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Project: Ajax Project Environmental Assessment
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Hard drilling.

At 21.96 m - static
water level,
measured 5/7/2014
11:54.
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NOTES:
1.  4" PVC standpipe piezometer installed with screen from 26.52 to 29.56 metres.
2.  Filter sand placed from 24.99 to 29.56 metres.
3.  Bentonite seal placed from 23.16 to 24.99 metres.
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Project: Ajax Project Environmental Assessment
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SAND
Gravelly, some silt, light brown, grasses and rootlets.
[TOPSOIL]

SAND (SP)
Fine to medium, some silt, trace coarse gravel, uniformly graded, light brown.
[TILL]

GRAVEL (GM)
Fine to coarse, sandy, silty, sand is coarse, well graded, grey and brown clasts.
[GLACIOFLUVIAL]

SAND AND GRAVEL (GM)
Silty, sand is fine to coarse, gravel is fine to coarse, well graded, brown with grey
clasts.
[GLACIOFLUVIAL]

END OF HOLE AT 6.10 m

NOTES:
1.  4" PVC standpipe piezometer installed with screen from 4.57 to 6.10 metres.
2.  Filter sand placed from 3.66 to 6.10 metres.
3.  Bentonite seal placed from 2.13 to 3.66 metres.
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Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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SAND (SW)
Fine to coarse, some fine to coarse gravel, trace silt, well graded, light brown with
grey clasts, light brown with grey clasts.
[TILL]

Below 3.04 m - increase in silt content.

WEATHERED BEDROCK
Drill cuttings: fine to coarse, sandy, trace silt, sand is medium to coarse, well graded,
ubangular to subrounded, greyish brown, moderately to highly weathered.
[IRONMASK HYBRID]

BEDROCK
Drill cuttings:  fine grained, angular to subangular, dark to light grey, fresh and
unweathered.
[IRONMASK HYBRID]
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From 13.72 m to 16.76 m - fine sand, light greenish grey, moderately weathered.

Below 16.76 - fine, angular, dark grey, fresh and unweathered.
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Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 3.96

Start Date: 26 Feb 2014

Finish Date: 27 Feb 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.89

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: SMRSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  919

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Below 22.86 m - subangular to rounded.
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Below 44.20 m - rounded to subangular, dark greenish grey, slightly softer than
previous.

At 47.80 m - possible fault.

At 47.77 m - subrounded to rounded, dark grey.
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At 50.46 m - increase in moisture content.

At 51.82 m - subangular, dark greenish grey, cuttings are uniform in size.

At 53.34 m - increase in moisture content.

END OF HOLE AT 53.95 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 47.85 to 53.95 metres.
2.  Filter sand placed from 46.94 to 53.95 metres.
3.  Bentonite seal placed from 45.11 to 46.94 metres.
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GRAVEL (GP)
Fine to coarse, some coarse sand, subangular to rounded, brown and grey clasts.
[TOPSOIL/FILL]

GRAVEL AND SILT (GM)
Some fine to coarse sand, gravel is fine to coarse, well graded, subangular to
subrounded, brown with grey and brown clasts.
[TILL]

SILT (ML)
Some fine sand to sandy, trace fine to coarse gravel, uniformly graded, brown with
grey clasts, clasts are angular to subrounded.
[TILL]

Below 6.10 m - decrease in gravel content, decrease in sand content, trace clay.

Below 7.62 m - clayey.

Below 9.14 m - trace to no gravel.
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Below 10.67 m - trace to some fine gravel.

BEDROCK
Drill cuttings:  fine to medium grained, angular to subrounded, brown and grey clasts,
moderately weathered.

Below 12.19 m - fine, dark grey, angular.

Below 13.72 m - slightly lighter grey than above.

Below 15.24m - dark grey.

 Below 16.76 m - subrounded, light grey, average clast size is 4 mm.

Below 18.29 m - subrounded, whitish grey.

Below 19.81 m - angular to subangular, grey.
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Below 21.34 - angular, dark grey.

Below 24.38 m - fine, angular to rounded, foliated, grey, flat and elongated.

Below 25.91 m - light grey, shape as above.

Below 27.43 m - long, flat, rounded.

Below 28.96 m - angular, grey, average clast size 2 mm.
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Below 30.48 m - drill cuttings described as soil:  fine sand, uniformly graded, whitish
grey, no dry strength, pulverized, powdery.

 Below 32.00 m - fine, flat, elongated, dark to light grey, foliated, unweathered.

Below 35.05 m - average clast size is 2 mm.
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Below 41.45 m - average clast size 5 mm.
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encountered.
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amount of water.
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28/02/2014 11:21

28/02/2014 11:30

28/02/2014 11:36

28/02/2014 11:40

28/02/2014 11:45

28/02/2014 11:47

28/02/2014 11:54

Dry

Dry

Dry

Dry

Dry

Dry



Below 51.82 m - angular, elongated, flat, dark grey.

Below 57.91 m -  rounded to subangular, light greyish white, average clast size is 2
mm.
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Below 62.48 m - subangular, light grey, average clast size is 4 mm.

Below 64.00 m - angular to subangular, dark grey, average clast size is 5 mm.

Below 67.06 m - average clast size is 3 mm.

Below 68.58 m - angular.
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Below 74.68 m - equant, subrounded clasts.

Below 76.20 m - rounded, average clast size is 4 mm.

END OF HOLE AT 78.33 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 46.02 to 58.22 metres.
2.  Filter sand placed from 44.20 to 59.74 metres.
3.  Bentonite seal placed from 41.91 to 44.20 metres.
4.  Hole backfilled from 59.74 m to 78.33 m with bentonite chips.

G29

G30

G31

G32

DRILL HOLE # BGC14-010

Water
Notes

Date
+

Time
Comments

Page 8 of 8

Coordinates (m): 681730E - 5607414N

Final Depth (m): 78.33Survey Method: Handheld GPS

S
ym

bo
l

Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 4.57

Logged By: SLP

Depth to Top of Rock (m): 10.97

Start Date: 27 Feb 2014

Finish Date: 02 Mar 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.89

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: TSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  979

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment

70

71

72

73

74

75

76

77

78

79

80

908

907

906

905

904

903

902

901

900

899

28/02/2014 13:08

28/02/2014 13:12

28/02/2014 13:15

28/02/2014 13:18

28/02/2014 13:25

28/02/2014 13:32

28/02/2014 13:37

Dry

Dry

Dry

Dry

Dry

Dry

Dry



SAND (SW)
Fine, some fine to coarse gravel, some silt, well graded, light brown with grey clasts.
[TOPSOIL/FILL]

SILT (ML)
Sandy, trace to some gravel, sand is fine, gravel is fine to coarse, well graded, low
plasticity, brown with brown and grey clasts.
[TILL]

Below 4.57 m - trace clay.

WEATHERED BEDROCK
Drill cuttings:  sandy, some gravel, sand is fine, gravel is fine, uniformly graded, light
green, highly weathered.
[NICOLA VOLCANICS]

From 9.75 m to 10.36 m - sandy, silty, green.
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BEDROCK
Drill cuttings:  fine grained, angular, dark grey, fresh and unweathered to slightly
weathered.

Below 12.19 m - angular to subrounded, average clast size is 6 mm.

Below 13.72 m - average clast size is 3 mm.

Below 15.24 m - rounded to subangular.

Below 16.76 m - subrounded to angular, dark greenish grey.

Below 18.29 m - subangular to subrounded.
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Drill cuttings:  sandy, sand is fine, uniformly graded, dark green, highly weathered.

Below 24.38 m - trace gravel, subangular.

END OF HOLE AT 29.56 m
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NOTES:
1.  2" PVC standpipe piezometer installed with screen from 23.47 to 29.56 metres.
2.  Filter sand placed from 22.56 to 29.56 metres.
3.  Bentonite seal placed from 19.81 to 22.56 metres.
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SAND (SW)
Fine, some fine to coarse gravel, some silt, well graded, light brown with grey clasts.
[TOPSOIL/FILL]

SILT (ML)
Some sand to sandy, trace to some gravel, sand is fine, gravel is fine to coarse, well
graded, low plasticity, light brown to brown with grey and brown clasts.
[TILL]

Below 4.57 m - trace clay.

BEDROCK
Drill cuttings:  fine grained, angular, dark grey, average clast size is 3 mm, fresh and
unweathered to slightly weathered.
[NICOLA VOLCANICS]

Below 9.14 m - subrounded, light grey.
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Drilling Contractor: JR Drilling Central Ltd.
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Fluid: Air
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Logged By: SLP

Depth to Top of Rock (m): 5.49
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Lithologic Description
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Client: KGHM Ajax Mining Inc.
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Project: Ajax Project Environmental Assessment
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Below 10.67 m - subangular to subrounded, average particle size is 4 mm.

Below 13.72 m - clasts are flat and angular, average clast size is 3 mm.

WEATHERED BEDROCK
Drill cuttings:  sand , trace gravel, sand is fine, gravel is fine to coarse, uniformly
graded, dark green.
[NICOLA VOLCANICS]

END OF HOLE AT 18.29 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 15.24 to 18.29 metres.
2.  Filter sand placed from 14.33 to 18.29 metres.
3.  Bentonite seal placed from 12.50 to 14.33 metres.
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SAND (SW)
Coarse, silty, gravelly, gravel is fine to coarse, well graded, angular to subrounded,
dark brown with multilithic clasts.
[TOPSOIL]

GRAVEL AND SAND (GP/SP)
Gravel is fine to coarse, sand is coarse, uniformly graded, angular, dark brown,
multilithic.
[GLACIOFLUVIAL]

SILT (ML)
Sandy, trace  gravel, trace clay, sand is fine, gravel is fine, uniformly graded, low
plasticity, very dark grey.
[TILL]

BEDROCK
Drill cuttings:  fine grained, angular to subangular, dark grey, average clast size is 3
mm, fresh and unweathered to slightly weathered.
[NICOLA VOLCANICS]

Below 7.62 m - average clast size is 5 mm.

Below 9.14 m - average clast size is 4 mm.
From 9.44 m to 10.36 m - fine sand and fine gravel, sand is uniformly graded, gravel
is rounded.
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Below 10.67 m - angular clasts.

Below 12.19 m - light grey, average clast size is 3 mm.

Below 15.24 m - greenish grey fine sand present in cuttings, gravel clasts as above.

Below 18.29 m - green sand no longer present in cuttings.

Below 19.81 m - average clast size is 4 mm.
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Drilling Contractor: JR Drilling Central Ltd.
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From 22.25 m to 25.91 m - fine sand, gravelly, rounded cuttings, dark reddish brown,
highly weathered, oxidized.

Below 24.38 m - dark purplish red.

Below 25.91 m - angular, grey, end of weathered zone.

Below 27.43 m - angular, uniformly graded, dark grey.

Below 28.96 m - subrounded, moderately weathered.

At 29.26 m - increase in moisture content.

END OF HOLE AT 29.56 m
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Project: Ajax Project Environmental Assessment
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NOTES:
1.  2" PVC standpipe piezometer installed with screen from 20.42 to 24.99 metres.
2.  Filter sand placed from 19.20 to 26.21 metres.
3.  Bentonite seal placed from 16.76 to 19.20 metres.
4. Hole backfilled from 26.21 m to 29.56 with bentonite chips.
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SAND (SW)
Coarse, silty, gravelly, gravel is fine to coarse, well graded, angular to subrounded,
dark brown with multilithic clasts.
[TILL]

GRAVEL AND SAND (GP/SP)
Gravel is fine to coarse, sand is coarse, uniformly graded, angular, dark brown,
mulitlithic.
[GLACIOFLUVIAL]

END OF HOLE AT 3.35 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 2.74 to 3.35 metres.
2.  Filter sand placed from 2.13 to 3.35 metres.
3.  Bentonite seal placed from 1.83 to 2.13 metres.
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3/17/2014 8:55.

At 2.13 m - water
encountered.
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SILT (ML)
Sandy, some clay, trace fine gravel, sand is fine, well graded, low plasticity, light
greyish brown.
[TILL]

SAND AND SILT (SM)
Sand is fine, trace clay, uniformly graded, low plasticity, brown.
[TILL]

Below 4.57 m - trace to some clay.

Below 7.62 m - slight increase in silt content.

Below 9.14 m - increase in silt content.

GRAVEL (GP)
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Fine to coarse, sandy, trace clay, sand is coarse, uniformly graded, subangular to
subrounded,  multilithic.
[GLACIOFLUVIAL]

BEDROCK
Drill cuttings:  fine to coarse grained, uniformly graded, angular, multilithic,
moderately weathered, oxidized.

Below 13.72 m - angular, dark grey, slightly weathered, faintly oxidized.

Below 18.29 m - subangular, dark grey to light grey, average particle size is 4 mm.

Below 19.81 m - uniformly graded, angular to subangular, dark bluish grey, average
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Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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particle size is 2 mm.

Below 22.86 m - trace silt, average clast size is 5 mm.

Below 24.38 m - angular, flat, grey, average clast size is 4 mm.

Below 25.91 m - average clast size is 2 mm.

From 28.04 m to 28.65 m - yellowish brown, clayey, silty discharge, cuttings are
angular, dark grey and brown.
At 28.91 m - angular, dark grey, as above.
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From 21.64 to
22.56 m - softer
drilling, silty
discharge water.
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From 29.56 m to 29.87 m - silty, yellowish brown, multilithic cuttings.
Below 29.87 m - fine, angular, dark grey.

END OF HOLE AT 30.48 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 27.43 to 30.48 metres.
2.  Filter sand placed from 26.52 to 30.48 metres.
3.  Bentonite seal placed from 24.08 to 26.52 metres.
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SAND (SW)
Fine, silty, gravelly, gravel is fine to coarse, well graded, dark brown with grey clasts.
[TOPSOIL/FILL]

GRAVEL (GP)
Fine to coarse, sandy, sand is coarse, uniformly graded, angular to subrounded,
brown and grey.
[GLACIOFLUVIAL]

SAND [SM]
Fine, silty, some gravel, gravel is fine to coarse, light brown with grey clasts.
[TILL]

SILT [ML]
Sandy, trace to some gravel, sand is fine, uniformly graded, low plasticity, grey with
grey and brown clasts.
[TILL]

Below 7.62 m - gravel is angular to subrounded, grey.

0

G1

G2

G3

DRILL HOLE # BGC14-014D

Water
Notes

Date
+

Time
Comments

Page 1 of 4

Coordinates (m): 686672E - 5607810N

Final Depth (m): 29.56Survey Method: Handheld GPS

S
ym

bo
l

(Continued on next page)

Drilling Contractor: JR Drilling Central Ltd.
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Depth to Top of Rock (m): 18.90

Start Date: 04 Mar 2014

Finish Date: 05 Mar 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.89

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: SMRSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  986

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015
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Below 10.67 m - trace clay, light brownish grey.

Below 13.72 m - trace gravel, multilithic.

Below 15.24 m - decrease in gravel content.

BEDROCK
Drill cuttings: sand and gravel, sand is medium to coarse, gravel is coarse, sand is
rounded, gravel is angular to subrounded, brownish grey, mulitlithic, moderately
weathered.
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Project: Ajax Project Environmental Assessment
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water level,
measured
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Below 21.34 m - rounded clasts, light greenish grey, fine sand present in cuttings,
moderately weathered.

Below 22.86 m - gravelly sand, sand is fine, light greyish green, gravel is rounded,
moderately weathered.

Below 24.38 m - sandy gravel, gravel is dark grey, angular to subrounded, sand is
coarse, grey, moderately weathered.

Below 25.91 m - fine sand, light greenish grey, uniform, trace gravel, gravel is dark
grey, angular, moderately weathered.

Below 27.43 m - gravel, fine to coarse, some sand (fine), gravel is grey, subrounded,
sand is greenish grey, moderately weathered.

END OF HOLE AT 29.56 m
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15:43 to 16:00.

At 24.69 m -
moisture
encountered, driller
described "break in
dust".
At 25.30 m -
moisture
encountered, driller
described "break in
dust".
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04/03/2014 16:09
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NOTES:
1.  2" PVC standpipe piezometer installed with screen from 23.47 to 29.56 metres.
2.  Filter sand placed from 22.56 to 29.56 metres.
3.  Bentonite seal placed from 20.57 to 22.56 metres.
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Project: Ajax Project Environmental Assessment

30

31

32

33

34

35

36

37

38

39

40

955

954

953

952

951

950

949

948

947

946



SAND (SW)
Fine to coarse, gravelly, silty, well graded, dark brown with grey clasts.
[TOPSOIL]

GRAVEL (GW)
Fine to coarse, silty, some fine to coarse sand, well graded, angular to subrounded,
greyish brown.
[GLACIOFLUVIAL]

SILT (ML)
Some fine sand, trace to some gravel, low plasticity, uniformly graded, brown with
grey clasts, clasts are angular.
[TILL]

Below 4.57 m - sandy, fine.

Below 6.10 m - decrease in gravel, light greyish brown with grey and brown clasts.
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Client: KGHM Ajax Mining Inc.

Print Date:  5/28/2015

Project: Ajax Project Environmental Assessment
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Welding time 11:40
to 12:04.

05/03/2014 11:28

05/03/2014 11:31

05/03/2014 11:35

05/03/2014 11:39

05/03/2014 12:06

05/03/2014 12:10
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Moist from snow
melt

Dry

Dry

Dry to moist
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Below 10.67 m - trace clay.

Below 15.24 m - increase in gravel content, angular to subrounded.

Below 16.76 m - decrease in gravel content.

Below 18.29 m - gravel is angular.

END OF HOLE AT 18.90 m

NOTES:
1.  2" PVC standpipe peizometer installed with screen from 12.80 to 18.90 metres.
2.  Filter sand placed from 12.19 to 18.90 metres.
3.  Bentonite seal placed from 9.75 to 12.19 metres.
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Project: Ajax Project Environmental Assessment

10

11

12

13

14

15

16

17

18

19

20

975

974

973

972

971

970

969

968

967

966

Welding time 12:16
to 12:40.

Welding time 13:00
to 13:20.
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SILT (ML)
Sandy, some gravel, trace clay, sand is fine, gravel is fine, well graded, low plasticity,
dark brown with grey clasts.
[TILL]

Below 3.04 m - some fine sand, trace to some clay.

SAND (SP)
Fine, some fine gravel, trace silt, uniformly graded, brown with brown and grey clasts.
[TILL]

Below 6.10 m - some silt, trace gravel, slight increase in moisture content.

At 7.01 m - boulder.

Below 7.62 m - increase in silt, gravel no longer present.

GRAVEL AND SAND (SP/GP)
Gravel is fine to coarse, sand is medium to coarse, trace silt, uniformly graded,
subrounded, dark grey.
[GLACIOFLUVIAL]

Below 9.14 m - trace to some silt, subangular to subrounded.
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Client: KGHM Ajax Mining Inc.
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Drill bit plugged
with soil 7:51 to
8:43.

At 0.95 m - static
water level,
measured 5/7/2014
2:02.

Welding time 8:58
to 9:20.

Changing drill bit
9:25 to 9:33.

At 8.53 m - water
encountered.

06/03/2014 07:50

06/03/2014 08:45

06/03/2014 08:47

06/03/2014 08:57

06/03/2014 09:23

06/03/2014 09:25

06/03/2014 00:00
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06/03/2014 09:40

Moist

Dry to moist

Dry to moist

Dry

Dry

Dry to moist

Wet

Wet



Below 10.67 - trace to some clay, driller described as cohesive drilling.

WEATHERED BEDROCK
Drill cuttings:  gravel and sand, gravel is coarse, sand is coarse, subangular,
brownish grey, moderately to extremely weathered.
[NICOLA VOLCANICS]

Below 13.72 m - fine sand, uniformly graded, brownish grey.

BEDROCK
Drill cuttings:  fine grained, angular, grey, fresh and unweathered.
[NICOLA VOLCANICS]

Below 16.76 m - average particle size is 4 mm.

Below 18.29 m - average particle size is 5 mm.
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Drilling Contractor: JR Drilling Central Ltd.

Drill Method: Dual Rotary

Fluid: Air

Cased To (m): 5.18

Logged By: SLP

Depth to Top of Rock (m): 11.28

Start Date: 06 Mar 2014

Finish Date: 06 Mar 2014

Lithologic Description

Diameter (m): 0.15

Reviewed By: TWC

Stick-up (m): 0.94

In
st

ru
m

en
t 

D
et

ai
ls

D
ep

th
 (

m
)

Location: SMRSF

Location: Ajax Project Site

Datum: NAD83 UTM ZONE 10U

Ground Elevation (m):  977

A
JA

X
 (

H
Y

D
R

O
G

E
O

) 
 A

JA
X

_S
O

IL
_H

Y
D

R
O

G
E

O
.G

D
L 

 B
G

C
.G

D
T

 5
/2

8/
15

E
le

va
tio

n 
(m

)

D
ep

th
 (

m
)

S
am

pl
e 

T
yp

e

S
am

pl
e 

N
o.

Project No.: 1125-007

Client: KGHM Ajax Mining Inc.
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Welding time and
had to case
through boulder
9:49 to 10:30.

At 11.25 m -
attempted to airlift,
no water expelled.

Hard drilling.

Tripping out rods to
switch drill bits
10:55 to 11:08.

Welding time 11:15
to 11:40.

06/03/2014 09:47
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Below 24.38 m - average clast size is 3 mm.

Below 25.91 m - average particle size is 2 - 3 mm.

Below 27.43 m - fine sand present in cuttings, increase in weathering.

At 28.96 m - average particle size is 4 mm.

END OF HOLE AT 29.56 m
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Driller described
"break in dust".

From 29.26 m to
29.56 m - moisture
detected, not
enough for airlift.
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NOTES:
1.  2" PVC standpipe piezometer installed with screen from 23.47 to 29.56 metres.
2.  Filter sand placed from 22.25 to 29.56 metres.
3.  Bentonite seal placed from 20.17 to 22.25 metres.
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SILT (ML)
Sandy, trace gravel, trace clay, sand is fine, well graded, low plasticity, brown with
grey and brown clasts.
[TILL]

Below 3.04 m - some sand increase in clay.

SAND (SW)
Fine, gravelly, silty, gravel is fine to coarse, well graded, angular, dark grey with grey
clasts.
[TILL]

Below 6.10 m - decrease in silt content.

Below 7.62 m - increase in silt content, dark greyish brown.

SAND (SP)
Fine, trace silt, some gravel to gravelly, gravel is fine, uniformly graded, greyish
brown.
[GLACIOFLUVIAL]
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At 0.88 m - static
water level,
measured
5/28/2014 10:27.

Welding time 15:20
to 15:46.

At 9.14 m -
moisture
encountered.
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Below 10.67 m - gravelly, fine to coarse.

END OF HOLE AT 11.28 m

NOTES:
1.  2" PVC standpipe piezometer installed with screen from 8.23 to 11.28 metres.
2.  Filter sand placed from 7.62 to 11.28 metres.
3.  Bentonite seal placed from 5.49 to 7.62 metres.
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SAND AND GRAVEL (SP/GP)
Sand is fine, gravel is fine to coarse, gap graded, light brown with brown and grey
clasts.
[TOPSOIL]

BEDROCK
Drill cuttings:  fine to medium grained, angular, light grey, slightly weathered, average
clast size is 5 mm.

Below 4.57 m - grey, average clast size is 4 mm, slight decrease in weathering
grade.

Below 6.10 m - average clast size is 2 - 3 mm, fresh and unweathered.

Below 7.62 m - darker grey.

Below 9.14 m - average clast size is 3 mm.
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Below 12.19 m -  subangular to angular, light grey to white, slightly weathered.

Below 13.72 m - slightly darker grey.

Below 15.24 m - angular to subrounded, grey, average clast size is 4 mm.

Below 16.76 m - angular, dark grey.

Below 18.29 m - angular to subangular, grey, average clast size is 5 mm.
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Below 21.34 m - angular, average clast size is 2 - 3 mm.

Below 25.91 m - subangular, whitish grey.

Below 27.43 m - subrounded to subangular, dark grey, slightly weathered.

END OF HOLE AT 29.56 m
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NOTES:
1.  2" PVC standpipe peizometer installed with screen from 23.47 to 29.56 metres.
2.  Filter sand placed from 23.47 to 29.56 metres.
3.  Bentonite seal placed from 20.12 to 22.56 metres.
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SAND (SW)
Fine, silty, some fine to coarse gravel, well graded, dark brown, trace organics (roots,
5  - 10 mm diameter).
[TOPSOIL]

SILT (ML)
Sandy, trace to some fine to coarse gravel, trace clay, sand is fine, well graded, light
brown, low plasticity, clasts are angular.
[TILL]

BEDROCK
Drill cuttings:  fine to medium grained, angular, grey, fresh and unweathered to
slightly weathered.

Below 6.10 m - fine, grey, slightly green, fresh and unweathered, average clast size
is 7 mm.

Below 7.62 m - bluish grey, average clast size is 4 mm.
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Below 10.67 m - angular to subangular, average clast size is 3 mm.

Below 13.72 m - greenish grey sand present in cuttings, slightly weathered.

Below 15.24 m - average clast size is 2 mm, slightly weathered.

At 18.29 m - lumps of clayey silt present in cuttings with slight oxidation, gravel
cuttings are subrounded, slightly purplish red to grey, modereately weathered.

Below 19.81 m - grey clasts with some greenish grey sand present, angular to
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subrounded.

Below 21.34 m - purplish grey, mostly fine sand, moderately weathered.

Below 22.86 m - only some sand present, gravel cuttings are greyish green, angular,
slightly weathered.

Below 27.43 m - moderately weathered, faint oxidation, moisture encountered.

Below 28.96 m - slightly weathered.

END OF HOLE AT 29.56 m
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NOTES:
1.  2" PVC standpipe piezometer installed with screen from 23.47 to 29.56 metres.
2.  Filter sand placed from 22.56 to 29.56 metres.
3.  Bentonite seal placed from 20.12 to 22.56 metres.
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SAND (SW)
Fine, silty, some fine to coarse gravel, well graded, dark brown, trace organics
(rootlets).
[TOPSOIL]

SILT (ML)
Sandy, trace fine to coarse gravel, trace clay, well graded, low plasticity, light brown
with brown and grey clasts, clasts are angular to subrounded.
[TILL]

BEDROCK
Drill cuttings:  fine to medium grained, angular, angular, fresh and unweathered to
slightly weathered.

END OF HOLE AT 5.18 m

NOTES:
1.  2" PVC standpipe peizometer installed with screen from 3.04 to 4.57 metres.
2.  Filter sand placed from 2.74 to 5.18 metres.
3.  Bentonite seal placed from 0.00 to 2.74 metres.
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1  Introduction

This User Guide focuses on the current Levelogger Series, which includes:

• Levelogger Edge
• Barologger Edge
• Levelogger Junior Edge
• LTC Levelogger Junior
• Rainlogger Edge

Software Version 4.1 is also compatible with Levelogger Gold, Barologger Gold,  
Levelogger Junior and Rainlogger dataloggers. For details on setting up these 
dataloggers, see Section 5.9. Software Version 4.1 is also compatible with the 
Leveloader Gold data transfer device, which has a separate User Guide.

This Windows based software provides many convenient features. You can view 
and program datalogger settings, begin logging sessions, monitor real-time 
readings, download data, manage data files, perform data compensations, and 
save and export data files. Depending on the type of datalogger, there will be 
differences in programming options. See below for a summary of the differences:

Datalogger Programming Options

Datalogger Type Sampling Options Memory Capacity Battery Life

Levelogger Edge Linear (0.125 second to 99 
hours), Compressed Linear, 
Event Based, Schedule, 
Repeat Schedule,  
Real Time View,  
Future Start/Stop

40,000 sets of 
readings or 
up to 120,000 
Compressed. Slate 
or Continuous Mode 
(see note)

10 years based on  
1 reading per 
minute

Barologger Edge Linear (0.125 second to 99 
hours), Compressed Linear, 
Event Based, Schedule, 
Repeat Schedule,  
Real Time View,  
Future Start/Stop

40,000 sets of 
readings or 
up to 120,000 
Compressed. Slate 
or Continuous Mode 
(see note)

10 years based on 
1 reading per 
minute

Levelogger Junior Edge Linear (0.5 second to 99 
hours), Real Time View

40,000 sets of 
readings in Slate 
Mode

5 years based on  
1 reading per 
minute

LTC Levelogger Junior Linear (5 seconds to 99 
hours), Real Time View

16,000 sets of 
readings in Slate 
Mode

5 years based on  
1 reading every  
5 minutes

Rainlogger Edge 
& Rainlogger 

Event Based (records tips 
from tipping-bucket rain 
gauge), Real Time View 

Up to 60,000 tip 
time logs in Slate 
Mode

10 years based on  
2 parameters logged  
every 10 minutes

Levelogger Gold Linear (0.5 second to 
99 hours), Event Based, 
Schedule, Real Time View, 
Future Start/Stop

40,000 sets of 
readings, Slate or 
Continuous Mode

10 years based on  
1 reading per 
minute

Barologger Gold Linear (0.5 second to 
99 hours), Event Based, 
Schedule, Real Time View, 
Future Start/Stop

40,000 sets of 
readings, Slate or 
Continuous Mode

10 years based on  
1 reading per 
minute

Levelogger Junior Linear (0.5 second to 99 
hours), Real Time View

32,000 sets of 
readings in Slate 
Mode

5 years based on  
1 reading per 
minute

  NOTE 
Let Solinst keep you up-to-date 
with each new software and 
firmware release.   
Register your software at:  
www.solinst.com/Registration/  
to receive these updates 
automatically.

  NOTE 
This version of software is not 
compatible with older models 
of the Levelogger (Made before 
Dec. 2005). To program and use 
the old versions, Levelogger 3.1.1 
Software and User Guides can still 
be accessed at:  
www.solinst.com/Downloads/  
For Software version 2.0.3, contact 
Solinst.

  NOTE 
To use the new compression 
algorithm, which enables up to 
120,000 data points, the Levelogger 
Edge or Barologger Edge must be 
in linear sampling mode and slate 
memory mode.
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LT Edge Models Full Scale Accuracy

F6, M2 6.6 ft, 2 m ± 0.05% FS

F15, M5 16.4 ft., 5 m ± 0.05% FS

F30, M10 32.8 ft., 10 m ± 0.05% FS

F65, M20 65.6 ft., 20 m ± 0.05% FS

F100, M30 98.4 ft., 30 m ± 0.05% FS

F300, M100 328.1 ft., 100 m ± 0.05% FS

F600, M200 656.2 ft, 200 m ± 0.05% FS

Levelogger Edge Technical Specifications

Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 6,15, 30, 65, 100, 300, 600 ft. (2, 5, 10, 20, 30, 100, 200 m)

Accuracy ± 0.05% FS

Normalization: Automatic Temperature Compensation 

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05ºC

Temp. Sensor Resolution: 0.003ºC

Temp. Comp. Range: 0ºC to 50ºC 

Battery Life: 10 years (based on 1 reading/minute)

Clock Accuracy: ± 1 minute/year (-20ºC to 80ºC) 

Operating Temperature: -20ºC to 80ºC

Maximum # Readings: 40,000 (up to 120,000 using data compression)

Memory: FRAM, Continuous or Slate mode

Communication Speed: 9600 bps, 38,400 bps with USB optical reader

Com Interface: Optical Infra-red: USB, RS-232, SDI-12

Size: 7/8" x 6.25" (22 mm x 159 mm)

Weight: 129 grams (4.5 oz.)

Corrosion Resistance:
Titanium based PVD coated body and superior corrosion resistant 
Hastelloy sensor

Other Wetted Materials: Delrin®, Viton®, 316L Stainless Steel

Sampling Modes:
Linear, Event & User-Selectable Schedule with Repeat Mode,  
Future Start, Future Stop, Real Time View

Measurement Rates: 0.125 second to 99 hours

Barometric Compensation: High accuracy, air-only, Barologger Edge

1.1  Levelogger Series

1.1.1  Levelogger Edge

The Levelogger Edge is an absolute (non-vented) datalogger, which measures 
groundwater and surface water levels and temperature. Water levels are displayed 
as temperature compensated pressure readings, and can be barometrically 
compensated with the aid of a Barologger Edge.

   NOTE 
The Model number refers to the 
depth of submergence below 
water level that the pressure sensor 
can withstand. i.e.: The Levelogger 
Edge, which is available in F6 (M2), 
F15 (M5), F30 (M10), F65 (M20), 
F100 (M30), F300 (M100), and F600 
(M200) ranges has actual water 
level ranges of 6.6 ft (2 m), 16.40 ft 
(5 m), 32.80 ft (10 m), 65.60 ft  
(20 m), 98.40 ft (30 m), 328.0 ft 
(100 m), and 656.2 ft (200 m), 
respectively.

   NOTE 
Solinst recommends using the 
most recent firmware, Version 3.003, 
when using a Levelogger Edge with 
Software Version 4.1.
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1.1.2  Barologger Edge

The Barologger Edge uses algorithms based on air pressure only. It measures 
and logs changes in atmospheric pressure, which are then used to compensate 
water level readings recorded by a Levelogger Edge, Levelogger Junior Edge, or  
LTC Levelogger Junior. 

Barologger Edge Technical Specifications

Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Accuracy ± 0.05 kPa

Normalization: Automatic Temperature Compensation 

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05ºC

Temp. Sensor Resolution: 0.003ºC

Temp. Comp. Range: -10ºC to 50ºC

Battery Life: 10 years (based on 1 reading/minute)

Clock Accuracy: ±1 minute/year (-20ºC to 80ºC) 

Operating Temperature: -20ºC to 80ºC

Maximum # Readings: 40,000 (120,000 using data compression)

Memory: FRAM, Continuous or Slate mode

Communication Speed: 9600 bps, 38,400 bps with USB optical reader

Com Interface: Optical Infra-red: USB, RS-232, SDI-12

Size: 7/8" x 6.25" (22 mm x 159 mm)

Weight: 129 grams (4.5 oz.)

Corrosion Resistance:
Titanium based PVD coated body and superior corrosion resistant 
Hastelloy sensor

Other Wetted Materials: Delrin®, Viton®, 316L Stainless Steel

Sampling Modes:
Linear, Event & User-Selectable Schedule with Repeat Mode,  
Future Start, Future Stop, Real Time View

Measurement Rates: 0.125 second to 99 hours

   NOTE 
Solinst recommends using the 
most recent firmware, Version 3.003, 
when using a Barologger Edge with 
Software Version 4.1. 

LT Edge Models Full Scale (FS) Accuracy

Barologger Air Only ±0.05 kPa
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1.1.3  Levelogger Junior Edge

The Levelogger Junior Edge provides an inexpensive alternative for measuring 
groundwater and surface water levels and temperature. 

Levelogger Junior Edge Technical Specifications
Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 15, 30 ft. (5, 10 m)

Accuracy ± 0.1% FS

Normalization: Automatic Temperature Compensation

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Accuracy: ± 0.1ºC 

Resolution: 0.1ºC

Temp Compensation Range: 0ºC to 40ºC

Battery life: 5 years (based on 1 reading/minute)

Clock Accuracy: ± 1 minute / year  (-20ºC to 80ºC)

Operating Temperature: -20ºC to 80ºC 

Memory: FRAM, Slate mode

Maximum # Readings 40,000 (no data compression)

Com Interface: Optical Infra-red: USB, RS-232, SDI-12

Communication Speed: 9600 bps

Size: 7/8" x 5.6" (22 mm x 142 mm)

Weight: 4.2 oz (119 grams)

Wetted Materials: Delrin®, Viton®, 316L Stainless Steel, Hastelloy

Sampling Mode: Linear, Future Start, Real Time View

Measurement Rates: 0.5 seconds to 99 hours

Barometric Compensation: High accuracy, air-only, Barologger Edge

LT Models Full Scale (FS) Accuracy 

F15, M5 16.4 ft., 5 m ± 0.1% FS

F30, M10 32.8 ft., 10 m ± 0.1% FS

   NOTE 
The Levelogger Junior Edge 
looks very similar to the previous 
Levelogger Junior. To determine the 
difference, look at the serial number  
on the body of the Levelogger. 
If the fourth number in the serial 
number is 1, it is a Levelogger 
Junior. If the fourth number is a 2, it 
is a Levelogger Junior Edge. 

   NOTE 
Solinst recommends using the 
most recent firmware, Version 3.003, 
when using a Levelogger Junior 
Edge with Software Version 4.1. 
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1.1.4  LTC Levelogger Junior

The LTC Levelogger Junior provides an inexpensive and convenient method to 
measure level, temperature and conductivity all in one probe. 

LTC Levelogger Junior Technical Specifications
Level Sensor: Piezoresistive Silicon with Hastelloy Sensor

Ranges: 30, 100 ft. (10, 30 m) 

Accuracy ± 0.1% FS

Normalization: Automatic Temperature Compensation

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Accuracy: ± 0.1ºC

Resolution: 0.1ºC

Temp Compensation Range: 10ºC to 40ºC

Conductivity Sensor: 4-Electrode Platinum

Full Range: 0 to 80,000 µS/cm

Calibrated Range: 500 to 50,000 µS/cm

Accuracy: ± 2% of reading or 20 µS/cm

Resolution: 1 µS

Normalization: Specific Conductance normalized to 25ºC for full range

User Calibration Points: 1413, 5000, 12,880 µS

Battery Life: 5 years (based on 1 reading/ 5 minutes)

Clock Accuracy: ± 1 minute / year 

Operating Temperature: -20ºC to 80ºC

Memory: Non-volatile EEPROM, FRAM back-up, Slate mode only

Maximum Readings: 16,000

Communication Speed: 9600 bps

Com Interface: Optical Infrared: USB, RS-232, SDI-12

Size: 7/8" x 7.5" (22 mm x 190 mm) 

Weight: 200 g  (7.05 oz.)

Wetted Materials: Hastelloy, Delrin®, Viton®, 316L Stainless Steel, Platinum

Sampling Mode: Linear, Future Start, Real Time View

Measurement Rates: 5 seconds to 99 hours

Altitude Input: -980 to 16,400 ft. (-300 to 5,000 m)

Barometric Compensation: High accuracy, air-only, Barologger

LTC Models Full Scale (FS) Accuracy 

F30, M10 32.8 ft., 10 m ± 0.032 ft., 1.0 cm 

F100, M30 98.4 ft., 30 m ± 0.098 ft., 3 cm 

   NOTE 
Solinst recommends using the 
most recent firmware, Version 2.005, 
when using a LTC Levelogger Junior 
with Software Version 4.1. 
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1.1.5  Rainlogger Edge

The Rainlogger Edge is designed for use with most standard tipping-bucket rain 
gauges with a reed switch output. It records each tip time from the tipping-bucket, 
and outputs the amount of rainfall per programmed time period (based on rainfall 
calibration constant).

Rainlogger Edge Technical Specifications
Battery Life: 10 years (logging 2 parameters/10 minutes)

Clock Accuracy: ± 1 minute/year

Operating Temperature: -20˚C to 80˚C

Maximum # Readings: Up to 60,000 tip times

Memory: Non-volatile EEPROM, Slate mode only

Communication: Optical infra-red: USB, RS-232, SDI-12

Measurement:
Records each tip by the tipping-bucket rain gauge and outputs 
the amount of rainfall

Sampling Mode: Event Based, Future Start, Real TIme View

Size: 7/8" x 5.5" (22 mm x 140 mm)

Weight: 1.6 oz (44 grams)

Materials: ABS, Delrin®, Viton®

1.1.6  Leveloader Gold

The Leveloader Gold is a data transfer device for use with all versions of 
Leveloggers.  It can be used to download, store, and transfer data from Levelogger 
to PC, as well as, save settings files for transfer to a Levelogger.  Also allows real 
time viewing of Levelogger readings. The Leveloader is used with Levelogger 
Software, see separate Leveloader Gold User Guide.

   NOTE 
Solinst recommends using the 
most recent firmware, Version 3.000, 
when using a Rainlogger Edge with 
Software Version 4.1.

   NOTE 
Solinst recommends using the 
most recent firmware, Version 2.001, 
when using a Leveloader Gold with 
Software Version 4.1. 



Levelogger Series User Guide - Software Version 4

Page 7

Levelogger Gold Technical Specifications
Level Sensor: Piezoresistive Silicon in 316L Stainless Steel

Accuracy 0.05% FS

Ranges: 15, 30, 65, 100, 300 ft. (5, 10, 20, 30, 100 m)

Normalization: Automatic Temperature Compensation

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05°C

Temp. Sensor Resolution: 0.003°C

Temp. Comp. Range: 10ºC to 40°C

Battery Life: 10 Years - based on one reading/min

Clock Accuracy: ± 1 minute/year

Operating Temperature: -20°C to 80°C

Maximum # Readings: 40,000 of level and temperature

Memory:
EEPROM Slate, Continuous,  
and redundant backup of last 1200 readings

Communication: Optical Infra-red: USB, RS-232, SDI-12

Communication Speed: 9600 bps

Size: 7/8" x 6" (22 mm x 154 mm)

Weight: 6.3 oz (179 grams)

Corrosion Resistance: Zirconium Nitride (ZrN) Coating

Other Wetted Materials: 316L Stainless Steel, Delrin®, Viton®

Sampling Modes:
Linear, Event & User-Selectable with 
30 separate line items

Measurement Rates: 0.5 sec to 99 hrs

Barometric Compensation: High accuracy, air-only, Barologger Gold

LT Models Full Scale (FS) Accuracy 

F15, M5 16.4 ft., 5 m ± 0.010 ft., 0.3 cm

F30, M10 32.8 ft., 10 m ±  0.016 ft., 0.5 cm

F65, M20 65.6 ft., 20 m ± 0.032 ft., 1 cm

F100, M30 98.4 ft., 30 m ±  0.064 ft., 1.5 cm

F300, M100 328.1 ft., 100 m ± 0.164 ft., 5 cm

1.1.7  Levelogger Gold

The Levelogger Gold is an absolute (non-vented) datalogger, which measures 
groundwater and surface water levels and temperature.  Water levels are displayed 
as temperature compensated pressure readings, and can be barometrically 
compensated with the aid of a Barologger.

   NOTE 
To use the Levelogger Gold with 
Software Version 4.1, ensure you 
are using version 2.007 firmware.

Contact Solinst if you need to 
upgrade your firmware from 
version 1.016 or lower. 
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LT Models Full Scale (FS) Accuracy

Barologger Air Only ± 0.003 ft., 0.1 cm

1.1.8  Barologger Gold

The Barologger Gold uses algorithms based on air pressure only.  It measures and 
logs changes in atmospheric pressure, which are then used to compensate water 
level readings recorded by a Levelogger.

Barologger Gold Technical Specifications
Level Sensor: Piezoresistive Silicon in 316L Stainless Steel

Accuracy 0.05% FS

Normalization: Automatic Temperature Compensation

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Temp. Sensor Accuracy: ± 0.05°C

Temp. Sensor Resolution: 0.003°C

Temp. Comp. Range: 0ºC to 40°C

Battery Life: 10 Years - based on one reading/min

Clock Accuracy: ± 1 minute/year

Operating Temperature: -20°C to 80°C

Maximum # Readings: 40,000 of pressure and temperature

Memory:
EEPROM Slate, Continuous,  
and redundant backup of last 1200 readings

Communication: Optical Infra-red: USB, RS-232, SDI-12

Communication Speed: 9600 bps

Size: 7/8" x 6" (22 mm x 154 mm)

Weight: 6.3 oz (179 grams)

Corrosion Resistance: Zirconium Nitride (ZrN) Coating

Other Wetted Materials: 316L Stainless Steel, Delrin®, Viton®

Sampling Modes:
Linear, Event & User-Selectable with 
30 separate line items

Measurement Rates: 0.5 sec to 99 hrs

   NOTE 
To use the Barologger Gold with 
Software Version 4.1, ensure you 
are using version 2.007 firmware.
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1.1.9  Levelogger Junior

The Levelogger Junior functions like the Levelogger Gold; provides an inexpensive 
alternative for measuring groundwater and surface water levels and temperature. 

Levelogger Junior Technical Specifications
Level Sensor: Piezoresistive Silicon in 316L Stainless Steel

Ranges: 15, 30 ft. (5, 10 m)

Accuracy ± 0.1% FS

Normalization: Automatic Temperature Compensation

Temperature Sensor: Platinum Resistance Temperature Detector (RTD)

Accuracy: ± 0.1ºC 

Resolution: 0.1ºC

Temp Compensation Range: 10ºC to 40ºC

Battery life: 5 years (based on 1 reading/minute)

Clock Accuracy: ± 1 minute / year 

Operating Temperature: -20ºC to 80ºC

Memory: Non-volatile EEPROM, FRAM back-up, Slate mode only

Maximum # Readings 32,000 (no data compression)

Com Interface: Optical Infra-red: USB, RS-232, SDI-12

Communication Speed: 9600 bps

Size: 7/8" x 5.5 " (22 mm x 140 mm)

Weight: 154 g (5.4 oz)

Wetted Materials: Delrin®, Viton®, 316L Stainless Steel

Sampling Mode: Linear, Future Start, Real Time View

Measurement Rates: 0.5 seconds to 99 hours

Altitude Input: -980 to 16,400 ft. (-300 to 5,000 m)

Barometric Compensation: High accuracy, air-only, Barologger Gold

LT Models Full Scale (FS) Accuracy

F15, M5 16.4 ft., 5 m ± 0.020 ft., 0.6 cm

F30, M10 32.8 ft., 10 m ±  0.032 ft., 1.0 cm

   NOTE 
To use the Levelogger Junior with 
Software Version 4.1, ensure you 
are using version 2.007 firmware.

   NOTE 
The Levelogger Junior looks very 
similar to the newer Levelogger 
Junior Edge. To determine the 
difference, look at the serial number 
on the body of the Levelogger. 
If the fourth number in the serial 
number is 1, it is a Levelogger 
Junior. If the fourth number is a 2, it 
is a Levelogger Junior Edge. 
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1.1.10  Rainlogger

The Rainlogger is designed for use with most standard tipping-bucket rain gauges 
with a reed switch output. It records each tip time from the tipping-bucket, and 
outputs the amount of rainfall per programmed time period (based on rainfall 
calibration constant).

Rainlogger Technical Specifications
Battery Life: 10 years (logging 2 parameters/10 minutes)

Clock Accuracy: ± 1 minute/year

Operating Temperature: -20˚C to 80˚C

Maximum # Readings: Up to 60,000 tip times

Memory: Non-volatile EEPROM, Slate mode only

Communication: Optical infra-red: USB, RS-232, SDI-12

Measurement:
Records each tip by the tipping-bucket rain gauge and outputs 
the amount of rainfall

Sampling Mode: Event Based, Future Start, Real TIme View

Size: 7/8" x 7" (22 mm x 175 m)

Weight: 4.8 oz (135 grams)

Materials: 316L Stainless Steel, Delrin®, Viton®

   NOTE 
Solinst recommends using the 
most recent firmware, Version 2.000, 
when using a Rainlogger with 
Software Version 4.1.

If using a firmware version prior to 
version 2.000, the Rainlogger will 
function differently (See previous 
Levelogger User Guide)
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1.2  Measurement Parameters

1.2.1  Level

All Leveloggers measure total (absolute) pressure. When submerged, 
the Levelogger is recording the combination of barometric pressure and 
water pressure. The actual pressure of just water (A) above the sensor is 
obtained by subtracting barometric pressure (B) from the total pressure (L)  
(see Figure 1-1).

The best method to compensate for barometric pressure is to employ a Barologger 
above the water level, to obtain records of barometric pressure. The Levelogger 
Software includes a Data Wizard, which guides you through the automated process 
of barometric compensation. Manual methods can be employed to determine the 
absolute water level using barometric records collected on-site or available from 
a local weather station (i.e. airport). Water level readings from Leveloggers are 
automatically temperature-compensated.

A = Actual water column height

B = Barometric pressure

L = Levelogger total pressure readings

D = Depth to water level, below reference datum

Note: the Levelogger Gold, Levelogger Junior and current LTC Levelogger 
Junior models convert pressure readings to the water level equivalent above the 
datalogger’s pressure zero point of 950 cm (31.17 ft). The Levelogger Edge 
and Levelogger Junior Edge have no zero point offset. As such, water level data 
will appear different, although measuring the same amount of pressure (i.e. 
Levelogger Edge data will appear to be reading 950 cm (31.17 ft) higher than a 
Levelogger Gold. Barometric Compensation using the Data Wizard, automatically 
considers this zero point offset difference when compensating a mix of Models. 

1.2.1.1 Pressure Calibration

The Levelogger Edge is calibrated against a range of set reference points to an 
accuracy of 3 decimal places. During the calibration procedure, the Levelogger 
is fully submerged in a highly accurate water bath. The bath is set to 5°C and 
allowed to stabilize. The pressure is then calibrated to six separate pressure 
points covering the entire range of pressure for that particular Levelogger to 
check for any non-linearity. The process is repeated again at 35°C to check for 
temperature effects. Once done, the Levelogger is approved after all specifications 
for accuracy, precision, stability and hysteresis have been met. The Levelogger 
should be calibrated for the life-time of the instrument, as long as it is used within 
its specified range.

1.2.2  Barometric Pressure

The Barologger is designed for use in air only. It has a specific range and firmware 
algorithms based on air pressure rather than water pressure. This makes the 
Barologger less accurate if used in water, but more accurate if used as intended in 
air. Using a Barologger is the most accurate and convenient method of obtaining 
atmospheric pressure and air temperature measurements, which are then 
synchronized to the Levelogger. The Data Wizard in the Levelogger Software 
simplifies the adjustment of the level measurements for barometric pressure 
changes, by using the synchronized data from all Leveloggers on site and the site 
Barologger. 

Figure 1-1  
Levelogger Measurement Fundamentals

A = L - B

   NOTE 
Leveloggers measure the pressure 
of air plus water column above their 
sensor (zero point). To adjust the 
level readings after data collection, 
for example to water level depths 
below top of casing (D), refer to 
the Advanced options within the 
software Data Wizard.

   NOTE 
The Levelogger Gold, Levelogger 
Junior and current LTC Levelogger 
Junior models convert pressure 
readings to the water level 
equivalent above the datalogger’s 
pressure zero point of 950 cm 
(31.17 ft). The Levelogger Edge and 
Levelogger Junior Edge have no 
zero point offset. As such, water 
level data will appear different, 
although measuring the same 
amount of pressure. Barometric 
Compensation using the Data 
Wizard, automatically considers this 
zero point offset difference when 
compensating a mix of Models. 
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1.2.3  Temperature

Leveloggers record temperature compensated water levels. Groundwater and 
surface water temperature measurements are particularly important in situations 
where temperatures may fluctuate significantly, and when temperature is used 
in determining liquid level, viscosity and hydraulic conductivity. Temperature 
monitoring is vital in the calculation of certain temperature dependent contaminant 
reaction rates. A Platinum Resistance Temperature Detector is used to accurately 
compensate for temperature changes within the range of 0 to +50ºC for the 
Levelogger Edge, -10ºC to +50ºC for the Barologger Edge, 0 to +40ºC for the 
Levelogger Junior Edge, and +10 to +40 for the LTC Levelogger Junior. The 
Levelogger will record temperature in its thermal range of -20 to +80ºC, but 
outside the range, compensation will be less accurate.

1.2.4  Conductivity

The LTC Levelogger Junior provides the added feature of electrical conductivity 
measurement. It measures the actual conductivity at the current temperature. 
Conductivity measurement is particularly useful in monitoring saltwater intrusion, 
surface water infiltration and mixing, as well as the monitoring of certain pollutants 
and contaminant parameters. Conductivity is measured via a platinum 4-electrode 
sensor, which produces highly stable and consistent readings. Conductivity 
calibration is performed by using a liquid solution, with a known conductivity 
value, and the Calibration Wizard in the Levelogger Windows Software. The 
Data Wizard allows you to convert conductivity readings to Specific Conductance  
(at 25ºC), or Salinity expressed in Practical Salinity Units (PSU). A Practical 
Salinity Unit (PSU) is a dimensionless descriptor for the Practical Salinity Scale 
(PSS). The PSS defines salinity as the ratio of a water sample's conductivity to 
that of a standard KCL solution. The Data Wizard uses the equation given in 
the UNESCO Technical Paper "Algorithms for computation of fundamental 
properties of seawater", to convert Conductivity readings to Salinity. For more 
information, see: Fofonoff, N. P. and R.C. Millard, Jr. Algorithms for computation 
of fundamental properties of seawater, UNESCO, Tech. Pap. Mar. Sci.,44.

1.2.4.1  Calibration of the Conductivity Sensor

The conductivity sensor of the LTC Levelogger Junior is a highly sensitive device 
requiring regular calibration by the user. The conductivity calibration frequency 
is dependent on the water quality of the Levelogger’s monitoring environment. 
To determine whether an LTC Levelogger Junior should be re-calibrated, test 
the unit in a solution with a known electrical conductivity value at a reference 
temperature. In Real Time View, observe current readings by using the Read 
Now function. If this reading varies from the known Specific Conductance of the 
solution by greater than 2% of the Full Scale of Conductivity measurement, the 
unit should be re-calibrated using the Conductivity Calibration Wizard procedure 
outlined in Section 6. As a minimum, calibrate your LTC Levelogger Junior at 
least twice a year. Ensure that a conductivity calibration is performed when the 
LTC Levelogger Junior is being set up for its initial use and after long periods of 
dry storage.

1.2.5  Total Rainfall

Solinst Rainloggers are designed to record the number of tips of an external 
tipping-bucket rain gauge, and output the amount of rainfall per tip.

   NOTE 
For every degree change in 
temperature, there is approximately 
a 2% change in conductivity. 
To convert raw conductivity 
measurements to Specific 
Conductance measurements, you 
can use the following equation:

Specific Conductance = 
Conductivity / (1 + 0.02 *  
(temp(C) - 25)) 

You can also perform this 
calculation automatically using the 
Data Wizard.
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1.3  Software Communication

Levelogger Software is Windows based, and is therefore used with a desktop or 
laptop PC. Dataloggers connect to a laptop or desktop PC with an Optical Reader 
cable. The Optical Reader cable uses an infrared data reader/port connected to 
the datalogger and a USB or RS-232 (Serial) Com Port to transfer information 
between the datalogger and computer.

If you are programming dataloggers in the office, or have deployed your 
datalogger using a wireline or cord, an Optical Reader is most commonly used 
for communication with a PC (see Figure 1-2). 

If a datalogger is deployed in the field using a Direct Read Cable, a PC Interface 
Cable is used for communication with the PC, without removing it from the well 
(see Figure 1-3).

Figure 1-2  Levelogger Connected to a PC Using an Optical Reader

Figure 1-3  
Levelogger and Direct Read Cable Connected to PC Using a PC Interface Cable

Optical Reader

PC Interface 
Cable

Datalogger 
Down Well

   NOTE 
Always plug in the USB device 
before starting the Software. 

When you plug in a USB device for 
the first time, you will need to install 
the USB Driver on the PC.  
(See Section 4.1.3).

   NOTE 
For software installation instructions, 
see Section 3.
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1.3.1  Backwards Compatibility

The Levelogger Edge is not backwards compatible with previous versions of 
Levelogger Software. Only Levelogger Software Version 4 and up can be used 
to program the Levelogger Edge and Barologger Edge. The Levelogger Junior 
Edge is only compatible with Levelogger Software Version 4.0.2 and up. The 
Rainlogger Edge is only compatible with Software Version 4.1 and up.

The Levelogger Junior, LTC Levelogger Junior, Rainlogger, and Leveloader are 
compatible with Levelogger Software Version 4.1. If used with previous software 
versions, they will not have some of the features gained with the release of Version 
4.1 Software. The Levelogger Gold and Barologger Gold are also compatible 
with Version 4.1 Software, and previous versions.

To use your Leveloggers with Version 4.1 Software, ensure your firmware is 
upgraded to the following versions:

   NOTE 
It is always recommended to use 
the most recent version of software 
and firmware.

   NOTE 
For more information, visit  
www.solinst.com to view the 
3001 Levelogger Series: Hardware 
Compatibility, which is located on 
the Downloads page.

Datalogger Firmware Version

Levelogger Edge 3.003

Barologger Edge 3.003

Levelogger Junior Edge 3.003

LTC Levelogger Junior  2.005

Rainlogger Edge 3.000

Leveloader Gold 2.001

Levelogger Gold 2.007

Barologger Gold 2.007

Levelogger Junior 2.007

Rainlogger 2.000

For more information on previous software and firmware versions, visit  
www.solinst.com to view 3001 Levelogger Series: Hardware Compatibility, 
located on the Downloads page.
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2  System Requirements

The minimal hardware and software requirements for software installation and 
operation are:

Hardware Software

Memory: 32 MB or more OS: Windows XP or 7

Display: VGA: 800 x 600 pixels, 256 colour

Ports: USB or RS-232 Serial Port

Bits per second 9600

Data bits 8

Stop bits 1

Flow control None

Figure 3-1 Software Installation Wizard

Communication Port Setting for Levelogger Communications:

3  Software Installation

Web Download

Download the newest version of Levelogger Software by visiting  
www.solinst.com/Downloads/ 

CD Installation

1) Insert the software CD provided.

2) If the installer does not automatically start, to activate the software install click on  
 the ‘setup.exe’ file located on the software CD.

3) The Software Installation Wizard will guide you through the remaining installation  
 process. Figure 3-1 shows the Levelogger Installation Wizard.

4) Restart the computer after installation is completed. Default Directory is  
 C:\Program Files\Solinst\Levelogger4_1
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4  Startup, Configurations and Settings

4.1  Startup

If using a USB port, plug in the USB cable before starting the Levelogger Software.  
If plugging in the USB device for the first time, the driver for the device will have 
to be installed, see Section 4.1.3 for USB driver installation instructions. 

To start the Levelogger Software, click , or click the Start button and select:

Programs > Solinst > Levelogger 4 > Levelogger 4.1

Once the program is started, you can set up the parameters for the Software. 

4.1.1 Software/Firmware Update Checks

Each time the software is opened, it automatically checks for software updates. If 
there is an update, "Software Update Available" will appear in the top right of the 
menu bar. When you click the message, it will open a web page where you can 
download the software update.

The Software also checks for firmware updates once you have retrieved settings 
from a connected Levelogger (see Section 5)."Firmware Update Available" will 
appear in the top right menu bar. Clicking the message will open a web page 
where you can download the firmware update. See Section 12 for firmware 
update instructions.

4.1.2  Communicating with a USB Port

USB port communication requires the installation of USB driver software and the 
setting up of a virtual com port.  If communicating via a USB port, the user will 
either:

1) Connect a Levelogger Optical Reader or PC Interface Cable to the USB port

2) Use a USB to RS-232 Adapter 

If 1, during the installation of Levelogger Software, the Virtual Com Port Driver 
will be installed automatically. The Levelogger Software Installation Wizard also 
copies a folder to the Levelogger folder containing all the Solinst USB drivers.  
When you plug in the Solinst USB device, check the com port designation after 
installing the device (see Section 4.2.1).

If 2, Solinst strongly recommends the use of either Keyspan™ or IO Gear™ USB 
to RS-232 Serial Adapters. These adapters have a sufficiently large buffer to 
accommodate the size of data bundle and bit transfer rate of the Levelogger. 
Follow the manufacturer's USB Driver and Com port setup installations found on 
the CD accompanying the adapter.

If you have installed another brand-name adapter, but cannot communicate with 
the Levelogger, in most cases the problem is that the adapter does not have 
a large enough internal memory buffer. The minimum buffer size should be  
96 bytes. 

   NOTES
To check the Com port assigned to 
a USB device after installation, open 
the Device Manager.  Expand “Ports 
(COM & LPT)” to show the Com Port 
that has been assigned. To change 
the assigned Port, see Section 4.2.1.

You may have to restart your 
computer after adding a new 
USB device, before that port will 
be detected by the Levelogger 
Software

   NOTE 
Your PC must have an internet 
connection to check for software 
and firmware updates.

You can also check for updates 
using the Help menu.
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   NOTE 
After plugging in the USB device, if 
the ‘Found New Hardware Wizard’ 
does not automatically appear, 
proceed to the Manual USB 
Installation instructions in Section 
4.1.3.2

4.1.3  Installing USB Drivers for Levelogger 4 Software

Levelogger Software Version 4.1, for use with Solinst USB Optical Reader,  
PC Interface Cable and Leveloader, comes equipped with USB drivers for: 
Windows XP and 7.

4.1.3.1  USB Installation for Windows XP

1)  Plug the USB device into the computer, and Windows will automatically detect  
 the connected device.  This will begin the ‘Found New Hardware Wizard’. 

2) The ‘Wizard’ will give the option to connect to Windows Update to search for  
 software components, select: ‘No, not at this time’.

3) Click ‘Install from a list or specific location’, then click the ‘Next’ Button.    
 (Figure 4-1).

   NOTE 
Do not install generic drivers that 
Windows will locate.  Generic 
drivers are completely incompatible 
with Solinst USB devices.

Figure 4-1 Found New Hardware Wizard Window

4) Select the installation option, ‘Include this location in the search’ (Figure 4-2),  
 then click the ‘Browse’ button to search for the appropriate directory:

 C:\Program Files\Solinst\Levelogger4_1\USB Drivers

Figure 4-2 Found New Hardware Window and Figure 4-3 Browse for Folder Window

  NOTE 
Make sure you only select the USB 
Drivers folder when browsing for 
the driver location. Do not choose a 
sub file from the folder.
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Figure 4-4 Found New Hardware Search Window

5) A warning message will then prompt that the software has not passed the  
 Windows Logo Test. Select ‘Continue Anyway’ (Figure 4-5). This will complete  
 the installation process. A system restart may be required. Repeat the  
 steps if the installation fails the first time.

Figure 4-5  Hardware Installation Window

Figure 4-6 Found New Hardware Completed Window
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4.1.3.2  Manual USB Installation

If your device is plugged in and the ‘Found New Hardware Wizard’ fails to start, 
then follow these steps:

1) Open the Device Manager. Typically this is found through the path: 
 Start > Control Panel > System > Hardware > Device Manager

 Once the Device Manager is open, a version of the following list(s) will appear:

2) Identify the Solinst device from the list.  The device will be categorized under  
 ‘Other Devices’ or ‘Universal Serial Bus Controllers’.

3) Highlight the device in the list and right click. You will see an option to ‘Update  
 the driver’. This will start the ‘Hardware Update Wizard’. Now follow the  
 instructions for your specific Windows version.

Figure 4-7 Device Manager

   NOTE 
If you do not know the correct 
Com Port that was assigned to 
your device, re-open the Device 
Manager.  Expand “Ports (COM & 
LPT)” to show the Com Port that 
has been assigned. To change the 
assigned Port, see Section 4.2.1.

   NOTE 
If you are unsure which is the 
correct device in the list, with the 
screen visible, safely remove the 
device and then reconnect it.  The 
list should automatically refresh 
accordingly.
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4.1.3.3  USB Installation for Windows 7

Plug the USB Device into the PC. The system will automatically detect the connected 
unit. Windows 7 should automatically install the driver for the device.

If no driver is automatically found, and the ‘Found New Hardware Wizard’ fails to 
start, the following steps should be taken:

1) Press the Windows start button to bring up the start menu, select ‘Control  
 Panel’, then ‘Hardware and Sound’, then ‘Device Manager’.

2) Under ‘Other Devices’ there will be a Solinst device shown with a yellow warning  
 symbol.  Right click on this device, and select ‘Update Driver Software’.

Figure 4-8 Windows 7 Device Manager

Figure 4-9 Update Driver Software

3) Select ‘Browse my computer for driver software’.

   NOTE 
USB driver installation should be 
automatic when connecting a PC 
Interface Cable or Optical Reader.  

   NOTE 
If you are unsure which is the 
correct device in the list, with the 
screen visible, safely remove the 
device and then reconnect it.  The 
list should automatically refresh 
accordingly.

   NOTE 
The ‘Found New Hardware Wizard’ 
may start automatically, beginning 
at step 3 below.

   NOTE 
If the USB driver does not install the 
first time, repeat the steps a second 
time. It often takes more than once 
to install the driver for Windows 7 
systems.
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Figure 4-10 Browse for Driver Software

4) Click the Browse button and point the navigation window to the provided USB  
 drivers located within the Levelogger4_1 folder. Default destination is: 

 C:\Program Files\Solinst\Levelogger4_1\USB Drivers

 Select the actual USB Drivers folder, not a sub file from the folder. 

5) Select Next. A window may appear stating ‘Windows can't verify the publisher  
 of this driver software’, select ‘Install this driver software anyway’.

6) Windows will confirm when the installation is complete. Press Close to close the  
 window, then go back to the ‘Device Manager’.

Figure 4-11 Update Complete

  NOTE 
Make sure you only select the USB 
Drivers folder when browsing for 
the driver location. Do not choose a 
sub file from the folder.
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Figure 4-12 Update Serial Port

7) You may have to repeat steps 2-6 to update the USB Serial Port.  This would be  
 shown under ‘Other Devices’ with a yellow warning symbol.

8) Once installation is complete, a window will confirm the COM port assigned  
 to the device.

   NOTE 
If you are unsure which is the 
correct device in the list, with the 
screen visible, safely remove the 
device and then reconnect it. The 
list should automatically refresh 
accordingly.
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4.2  Configuration and Settings

4.2.1  Com Port Designation Set Up

After installing a USB device, should the Com Port number assigned to the 
device conflict with your existing devices, it is possible to change the Com Port 
designation number:

1) Click Start > Settings > Control Panel

2) Click Systems to open the System Properties

3) Click the Hardware tab and click ‘Device Manager’

4) Double Click the Ports Icon and select the ‘USB Serial Port’

5) Right click and select Properties 

6) Click the ‘Port Settings’ tab and click ‘Advanced’

7) Select the Com Port Number and click ‘OK’

Note: the path to the ‘Port Settings’ tab may be different for each Windows operating 
system. The above is just a guideline. 

4.2.2  Data Directory

The program will save data downloaded to the following default directory: 
<C:\Program Files\Solinst\Levelogger4_1\Data> unless otherwise specified in 
the Default Directory field of the Application Settings window (Figure 4-13). 

Click the Configuration menu at the top of the program window, select Application 
Settings and input or navigate to a different folder destination. After completing 
the Application Settings, click the OK button to confirm and save the settings. 

Figure 4-13 Application Setting Window

   NOTES
To check the Com port assigned to 
a USB device after installation, open 
the Device Manager.  Expand 'Ports 
(COM & LPT)' to show the Com Port 
that has been assigned.

You may have to restart your 
computer after adding a new 
USB device, before that port will 
be detected by the Levelogger 
Software

4.2.3  File Name Settings

From the Application Settings window in the Configuration menu, you can set 
what information will be included in your default file names of downloaded data  
(see Figure 4-13). You can include Start Date, Stop Date, Serial Number, and 
Location. Check-off the information you would like included. 

After completing the Application Settings, click the OK button to confirm and 
save the settings. 
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4.2.4  Default File Type

From the Application Settings window in the Configuration menu, you can set 
what default file type you would like to use for downloaded, saved and exported 
data files. You can select between either *.xle (default) or *.lev file types (see Figure 
4-13). For more information about the two file types, see Section 7.1.1. 

After completing the Application Settings, click the OK button to confirm and 
save the settings. 
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5  Levelogger Edge Series Setup

After you start the Levelogger Software, the main Levelogger Software window 
will appear, with the Datalogger Settings tab open.

Figure 5-1 Datalogger Settings Tab

Select the appropriate COM or USB Port for the connected communications 
device from the centre drop-down menu. 

Click
 

 to retrieve the current settings from the connected datalogger.  

5.1  Datalogger Settings

After you have retrieved the settings of the connected datalogger, the Datalogger 
Settings tab will identify the Instrument Type, Serial Number, Firmware Version, 
Project ID, Location, and the Channel Settings.

• Instrument Type: will display the model of the attached  
 datalogger, i.e.: F100/M30, Barologger, Rainlogger.
• Serial Number: the unique serial number of the attached datalogger  
 will be displayed.
• Firmware Version: shows the firmware version of the attached  
 datalogger.
• Project ID: input your own identification system. The Project ID is  
 limited to 32 characters.
• Location: input specific site / location information. The location is  
 limited to 32 characters.

   NOTE 

Click on  icons to get an 
explanation of that software 
feature.

   NOTE 
The Levelogger Edge, which is 
available in F6 (M2), F15 (M5), F30 
(M10), F65 (M20), F100 (M30), F300 
(M100), and F600 (M200) ranges 
has actual water level ranges of  
6.6 ft (2 m), 16.40 ft (5 m), 32.80 ft 
(10 m), 65.60 ft (20 m), 98.40 ft  
(30 m), 328.0 ft (100 m), and  
656.2 ft (200 m), respectively.

   NOTE 
Depending on your Levelogger 
type, there will be different 
programming options.  
See Table 1-1 for the major 
differences. See Section 5.9 for 
programming the Levelogger Gold, 
Barologger Gold, and Levelogger 
Junior.

   NOTE
When first setting up a Barologger 
and Levelogger(s) that will be used 
for the same project, it is suggested 
to set them at the same sampling 
interval, and to use the Future Start 
and Stop options where possible. 
When the data sets have the same 
time stamps, and start and stop 
times, barometric compensation of 
the data will be most accurate. It is 
also useful to synchronize the clocks 
of the dataloggers. See Section 5.4. 
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5.1.1  Setting Up Channel Information

In the lower left portion of the Datalogger Settings tab is the area for setting 
channel parameters (level, temperature, conductivity, rainfall). The software will 
detect the available channels when the datalogger settings are retrieved.

5.1.1.1  Level Channel (Ch1)

• Identification describes the measurement parameter of the channel  
 and has already been configured as ‘LEVEL’. The channel can be  
 re-named to suit each project. The channel monitors water column  
 equivalent pressure. The Identification field will be the channel heading,  
 data column heading and graph line name when viewing the data.  
 Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. There are six  
 options when using a Levelogger Edge or Levelogger Junior Edge,  
 m (default), cm, ft, kPa, bar, and psi. When using a Barologger Edge,  
 the options are kPa (default), mbar, and psi. 
• Offset refers to an adjustment, such as the distance between  
 the tip of the Levelogger and the monitoring well cap or static water  
 level. It is recommended that the value of 0.00 be used, as this  
 keeps all subsequent readings relative to the tip of the Levelogger. The  
 reference range is -1000 to 16,400 ft or -300 m to 5000 m. 

Figure 5-2 Levelogger Edge Channel Setup

   NOTE 
Readings can be converted to other 
units using the Data Wizard.

Readings can be corrected or offset 
with respect to a specific reference 
elevation or datum for a much 
wider spectrum of numeric offsets 
as part of the Data Wizard.

   NOTE 
There is no Offset input option for 
the Barologger Edge.

   NOTE 
Levelogger Edge, Barologger Edge, 
and Levelogger Junior Edge data 
can be adjusted for altitude and 
density post data collection using 
the Data Wizard.

 The LTC Levelogger Junior also has inputs for:

• Altitude in feet or meters above sea level, at which the logger is  
 actually deployed, is input in the altitude field.  You can enter an  
 elevation between -1000 ft below sea level and 16,400 ft  
 (or -300 m and 5000 m) above sea level. The readings will then be  
 automatically compensated for elevation. 
• Density is used to adjust the range of the Levelogger based on the  
 sample fluid density.  The range for the density adjustment is from  
 0.9 kg/L to 1.1 kg/L. 

5.1.1.2  Temperature Channel (Ch2)

• Identification describes the measurement parameter of the channel  
 and has already been configured as 'TEMPERATURE’.  The channel  
 can be re-named to suit each project. The Identification field will be the  
 channel heading, data column heading and graph line name when  
 viewing the data. Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. For the Levelogger  
 Edge, Barologger Edge, and Levelogger Junior Edge, the temperature  
 channel can be set to °C (default) or ºF.

   NOTE 
The LTC Levelogger Junior only 
measures in ºC
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5.1.1.3  Conductivity Channel (Ch3)

• Identification describes the measurement parameter of the channel  
 and has already been configured as 'CONDUCTIVITY'.  The channel  
 can be re-named to suit each project. The Identification field will be the  
 channel heading, data column heading and graph line name when  
 viewing the data. Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. There are two units  
 of measure available for the user to select: mS/cm or µS/cm.

Figure 5-3 Conductivity Channel Setup

   NOTE 
For every degree change in 
temperature, there is approximately 
a 2% change in conductivity. 
To convert raw conductivity 
measurements to Specific 
Conductance measurements, you 
can use the following equation:

Specific Conductance = 
Conductivity / (1 + 0.02 *  
(temp(C) - 25)) 

You can also perform this 
calculation automatically using the 
Data Wizard.

You can also convert Conductivity 
readings to Salinity (expressed in 
Practical Salinity Units (PSU)) using 
the Data Wizard.
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5.1.1.4  Rainloggers

There is one channel of measurement for the Rainlogger Edge and Rainlogger. 
The RainFall Channel records each tip time by the connected tipping-bucket and 
outputs the amount of rainfall per tip (input Rainfall Cal Constant).

• Identification describes the measurement parameter of the channel  
 and has already been configured as 'RainFall'. The channel can be  
 re-named to suit each project. The Identification field will be the  
 channel heading, data column heading and graph line name when  
 viewing the data. Identification is limited to 32 characters.
• Units refers to the channel’s unit of measurement. There are two units  
 of measure available for the user to select: mm or in.
• The Rainfall Cal Constant field allows you to enter the calibration  
 factor for the tipping-bucket you will be using. The calibration factor  
 is the amount of rainfall depth (mm, in) per tip. The calibration factor  
 should be indicated on a label on the tipping-bucket device or in the  
 manufacturer's documentation. Input the calibration factor in mm or  
 inches.

Figure 5-4 Rainlogger Channel Setup
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5.2  Datalogger Information

The Datalogger Information section shows the Status of the attached datalogger 
(i.e.: Started, Stopped, Future Start) and the Start Time and Stop Time of the 
datalogger. When a Future Start and/or Stop time is set (see Section 5.8), the 
Start Time and Stop Time fields will fill in. The fields will update each time the 
datalogger is stopped and started.

5.4  Datalogger Time

The Datalogger Time section provides the controls for setting the datalogger 
clock. If you want to synchronize the datalogger’s clock to the computer clock, 
click Synchronize to set the time in the datalogger. 

If you start the datalogger without synchronizing the clock and the time difference 
between the datalogger and the PC is more than 3 seconds, the software will give 
you a message asking ‘Do you want to synchronize the logger time to system 
time?’.  Click Yes to synchronize the clock. 

It can be very useful to synchronize the clocks of all the Leveloggers and 
Barologgers when it comes to Barometric Compensation.

Figure 5-5 Datalogger Information

Figure 5-8 Datalogger Time

   NOTE 
It is very useful to synchronize the 
clocks of all the Leveloggers and 
Barologgers for use on the same 
project.

5.3  Datalogger Memory

The Datalogger Memory section shows the amount of memory used, and the 
amount of memory remaining (number of readings). 

Figure 5-7 Datalogger Compressed Memory

If the Data Compression option is selected (see Section 5.5), the amount of free 
memory shown is approximated as a visual status bar.

Figure 5-6 Datalogger Memory Remaining

   NOTE 
To synchronize to a different time/
time zone you first must adjust the 
computer time using the Windows 
Operating System Date and Time 
Settings menu. Then re-start the 
Solinst Levelogger Software and 
synchronize your Dataloggers to the 
new time. 
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5.5  Datalogger Sampling Mode

The Datalogger Sampling Mode section allows you to choose the sampling 
measurement type. Options for the Levelogger Edge are Linear, Event Based 
and Schedule.

Linear refers to a set time interval between collection of readings. Sample Rate 
can be any number from 0.125 seconds to 99 hours for the Levelogger Edge. 
There is a data compression option available for the Levelogger Edge. This 
increases the memory capacity of the Levelogger Edge from 40,000 readings to 
up to a maximum of 120,000. Check the Data Compression box to allow data 
compression. 

Data Compression works by only saving data changes in memory.  For example, 
if you have linear sampling set to record each second, and your water level varies 
a little for 60 seconds, the memory will only record incremental values for the 
60 seconds. When your data is exported, it will display all 60 intervals with the 
corresponding level data.

Figure 5-9 Linear Sampling Setup

Event Based sample collection is the most memory efficient means of data 
collection. In Event mode, the Levelogger will be activated at every defined 
‘Sample Rate’ to check if readings have changed by the selected ‘Change’ from 
the last recorded reading. 

For the Levelogger Edge, ‘LEVEL’ or ‘TEMPERATURE’ is the selected parameter 
where change is monitored. The Levelogger will record a new reading only if the 
specified change in the parameter has occurred, at the specific point in time, as 
defined by the ‘Sample Rate’.

A default reading will also be stored in the datalogger memory, every 24 hours 
from the last recording, if no ‘Change’ occurs.

Figure 5-10 Event Based Sampling Setup

   NOTES
The battery life of the Levelogger 
Edge is 10 Years, based on  
1 reading per minute.  More rapid 
readings will reduce the battery 
life. For example, if a Levelogger 
Edge is setup in Continuous Mode 
at a sampling rate of 1 second, 
the battery will be depleted in 
approximately 4 months.

If a Levelogger Junior Edge or 
LTC Levelogger Junior are used 
at a sampling rate of 5 seconds, 
the battery will be depleted in 
approximately 2.5 months.

   NOTES
In Event Based sampling mode, 
the Levelogger Edge has a total 
memory of 25,000 readings of level 
and temperature.

In Event Based sampling mode, 
battery consumption is mainly 
a function of sampling rate.  
Therefore, with a smaller sampling 
interval, battery power will be used 
up quickly whether readings are 
stored or not.

   NOTE 
The LTC Levelogger Junior and 
Levelogger Junior Edge record 
using Linear sampling mode only.  

The Levelogger Junior Edge has a 
sample rate of 0.5 seconds to 99 
hours. The LTC Levelogger Junior 
has a sample rate of 5 seconds to 
99 hours.

   NOTE 
Rainloggers record in Event Based 
mode only. They record the tip 
times of a connected tipping-
bucket. 
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Schedule Sampling allows you to select a logarithmic style sampling schedule 
adapted to the needs of each application. 

Schedule Sampling is set by using the plus and minus buttons to add or subtract 
line items in the Schedule window. The maximum number of line items in a 
schedule is 30, each with its own sampling interval of seconds, minutes or hours 
and duration of seconds, minutes, hours, days or weeks. A 'Pause' interval can 
also be selected, which stops the Levelogger from recording for the specified 
duration.

Running totals of the number of readings still available, from the total possible 
40,000 or 120,000, and the run time to date are shown.  If the number of 
readings selected exceeds the Leveloggers memory capacity an error message 
appears.  

By checking Repeat, the Levelogger will continue to run through the schedule 
until its memory is full, or it is stopped.

Figure 5-11 Schedule Sampling Setup

   NOTE 
A schedule can be saved and 
applied to other Leveloggers, 
or a Leveloader, by saving the 
Levelogger Settings file  
(see Section 5.7).

5.6  Datalogger Memory Mode

Datalogger Memory Mode selection will only appear when Linear sampling 
mode is selected. When using a Levelogger Edge in Linear Mode, there is a 
choice of Continuous Logging (wrap around) or Slate Logging .  

Compressed Linear, Event Based and Schedule sampling modes can only use 
the Slate Mode option. 

In Continuous Logging, the new log is started at the end of any previous log and 
continues logging, eventually recording over the first logged data.  As one of the 
download options is to ‘Append Data’, Continuous Logging can be a preferred 
choice when logging long-term (see Section 7.1.2). 

In Slate Logging, the new log is also started at the end of any previous log, but 
will stop recording after 40,000 readings (or up to 120,000 readings), so that 
the beginning of the current log will not be written over.

Figure 5-12 Datalogger Memory Mode 

   NOTE 
Datalogger Memory Mode is only 
available for Levelogger Edge and 
Levelogger Gold units using Linear 
Sampling.

Levelogger Junior Edge and LTC 
Levelogger Junior operate in Slate 
logging mode only.
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5.7  Saving and Retrieving Levelogger Settings Files

To store settings as defaults, click . It will store the settings of the 
Levelogger into an *.dtf file as a series of defaults. The *.dtf file will save the 
Project ID, Location, Sample Mode, Sample Rate, Channel ID, Unit, and Offset. 

To retrieve settings from defaults, click  from a selected *.dtf file. This is 
particularly useful if programming several Leveloggers with similar identical 
settings. Keep in mind that Project ID and Location identification information 
will be identical and should be distinguished from logger to logger or monitoring 
point to point.

5.8  Starting and Stopping the Datalogger

Starting the Datalogger

There are two ways to start logging: Start Now or by programming a Future 
Start time.

To start logging immediately, do not fill in a Future Start time and click, .  
It should say Start Now below the icon to indicate an immediate start. Any 
changed settings will automatically be applied to the datalogger, and it will start 
logging. Datalogger Status will change from Stopped to Started.  

After the datalogger is started, and begins collecting readings, the Start icon will 
be greyed out, and only the Stop icon and Future Stop settings will be active. 

Figure 5-13 Starting the Datalogger Immediately

   NOTES
If a setting has been changed, it 
will be highlighted in yellow as a 
reminder before the datalogger is 
started.

If a setting has been entered 
incorrectly, it will be highlighted 
in red.

Changed settings are applied to the 
datalogger automatically when the 
Start icon is selected.

   NOTE 
Remember to download any data 
on the datalogger before starting 
a new session. When starting a 
new  logging session, any data from 
previous recording sessions will be 
erased. 

Figure 5-14 Future Start Setting

Check Future Start 'At' to set logging to start at a later date and/or time. This 
Start mode is referred to as Future Start in the Status field. Click to apply 
the Future Start time and any changes to the datalogger settings.

When the Future Start time is reached, the datalogger will start logging and the 
Status will change from Future Start to Started.

   NOTE 
Settings files created in Levelogger 
Software  Version 3 or earlier (.lls 
or .sci files) can not be opened by 
Software Version 4. These settings 
files will need to be re-created 
and saved in Levelogger Software 
Version 4. 

   NOTE 
Retrieve the Levelogger settings in 
order to refresh the status (i.e. when 
the status changes from Future Start 
to Started).
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Stopping the Datalogger

There are two ways to stop logging: Stop Now or at a programmed Future Stop 
time for the Levelogger Edge and Barologger Edge.

To stop the datalogger immediately when it is logging, click , (it should 
say Stop Now below the icon).

The Levelogger can be stopped at any time before it reaches the maximum 
reading capacity.  Starting again begins a new recording session and clears 
previously stored data readings.

Figure 5-16 Future Stop Setting

   NOTE 
If you have set a Future Stop time, 
but wish to stop the datalogger 
immediately, uncheck the Future 
Stop 'At' box, and the Stop icon 
should say Stop Now. Click the icon 
to stop logging.

To program a Future Stop time for your datalogger, check Future Stop 'At' and 
fill in the desired stop time. The Future Stop time will be applied to the datalogger 
once is selected for an immediate or future start. 

You can also program a Future Stop time after you have started the datalogger, 
by checking Future Stop 'At' and filling in the desired stop time. Select to 
apply the Future Stop time (it should say Future Stop below the icon).  
The Stop Time should be shown in the Datalogger Status section.

It is critical to note that when Leveloggers log data in Slate mode, it means they 
will record data until stopped or their memory is full. When the memory fills, 
the datalogger will stop recording.  For this reason, it is important to determine, 
based on your start time and sampling rate, the date and time at which the 
memory will be full and the datalogger will stop recording. Levelogger Edge units 
record in Slate mode if Event, Schedule, or Compressed logging, but in standard 
Linear mode they can be set to Slate or to Continuous logging.

Figure 5-15 Stopping the Datalogger Immediately

   NOTE 
You can not set a Future Stop time 
for the Levelogger Junior Edge, 
LTC Levelogger Junior or a 
Rainlogger.
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5.9  Levelogger Gold Series Setup

This section briefly describes the Levelogger Gold, Barologger Gold and 
Levelogger Junior setup.

Figure 5-17 Levelogger Gold Settings 

Select the appropriate COM or USB Port for the connected communications 
device from the centre drop-down menu. 

Click
 

 to retrieve the current settings from the connected datalogger.  

Channel Information

Level Channel (Ch1)

• Identification describes the measurement parameter of the channel 
 and has already been configured as 'LEVEL’.  The channel can be  
 renamed to suit each project.  The channel monitors water column  
 equivalent pressure.  The Identification field will be the channel  
 heading,  data column heading and graph line name when viewing the  
 data.  The Identification is limited to 32 characters.
• Units refers to the channel’s units of measurement. There are three  
 units of measure available for the user to select: cm, m or ft.  When  
 the user changes the unit, the value of the range and altitude will  
 change according to the Unit Conversion formula.  Note that when a  
 metric unit is used, the unit of altitude is meters. When feet are the  
 level channel units, feet are the units of altitude.

   NOTE 

Click on  icons to get an 
explanation of that software 
feature.
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• Offset refers to an offset correction, such as the distance between the  
 tip of the Levelogger and the monitoring well cap or static water level.   
 It is recommended that the value of 0.00 be used for offset as this  
 keeps all subsequent readings relative to the tip of the Levelogger. The  
 offset range for Levelogger Gold and Barologger Gold units is -1000 to  
 16400 ft or -300 m to 5000 m. 
• Altitude in feet or meters above sea level, at which the logger is  
 actually deployed, is input in the altitude field.  Water column  
 equivalent pressure decreases with altitude at a rate of approximately  
 1.2:1000 in the lower atmosphere below 5000 m.  You can  
 compensate for this by entering an elevation between -1000 ft below  
 sea level and 16,400 ft (or -300 m and 5000 m) above sea level. The  
 readings will then be automatically compensated for elevation.
• Density Adjustment is used to adjust the range of the Levelogger  
 based on the sample fluid density.  The range for the density   
 adjustment is from 0.9 kg/L to 1.1 kg/L.

Temperature Channel (Ch2)

• Identification describes the measurement parameter of the channel  
 and has already been configured as 'TEMPERATURE’.  The channel  
 can be re-named to suit each project. The Identification field will be the  
 channel heading, data column heading and graph line name when  
 viewing the data. Identification is limited to 32 characters.
• Unit refers to the channel’s unit of measurement. The Levelogger  
 Gold and Barologger Gold measure in ºC only.

Sample and Memory Modes

Sample Mode, allows you to choose the sampling measurement type. Options 
are Linear, Event Based and Schedule.

• Linear refers to a set time interval between collection of readings.  
 Sample Rate can be any number from 0.5 seconds to 99 hours.  
 The Levelogger Gold and Barologger Gold can store 40,000 readings  
 of level and temperature. 
• Event Based sample collection is the most memory efficient means  
 of data collection. In Event mode, the Levelogger will activate every  
 sampling interval defined and check if readings have changed by the  
 selected threshold (Change) from the last recorded reading. For the  
 Levelogger Gold, 'LEVEL' or 'TEMPERATURE' is the selected  
 parameter where change is monitored. The Levelogger will record a  
 new reading only if the specified change in the parameter has  
 occurred.
• Schedule Sampling allows you to select a logarithmic style sampling  
 schedule adapted to the needs of each application. Schedule Sampling  
 is set by using the plus and minus buttons to add or subtract line  
 items in the Schedule window. The maximum number of line items in  
 a schedule is 30, each with its own sampling interval of seconds,  
 minutes or hours and duration of seconds, minutes, hours, days or  
 weeks. 

   NOTE 
In Event Based sampling mode, 
the Levelogger Gold has a total 
memory of 25,000 readings of level 
and temperature

   NOTE 
An important reminder for Event 
Based sampling is that, although 
actual memory usage in stable 
water level conditions may be 
relatively small, battery power 
consumption is partially a function 
of the sample reading rate.  
Therefore, a small sample reading 
interval will consume battery power 
at a higher rate whether readings 
are stored or not.

   NOTE 
The Levelogger Junior records 
using Linear sampling mode only.  
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Memory Mode selection will be grayed-out if not in Linear Mode sampling. 
When using a Levelogger Gold in Linear Mode, there is a choice of Continuous 
logging (wrap around) or Slate logging. In Continuous logging the new log is 
started at the end of any previous log and continues logging, eventually recording 
over the first logged data.  As one of the download options is to ‘Append Data’, 
Continuous logging can be a preferred choice when logging long-term.  In Slate 
logging the new log is also started at the end of any previous log, but will stop 
recording after 40,000 readings, so that the beginning of the current log will not 
be written over.

Starting and Stopping the Levelogger

There are two ways to start logging: Start Now or by programming a Future 
Start time.

To start logging immediately, do not fill in a Future Start time and click, .  
It should say Start Now below the icon to indicate an immediate start. Any 
changed settings will automatically be applied to the datalogger, and it will start 
logging. Datalogger Status will change from Stopped to Started.  

After the datalogger is started, and begins collecting readings, the Start icon will 
be greyed out, and only the Stop icon and Future Stop settings will be active. 

Check Future Start 'At' to set logging to start at a later date and/or time. This 
Start mode is referred to as Future Start in the Status field. Click to apply 
the Future Start time and any changes to the datalogger settings.

When the Future Start time is reached, the datalogger will start logging and the 
Status will change from Future Start to Started.

To stop the datalogger immediately when it is logging, click , (it should 
say Stop Now below the icon).

The Levelogger can be stopped at any time before it reaches the maximum 
reading capacity.  Starting again begins a new recording session and clears 
previously stored data readings.

It is critical to note that when Leveloggers log data in Slate mode, it means they 
will record data until stopped or their memory is full. When the memory fills, the 
datalogger will stop recording.  For this reason, it is important to determine, based 
on your start time and sampling rate, the date and time at which the memory will 
be full and the datalogger will stop recording. Levelogger Gold units record in 
Slate mode if using Event, or Schedule sampling mode, but in standard Linear 
mode they can be set to Slate or to Continuous logging.
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6  Conductivity Calibration

The LTC Levelogger Junior conductivity sensor must be calibrated for reliable 
conductivity measurements. Calibrate for conductivity at the start of each new 
monitoring project or at a minimum each new monitoring season (twice a year).

Calibrating the LTC Levelogger Junior directly after the monitoring project or 
season will provide information on the degree of conductivity deviation during 
the project or season. If necessary, readings can be corrected for any conductivity 
deviation in a spreadsheet program after the data has been exported. 

The process of conductivity calibration is performed automatically by use of the 
Calibration Wizard. You place the LTC Levelogger Junior in a specified calibration 
solution and follow the steps provided by the wizard. Conductivity calibration 
solutions are available from Solinst or any laboratory supply outlet. 

The LTC Levelogger Junior has an 80,000 µS/cm conductivity range 
and a calibrated range from 500 to 50,000 µS/cm. It can be calibrated to  
3 calibration standard points:

• 1,413 µS/cm
• 5,000 µS/cm
• 12,880 µS/cm 

If you know the approximate conductivity range of the water that you will be 
measuring, best accuracy when calibrating your unit is to select two calibration 
points - one above, and one below that range. A two point calibration provides a 
greater % accuracy than a three point calibration. 

The solution(s) must be between 10ºC and 30ºC during actual calibration. 
Temperature should remain stable during the 10 - 20 seconds it takes to perform 
each calibration.

For best accuracy, it is recommended you use calibration solutions that have a 
temperature error of ±2% or better. You should also keep the solution as close to 
the stated temperature on the bottle as possible (i.e. 25ºC). The closer you get to 
the temperature extremes of 10ºC and 30ºC, the less accurate your calibrations 
may be.

Figure 6-1  
LTC Levelogger Junior

   NOTE 
If you know the approximate 
conductivity range of the water 
that you will be measuring, best 
accuracy when calibrating your 
unit is to select two calibration 
points - one above, and one below 
that range. A two point calibration 
provides a greater % accuracy than 
a three point calibration.
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   NOTE 
Ensure that the calibration solution 
covers the entire sensor cell and 
the logger is agitated to release 
entrapped air bubbles.

Retrieve the settings from the attached LTC Levelogger Junior by clicking .

Stop the LTC Levelogger Junior by clicking . 

Start the Calibration Wizard by clicking the Conductivity Cal tab. The wizard will 
guide you through the calibration process. You can exit the wizard after any step 
to cancel the calibration session. 

Introduction: The LTC Levelogger Junior must be connected to the computer 
with an Optical Reader during the entire calibration process and must be in 
the stopped mode. Ensure you use fresh calibration solution and allow thermal 
equilibration of the solution during the process. Also ensure no air bubbles 
are present on the sensor and that the pins are clean. See Section 10.2 for 
recommended methods to clean the sensor pins. See Section 10.1.5.3 for 
protection against biofouling conditions.

Figure 6-2 LTC Levelogger Junior Calibration Wizard Introduction
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1) Setting the Temperature Coefficient: The default setting for the Temperature  
 Coefficient is 2.00.  If the conductivity solution you are using to calibrate the LTC  
 Levelogger Junior states a different temperature coefficient on the label, please  
 input that number into the Temperature Coefficient field.

Figure 6-3 LTC Levelogger Junior Calibration Wizard Step 1

2) Setup: The Levelogger Software requires the user to choose the calibration  
 solutions. You can choose up to three solutions for a multipoint calibration of the  
 LTC Levelogger Junior.  Ensure the solutions are ready in the calibration beaker  
 or container. Start the calibration by selecting Next.

Figure 6-4 LTC Levelogger Junior Calibration Wizard Step 2

   NOTE 
By selecting more than one 
solution, you will be performing a 
multipoint calibration.
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Calibration: Since most standard calibration solutions state conductivity at 
a standard temperature of 25ºC, the LTC Levelogger Junior can account for 
temperature differences between 10 to 30ºC when you calibrate the unit. The 
LTC Levelogger Junior will compare the current temperature and conductivity 
readings against the temperature corrected standard solution. 

3) LTC Levelogger Junior Rinsing Process: Use DI water to rinse the  
 LTC Levelogger Junior first and then rinse the LTC Levelogger Junior with the  
 displayed calibration solution. Use fresh solution for calibration, and immerse the  
 LTC Levelogger Junior. Lightly tap the Levelogger to remove any bubbles from  
 the sensor. Allow 2-3 minutes to stabilize, then select next to calibrate.

Figure 6-5 LTC Levelogger Junior Calibration Wizard Step 3  
(example of window calibrating with 1413 µS/cm solution)

   NOTE 
Always remember to use fresh 
solution, remove all bubbles from 
the sensor pins, and allow for 
thermal equilibration of the sensor 
before proceeding.

   NOTE 
Once the calibration is complete 
for the first solution of a multipoint 
calibration, the Calibration Wizard 
will then go back to the beginning 
of Step 3 to start the rinsing process 
for the next solution selected.

Figure 6-6 LTC Levelogger Junior Calibration Successful
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When a single-point calibration is successful, the process is complete. Once the 
calibration is complete for the first solution of a multipoint calibration, a message 
will appear stating that the calibration was successful. When you select 'Okay', 
the Calibration Wizard will go back to the beginning of Step 3 to start the rinsing 
process for the next solution selected. The calibration process will proceed 
automatically until completed for all solutions. 

If a failure occurs at any point during calibration, a message will appear asking 
you to clean and check your probe, then start the calibration process over for 
that current solution by selecting 'Yes' (Figure 6-7). If performing a multipoint 
calibration, any previous successful calibration points will remain. 

Figure 6-7 LTC Levelogger Junior Calibration Warning 1

If a second failure occurs during calibration, a warning message will appear 
indicating that your probe may still be dirty, or damaged. This may occur if 
your LTC Levelogger Junior conductivity sensor has been affected by dirt, 
mineral build-up, etc., so it no longer responds like it did when it was first factory 
calibrated. This step allows your sensor to be calibrated within a wider range of 
the standard solution value. 

Figure 6-8 LTC Levelogger Junior Calibration Warning 2
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6.1  Restore Factory LTC Levelogger Junior Calibration

An LTC Levelogger Junior can be set back to original factory calibration 
settings for conductivity at any time, using this function. If you suspect that user 
calibrations are not working properly, you can restore the LTC Levelogger Junior 
to its original factory settings and then perform a "first-time" conductivity user 
calibration to maximize accuracy.

To execute this function, simply click the Restore Factory LTC Calibration button, 
 with the LTC Levelogger Junior connected to the PC.

If you select 'Yes' to accept the larger tolerance, the calibration process will start 
over for that current solution (Figure 6-8). If performing a multipoint calibration, 
any previous successful calibration points will still remain. If you select 'No', the 
LTC Levelogger Junior will default back to the last pre-calibrated state. You can 
retry the calibration using the normal tolerance range.

If a third calibration error occurs, or the results of the calibration are outside 
the error tolerance range, a warning message will appear asking you to contact 
Solinst for more options (Figure 6-9).

Figure 6-9 LTC Levelogger Junior Calibration Warning 3
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7  Data Control
(Downloading and Viewing Data)

Click the Data Control tab on the Main window. From the Data Control tab you 
can download data from a Levelogger, display data in tabular or graphic format, 
and save and export data files.

Figure 7-1 Data Control Tab

Click to open a *.xle or *.lev file. Multiple files can be opened at the same 
time and are available for viewing by clicking the File Name Tab on top of the data 
table. 

All the Levelogger settings and the channel information effective during data 
collection are shown on the top left of the window.  

The bottom left sections of the window are used to display information after a 
data compensation has been performed. The middle section displays information 
from a Barologger, if a barometric compensation is performed, and the bottom 
section includes information from other conversions, such as offsets or conductivity 
conversions (see Section 8).

   NOTE 
When you click on a data point 
in the graph, the corresponding 
data  point will be highlighted in 
the table. You can also highlight a 
section of data in the graph.
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Figure 7-2 Rainlogger Data

When you view data downloaded from a Rainlogger, the RainFall data will be 
shown in a table and in a bar graph. A drop-down menu appears that allows you 
to select the time interval at which you would like the data shown, from 1 to 99 
seconds, minutes, hours, days, or weeks (this acts like a zoom function). Figure 
7-2 shows the data every 5 seconds from the start date and time.

7.1  Downloading Options and Saving Data Files

7.1.1  Default File Format

The default file type for Levelogger Software Version 4 and up is *.xle, unless 
changed to *.lev in the Application Settings (see Section 4.2.4). Previous 
Levelogger Software used *.lev files as the default. The *.xle file type is a *.xml 
format, which allows for enhanced functionality. The *.xle files can be exported 
as *.xml files, which can be integrated into external database programs.  

The *.lev files of previous Levelogger downloads are compatible with Levelogger 
Software Version 4 and up, however, *.xle files are not compatible with previous 
software versions. To ensure compatibility, all Levelogger Software versions allow 
data to be exported as *.csv files for use in external spreadsheet programs. See 
Section 7.3 for Export options.

   NOTE 
As there is only one channel of 
data for Rainloggers, there are no 
graphing options.

   NOTE 
The default file type is *.xle, unless 
changed in the Application Settings 
(see Section 4.2.4).
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   NOTE 
Before downloading data you 
must select the COM Port that 
the datalogger is connected to 
and retrieve the settings from the 
attached datalogger by clicking  
              in Datalogger Settings tab.

7.1.2  Downloading Data

Click from the Data Control tab to download data from a connected 
datalogger. There are four options for downloading data. They are: All Data, 
Append Download, Partial Download and Recover Previous Log. 

If you select All Data, the program will download all the data from the current 
logging session of a datalogger into a *.xle file. 

The default directory for saved data is in the ‘Data’ folder:  
<C:\Program\Files\Solinst\Levelogger4_1\Data>. 

If you select Append Download, the program will append the data in an opened 
*.xle file from the datalogger. The opened *.xle file and the attached datalogger 
should have the same serial number and start time, otherwise an error will occur.

If you select Partial Download, a Partial Download Selection Window will open. 
The window shows the time stamp of the first and last reading in the logging 
session. Use the slider to select the time interval you would like data from. Once 
you click OK, all the data within that time will be downloaded to a *.xle file. 

If you select Recover Previous Log, the software will try to recover the data from 
the previous log session and download the data to a *.xle file.

Once the data is downloaded from a Levelogger, it is automatically saved in a 
temporary file.  

Figure 7-3 Partial Download Window
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   NOTE 
Right click, and drag the mouse to 
scan the data graph.

The Line Option is used to adjust the style and colour of the line in the graph for 
each channel. The user can also select the shape of the data marker or remove 
the data marker.

Figure 7-5 Line Option Window

7.1.3  Saving Data

Click to save the data in a specific *.xle file. 

The default directory for saved data is in the ‘Data’ folder:  
<C:\Program\Files\Solinst\Levelogger4_1\Data>. 

However, the default directory for saved files can be changed by clicking the 
Configuration menu at the top of the program window, selecting ‘Application 
Settings’ and inputting or navigating to a different folder destination. If an error 
is experienced in saving your first data file such as depicted in Figure 7-4, you 
may not have file writing privileges to the default directory.  It this case, create 
and set as the default file save folder, a new Levelogger data folder within the  
My Documents folder and attempt the file save procedure again.

7.2  Graph Manipulation and Zoom Function

To perform the Zoom In function on the graph, click . 

To perform a Zoom Out function on the graph click . Click to undo  
all the zoom functions.

The Zoom functions can also be used for data selections in the graph.

Click to open the Graph Option Dialog. The Graph Dialog is shown in 
Figure 7-5.

Figure 7-4 File Write Error Message

   NOTE 
As there is only one channel of 
data for Rainloggers, there are no 
graphing options.
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Figure 7-7 Combined and Separated Plot Graphs

The Title and Axis Option is used to enter the title of the graph and change the 
Y axis label or user selected scale. Check the Best Fit box to enable the software 
to determine the best fit scale. If the Best Fit box is not checked, the user has 
to enter a maximum and minimum value of the selected channel. The X axis is 
logging time.

There is the option to show Combined Plot graphs or Separated Plot graphs of 
the data. Choosing a Combined Plot will show the data from each of the channels 
in one graph. The Separated Plot option will show a separate graph for each data 
channel. 

Figure 7-6  Title and Axis Option Window
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Figure 7-8 Viewing Two Graphs

There is also the option to view more than one graph at a time. Click and drag a 
File Name Tab and drop it when you see a shaded area on the window to open a 
separate graph of that data file. You can view any number of graphs at one time 
by re-sizing your window as required.
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7.3  File Export and Print Function

Data can be exported in *.csv (comma separated value) file format or *.xml 
(extensible markup language) file format by clicking File > Export > Data or 

The *.csv and *.xml file formats are supported and can be imported by most 
spreadsheet and database programs.

Also, the data graph can be exported to a *.bmp file or a *.wmf file by clicking 
File > Export > Graph. 

The Datalogger Settings, data table and data graph can be printed. Click File > 
Print Preview, to open the Print Preview window. Figure 7-9 shows the print 
preview of the Datalogger Settings. The Datalogger Settings are always on the 
first page of the document. The data graph is on the second page of the document 
and the rest of the document is the data table. 

Click Print..., to open the print dialog. You can choose to print the entire document 
or just a selection. You can also click File > Print, to open the print dialog.

Figure 7-9 Print Preview Window
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8  Data Compensation

Data Compensations, such as Barometric Compensation, Manual Data 
Adjustments and Parameter Adjustments can be performed automatically using 
the Levelogger Software Data Wizard, or manually, by exporting data to an 
external spreadsheet program.

8.1  Data Wizard

Open the Data Wizard tab. The first step is to select your Data Compensation 
Path. The choices are Basic or Advanced. 

Choosing Basic allows you to do a simple Barometric Compensation of 
Levelogger data only. 

The Advanced option allows you to perform Barometric Compensation, 
Manual Data Adjustments and Parameter Adjustments, including adjustments to 
Rainlogger data. 

Figure 8-1 Data Wizard

   NOTE 
Multiple datalogger files can be 
compensated at once.
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   NOTE 
Manual Data Adjustment,  and 
Parameter Adjustments are useful 
for correcting Levelogger data files 
to make data consistent across a 
project.  

Barometric Compensation simply subtracts the barometric reading from the 
corresponding Levelogger reading(s), to give true water level measurements.

Manual Data Adjustment allows you to enter a manual water level measurement 
or reference point as a field zero, which all Levelogger water level readings can 
then be adjusted to. There is the option to convert readings to Depth to Water 
Level measurements (e.g. from the top of a well casing to water level), or Elevation 
of Water Level measurements (e.g. above sea level).

Parameter Adjustments allow you to change Levelogger, Barologger or 
Rainlogger data to different units of measurements, add an offset, correct data for 
elevation differences, convert conductivity to Salinity or Specific Conductance, 
adjust density, or adjust barometric efficiency. Only the options available for your 
opened datalogger file types will be active (e.g. Conductivity Conversion is only 
available for LTC Levelogger Junior data files).

 Standard Adjustments:

• Unit conversion allows you to convert level readings in a Levelogger  
 file to different units (m, cm, ft, kPa, bar or psi), a Barologger file to  
 kPa, mbar, or psi, temperature readings to ºC or ºF, conductivity  
 readings to µS/cm or mS/cm, or rainfall values to mm or inches.
• Offset allows you to enter any value, positive or negative, which will  
 be added to each reading in the selected Levelogger file to be offset by  
 that amount. It is recommended to stay with the default zero value,  
 unless a known offset has been determined (e.g. to correct for pressure  
 sensor drift. See Solinst Technical Bulletin: Understanding Pressure  
 Sensor Drift).
• Elevation is used to correct for altitude differences between Levelogger  
 or Barologger locations. Water column equivalent pressure decreases  
 with altitude at a ratio of approximately 1.21/1000 in the lower  
 atmosphere below 5000 m. You can compensate for this by entering an  
 elevation between -1000 ft below sea level and 16,400 ft (or -300 m  
 and 5000 m) above sea level.
• Conductivity Conversion allows you to convert raw Conductivity  
 readings from an LTC Levelogger Junior, to Specific Conductivity  
 (conductivity that is temperature compensated to the standard of  
 25ºC). The Temperature Coefficient default for Specific Conductivity  
 is 2.00. The Temperature Coefficient should not be adjusted, unless  
 you know the value specific to the solution you are measuring. You  
 can also convert Conductivity readings to Salinity expressed in Practical  
 Salinity Units (PSU) (See Section 1.2.4).
• Rainfall Cal. Constant allows you to enter a different rainfall  
 calibration constant for a Rainlogger Edge or Rainlogger data file  
 (amount of rainfall per tip of the tipping-bucket rain gauge).

 Additional Adjustments:

• Density Adjustment corrects the range of the level channel in the  
 Levelogger data file based on a user input adjustment of fluid density.  
 The range of the density adjustment is from 0.9 kg/L to 1.1 kg/L.
• Barometric Efficiency adjustment is used to proportionally adjust  
 Barologger data in relation to a particular Levelogger. Barometric  
 efficiency is often expressed as a percentage or proportion. The input  
 field is proportional and has a default value of 1.00. For more  
 information about Barometric Efficiency, see Section 10.1.3.1.  The  
 barometric efficiency can be set from 0.01 to 3.00.

   NOTE 
Advanced compensation provides 
the option of performing one, two, 
or all three data compensation 
types, in any combination.

   NOTE 
Parameter Adjustments is the 
only option for compensating 
Rainlogger data.

   NOTE 
Additional Adjustments appear 
when “>>” is selected. These are 
application specific, for advanced 
users. 
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8.1.1  Basic Compensation

When you choose Basic compensation, the next step is to select the Barologger 
file you want to use for compensation, then select the Levelogger file(s) you want 
to compensate. You can only select one Barologger file to compensate multiple 
Levelogger files. 

For best accuracy, the Levelogger file(s) and Barologger file should have 
the same start time and logging interval. (The Future Start option in the 
Datalogger Settings tab is a convenient way to start all of your loggers at the 
same time.) If there is an inconsistency of the time stamp between the Barometric 
file and the Levelogger file(s), a linear approximation on the barometric data will 
be performed. 

   NOTE 
One Barologger can be used to 
compensate all Leveloggers in a 
20 mile (30 km) radius and/or with 
every 1000 ft. (300 m) change in 
elevation.

Figure 8-2 Selecting Files for Barometric Compensation

Any files you have open in the Data Control tab will be listed. 

Use the directory on the left of the window or click  to open any other 
Levelogger data files you would like to compensate. Ensure the files you want to 
compensate are highlighted in the list. Do this by clicking the file name. To de-
select a file, click it again. Multiple Levelogger files can be selected at once.

Select Next to complete the compensation. 

The compensated data will automatically be saved in a new *.xle file. The 
default file name will be the <original Levelogger file name> with the word 
<compensated> added to the file name prefix. Alternatively, the user can 
rename the compensated file by saving it in the Data Control tab. Do not 
change or delete the file extension. All data files are saved to the default location:  
<C:\Program Files\Solinst\Levelogger4_1\Data>.

   NOTE 
All data files are saved to the default 
location: <C:\Program Files\Solinst\
Levelogger4_1\Data>. However, 
the default directory for saved files 
can be changed by clicking the 
Configuration menu at the top of 
the program window, selecting 
‘Application Settings’ and inputting 
or navigating to a different folder 
destination. 
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From the Data Control tab, you can view the data, save the compensated file with 
a new filename and/or export the data (see Section 7). 

All the original Levelogger settings and the channel information effective during 
data collection are shown on the top left of the window. The bottom left sections 
of the window are used to display the compensation information. The middle 
section displays information from the Barologger.

Figure 8-3 Barometric Compensation Results

Figure 8-4 Viewing Compensated Files in the Data Control Tab

The next window will show the results of the compensation. If the compensation 
was unsuccessful, there will be an explanation in the Reason column (e.g. time 
stamp of Levelogger and Barologger files were not close enough to perform 
an accurate compensation). You can still view the compensated file in the Data 
Control tab by clicking ‘Open’ in the Action column. If the compensation is 
successful, select ‘Open’ to view the compensated file in the Data Control tab. 
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8.1.2  Advanced Compensation

When you select Advanced compensation, the Data Compensation Options 
window will open. 

Figure 8-5 Advanced Data Compensation Options

First, you will select how you want your data displayed (Manual Data Adjustment):

• Height of Water Above Sensor is the default display option. Select  
 this option to perform a Barometric Compensation and/or Parameter  
 Adjustments to one or more data files, while keeping the sensor  
 diaphragm (zero point) as the reference point.
• Depth to Water Level adjusts water level data to represent depth to  
 water level readings (from the top of a well casing or other  
 reference point) by entering a field zero, such as a manual depth to  
 water level measurement. Adjustments can be made to one or more  
 data files. 
• Elevation of Water Level adjusts water level data to represent  
 elevation of water level readings (above sea level or other reference  
 point) by entering a measuring point elevation, and a field zero,  
 such as a staff gauge measurement from that point. Adjustments can  
 be made to one or more data files.
• Parameter Adjustments Only allows you to adjust one or more data  
 files to different units, elevation, etc., while keeping the sensor  
 diaphragm (zero point) as the reference point for Leveloggers. It also 
 allows you to change Rainlogger data file parameters. 

Next, you will select Yes or No to Barometrically Compensating the data (will 
not be active if you selected Parameter Adjustments Only).

Next, you will select Yes or No to performing any Parameter Adjustments on 
the data files (will not be active if you selected Parameter Adjustments Only).

Click Next, after you have selected all of your Data Compensation options. 

   NOTE 
Parameter Adjustments Only, is 
the only option for compensating 
Rainlogger data.
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   NOTE 
See Section 8.1.1 for more 
information on selecting files for 
Barometric compensation.

In the next window, you will choose the Levelogger file(s), Rainlogger file(s), and 
Barologger file(s) you would like to use in the compensation. Any files you have 
open in the Data Control tab will be listed. 

Use the directory on the left of the window or click  to open any other data 
files you would like to compensate. Ensure the files you want to compensate are 
highlighted in the list. Do this by clicking the file name. To de-select a file, click 
again. Select Next to continue.

Figure 8-6 Selecting Files for Compensation

If you have selected yes to Parameter Adjustments, or selected the Parameter 
Adjustments Only option, in the next window you will enter these. You can 
expand the window by clicking “>>” to show additional adjustment options. If you 
did not select to change any parameters, this window will not be shown.

Figure 8-7 Parameter Adjustments

   NOTE 
When adjusting Units for 
Levelogger files or Rainlogger files, 
If you select apply to all, the same 
unit change will be applied to all 
of the files being compensated at 
that time.

   NOTE 
To show Additional Parameters that 
can be adjusted, click on the “.>>” 
icon.
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Next, for each selected Levelogger file, you will enter the Field Zero(s) you would 
like to use to manually adjust your Levelogger data. (If you have selected Height 
of Water Above the Sensor or Parameter Adjustments Only, this window will 
not be shown.)

For Depth to Water Level adjustments, enter a Field Zero (A). If the static water 
level is below your Field Zero measurement, the Field Zero is input as a positive 
value (e.g. a manual water level meter measurement taken from the top of a well 
casing. See Example 8.1). If the static water level is above your Field Zero, the 
Field Zero is input as a negative value (such as in an artesian condition).

The Time the Field Zero measurement was taken must replace an actual reading 
in the Levelogger file. This is selected from the drop-down menu showing all time 
stamps in the Levelogger file. Click ‘Add’ to apply the adjustment. If you need to 
change a Field Zero, click ‘Update’ after any edits.

Figure 8-8 Manual Data Adjustment - Depth to Water Level

Example 8.1 Depth to Water Level Adjustment

When using a manual depth to water measurement taken from the top of a 
well casing as a Field Zero, enter it as a positive value (e.g. 10 m). 

In your adjusted data file, your readings will increase in value as the water 
level decreases. This is because the depth to static water level from the top 
of the well casing is increasing. The adjusted readings will decrease in value 
as the static water level rises. 

   NOTE 
The date and time of measurement 
of the Field Zero must be recorded 
to complete the adjustment. 
The Field Zero must replace an 
actual reading the Levelogger file. 
I.e. take a manual measurement 
immediately after starting the 
Levelogger, and note that time. .

Original Levelogger Data
(barometrically compensated 
height of water above sensor)

8.75 m 8.50 m 8.75 m 9.0 m 9.25 m

Adjusted Levelogger Data  
(depth to water)

(A) 10.0 m 10.25 m 10.0 m 9.25 m 9.0 m
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The Time the Field Zero measurement was taken, must replace an actual reading 
in the Levelogger file, and is selected from the drop-down menu showing all time 
stamps in the Levelogger file. Click ‘Add’ to apply the adjustment. If you need to 
change a Field Zero, click ‘Update’ after any edits.

You can make multiple adjustments to one data file by selecting ‘Add’ again to 
enter another Field Zero. All readings after this Time, will be adjusted to this 
second measurement. You can add as many adjustments to one Levelogger data 
file as you would like (as long as it doesn't exceed the total number of readings in 
that file).

Select Next to complete the compensation. 

   NOTE 
The date and time of measurement 
of the Field Zero must be recorded 
to complete the adjustment. 
The Field Zero must replace an 
actual reading the Levelogger file. 
I.e. take a manual measurement 
immediately after starting the 
Levelogger, and note that time. .

Figure 8-9 Manual Data Adjustment - Elevation of Water Level

For Elevation of Water Level adjustments, enter a Measuring Point Elevation 
(A) and a Field Zero (B) from that Measuring Point. 

If the static water level is below your Measuring Point, the Field Zero is input as 
a positive value  (e.g. if you are using a manual depth to water measurement as a 
Field Zero, from the top of a well casing as the Measuring Point).

If the static water level is above your Measuring Point, the Field Zero is input as a 
negative value (such as an artesian condition). The Measuring Point elevation may 
also be entered as a negative value.
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Figure 8-10 Advanced Data Compensation Results

   NOTE 
All data files are saved to the default 
location: <C:\Program Files\Solinst\
Levelogger4_1\Data>. However, 
the default directory for saved files 
can be changed by clicking the 
Configuration menu at the top of 
the program window, selecting 
‘Application Settings’ and inputting 
or navigating to a different folder 
destination. 

The compensated data will automatically be saved in a new *.xle file. The 
default file name will be the <original Levelogger file name> with the word 
<compensated> added to the file name prefix. Alternatively, the user can 
rename the compensated file by saving it in the Data Control tab. Do not 
change or delete the file extension. All data files are saved to the default location:  
<C:\Program Files\Solinst\Levelogger4_1\Data>.

The next window will show the results of the compensation. If the compensation 
was unsuccessful, there will be an explanation in the Reason column (e.g. time 
stamp of Levelogger and Barologger files were not close enough to perform 
an accurate compensation). You can still view the compensated file in the Data 
Control tab, by clicking ‘Open’ in the Action column. If the compensation is 
successful, select ‘Open’, to view the compensated data file in the Data Control 
tab. 



Levelogger Series User Guide - Software Version 4

Page 59

Figure 8-11 Viewing Compensated Files in the Data Control Tab

From the Data Control tab, you can view the data, save the compensated file with 
a new filename and/or export the data (see Section 7).

All the original Levelogger settings and the channel information effective during 
data collection are shown on the top left of the window. The bottom left sections 
of the window are used to display the compensation information. The middle 
section displays information from the Barologger, and the bottom section includes 
information about manual data and parameter adjustments. 
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8.2  Manual Barometric Compensation

This section describes how to perform manual barometric compensation on 
Levelogger Edge and Levelogger Junior Edge data files when a Barologger was 
not dedicated as a barometric recorder. 

For short term tests during which the barometric pressure varies insignificantly, 
the collection of continuous barometric data may be unnecessary. In this event, 
take a reading from an open air exposed Levelogger prior to running the short 
term test and record this level. This level represents the barometric pressure. 
Similarly, at the end of your test, take another barometric reading and record 
this measurement. After the submerged Levelogger data has been exported to 
a spreadsheet program, compensate your submerged Levelogger data files for 
barometric pressure. If no appreciable change in barometric reading occurred, 
you may write in the first cell of a new column, a simple calculation that subtracts 
your barometric reading from the submerged data file, then copy and paste this 
calculation to all the cells in that new column. The new column will represent the 
barometrically compensated liquid level.

Barometric data can be collected on site using a recording barometer or from a local 
weather station. To accomplish an accurate manual barometric compensation, 
the atmospheric pressure station should not be greater than 20 miles (30 km) 
away and within an elevation change of 1000 ft (300 m). In addition, the date 
and time of the barometric data should cover the range of data collected by the 
Levelogger. If setting up the barometer, set the recording interval to that of the 
Levelogger sampling interval or some multiple of the Levelogger interval. To 
compensate submerged Levelogger data using barometric data collected from an 
on site barometric datalogger or a nearby weather station, these steps must be 
taken:

1)  Export both the Levelogger data file and the barometric file to a spreadsheet.

2)  In the spreadsheet, ensure both files are using the same units. If your  
 Levelogger data was recorded in m, cm, or ft, convert the barometric data  
 column from its barometric measurement units (typically atm, mm Hg, psi,  
 mbar or kPa) to feet or meters of water column equivalent using the conversion  
 factors in Table 8-1. (There is also the option to initially set up your Levelogger  
 Edge or Levelogger Junior Edge to record in psi, kPa, or bar. This makes  
 compensation using other atmospheric pressure devices easier.)

Table 8-1 Common Barometric Units to Water column Equivalent Conversions

   NOTE 
When analyzing barometric data it 
is important to keep in mind that 
storm events commonly reduce 
total atmospheric pressure by 
about 1.7% from pre-existing high 
pressure conditions. 1.7% converts 
to approximately 0.6 ft or 0.2 m of 
water level equivalent barometric 
fluctuation.

   NOTE 
For Manual Barometric 
Compensation instructions for the 
Levelogger Gold and Levelogger 
Junior, visit: www.solinst.com and 
see the Levelogger Software Version 
3.4.1 User Guide in the Downloads 
Section. 
Or view " Automatic or Manual 
Barometric Compensation of Your 
Levelogger Data" in the Technical 
Bulletin  Section at:  
http://www.solinst.com/Prod/3001/
Datalogger-Technical-Bulletins.html

   NOTE 
You can also convert the Levelogger 
Edge data units to match the 
Barometric units using the Data 
Wizard.

3)  Once the units for each column are the same, subtract the barometric  
 column from the Levelogger data to get the true net water level recorded by  
 the Levelogger Edge.

   NOTE 
It is important to remember that 
weather station barometric data 
will often contain an offset or 
normalization (i.e. normalization to 
sea level). Manual data conversation 
and barometric compensation 
should account for any variation 
of the normalization or offset used 
between the barometric data 
sourced and Solinst Leveloggers.

Table 8-1
Common barometric units to water column equivalent conversions

Barometric unit
Water column  
equivalent (ft)

Water column 
equivalent (m)

1 psi 2.307 0.703

1 kPa 0.335 0.102

1 mbar 0.033 0.0102
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9  Real Time View

Click the Real Time View tab from the main software window (Figure 9-1). The 
purpose of this tab is to provide on-screen measurement as data is being recorded 
by the connected datalogger. The data is displayed in tabular and graphical 
format. All the channel information and Levelogger settings are displayed on the 
left of the window.  

First, select a non-logged view rate  . This rate can be set 
independently of the logging period of the Levelogger and does not interfere with 
any logging taking place in the Levelogger itself.

Checking, Enable Manual Data Adjustment, allows you to enter a datum/ field 
zero (e.g. depth to water level) to which the change in Real Time View level 
measurements are then adjusted against. This is only available when you are 
taking readings in m, cm, or ft.

Real Time View readings can be displayed as a graph or in tabular format.  The 
same graphing options as the Data Control tab are available for Real Time View 
readings. Real Time View readings are being recorded within the Levelogger 
Software and prior to closing the window, they can be saved by exporting the 
data into a *.csv file, by choosing the file export option .

To start the current readings, click . Immediately the readings will be 
displayed.  

To take a reading at any specific time, click the  button and that reading will 
be added to the displayed data. To turn the Real Time View monitoring off, 
decide if you want to save the data as described above, and simply click .

Figure 9-1 Real Time View Window

   NOTE 
Datalogger settings can not be 
changed in the Real Time tab.  
Changes must be made in the 
Datalogger Settings tab.  The 
changes are applied when the  
Real Time readings are started.

   NOTE 
You can also view Real Time 
readings from a Rainlogger Edge or 
Rainlogger using  firmware version 
2.000 or higher. 
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10  Installation and Maintenance of Leveloggers

10.1  Installation

Many options exist for installation of the Levelogger, but essentially these 
installation methods can be classified into two broad categories: free suspended 
or fixed installations. 

1)  In free suspended installations, the Levelogger is hung via suspension wire or  
 Direct Read Cable from a well cap, or some fixed tie-off location, at the well  
 head. 

2)  In fixed installations the Levelogger is fixed in place by a compression fitting, a  
 clamping mechanism or simple metal straps.

It is recommended that the Levelogger be installed in a vertical orientation. 
However, inclined or horizontal installation is acceptable. The level sensor in the 
Levelogger is indicated by the machined line about the body of the logger just 
above the pressure access holes. The pressure transducer is oriented in a plane 
normal to the long axis of the body and detects pressure directed along the plane 
of the long axis (Figure 10-1).  In vertical orientations, the sensor detects pressure 
above the pressure transducer line, where as in non-vertical orientations, the 
pressure zero point is proportional to the angle of inclination. 

Care should be taken to avoid dropping the Levelogger against a hard surface.  
Leveloggers should always be installed with the installation cap on (if not using 
a Direct Read Cable), whether it is being suspended by it or not. This prevents 
unnecessary battery drainage and protects the optical eyes.

Make sure you properly estimate the maximum and minimum expected water 
levels during the monitoring period. You need to install your Levelogger so it 
remains submerged at all times, and ensure that its maximum submergence depth 
throughout the monitoring period remains within its specified range. The pressure 
transducer can be damaged if the datalogger is over-pressurized by submergence 
greater than its level range. The Levelogger Edge and Levelogger Junior Edge 
are warranted to pressures up to 200% of their full scale level range (150% for 
the Levelogger Gold, Levelogger Junior and LTC Levelogger Junior Models), 
however accuracy can not be guaranteed beyond its full scale.

Other important considerations when installing the Levelogger in pressurized or 
intermittently pressurized locations such as pressure vessels, pressurized pipes, 
pulse flow conditions, drop structures or near hydraulics works, is to keep in 
mind the potential effect of water or steam hammer and hydraulic jump. Water 
hammer is caused by an abrupt alteration of flow direction resulting in pressure 
surges. Steam hammer occurs when steam enters a cold pipe partially filled with 
water.  The hammer effect has the potential to significantly increase hydraulic 
pressure possibly exposing the pressure sensor to pressures beyond its maximum 
rating.  Hydraulic jump is a phenomenon that occurs when water is ‘lifted’ or 
‘ramped’ by velocity or flow obstructions. Hydraulic jump causes turbulence and 
creates non-representative head conditions in the water column.  Care should be 
taken to avoid logger installation at points susceptible to hydraulic jump.

Figure 10-1

Levelogger Junior Edge 
/LTC Levelogger Junior 
Measurement Line

Levelogger Edge 
Measurement Line

Levelogger Gold  
Measurement Line
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10.1.1  Free Suspended Installations

10.1.1.1  Suspension Wire/Cord Installation

When installing on a suspension wire or cord, the Levelogger is pre-programmed 
and started using the software. It is then deployed with the suspension wire or 
cord connected to the installation cap of the Levelogger to the underside of a well 
cap. The data is retrieved manually, by withdrawing the Levelogger, removing the 
installation cap and attaching an Optical Reader directly to the datalogger. Data 
is downloaded to a desktop or laptop PC or by using a Leveloader. This type of 
installation is applicable to both submerged and barometric record applications.

Solinst supplies stainless steel suspension wire assemblies including SS stranded 
wire and hooks available in a variety of lengths from 50 ft (15 m) to 500 ft  
(150 m), and Kevlar cord assemblies to 500 ft (150 m). Solinst also supplies the 
Model 3001 2" Well Cap Assembly from which the Levelogger can be suspended. 
An Adaptor for 4" wells also available (see Section 10.1.1.3). 

Follow these steps to install the Levelogger using stainless steel wire and hooks:

1)  Loop the cable through the coil 2 of the hook assembly, then wind the looped  
 strands several times around the hook shaft and pass through coil 1.

2) Pass coil 3 through the Well Cap eyelet or Levelogger/Barologger eyelet and  
 snap coil 3 to the hook shaft.

3) If the Well Cap is not used then some secure tie-off point should be used or  
 installed.

4)  If installing a Barologger, ensure the suspension level is above the highest  
 expected water level.

5)  When retrieving data and/or reprogramming the Levelogger, extract it from the  
 monitoring location, un-thread the installation cap, interrogate and re-suspend  
 the unit rechecking the security of the wireline clamps each time.

Figure 10-2 
Solinst 2" Locking Well Cap  
for Wireline or Kevlar Cord

Coil 1

Coil 1

Coil 1

Coil 1

Coil 3

Coil 2

Coil 2

Coil 3

Coil 2

Coil 3

Coil 2

Coil 3

Wireline

Wireline

Wireline

Diagram 1

Diagram 2

Diagram 3

Diagram 4

Figure 10-3 Wireline Hook Installation

Bowline 
Knot

Figure 10-5 Bowline Knot Used to Connect 
Kevlar Cord to the Levelogger

It is recommended that the Kevlar cord be connected to the Levelogger and 
well cap using a bowline knot (see Figure 10-5). The Kevlar cord is comprised 
of multiple Kevlar strands braided with black polyester, and has break strength of  
150 lbs. Kevlar is very suitable for underwater applications in freshwater and 
marine environments, as the material resists rusting.

Figure 10-4 Kevlar Cord 
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10.1.1.2  Direct Read Cable Assembly Installation

When installing using a Direct Read Cable Assembly, the Levelogger can be 
deployed before it is programmed and started with the software. The Levelogger 
is installed using a Direct Read Cable to a Direct Read Wellhead, where a  
PC Interface Cable is connected allowing the Levelogger to communicate with a 
desktop or laptop PC, or a Leveloader.  

The Direct Read Cable system is composed of the ordered length of Direct 
Read Cable, the Model 3001 Well Cap Assembly (see Section 10.1.1.3) and 
the PC Interface Cable. The Direct Read cable threads to the Levelogger, while 
the socket at the opposite end of the Direct Read Cable fits into the specially 
designed Well Cap insert. The PC Interface Cable connects to the Direct Read 
socket at surface and to either a USB or RS-232 port on the PC. While use of the   
Model 3001 Well Cap is recommended and convenient, it is optional as long as 
a satisfactorily secure alternative tie-off point is found for the Direct Read Cable. 
Follow these steps to install a Direct Read Cable Assembly to the Levelogger:

1)  Remove the installation cap from the Levelogger, align and connect the optical  
 socket (two glass ‘eyes’ using the alignment pin) of the Direct Read cable to the  
 Levelogger by threading the coupling onto the Levelogger tightly. 

2) The Levelogger and optical socket will fit through the hole in the Well Cap insert.

3) Remove the protective cap from the non-optical socket at the wellhead end of  
 the  Direct Read Cable, seat the socket in the Well Cap Insert and align and  
 thread it to the round socket of the PC Interface Cable.

4) Connect the USB or RS-232 socket of the PC Interface Cable to the USB or  
 RS-232 Com Port on your PC.

5) The two plugged holes in the Well Cap can be opened to provide an access port  
 for a Barologger, as well as a water level meter probe. 

Figure 10-7 
Solinst Direct Read Cable

Dual Well Cap Option

Single Well Cap Option

Figure 10-6  
Solinst 2" Locking Well Caps for  
Direct Read Cable Installation

When removing a Direct Read Cable from a Levelogger, ensure you only 
twist the coupling.  To avoid possible damage, do not twist the strain relief 
on the Direct Read Cable.

Figure 10-8 Proper way to remove a Direct Read Cable from a Levelogger

Strain 
ReliefCoupling
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10.1.1.3  Model 3001 Well Cap Assembly

The Model 3001 Well Cap Assembly is designed to fit 2" wells, and provides 
options for installing Leveloggers with wireline, Kevlar cord, or using a Direct 
Read Cable.

The well cap base provides a tight friction fit onto the well casing. The cap is 
secured to the base with a twist lock.  For further security, a 3/8" (9.5 mm) shackle 
diameter lock can be used. The Well Cap is vented to allow for the equalization 
of barometric pressure in the well. Users can choose to permanently secure the 
PVC Well Cap to the well casing, using three screw points on the inner shoulder 
of the Well Cap Base.

For wireline or Kevlar cord suspension, simply use the suspension hook on the 
underside of the insert to secure the Levelogger to the Well Cap (see Section 
10.1.1.1). To install using a Direct Read Cable, lower the Levelogger with the 
Direct Read Cable through one opening in the insert (see Section 10.1.1.2).

Figure 10-10 If installing Leveloggers in a 4" well, a reducer adaptor is available.  (#110235) 

   NOTE 
The insert has openings to hold 
two Direct Read Cables in the same 
well. If only one Direct Read Cable 
is used, the other hole (0.89" ID)
provides access for Solinst Water 
Level Meters.

Figure 10-9 Model 3001 Well Cap Assembly (#110099)

Well Cap 

Insert 

Plugs 

Well Cap Base 

0.39" 10 mm dia. lock hole
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Figure 10-11 
7/8” Nylon Compression Fitting with  

1/4" NPT Connector

10.1.2  Fixed Installations

10.1.2.1  Artesian Monitoring

Monitoring of artesian conditions in which the piezometric surface is above 
ground surface or more particularly above the top of well casing elevation using 
Leveloggers can be quite straight forward. 

Continuous artesian conditions infer that the piezometric surface never drops 
below the level the ground surface or particularly the top of casing elevation 
and the casing is sealed with a sealed wellhead. In this case, where freezing is 
not a concern, the Levelogger need only be installed on the wellhead itself by 
means of a large compression fitting with a 1/4" NPT connector, as illustrated in  
Figure 10-11. Solinst can supply a 7/8" nylon compression fitting for this 
purpose. First, a 1/4" NPT hole is tapped into the wellhead.  The user slides the 
Levelogger into the compression fitting, leaving about 1/4 of the logger body 
exposed above the fitting. The compression fitting nut is tightened around the 
Levelogger. The 1/4" NPT connector on the bottom of the pressure chamber of 
the fitting threads into the hole in the sealed wellhead. The user can communicate 
with the logger simply by removing the logger cap and attaching the optical 
reader. Ensure that the logger and sealed wellhead are enclosed within an outer 
protective well cap or enclosure. This method should only be used in low pressure 
conditions (less than 30 psi or 66 ft (20 m) of water column). 

When conducting artesian monitoring with Leveloggers a number of considerations 
must be kept in mind. First, ensure that the maximum hydraulic pressure the 
Levelogger will encounter within the well at its installation point will not exceed 
the hydraulic range of the logger. Second, artesian conditions do not preclude the 
necessity for barometric compensation of Levelogger data. Artesian conditions 
are caused by aquacludes forming confined aquifers. Confined aquifers, while 
not acted on by barometric pressure to the same extent as unconfined aquifers, 
are typically subject to barometric pressure at some barometric efficiency (See 
Section 10.1.3.1).  Finally, bear in mind that the total pressure and subsequent 
water column equivalent depth measured by the Levelogger after barometric 
compensation may not represent the actual water level within the artesian well. 
Sealed intermittent artesian wells can be pressurized when artesian, but can also 
be de-pressurized when non artesian.  The Levelogger’s reading after barometric 
compensation represent the height of the piezometric surface.

10.1.2.2  Vacuum Monitoring

Vacuum monitoring is usually conducted by first installing pressure transducers 
such as the Levelogger in monitoring wells and then shutting-in or sealing those 
wells to the atmosphere with pressure sealed wellheads. Air is pumped out from 
an extraction well amongst the cluster or matrix of monitoring wells, theoretically 
dropping air pressure in the vicinity of the extraction well. For short-term tests 
in which data is not required during the extraction event, the Leveloggers can be 
programmed and simply suspended from hooks or eyelets on the underside of 
the sealed wellheads, the test run and the data collected at the end of the test by 
extraction and downloading of the loggers. However, if ongoing data from the 
Leveloggers is required during the extraction event, the loggers must be installed 
in a manner similar to the artesian monitoring scenarios described previously 
in this section. Leveloggers or Barologgers can be used to monitor the drop in 
pressure.

Levelogger Cap

Levelogger Body

Compression 
Fitting Nut

Ferrule

Pressure 
Chamber

1/4" NPT 
Connector

   NOTE 
The Levelogger NPT Adaptor is 
not recommended for pressures 
in excess of 30 psi (66 ft (20 m) of 
water column).
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10.1.3  Barologger Installation

The Barologger is a Levelogger with a small range adequate to monitor the 
fluctuations that occur in barometric pressure. The Barologger’s readings 
are used to barometrically compensate Levelogger readings. As a rule of 
thumb, a Barologger can be used to compensate all the Leveloggers in a  
20 mile (30 km) radius and/or with every 1000 ft. (300 m) change in elevation.

To monitor barometric pressure correctly, the Barologger should never be 
submerged. In well installations, it is recommended that the Barologger be 
suspended in one of the monitored wells above the high water point (the well 
must be vented).  For best reading accuracy, the Barologger should be installed in 
a similar thermal environment to that of the Levelogger. In groundwater wells, the 
Barologger should be suspended beyond the frost line and deep enough to avoid 
large temperature fluctuations. In surface water applications, the Barologger is 
best deployed in a dry well – a well embedded in the bottom of the water body, 
but sealed at the base from water entry and vented to the atmosphere. If a dry 
well cannot be installed, the Barologger can be installed on a float in the stilling 
well. Further information on the Barologger and barometric pressure can be 
found in Section 8.2.

10.1.3.1  Barometric Efficiency

The influence of barometric pressure on a groundwater surface can follow three 
scenarios. In confined aquifers with capillary or vadose head space, increased 
atmospheric pressure can tighten the pore spaces in the overlying soil and produce 
a capillary effect as the water level rises in response to having nowhere else to 
go but up. Second, some deeper aquifer systems can be quite barometrically 
isolated from the relatively small change in level that barometric influences can 
produce. The third scenario occurs in an unconfined aquifer, with high barometric 
efficiency, in which a barometric pressure change results in an equivalent or 
highly proportional drop or rise in groundwater pressure. In essence, depending 
on the aquifer type and depth, increased barometric pressure can result in either 
increased, static or decreased water levels. Barometric efficiency, the relationship 
of a barometric change on groundwater pressure, in confined aquifers generally 
ranges from 20 to 75%, whereas in unconfined aquifers the efficiency can range 
from 80 - 100%. 

A second important element of Barometric efficiency is time lag – the time 
differential between a unit change in barometric at the surface to the time of 
transmission of that change to the aquifer. Calculating general barometric 
efficiency should not be done on a single barometric event, but rather on a 
statistically significant number of events. As a result, it may take a month or 
more of submerged Levelogger and Barologger data to determine barometric 
efficiency and time lag. As Barometric pressure fluctuates over time in excess of 
60 cm water column equivalent pressure and as barometric efficiency can be such 
an important factor in accurately monitoring groundwater levels, it is vital that 
barometric compensation of the Levelogger data be performed.

The absolute pressure method used in the Levelogger and Barologger provide 
the user with the data necessary to determine barometric efficiency and time lag. 
If a barometric efficiency value has been determined from the Levelogger and 
Barologger data, that value can be applied to Barologger data in the Data Wizard.

Figure 10-12 Levelogger  
and  Barologger in Well

   NOTE 
The Barologger Edge should 
not be used to monitor water, 
as the internal mathematics for 
temperature compensation are 
based on air rather than water.
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Wells puncturing an aquifer have a negligible to non-existent effect on directly 
transmitting barometric changes to the larger aquifer. Barometric pressure is 
transmitted through overlying layers. To obtain the best and most accurate long 
term water level readings from Leveloggers, the user must first understand how 
the Levelogger calculates a depth of water above the transducer and second 
whether barometric efficiency should be considered in barometric compensation.
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10.1.4  Rainlogger Installation

Solinst Rainloggers (Figure 10-13) are designed to log the tip times of an external 
tipping-bucket rain gauge, and output the amount of rainfall per tip.

The Rainlogger Edge housing is made of ABS, while the Rainlogger housing 
is made of stainless steel. Direct exposure to rainfall should be avoided, and 
Rainloggers should not be submerged. The Rainlogger Edge ABS housing 
provides extra electrostatic discharge (ESD) protection.

The rain gauge connected to the Rainlogger is supplied by the customer and is a 
reed-switch type gauge most commonly known as a tipping-bucket rain gauge. 
The Rainlogger rain gauge connector (Figure 10-14) connects to the 2 m (6.5 ft.)  
cable supplied with the Rainlogger. The Rainlogger Edge and Rainlogger are 
supplied with different connector cables, which can not be interchanged.  
The connector cables have two wires, which are connected to the tipping-bucket 
by splicing to the tipping-bucket cable. As the tipping-bucket is just an electrical 
switch, for most models, the wires can be connected to either cable wire.  
Refer to the manufacturer’s operating instructions. Longer, exposed cables should 
be protected from rodents and vandalism by cable armoring or installation within 
electrical conduit. 

Figure 10-13 Solinst Rainloggers

Figure 10-14 
The Tipping-bucket Rain Gauge Connector 

of the Rainlogger Edge

Rain Gauge  
Connector

Figure 10-15 Rainlogger Connected to Tipping-bucket

   NOTE 
The Rainlogger Edge and 
Rainlogger are supplied with 
different connector cables, which 
can not be interchanged. 
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10.1.5  Installation in Extreme Environments

10.1.5.1  Freezing or High Temperature Conditions

Levelogger installation at submerged depths that may be at risk of freezing during 
the monitoring session is not recommended without taking adequate precautions 
to avoid transducer damage. When water freezes it expands approximately 9% 
by volume. A 9% expansion can equate to extreme pressure as demonstrated in 
Example 10.1. Therefore, solid freezing has the potential to damage the pressure 
transducer, which is rated to withstand up to 200% (150% for the Levelogger Gold 
and Junior Models) of its depth fluctuation range. Pressures beyond this threshold 
may damage the transducer. As such, care should be taken when choosing the 
appropriate pressure transducer range for your application. 

Example 10.1 Solid Freezing Effects

The pressure exerted by the physical expansion or ice crystallization 
process on a retaining or enclosing contact surface is related to the 
temperature gradient over which the process occurs, i.e. the speed at 
which freezing occurs.  For example, liquid freezing at -22ºC, can create 
expansion pressures of 22 kg/cm2 or 313 psi or the equivalent of 721 ft or 
220 m water column depth.

Figure 10-16 
Installation in Freezing Liquid

   NOTE 
Although precautions can be taken, 
placing a Levelogger in a situation 
where the water may freeze solid 
can permanently damage the 
sensor.

With precautions, the Levelogger can be used in freezing liquid environments. If 
monitoring shallow water bodies or groundwater zones susceptible to freezing, 
the easiest way to avoid transducer damage is to lower the transducer to a point 
in the water column below the frost line or ice formation depth. In water bodies 
such as shallow streams, wetlands or ponds where freezing may penetrate to the 
bottom, install the Levelogger in a vented stilling well imbedded into the bottom 
of the water body beyond the frost line. 

In cases where the above noted precautions cannot be taken and the Levelogger 
must be installed in the freezing zone, it is recommended that the logger be 
placed inside two elongated silicon, rubber or latex balloons, the balloons 
can be filled with a non-toxic, non-corrosive anti-freeze solution and sealed  
(Figure 10-16). Place the balloons in a section of perforated, 1.25"  
(30 mm) ID pipe and install the logger in the monitored water. The antifreeze 
solution will protect the Levelogger from ice expansion at the pressure transducer, 
yet transmit any pressure fluctuations that occur. However, it should be noted that 
even if these precautions are taken, there is still the risk that placing a Levelogger 
in a situation where the water may freeze solid can permanently damage the 
sensor (see Example 10.1).

Please note that a similar installation protection can be used when the Levelogger 
is monitoring liquids which are incompatible with its wetted materials. 

The operating temperature range for Leveloggers is -20° to 80°C (-4° to 180°F).  
At the opposite end of the thermal scale, exposing the Levelogger to temperatures 
beyond 80°C may damage the thermistor and otherwise affect the Levelogger.
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10.1.5.2  Marine or Brackish Installations

When installing the Levelogger in salt or brackish water or in a liquid having 
a specific gravity (density) different than fresh water, the density difference is 
compensated for by inputting the density of the monitored fluid in the Datalogger 
Settings window  for the LTC Levelogger Junior and the Levelogger Gold Series 
(see Section 5.1). Also, see Section 8 for details in compensating the Levelogger 
Edge and Levelogger Junior Edge for fluid density differences. 

The Levelogger Edge can be used for monitoring in salt or brackish water. However, 
long term use of the stainless steel body Levelogger Junior Edge, LTC Levelogger 
Junior, Levelogger Junior and first generation LTC and LT Leveloggers in salt 
or brackish water is not recommended, as the salt or other pollutants may cause 
pitting which can lead to perforation of the Levelogger’s casing. To minimize 
this effect, regularly lift the Levelogger from the liquid; within seconds a thin 
protective layer will be formed by oxidation. Again, this precaution applies to 
the Levelogger Junior Edge, LTC Levelogger Junior, Levelogger Junior, and first 
generation LTC and LT Leveloggers.

If using these dataloggers in a continuous salt/brackish monitoring scenario, the 
stainless steel body of the datalogger can be protected in a manner similar to the 
freezing protection method described in Section 10.1.5.1. The Levelogger can 
be placed in balloons and the balloons filled with non-corrosive/ non-toxic fluid. 
As pressure changes, the fluid encasing the loggers will transmit the pressure 
differential to the datalogger’s pressure transducer. Care must be taken in the 
selection of the balloon material or filling fluid such that the balloon material 
prevents diffusion of salts across the concentration gradient or that the filling 
fluid is comprised of polymeric molecules too large to diffuse out of the balloon 
material.

10.1.5.3  Biofouling Conditions

Biofouling is the unwanted buildup of microorganisms, plants, algae, or organisms 
such as barnacles and muscles on a wetted surface. When a Levelogger is deployed 
for an extended period of time, especially in a saltwater environment, there is the 
risk of biofouling. Biofouling on the pressure sensor and conductivity cell can 
compromise the accuracy of the measurements.

A Solinst Biofoul Screen can be used to protect the Levelogger from biofouling. 
The copper-coiled Delrin screen naturally reduces biofouling, and lengthens the 
time a Levelogger can be deployed before maintenance is required. The Biofoul 
Screen simply slips onto the sensor end of the Levelogger where it is held in 
place with its compression fitting. It adds about 3/4" (19 mm) to the length of 
the Levelogger. It allows water to freely enter the conductivity cell, as well as the 
pressure transducer inlets. It is replaced as required.

Figure 10-18 Solinst Biofoul Screen for the Levelogger

1.65"  
(42 mm)

4 1/8" 
(105 mm)

Figure 10-17 Biofoul Screen Dimensions
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10.2  Levelogger Maintenance

Levelogger maintenance consists of cleaning the outside casing, the circulation 
holes and the optical infrared eyes. The required frequency of cleaning is 
dependent on several aspects of the monitored water quality. In freshwater with 
good to excellent water quality, the Levelogger cleaning requirements will be 
very minimal; amounting to a seasonal or even annual maintenance inspection. 
In most cases cleaning can be accomplished by rinsing the Levelogger and using 
mild, non-residual, non-abrasive household cleaners using a very soft-plastic, 
bristled, pipe-cleaner type brush. Do not insert any object through the circulation 
holes at the sensor end of the Levelogger. In some cases simple cleaners are 
insufficient to properly clean the Levelogger. Several commonly occurring water 
conditions require specific maintenance methods, these include hard water, high 
suspended solids loading, biological or chemical fouling and salt or brackish water 
conditions. 

Hard water monitoring can result in the precipitation of calcium and magnesium 
deposits on the pressure transducer as well as other components of the Levelogger. 
These deposits can be safely dissolved using a diluted solution (typically ≤ 10% 
strength) of acetic or phosphoric acid. Commercially available products for 
dissolving hard water scaling are also available and can be used if designed for 
household use. Some industrial strength hard water scaling removers are much 
higher strength and are not recommended for cleaning the Levelogger. 

High suspended solids load may block the circulation ports or clog the internal 
pressure cell of the Levelogger. The potential clogging effect of solids deposition 
can be minimized by placing the Levelogger in zones of flow.  To remove solids 
build up, rinse the Levelogger under a low flow of tap water until particles have 
been washed away.

Bacteriological or chemical fouling can be an important consideration in 
many ground and surface water monitoring projects. Sessile bacteria will often 
utilize installed instrumentation as an attachment substrate. Chemical deposit 
can be the result of electrical charge differential between the instrumentation of 
the monitored liquid or the result of biological or algal activity.  Both forms of 
fouling can result in difficult to remove deposits on the Levelogger transducer, the 
conductivity wires and the Levelogger casing. To remove fouling use a diluted (≤ 
10%) solution of sulfuric acid.  Persistent material may require soaking for several 
hours.

Cleaning LTC Levelogger Junior sensor pins is recommended before calibrating 
the unit prior to starting a project. The pins of the LTC Levelogger Junior sensor 
are platinum-coated, therefore they should not be roughly cleaned or touched 
with any metal. They can be cleaned with a soft bristle brush, Q-tip, or cloth. 
Almost any acid solution can be selected to clean the sensor, provided it is highly 
diluted (generally less than 10% acid). The "soaking" time should be monitored 
and kept to a minimum. 

   NOTE 
It is important to ensure the 
installation cap or a Direct Read 
Cable is attached to the Levelogger 
during storage to prevent 
unnecessary battery drain and to 
protect the optical eyes.
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11  Diagnostics Utility

The Levelogger Diagnostics Utility can be used for troubleshooting Leveloggers 
and obtaining information about that Levelogger that can assist the Solinst 
Technical Support representative to identify and fix any problems you may 
encounter with your Levelogger.  The Diagnostics Utility can be launched from 
the Utilities menu at the top of the software. The utility can be used to run a self-
test, do a Memory Dump and create and email reports.

11.1  Run Diagnostics

The Run Diagnostics function reads the following information from the 
Levelogger:
 1) Serial Number
 2) Model Number
 3) Firmware Version
 4) Battery Voltage
 5) Charge Level
 6) Current Level Reading
 7)  Current Temperature Reading
 8) Max/Min Pressure Reading
 9) Max/Min Temperature Reading
 10) Max/Min Conductivity Reading
 11) Total Number of Logs

This information can be used to identify firmware, battery and/or temperature/
pressure/conductivity sensor problems. This function also performs a series of 
self-tests on the Levelogger to check for problems with the battery, memory, 
pressure/temperature/conductivity sensors. If an LTC Levelogger Junior fails 
the Conductivity Sensor Test, this could mean that you have not calibrated your 
LTC in a while (~1 year). It is recommended that you perform a conductivity 
calibration, then ‘Run Diagnostics’ again. If any of these tests fail then a report 
should be created and emailed to Solinst Technical Support. To execute this 
function simply click the ‘Run Diagnostics’ button.

Figure 11-1  Run Diagnostics

   NOTE 
If an LTC Levelogger Junior fails the 
Conductivity Sensor Test, this could 
mean that you have not calibrated 
your LTC in a while (~1 year). It is 
recommended that you perform a 
conductivity calibration, then ‘Run 
Diagnostics’ again.



Levelogger Series User Guide - Software Version 4

Page 74

11.2  Read Memory Dump

This function creates a complete dump of the Levelogger’s memory, which can 
then be sent to Solinst Technical Support for analyzing.  

To execute this function simply click the Read Memory Dump button.  Performing 
a memory dump will create a *.xle file of the data to save.

Figure 11-2  Read Memory Dump

   NOTE 
It is recommended that, before 
attempting to use this function, 
you use the ‘Create Report’ function 
to send a report to the Solinst 
Technical Support.

11.3  Create Report

This function simply creates a text file containing the information obtained 
from the Run Diagnostics function. When you click the Create Report button, a 
window will pop up asking you to fill out your company information. Simply fill 
this out and the resulting report can be saved or sent to Solinst Technical Support 
for troubleshooting. If creating a report for an LTC Levelogger Junior, the  
LTC Calibration History Report will be included.

Figure 11-3  Customer Info Input Window

   NOTE 
The 'Email Report' option 
automatically creates a report and 
attaches it to an email to send to 
Solinst - all in one step.
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Figure 11-4 Report Example

11.4  Email Report

Clicking Email Report will guide you through the process of creating a Diagnostics 
Report, and it will automatically attach the report to an email to send to 
Solinst Technical Staff for troubleshooting. If you are emailing a report for an  
LTC Levelogger Junior, the LTC Calibration History Report will be included.
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11.5  LTC Calibration History Report

This function creates a report of all previous user calibrations performed on the 
LTC Levelogger Junior. Use it to send a history report to Solinst for analysis 
if the LTC Levelogger Junior readings are irregular and/or the unit does not 
maintain its calibration. To execute this function simply click the LTC Calibration 
History Report button. This creates a text file that can be sent to Solinst Technical 
Support.

Figure 11-5 LTC Calibration History Report

11.6  Software/Firmware Updates

Each time the Diagnostic Utility is opened, it automatically checks for software 
updates. If there is an update, "Software Update Available" will appear in the top 
right of the window. When you click the message, a web page will open, allowing 
you to download the software update.

The Utility also checks for firmware updates. "Firmware Update Available" will 
appear in the top right of the window. Clicking the message will open a web 
page where you can download the firmware update. See Section 12 for firmware 
update instructions.

   NOTE 
Your Computer must have an 
Internet connection to check for 
software and firmware updates.

You can also check for updates 
using the Help menu.
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12  Firmware Upgrade Utility

The Firmware Upgrade Utility is used to upload new firmware files to a 
Levelogger. The zipped firmware file can be obtained from:  
http://www.solinst.com/Downloads/

Make sure to unzip the firmware file after you have downloaded it, so you can 
access the *.ssf file.

To upload new firmware to a Levelogger, follow these steps:

1)  Open the Solinst Firmware Upgrade Utility from the Utilities menu in the main  
 Levelogger Software.  Pick the Com Port to which the Levelogger is connected  
 and make sure the Baud Rate is set to 9600.

2)  Click the ‘Open’ button , which should open a file dialog asking for the  
 firmware file (*.ssf) to upload.  Navigate to the directory where the firmware file  
 was saved on your PC, then click on the file and click ‘Open’.

3)  Check the ‘Firmware File Information’ box to make sure that the opened file is  
 the right one.

4)  Click the ‘Upload Firmware’ button , to start the firmware upload process. 

5) If a communication error occurs and is indicated in the Levelogger Information  
 Window (Figure 12-1) either before the ‘Verified Program Checksum’ message or  
 after the ‘Program Information Section’, then restart the upgrade process.

6)  If, however, a communication error occurs between the ‘Verified Program  
 Checksum’ and the ‘Program Information Section’ messages, then please contact  
 Solinst. You will need to give the Levelogger Serial Number and explain the exact  
 positioning of the error message.

Figure 12-1 
Firmware Upgrade Utility Window

   NOTE 
It is important that the 
communication between the 
PC and the Levelogger is not 
interrupted during a firmware/
calibration upload so please make 
sure to close any other running 
programs, including screen 
savers, and do not disconnect the 
Levelogger  before the upload is 
finished.

   NOTE 
To check for firmware updates 
using Levelogger Software, retrieve 
settings from the connected 
datalogger (see Section 5). 
"Firmware Update Available" will 
appear in the top right menu bar if 
there is an update available. Clicking 
the message will open a web page 
where you can download the 
firmware update. You can also use 
the Software's Help menu.
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13  Trouble Shooting

13.1  Problems During Installation of Levelogger Software

‘Class not Registered’ or ‘DLL not found’ or ‘Access violation’ 

1) You may not have Administrator Rights to install the software in the  
 Windows XP/Windows 7 environment. 

  - Ask your System Administrator for assistance. 

2) Some files got corrupted during installation of the Levelogger software. Use  
 ‘Add/Remove Programs’ to uninstall then re-install Levelogger software. 

13.2  Error During Software Uninstall Process

The ‘Add/Remove Program’ cannot locate the Levelogger <setup.exe> file of 
the software or the link between the software and the ‘Add/Remove Program’ 
is damaged.

The record in the Registry Table must be removed: 

1)  Ask your System Administrator to remove this.

2) Refer to the following link from Microsoft Website for instructions: 
 http://support.microsoft.com/default.aspx?scid=kb;en-us;247501

13.3  Problems During Installation of RS-232 to USB Converter

Unable to install the RS-232/USB converter from Keyspan or IO Gear

1)  After plugging in the RS-232/USB Converter, a Hardware Installation Wizard  
 will open. Follow the instruction from the Wizard and make sure to select the  
 RS-232/USB Converter Driver from the Keyspan or IO Gear Installation CD. 

2)  If the Hardware Installation Wizard does not open after plugging in the RS-232/ 
 USB Converter, follow the steps below to open the Hardware  
 Installation Wizard:

a. Select Control Panels
b. Double click on System
c. Select the Device Manager Tab
d. Double click on Other devices
e. Right click on USB Serial Converter
f. Select Update Driver...

13.4  Data Has Been Erased Accidentally

If Levelogger has been restarted and old data has not been saved, go to 
Download Options and choose Data Recovery. It downloads the immediately 
previous log. 

   NOTE 
Solinst recommends Keyspan or  
IO Gear.  For problems 
with converters from other 
manufacturers, please contact the 
manufacturer.
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13.5  Error Messages During Use of Software

‘Communication Time Out’ or ‘Communication Error’ or  
‘The Command that is sent to the Levelogger Edge is not defined’

1)  Try communicating with another Levelogger, Optical Reader or Direct Read  
 Cable. The communication cable, Optical Reader or Levelogger may be damaged.

2)  Clean the optical ‘eyes’ on the Levelogger and the cable, with a soft cloth.

3) Check that the communication cable is connected to the same Com Port that is  
 chosen in the upper middle of the Main Window of the Levelogger software.

4) Check the Com port settings. They should be as follows:

• Bits per second: 9600
• Data bits: 8
• Parity: None
• Stop bits: 1
• Flow control: None  
 (This may have been set to Xon/Xoff – change it to None, Select [OK]   
 and back out of this pathway.)

The route to view your Com port settings is as follows:

a. Select Control Panels
b. Double click on System
c. Select the Device Manager Tab
d. Double click on Ports
e. Double click on Communications Port(s)
f. Choose the Port Settings Tab

5)  Try using a different computer, to see if this is the cause of the problem.

6)   If using a laptop (especially in conjunction with a Direct Read Cable) your Com  
 Port may not be powered adequately to receive/transmit data.  Try using a  
 desktop computer to test this, or contact Solinst to obtain a PC Interface Booster  
 Cable.

7) If problem persists, contact Solinst.

'Port Cannot Open’

1)  If using a USB device, ensure you plugged it in before starting the Levelogger  
 Software.

2) Ensure the correct Com Port is selected in the upper middle of the Main Window  
 of the Levelogger software.

3) If the correct Com Port is not available, a USB Driver installation or update may  
 be required.

4)  Check if some other software is using the same Com Port in the background.   
 Shut that software down or choose another Com Port if available.  Such  
 background software may be anti-virus software or PDA software.
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5) Make sure your Com Port has been enabled: 

a. Select Control Panel
b. Double click on System
c. Select the Device Manager Tab
d. Double click on Ports
e. Double click on Communications Port(s)
f. Choose General 
g. Uncheck ‘Disable in this hardware profile box’

6)  If you are using a virtual Com Port, like a USB optical reader or USB/RS-232  
 converter, refer to the ‘Problems During Installation of RS-232 to USB Converter’  
 section to make sure they are installed properly. 

‘File Create Error’ and ‘File Write Error’

1)  If you do not have file-writing privileges to the Levelogger default data folder,  
 change the folder as follows: in the Levelogger software, click ‘Configuration’  
 then ‘Application Settings’. Under ‘Default Directory’, enter a new destination  
 folder, to which you have file writing privileges, e.g. ‘My Documents’. Follow the  
 same procedure if you have the same problem when you export the data file in  
 csv format. 

2) Ask your System Administrator for assistance.

‘File Open Error’ and ‘File Read Error’

1) Shut down or disable any other software that is active and using the same file.

2) In Notepad or Wordpad, open the <*.xle> or <*.lls> file to check for corruptions  
 in the file.  How are the Levelogger files ended?

3) If problems persist contact Solinst for assistance.

‘Time Span Error, some data cannot be compensated’

1) Find another barometric data file that has the same time stamp as the Levelogger.

2) Perform the compensation (a simple subtraction) in a spreadsheet program for  
 any missing time stamps. 

‘A different type of Levelogger is detected’

Try clicking the Retrieve Settings icon again, or replace the Levelogger currently 
in the Optical Reader with the one that was previously being worked on, and 
complete the operation. 

‘The selected file is not a barometer’

Select a Barologger for the compensation process.

‘Data Corrupted’

Contact Solinst for assistance. Use Levelogger Diagnostic Utility to do a memory 
dump and sent the dump file to Solinst for further analysis.

‘Internal Error’

Contact Solinst for assistance.
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‘Fail to append data - A different Levelogger has been detected!’ or ‘Fail to 
append data - A different start time has been detected!’ or ‘Fail to append 
data - New data is not available in the Levelogger!’ 

The Levelogger software can only append data to a file that has the same serial 
number and start time as the connected Levelogger.  Find the correct file, or use 
‘All Data’ to download the complete file.

‘Only Levelogger Gold/Edge supports this function’

The ‘Append Data’, ‘Partial Download’ and ‘Data Recovery’ functions are 
only supported by the Levelogger Gold/Edge loggers, not previous version 
Leveloggers.

‘Schedule cannot be empty’

When using the ‘Schedule’ sampling option in a Levelogger Gold/Edge, the 
schedule must contain at least one item.

‘Readings in schedule exceed the maximum’

The number of readings in a schedule should not result in more than 40,000 (or 
up to 120,000) individual readings.
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Chapter 1: 
An Overview of HOBOware 
HOBOware software is used for launching, reading out, and plotting data from HOBO® data loggers and wireless 
HOBO data nodes. There are two versions of HOBOware: HOBOware Pro and HOBOware Lite. To upgrade from 
HOBOware Lite to HOBOware Pro, call 1-800-564-4377 and ask for Onset Customer Service.  

HOBOware Pro 
With HOBOware Pro, you can quickly launch, read out, and plot data recorded by HOBO data loggers. You can also: 

• Filter data to extract key series information such as minimum, maximum, or average values 

• Scale data to sensor units 

• Save graphs as project files 

• Export data to Microsoft® Excel® or other ASCII-compatible programs 

• Export multiple files with the Bulk Export Tool 

• View a subset of data with the Subset Statistics Tool 

• Use Data Assistants to create new data series by combining data recorded by the logger with 
additional data that you enter before you display the plot. For example, the kWh Assistant converts 
logged pulse data from an energy transducer to kWh, average kW, and energy cost 

• Set Launch and Readout Time-Saving Options to help you work efficiently with multiple loggers 

• Work in Secure mode for 21 CFR Part 11 compliance 

• Run HOBOnode Manager for configuring and maintaining a wireless HOBO data node network 

HOBOware Pro is compatible with the following devices:  

• HOBO U-Series loggers 

• HOBO Weather Stations, including HOBO U30 Station 

• HOBO Micro Stations 

• HOBO Energy Logger Systems 

• HOBO U-Shuttle and Waterproof Shuttle 

• HOBO FlexSmart Modules 

• HOBO Data Nodes (Wireless Sensors) 

• HOBO 4-Channel Pulse Input (UX120-017) 

• Energy and Power Meter (T-VER-E50B2) 

HOBOware Lite 
HOBOware Lite is entry-level software for HOBO U-Series loggers. With HOBOware Lite, you can: 

• Launch and read out U-Series loggers 
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• Check the logger status and current readings 

• Plot, filter, and export data 

• Save changes to graphs in a project file 

For a comparison between HOBOware Pro and HOBOware Lite, see 
http://www.onsetcomp.com/sites/all/themes/foliage/hoboware_comparison.html. 

Getting Started 
If you are using HOBO data loggers, follow the instructions in the Getting Started Guide to install the software, 
connect your logger, launch, and readout data. You can expect to be comfortable with HOBOware fundamentals 
within a few minutes.  

If you are using HOBO wireless data nodes, refer to HOBOnode Manager. 

For an introduction to the HOBOware interface, see A Tour of the HOBOware Interface. 

Installing HOBOware 
You can install HOBOware by from the Onset website or software CD. Note: You must be an administrator to install 
HOBOware. 

Before you begin the installation: 

• Check the README file at http://www.onsetcomp.com/hoboware or on the installation CD for 
detailed information about the hardware and software needed to run HOBOware. If you have 
additional questions, please contact Onset Technical Support. 

• Make sure you have the license key, which is located in the email confirmation or online receipt you 
received when purchasing the software. If you have a HOBOware CD, the license key is printed on the 
back of the CD case. If you don't have a license key, you can run HOBOware in Trial Mode for 30 days. 

Installing HOBOware from the Onset Website 
To download HOBOware from the Onset website, go to the following URL and follow the instructions for 
downloading and installing HOBOware: 

http://www.onsetcomp.com/products/software 

Installing HOBOware from the Installation CD 

Windows 

1. Insert the CD in your computer’s CD-ROM drive. The installation program should start automatically. If 
it does not, navigate to the CD drive in My Computer or Windows Explorer and double-click 
HOBOware_Setup.exe to launch the HOBOware installer. 

Note: HOBOware for Windows requires the Java Runtime Environment. If the correct Java Runtime 
Environment version is not already installed on your computer, the HOBOware Setup program will ask 
if you want to install it now. (You must be logged in as an administrator on your computer to install the 
Java Runtime Environment.) Click Yes and follow the prompts. After the Java Runtime Environment is 
installed, the HOBOware installation will continue.  

2. Follow the prompts to install HOBOware. 

3. To start HOBOware, double-click the HOBOware icon on your desktop or select Programs> Onset 
Applications > HOBOware from the Start menu. 
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Mac 

1. Insert the CD in your computer’s CD-ROM drive.  

2. Double-click the CD icon in the Finder and double-click the HOBOware.pkg to launch the HOBOware 
installer.  

3. When you reach the final screen of the installation program, click Restart.  

4. After restarting, open HOBOware by double-clicking the HOBOware icon in your computer’s 
Applications folder.  

Activating HOBOware 
The first time you open HOBOware, you will be prompted to enter your license key from the email confirmation, 
online receipt, or the CD case. Type the license key in the License Key Manager and click OK. You will need to 
reopen HOBOware after entering the license key. Note that you will not be required to enter the license key when 
upgrading to subsequent versions of HOBOware. 

 
If you don't have a license key, select "I want to use HOBOware Pro Trial" and click OK. Your trial period of 
HOBOware will last for 30 days. The date the trial will expire appears at the top of the HOBOware window. The 
License Key Manager will continue to appear each time you open HOBOware during the 30 days. Select "I want to 
use HOBOware Pro Trial" and click OK each time you open HOBOware until the trial is over. When the trial expires, 
you will be prompted to enter a license key to continue to use HOBOware. Contact Onset Computer if you'd like to 
purchase the software. 

Running the Setup Assistant (HOBOware Pro) 
The HOBOware Setup Assistant appears the first time you open HOBOware Pro to help you quickly select key 
settings for device types and serial ports, units of measurement, and data assistants. To run the Setup Assistant, 
click Start and follow the prompts to change some key preferences. Click Cancel to use HOBOware Pro with its 
default settings. With the Setup Assistant, you can select: 

• Device Types. Select USB, USB and serial devices, or serial devices only. If you select serial devices, 
you can choose the serial port. 

• Unit System. Select either US or SI units. 

• Data Assistants. Select the installed Data Assistants you want to show when relevant data is 
present. All loaded Data Assistants are checked by default. You can also load a new Data Assistant if 
one is available. 

You can also run the setup assistant at a later time. From the File menu in Windows or the HOBOware menu in 
Macintosh, select Preferences. Click the Setup Assistant button at the bottom of the Preferences window. 
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Checking for Software Updates 
If you have an Internet connection, HOBOware will periodically ask if you would like it to check the Onset website 
for software updates. The default is to check once per week. To change the frequency: 

1. From the File menu in Windows or the HOBOware menu on Macintosh, select Preferences 

2. Select the General category on the left and then click Startup on the right. 

3. Choose the frequency and the type of updates you want to check for and click OK. 

You can also check for updates manually at any time by selecting Check for Software Updates from the Help menu. 

Note: If you are using HOBOnode Manager with a HOBO ZW wireless network, you must stop device 
communication before you can upgrade HOBOware. 

Upgrading HOBOware Lite 
To upgrade from HOBOware Lite to HOBOware Pro, call 1-800-564-4377 and ask for Onset Customer Service. 

New HOBOware Features 
The following new features are available in HOBOware 3.6: 

• Support for the new HOBO 4-Channel Analog logger (UX120-006M), including launch capability, pre-
launch filters, alarms, burst logging, statistics logging (maximum, minimum, average, and standard 
deviation), and the ability to stop and restart logging during a single deployment. 

• A new preference for exporting the information in the Details Pane and series data from the Points 
Table in the same file. 

New Features in Previous Releases 

HOBOware 3.5: 

• Support for the new HOBO 4-Channel Thermocouple logger (UX120-014M), including launch 
capability, pre-launch filters, alarms, burst logging, statistics logging (maximum, minimum, average, 
and standard deviation), and the ability to stop and restart logging during a single deployment. 

• The ability to assign labels to sensors for all logger models in the Launch Logger window, a feature 
previously only available for station loggers, such as the HOBO U30 and Micro Station. 

• Enhancements to the export table data feature, including the ability to set the default order of 
measurement types in the Export Settings preferences and to quickly reorder series in the Export 
window by dragging them. 

HOBOware 3.4.1: 

• Device menu options specific to HOBO U30 Stations are now available through a new "Manage U30" 
menu choice. 

HOBOware 3.4: 

• Support for the new HOBO UX100 series data loggers, including launch capability, pre-launch filters, 
alarms, burst logging, statistics logging (maximum, minimum, average, and standard deviation), and 
the ability to stop and restart logging during a single deployment. 

• Pie charts for loggers with state series that you can view, print, and save as .png files for additional 
analysis beyond line graphs. This is especially helpful for light and occupancy data from UX90-005x 
and -006x loggers. 
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• A firmware upgrade tool that automatically detects when a new firmware file is available for UX90 and 
UX100 series data loggers and walks you through the update process. 

• Improvements to the process of exporting data points, including the ability to select individual series 
or event types and to sort columns. 

• A new preference for setting the logger launch description as the serial number so that you can easily 
differentiate files when launching and reading out several loggers of the same type. 

• The ability to shows gaps in series when merging datafiles or when plotting a UX100 logger that had 
stopped and resumed logging. 

• Improved the Network Map feature in HOBOnode Manager. (This requires a ZW Receiver firmware 
upgrade.) 

• Support for the new Windows 8 operating system. The current list of supported operating systems is 
Windows 8, Windows 7 (Pro, Ultimate, and Home Premium), and Windows XP (Pro and Home) on the 
PC and OS X Versions 10.6.x, 10.7.x, and 10.8.x on Mac. 

Note: The Alarm & Readout Tool is no longer installed with HOBOware as of version 3.4. However, you will still 
have access to the software if it was installed with an older version of HOBOware. 

HOBOware 3.3.2: 

• Support for the following languages and their associated formats in the software user interface: 
Spanish (Spain), Portuguese (Portugal), and German (Germany); Help and user guides are available in 
English only. 

• Improved field calibration accuracy in the Conductivity Assistant. 

HOBOware 3.3.1: 

• Support for the new HOBO U26 Dissolved Oxygen logger, including launch and readout capability, a 
Lab Calibration tool to calibrate the logger to 100% and/or 0% saturation, and a Dissolved Oxygen 
Data Assistant that corrects for measurement drift from fouling and generates salinity-adjusted DO 
concentration as well as percent saturation data. 

• The ability to update firmware for receivers and data nodes in the HOBO ZW Wireless System, with 
the option to update a single device at a time or multiple data nodes in a group. 

• A data encoding preference added to the General preferences that controls whether data in 
HOBOware is imported and exported based on UTF-8 or operating system standards. 

• French language support for the software user interface (Help and user guides are available in English 
only). 

HOBOware 3.3: 

• Support for the new HOBO UX90 series data loggers, including launch capability, advanced sensor 
configuration, and pre-launch filters. The models supported with this release are the 
State/Pulse/Event/Runtime logger (UX90-001x), Light On/Off logger (UX90-002x), Motor On/Off 
logger (UX90-004x), and Occupancy/Light logger (UX90-005x/-006x). 

HOBOware 3.2.2: 

• Enhanced display preferences for sorting data series in the Status and Plot Setup windows. 

• A utility for upgrading the HOBOnode Manager database to improve performance. 

• Performance improvements for the HOBO data nodes data delivery feature. 

• A change to the FTP option for the HOBO data nodes data delivery feature so that it uses passive 
mode, which allows for better connections through firewalls. 



HOBOware User’s Guide 

1-800-LOGGERS 10 www.onsetcomp.com 

• An update to the Conductivity Assistant, which includes refinements in the calculation of temperature 
compensation and a new option for non-linear, sea water compensation based on PSS-78. 

• A revision to the calculation for T-CDI-5200-10S and T-CDI-5400-20S sensors when used with U-Series 
loggers ensuring data is displaying properly. 

• Support for Java 7®. 

HOBOware 3.2.1: 

• The integration of the Alarm & Readout Tool, which is now automatically installed and available for 
use from the Tools menu. 

• The ability for all non-administrator users to run HOBOware on Windows (administrator privileges are 
required to install HOBOware, map and unmap file assocations, and load new Data Assistants). 

• Compatibility with iMac® and MacBook® Pro and Intel® Core™ i5 and i7 processors. 

• A revision to the calculation for the S-SMD Soil Moisture Sensor ensuring data is displaying accurately. 

• The option to create new files or overwrite existing ones via FTP when using the data delivery feature 
for HOBO Data Nodes. This allows you to automatically import wireless node CSV data into other 
applications, such as Microsoft® Excel®. 

HOBOware 3.2: 

• A redesigned launch window for quick logger configuration and easy sensor setup. 

• Faster processing times for opening large data files (512KB and up). 

• The ability to configure filtered series when launching the logger, which automatically generates 
custom series, such as average temperature per day, when you read out the logger and plot data. 

• The ability to configure Pulse Scaling, Linear Scaling, and kWh Data Assistant series when launching 
any logger with applicable external sensors 

• Support for the new HOBO 4-Channel Pulse Input Data Logger (UX120-017x), including advanced 
sensor configuration for setting maximum pulse frequency and lockout times as needed in raw pulse 
and event channels. 

• Support for the new E50B2 Power & Energy Meter (T-VER-E50B2), including single-step configuration 
with the HOBO 4-Channel Pulse Input Data Logger (UX120-017x) and automatic calculation of 
numerous additional data series for analysis. 

• Support for the new HOBO Conductivity Logger (U24-002). 

• The option to disable logging the battery channel by default on some loggers, which can extend 
battery life and memory space. 

Note: Loggers launched in HOBOware 3.2 or later with series created by the Pulse Scaling, Linear Scaling, and kWh 
Data Assistants or with filtered series cannot be read out in earlier versions of HOBOware. 
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A Tour of the HOBOware Interface 
This is the main HOBOware window. Use the menu bar or tool bar to access all the features within HOBOware. The 
status bar at the bottom of the window shows the current view in place (as selected by the Window menu) as well 
as the device currently selected or connected, if any. 

 
This example shows a file that has been opened and plotted. There are three components to a plotted datafile: the 
Points Table, the Details Pane, and the Plot. 

The Points Table 
The Points Table is a list of data points, or values, and logged events displayed in the plot. The Points Table is linked 
to the graph: only the data for the series and events on the plot are listed in the Points Table.  

 
The data points are listed chronologically. Each point or event is listed in a single row and each series or event type 
is displayed in a column. You can resize the columns by clicking and dragging the dividers between the column 
headers. 

Use the arrow keys or scroll bars to move up, down, left, and right in the Points Table. Additionally, as you click the 
crosshair tool  in the plot, the corresponding point is selected in the Points Table. Similarly, if you click a value or 
event cell in the Points Table, the crosshair will appear on the graph at the time corresponding to that cell.  
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To resize the pane, drag the divider between the Points Table and the plot. To hide the Points Table, select Points 
Table from the View menu. 

If you do not want the Points table to be displayed by default when you plot data, open the Preferences, select 
Plotting, and then Layout. Disable the "Show the points table when plotting data" checkbox. 

The Details Pane 
The Details Pane shows information for each series and event displayed in the plot including: 

•  Information about the devices, such as model and serial numbers. 

•  Deployment information, such as the launch description, deployment number, start time and time 
zone, logging interval, and battery voltage at launch.  

•  Series statistics, such as the total number of sensor samples and events, time of the first and last 
sample, and the maximum, minimum, average, and standard deviation for each sensor series in the 
plot, 

•  Audit trail information for secure files, 

 
Click the + or - button to expand or collapse an entry in the Details Pane. Click the Show All/Hide All buttons to 
expand or collapse the entire details tree. 

Click a series node in the details tree to select the corresponding series on the graph and corresponding column in 
the Points Table. 

To resize the pane, drag the divider between the Details pane and the graph. To hide the Details Pane, select 
Details Pane from the View menu. 

If you do not want the Points table to be displayed by default when you plot data, open the Preferences, select 
Plotting, and then Layout. Disable the "Show the details table when plotting data" checkbox. 

The Plot 
The plot displays the data series and events in a graph. The plot has a time axis (x-axis) and a value axis (y-axis) for 
each series selected in the Plot Setup window. The title, displayed at the top of the plot by default, is the 
Description in the Plot Setup window. The legend, displayed to the right of the plot by default, lists the keys for 
each series (line colors and marker types). If the crosshair tool is in use, it also lists the date, time and point values 
currently selected by the crosshair. For secure files (.hsec and .dsec), a padlock icon  appears in the legend next 
to the names of the series that were verified as original data.  
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To show or hide the title or legend, use the View menu. Double-click a plot element (series, axis, title, or 
legend) to change its properties or right-click the plot and select the item from the menu. 

For more details on working with plot, see Reading Out, Plotting, and Analyzing Data. 

Working in Secure Mode: 21 CFR Part 11 Compliance 
You can create secure files in HOBOware Pro to comply with 21 CFR Part 11, or simply to add a level of security 
when working with datafiles. When Secure Mode is enabled, HOBOware Pro begins an audit trail in the logger 
when you launch it and adds an encoded digital signature to the new datafile when you read it out. A digitally 
signed file, or "secure file," has a filename extension of .hsec (for most U-Series loggers) or .dsec (for station-type 
loggers).  

Notes: 

• Issues may arise if you do not always use HOBOware Pro in the Secure Mode, if you sometimes use 
HOBOware Lite, or if you sometimes use a version of HOBOware prior to 2.3.0. The resulting file issues 
are described later in this section. 

• This feature is not available for use with HOBOnode Manager and its associated ZW series data node 
files. 

• Project (.hproj) and export files are not secure, even if you create them from secure files. 

To enable secure mode: 

1. From the File menu in Windows or the HOBOware menu in Mac, select Preferences 

2. Select General and then select Data Verification. 

3. Select the Enable Secure Mode checkbox.  

4. Click OK. When Secure mode is enabled, a padlock icon  appears in the lower right corner of the 
main HOBOware Pro window 

Opening a Secure File and Data Verification 
Secure files can be opened with HOBOware Pro 2.3.0 or greater. You can open .hsec files only with HOBOware Lite 
2.3.0 or greater. 
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Every time you open a secure file – even when you are not in Secure mode – HOBOware verifies the encoded 
digital signature to detect whether the file has been corrupted or tampered with. When a file is verified as secure, 
the padlock icon  appears in the legend next to the series that were verified as original data. 

• Filtered series set up prior to launching or created after readout are not verified. 

• Series that were created as a result of user input after readout, such as running a data assistant or 
entering a constant temperature value for pressure or humidity, are not verified. 

• Series retain their verification status (and padlock icon) when copied and pasted into other plots. 

In the Details pane, audit trail information is displayed under the Data Verification node for each series. HOBOware 
Pro automatically obtains the Launch User and Readout User names from your computer's operating system. To 
save the Launch User name, you must have Secure Mode enabled when you launch the logger. 

If the digital signature cannot be verified when you open a file and even a single bit of data has changed since 
readout, a warning message will appear that verification has failed. This means that the file has been altered or 
become corrupted since it was originally saved. You may still be able to plot the data from the file, but the padlock 
icon will not display in the legend or there will be no signing information in the Details pane. You will still be able to 
perform typical HOBOware functions on the file. 

File Compatibility 
Depending on the type of logger, the version of HOBOware that launched the logger, and the version of 
HOBOware that reads out the logger, the resulting datafile may not be compatible with versions of HOBOware 
prior to 2.3.0 or you may not be able to read out the logger at all. The following files are created when launching 
and reading out in these scenarios: 

• Launching and reading out in non-secure mode with any version of HOBOware. A backward-
compatible datafile (.hobo or .dtf) is created. 

• Launching in non-secure mode with any version of HOBOware and reading out in secure 
mode. A secure file (.hsec or .dsec) is created with an audit trail that lists the readout user, but not 
the launch user. Secure files are not backward-compatible. 

• Launching in secure mode and reading out in a pre-2.3 version of HOBOware. Most U-Series 
loggers cannot be read out. A backward-compatible datafile (.dtf) is created for station loggers. 

• Launching in secure mode and reading out in non-secure HOBOware 2.3. A datafile (.hobo) is 
created for U-Series loggers, but it is not backward-compatible. A backward-compatible datafile 
(.dtf) is created for station loggers.  

• Launching and reading out in secure mode. A secure file (.hsec or .dsec) is created with a full 
audit trail. Secure files are not backward-compatible. 
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Chapter 2 
Working with HOBO Data Loggers 
Working with HOBO data loggers involves the following basic steps: 

1. Connect the logger to the computer for the initial setup and launch. 

2. Launch the logger. Enter or select the appropriate parameters for the logger deployment and then 
launch, or start, the logger. 

3. Check the status of the logger. You have the option of checking the current status of the logger and 
any current readings while it is still connected to the computer. This can be helpful to verify that the 
launch configuration is as expected. 

4. Read out the logger. After deploying the logger, read out all recorded data and save it to a file. Many 
devices also work with shuttles that allow you to keep the logger in the field, but still read out any 
recorded data. You can then bring the shuttle back to the office, connect it to the computer, offload 
and save the files. 

5. Plot the data. After reading out the logger and saving the data, you can select and define the data 
series you wish to plot in a graph. HOBOware Pro also provides Data Assistants for automatic scaling 
of certain data when plotting. 

6. Analyze the data and customize the plot. There are numerous tools available for working with the data 
and changing the plot, such as exporting, filtering, merging files, cropping, and more. 

7. Save changes to the plot as a project file. Changes to the axis, series, plot, and legend properties as 
well as any filtering or merging can be saved as a .hproj file. 

Connecting Devices 
Most HOBO data loggers and shuttles connect to the computer with a USB cable as shipped with the device. The 
HOBO Weather Station, HOBO Micro Station, and HOBO Energy Logger connect to the computer with a serial cable 
(or to a USB port with a Keyspan™ serial adapter). 

Some loggers require an optic USB base station/coupler to connect to the computer. Consult the manual that 
came with your device for specific information about required base stations/couplers or cables. 

Once a device is properly connected to the computer as described below, the device name is listed in the status 
bar at the bottom of the main HOBOware window. 

Notes: 

• For instructions on connecting HOBOware compatible shuttles or using the HOBO Waterproof shuttle 
as a base station, refer to the shuttle's user guide. 

• HOBOware Pro is required for loggers that use a serial cable. 

• For details on working with HOBO ZW Wireless Data Nodes, see HOBOnode Manager. 

• Windows only: If the device has never been connected to this computer before, it may take some time 
for the computer to detect the new hardware and report that it has connected successfully. One or 
more messages will appear, indicating that new hardware has been found. You may also hear a chime. 

• Windows only: Your computer may tell you to reboot before you can use the device. It is not 
necessary to reboot. 
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Connecting a USB logger or Shuttle 
To connect a logger or shuttle to HOBOware using a USB cable: 

1. Open HOBOware. 

2. Plug the large end of the USB interface cable into a USB port on the computer. 

3. Plug the small end of the USB interface cable into the port on the device. 

For instructions on connecting shuttles or using the HOBO Waterproof Shuttle as a base station, refer to the 
shuttle’s user guide.  

Connecting a Serial Device 
To connect a device to a computer using a serial cable: 

1. Open HOBOware Pro. 

2. Plug the 9-pin end of the serial interface cable into a serial port on the computer or Keyspan adapter.  

3. Plug the other end of the serial interface cable into the communications port on the device. (Refer to 
the diagram and instructions that came with the device if you need help finding the port.)  

4. Click the Select Device icon  on the toolbar to ensure that the device is listed in the Select Device 
window. Click the button next to the device in the window, then click OK. 

If you are using a serial port other than COM1 (PC) or Default (Macintosh), you will need to set up HOBOware to 
use another port. To change the serial port: 

1. From the File menu in Windows or the HOBOware menu in Macintosh, select Preferences. 

2. Select Communications. 

3. Select the serial port you want to use. Note that checking multiple serial ports can take some time, 
even when no devices are attached.  

4. Click OK. 

Connecting a Base Station/Coupler 
To connect a logger to a base station/coupler: 

1. Open HOBOware. 

2. Plug the base station/coupler cable into a USB port on the computer. Important: Make sure the 
base/station coupler is the correct model for the logger you want to use. Consult the manual that 
came with the logger if you are not sure. 

3. Attach the logger to the base station/coupler as described in the documentation that came with your 
logger. 

Disconnecting a Device 
To disconnect the device, simply unplug the USB or serial cable or unplug the device from the base 
station/coupler. 

To attach another logger via a base station/coupler, remove the logger, leaving the base station/coupler 
connected and then connect the next logger. 
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Connecting Multiple Devices 
If your computer has multiple USB and serial ports, you can connect multiple devices and work with one at a time 
(HOBOware Lite can only be used for USB Ports). When multiple devices are connected, the Select Device window 
opens every time you select Launch, Readout, Stop, or Status from the Device menu. Click the button next to a 
device on the list to select it, then click OK. The selected action will then proceed. The status bar lists the number 
of devices connected. 

To access the Select Device window at any time, click the Select Device  icon on the toolbar, or choose Select 
Device from the Device menu. 

Click the Blink Device Light button in the Select Device window to verify that you have selected the appropriate 
device. This briefly illuminates the light on the devices that you have selected. If the device does not have a light, 
or if the light is not visible when the devices is in the base station/coupler, simply check the serial number (S/N) on 
your devices to make sure that it matches the one that is selected in this window. 

Notes: 

• If serial devices are selected in Preferences, it may take some time for HOBOware Pro to scan all the 
serial ports. You can select the device you want as soon as it is displayed. You do not have to wait for 
all of the ports to be scanned. 

• Serial devices that you have added or removed are not reflected in the device count until you click the 
Select Device icon on the toolbar to update the device list. 

• If you work with multiple U-Series devices frequently and are using HOBOware Pro, you can set the 
Default Action in the Device menu to Launch and enable Launch Time-Saving Options to work more 
efficiently.  

Launching Devices 
To set up a logger to record data, you must specify several parameters and launch, or start, the logger.  

Tip: Check that the time on the computer is correct before configuring a launch. If it is not correct, close 
HOBOware, update your computer's clock manually or synchronize it with an online time server (if available) and 
then reopen HOBOware. 

To launch a logger: 

1. Connect the logger to the computer. 

2. Click the Launch  icon on the toolbar, or select Launch from the Device menu. 

3. Different messages may appear depending on the state of the logger. Answer each of the prompts 
accordingly. 

A warning appears if the logger has already been launched. Click Yes to continue or click No to cancel. 

For U-Series loggers only (other than the HOBO U30 Station), a warning appears if the logger has 
recorded data since its last readout. Click Yes to proceed to the launch window, or click No to cancel 
the launch and read out the data first. Because loggers are tested before shipping, there may be data 
in your logger the first time you launch it. In this case, it is not necessary to read out the logger. Click 
Yes to proceed. 

4. Select the options for the launch in the Launch Logger window. 

5. Click the Start button when you are finished choosing the launch settings. Note that the text on the 
Start button varies depending on when you chose logging to begin. HOBOware displays the progress 
of the launch and warns you not to unplug the logger while it is being configured. 
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Once the logger begins logging, it will continue logging until the memory is full, it is stopped, or the battery runs 
out. 

Launch Logger Window 
Use the Launch Logger window to set up your logger to record data. The Launch Logger window is divided into the 
following three panes: 

• Logger Information. The name of the logger currently selected appears at the top of this pane, 
which also includes the serial number, deployment number, and current battery level. 

Use the Description field to type up to a 40-character name for the logger deployment. The description 
you enter here will be used as the default file name when you read out the logger and save the data. It 
will also be the default title on the plot. For new loggers, the description defaults to the logger serial 
number. 

Click the Status button in this pane to see the current status of the logger and the settings used on the 
previous launch. 

A User Notes button may also appear for some loggers. Click it to enter more extensive notes about 
the deployment. 

• Sensors. This pane displays a list of the sensors available for the logger. Choose the sensors, or 
channels, that you wish to log in this deployment, select any external sensors you may be using, and 
type labels for sensors as desired. Note that labels may not be applied to some calculated or derived 
channels, such as filtered series. This pane also displays any utilities available for your logger, such as 
Alarms, Scaling, and Filters. 

• Deployment. Use this pane to select the logging interval (the rate at which you want the logger to 
record data) and to choose when the logger should begin recording data. Loggers can be configured to 
start logging immediately or on a specific date/time. Some loggers also can be configured to start at an 
interval or start with push button/coupler start. The coupler start (also known as a triggered start) 
involves removing the logger from its coupler or base station and then taking it to the deployment 
location. When you are ready for logging to begin, insert the logger in the coupler without the base 
station for three seconds. Refer to the logger manual for details. 

This pane also displays the logging duration, which is the approximate time it will take to fill the logger memory 
based on the logging interval, sensors, and other settings currently selected. For some loggers, you can also set a 
sampling interval, choose when to stop logging, and select other options in this pane.  

When you are done choosing the launch settings, click the button in the lower right-hand corner of the window to 
send the settings to the logger. Note that the button text changes based on when you chose to start logging. 

HOBOware Pro Tip: If you will be using the same launch settings for multiple deployments of the same logger type, 
select the Skip Launch Window Next Time checkbox to bypass this window the next time you launch a device. This 
will cause the next logger to be launched with either the previous launch settings or the current logger settings as 
set in Launch Time-Saving Options subcategory of the General preferences. 

The options available in the Logger Launch window vary depending on the type of logger you are using. For more 
details about launching your particular device, refer to the following topics: 

• Launch Options for HOBO UX90 Series Loggers 

• Launch Options for HOBO UX100 Series Loggers and the HOBO 4-Channel Thermocouple Logger 
(UX120-014M) 

• Launch Options for the HOBO 4-Channel Pulse Input Data Logger (UX120-017x) 

• Launch Options for Other U-Series Loggers 

• Launch Options for Station Loggers 
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Launch Options for HOBO UX90 Series Loggers 
The following launch options are available for HOBO UX90 series data loggers. Note that the Launch Logger 
window may vary from the example shown below.  

 

Logger Information 

• Description. Enter a description for the launch, up to 40 characters, in this field. This description is 
used as the default file name when you read out and save the data recorded by the logger. It is also 
the default title of the plot. 

• Serial Number. This is the serial number for the logger. Note that some external sensors or devices 
also have serial numbers, which are not listed here. 

• Deployment Number. This is the number of times (including this time) the logger has been 
launched. Each time you start a new launch, the deployment number increases by one. 

• Battery Level. This shows the current battery level in the logger. 

• Status. Click the Status button to check the logger settings from the previous launch. 

Sensors 

The Sensors List displays all internal and external sensors available for recording data. Choose the sensors, or 
channels, that you wish to log in this deployment. To configure a sensor: 

1. Select the sensor(s) you wish to log. 

2. Choose the measurement to log (e.g. State, Runtime, etc.) from the drop-down list. 

3. Type a label for the sensor, if desired. 
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4. Complete additional details for the sensor. This will vary depending on what the logger will be 
measuring. For most sensors, type a name and select a description pair from the drop-down list. For 
external Pulse channels, click the button for the corresponding channel in the sensor list to select the 
sensor type as shown below. If you select Raw Pulse for the sensor type, you can use Data Assistants 
to set up kWh and pulse scaling information as necessary (HOBOware Pro only), which will also display 
on the logger LCD screen. Note that sensors that support Data Assistants at launch time display the 
kWh and/or scaling icon next to their name. 

 

5. Repeat steps 1 through 4 if your logger supports multiple sensors.  

6. Set the units that display on the logger's LCD screen. When the sensor is configured to log State or 
Runtime, choose either: 

• "Time" to show the total amount of time the switch has been closed or on since 
logging began, ranging from seconds to days; or 

• "%" to show the percentage of time the switch has been closed or on since logging 
began. 

When the sensor is configured to log Pulse or Event, the LCD will display the units in three characters. Accept 
either the default units or type your own three-character units. 

Notes on configuring sensors: 

• Click the Filters button to create additional filtered series for any of the channels you configured. The 
filtered series will then be automatically calculated when you read out the logger and plot the data.  

• Click the Advanced button to access the following settings specific to the logger: Pulse Frequency and 
Lockout Time, Occupancy, and Calibration. 

• When setting up a pulse sensor, consider setting up the launch for a delayed or push button start and 
then connect the sensors/devices later before logging begins. Important: Sensors that are connected 
after logging begins may not log accurate data. 

• The Occupancy/Light logger (UX90-005x/-006x) also automatically generates additional series upon 
reading out the logger to give you combined statistics, such as how long the lights were left on while 
the room was unoccupied. These series will be available in the Plot Setup dialog when opening the 
datafile. 

• You have the option to record the logger's battery voltage at each sample time; this is the last channel 
in the sensors list. Like the other data channels, logging the internal battery channel consumes some 
of the logger's memory. Unless you suspect abnormal battery performance, you do not need to log 
the battery voltage. You can also hide the battery channel with Series preferences (in Preferences, 
select Display, then Series). 

• Note that labels do not apply to calculated or derived channels, such as filtered series. 
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Deployment 

• Logging Interval. Select how often the logger will record data (only available for sensors configured 
to log Pulse or Runtime). You can choose either one of the preset logging intervals or specify a custom 
logging interval. The minimum logging interval is one second and the maximum for most loggers is 18 
hours, 12 minutes, and 15 seconds. The shorter the logging interval, the more quickly memory fills 
and battery power is consumed. See also Multiple Logging Intervals and Fast Logging Intervals. 

• Logging Duration. This lists the approximate time it will take to fill the logger memory based on the 
logging interval and sensors currently selected. This is a theoretical estimate only; battery life and 
frequent state and event logging will affect your deployment. This estimate is only available when the 
sensors are configured to log Pulse or Runtime. For estimates with State and Event logging, refer to 
the logger documentation, also available at http://www.onsetcomp.com/support/manuals. 

• Start Logging. Select when to launch the logger. This defaults to the setting for the logger's previous 
launch (you can change this in HOBOware Pro with the Launch Time-Saving Options subcategory of 
the General preferences). You can choose to launch this logger: 

 Now. Logging begins as soon as you click the Start button in the Launch Logger window. 

 At Interval. Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when 
you choose a one-hour logging interval). The exact start time depends on the logging interval you 
choose. This option is only available when the sensors are configured to log Pulse or Runtime. 

 Push Button. Logging will not start until you press the Start/Stop button on the logger and hold it 
down for at least three seconds. The LCD screen on the logger will display "Start" until you press 
the button. 

 On Date/Time. Logging will begin at a date and time you specify, up to approximately six months 
from the present. The LCD screen will count down to that start date/time and then logging will 
begin. 

• Stop logging. Select when you want the logger to stop logging. You can choose: 

 When memory fills or Never (wrapping). If you select "When memory fills," then the logger will 
stop recording data once the memory is full. If you select "Never (wrapping)," the logger will 
record data continuously until either the logger battery runs out or you stop it. Once the logger is 
full, the newest data will overwrite the oldest data. When wrapping, the memory segment on the 
logger LCD screen will blink. 

 Push button. When this option is selected, the logger will stop recording data when you press the 
Start/Stop button on the logger itself for 3 seconds. The LCD screen on the logger will display 
"Stop" when this option has been selected. 

 Specific stop date. Select the date you want the logger to stop recording data. Choose either a 
preset time or set your own custom date and time. 

• Options. Select "Turn LCD off" if you want the logger to operate in "stealth mode" with the LCD 
screen turned off. You can override this temporarily by pressing the Start/Stop button on the logger. 
The LCD will then remain illuminated for 10 minutes. 

Skip launch window next time (HOBOware Pro)  

Check this box if you would like to bypass the Launch Window the next time you choose Launch from the Device 
menu or click the Launch icon. This will cause the next logger to be launched with either the previous launch 
settings or the current logger settings as set in Launch Time-Saving Options subcategory of the the General 
preferences. 



HOBOware User’s Guide 

1-800-LOGGERS 22 www.onsetcomp.com 

Launch Options for HOBO UX100 Series Loggers and the HOBO  
4-Channel Thermocouple Logger (UX120-014M) 
The following launch options are available for HOBO UX100 series data loggers and the HOBO 4-Channel 
Thermocouple Logger (UX120-014M). Note that the Launch Logger window may vary from the example shown 
below. 

  

Logger Information 

• Description. Enter a description for the launch, up to 40 characters, in this field. This description is 
used as the default file name when you read out and save the data recorded by the logger. It is also 
the default title of the plot. 

• Serial Number. This is the serial number for the logger. Note that some external sensors or devices 
also have serial numbers, which are not listed here. 

• Deployment Number. This is the number of times (including this time) the logger has been 
launched. Each time you start a new launch, the deployment number increases by one. 

• Battery Level. This shows the current battery level in the logger. 

• Status. Click the Status button to check the logger settings from the previous launch. 

Sensors 

The Sensors List displays all sensors available for recording data. Choose the sensors, or channels, that you wish to 
log in this deployment. If connecting a thermocouple, select the appropriate type from the drop-down list. Type a 
label for the sensor, if desired. 

Notes: 
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• Click the Alarms button to set an alarm for this logger. Note that the Logging Mode must be set to 
Normal or Statistics to configure an alarm. For thermocouple loggers (UX100-014M and UX120-014M 
models), alarms can only be configured on thermocouple channels; they are not available on the 
internal 10K thermistor (temperature) channel. 

• Click the Filters button to create additional filtered series for any of the channels you configured. The 
filtered series will then be automatically calculated when you read out the logger and plot the data.  

• You have the option to record the logger's battery voltage at each sample time; this is the last channel 
in the sensors list. Like the other data channels, logging the internal battery channel consumes some 
of the logger's memory. Unless you suspect abnormal battery performance, you do not need to log 
the battery voltage. You can also hide the battery channel with Series preferences (in Preferences, 
select Display, then Series). 

• Note that labels do not apply to all calculated or derived channels, such as filtered series channels. 

Deployment 

• Logging Interval. Select how often the logger will record data. You can choose either one of the 
preset logging intervals or specify a custom logging interval. The minimum logging interval is one 
second and the maximum for most loggers is 18 hours, 12 minutes, and 15 seconds. The shorter the 
logging interval, the more quickly memory fills and battery power is consumed. 

• Logging Mode. Select the type of logging mode you wish to use: Normal, Burst Logging, or Statistics. 
With Burst Logging mode, you can configure the logger to use a different logging interval when 
specific conditions are met. With Statistics mode, you can configure the logger to calculate maximum, 
minimum, average, and standard deviation for all enabled sensors (except battery voltage) during 
logging at a sampling interval you specify. Keep in mind that the more statistics you record, the 
shorter the logger duration and the more memory is required. Once you launch the logger, the 
selected statistics will be displayed on the logger LCD. After you set up Burst or Statistics logging, 
there will be an Edit button next to Logging Mode in the Launch Logger window to make additional 
changes as necessary. Note that Normal or Statistics mode is required if you want to set up alarms for 
the logger. On thermocouple loggers, burst logging and statistics are only available on thermocouple 
channels and not on the internal temperature channel. 

• Logging Duration. This lists the approximate time it will take to fill the logger memory based on the 
logging interval, logging mode, and sensors currently selected. This is a theoretical estimate only; 
battery life and other factors will also affect the deployment.  

• Start Logging. Select when to launch the logger. This defaults to the setting for the logger's previous 
launch (you can change this in HOBOware Pro with the Launch Time-Saving Options subcategory of 
the General preferences). You can choose to launch this logger: 

 Now. Logging begins as soon as you click the Start button in the Launch Logger window. 

 At Interval. Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when 
you choose a one-hour logging interval). The exact start time depends on the logging interval you 
choose. 

 On Date/Time. Logging will begin at a date and time you specify, up to approximately six months 
from the present. The LCD screen will count down to that start date/time and then logging will 
begin. 

 Push Button. Logging will not start until you press the Start/Stop button on the logger and hold it 
down for at least three seconds. The LCD screen on the logger will display "Start" until you press 
the button. 

• Stop Logging. Select when you want the logger to stop logging. You can choose: 
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 When memory fills or Never (wrapping). If you select "When memory fills," then the logger will 
stop recording data once the memory is full. If you select "Never (wrapping)," the logger will 
record data continuously until either the logger battery runs out or you stop it. Once the logger is 
full, the newest data will overwrite the oldest data. When "Never (wrapping)" is selected, a wrap 
indicator icon will display on the logger LCD screen. Note: You cannot select "Never (wrapping)" 
on UX100 series loggers if Burst is selected for the Logging Mode. 

 Push button. When this option is selected, the logger will stop recording data when you press the 
Start/Stop button on the logger for three seconds. The LCD screen on the logger will display 
"Stop" when this option has been selected. 

 Resume logging on next button push. This setting is available when "Push button" is selected as a 
"Stop Logging" option. If you select this option, you can resume logging on a stopped logger by 
pressing the Start/Stop button for three seconds. For example, press the Start/Stop logging button 
on the logger once to stop logging. Then, a few minutes, hours, or even days later when you are 
ready to continue logging, press the Start/Stop button on the logger again and logging will resume 
using the same logging interval from the last launch. You can then continue to start and stop 
logging as often as you'd like during this same deployment. Any gaps between when you stopped 
and restarted logging during this deployment will be reflected on the plotted data when you read 
out the logger. Once you relaunch the logger with HOBOware or the U-Shuttle, a new deployment 
and datafile will begin. The data from the previous deployment will not be carried over to the new 
one. 

 Specific stop date. Select the date you want the logger to stop recording data. Choose either a 
preset time or set your own custom date and time. Note: If you select a specific stop date and also 
have the logger configured to resume logging on the next button push, then the logger will stop 
logging at the date you select regardless of how many times you stop and restart the logger with 
the Start/Stop button. 

• Options. Select "Turn LCD off" if you want the logger to operate in "stealth mode" with the LCD 
screen turned off. You can override this temporarily by pressing the Start/Stop button on the logger. 
The LCD will then remain illuminated for 10 minutes. 

Skip launch window next time (HOBOware Pro)  

Check this box to bypass the Launch Window the next time you choose Launch from the Device menu or click the 
Launch icon. This will cause the next logger to be launched with either the previous launch settings or the current 
logger settings as set in the Launch Time-Saving Options subcategory of the General preferences. 

Important: After you choose the launch settings in this window and click Start, the settings are then loaded into 
the logger. The LCD screen on the logger will display "LOAD" during this process. If you disconnect the logger from 
the USB cable before this process is finished, "Err" will appear on the LCD screen instead. If you see "Err" at any 
point during launch configuration, check the USB connection between the computer and the logger, reopen the 
Launch Logger window and click Start again. 
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Launch Options for the HOBO 4-Channel Analog Logger (UX120-006M) 
The following launch options are available for the HOBO 4-Channel Analog logger (UX120-006M). Note that the 
Launch Logger window may vary from the example shown below. 

 

Logger Information 

• Description. Enter a description for the launch, up to 40 characters, in this field. This description is 
used as the default file name when you read out and save the data recorded by the logger. It is also 
the default title of the plot. 

• Serial Number. This is the serial number for the logger. Note that some external sensors or devices 
also have serial numbers, which are not listed here. 

• Deployment Number. This is the number of times (including this time) the logger has been launched. 
Each time you start a new launch, the deployment number increases by one. 

• Battery Level. This shows the current battery level in the logger. 

• Status. Click the Status button to check the logger settings from the previous launch. 

Sensors 

The Sensors list displays all internal sensors and external channels available for recording data. Choose the sensors, 
or channels, that you wish to log in this deployment. To configure a sensor: 

1. Select the checkbox next to the channel number to enable the sensor. 

2. Select the type of sensor or cable that will be connected to that channel on the logger as shown in the 
following example. 
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3. Type a label for the sensor, if desired. 

4. Type a 3-character description for the units that the LCD will display for that sensor or use the default 
units. 

5. Set up scaling for the sensor, if applicable. Click the Scaling button and enter the scaled values and 
units as recommended in the sensor documentation. 

6. Repeat steps 1 through 5 for each sensor you wish to configure. 

Notes on configuring sensors: 
• Although it is helpful to see the connected sensors/devices when setting up the launch, it is not 

required that you physically connect them while selecting sensor type options. You may set up the 
launch for a delayed or push button start, then connect the sensors/devices later, before logging 
begins. Be sure to connect each sensor into the correct numbered jack based on you configured the 
corresponding channel. Important: Sensors that are connected after logging begins may not log 
accurate data. 

• Click the Filters button to create additional filtered series for any of the channels you configured. The 
filtered series will then be automatically calculated when you read out the logger and plot the data. 

• You have the option to record the logger's battery voltage at each sample time; this is the last channel 
in the sensors list. Like the other data channels, logging the internal battery channel consumes some 
of the logger's memory. Unless you suspect abnormal battery performance, you do not need to log the 
battery voltage. You can also disable the battery channel with Series preferences (in Preferences, 
select Display, then Series).Note that labels do not apply to calculated or derived channels, such as 
filtered series. 

• Although it is possible to set up more than one scaling value for each sensor, only the first scaling value 
for that sensor will be used. 

Deployment 

• Logging Interval. Select how often the logger will record data. You can choose either one of the preset 
logging intervals or specify a custom logging interval. The minimum logging interval is one second and 
the maximum for most loggers is 18 hours, 12 minutes, and 15 seconds. The shorter the logging 
interval, the more quickly memory fills and battery power is consumed. If you did not select any 
channels to log, this field will be disabled. 
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• Logging Mode. Select the type of logging mode you wish to use: Normal, Burst Logging, or Statistics. 
With Burst Logging mode, you can configure the logger to use a different logging interval when specific 
conditions are met. With Statistics mode, you can configure the logger to calculate maximum, 
minimum, average, and standard deviation for all enabled sensors (except battery voltage) during 
logging at a sampling interval you specify. Keep in mind that the more statistics you record, the shorter 
the logger duration and the more memory is required. Once you launch the logger, the selected 
statistics will be displayed on the logger LCD. After you set up Burst or Statistics logging, there will be 
an Edit button next to Logging Mode in the Launch Logger window to make additional changes as 
necessary. Note that Normal or Statistics mode is required if you want to set up alarms for the logger. 

• Logging Duration. This lists the approximate time it will take to fill the logger memory based on the 
logging interval and sensors currently selected. This is a theoretical estimate only; battery life and 
other factors will affect your deployment. 

• Start Logging. Select when to launch the logger. This defaults to the setting for the logger's previous 
launch (you can change this in HOBOware Pro with the Launch Time-Saving Options subcategory of the 
General preferences). You can choose to launch this logger: 

 Now. Logging begins as soon as you click the Start button. 

 At Interval. Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when 
you choose a one-hour logging interval). The exact start time depends on the logging interval you 
choose. 

 Push Button. Logging will not start until you press the button on the logger and hold it down for at 
least three seconds. The Waiting LED will blink on the logger until you press the Start/Stop button. 
Resume logging on next button push. This setting is available when "Push button" is selected as a 
"Stop Logging" option. If you select this option, you can resume logging on a stopped logger by 
pressing the Start/Stop button for three seconds. For example, press the Start/Stop logging button 
on the logger once to stop logging. Then, a few minutes, hours, or even days later when you are 
ready to continue logging, press the Start/Stop button on the logger again and logging will resume 
using the same logging interval from the last launch. You can then continue to start and stop 
logging as often as you'd like during this same deployment. Any gaps between when you stopped 
and restarted logging during this deployment will be reflected on the plotted data when you read 
out the logger. Once you relaunch the logger with HOBOware or the U-Shuttle, a new deployment 
and datafile will begin. The data from the previous deployment will not be carried over to the new 
one. 

 On Date/Time. Logging will begin at a date and time you specify, up to approximately six months 
from the present. The Waiting LED will blink on the logger until logging begins on the selected 
date/time. 

• Stop logging. Select when you want the logger to stop logging. You can choose: 

 When memory fills or Never (wrapping). If you select "When memory fills," then the logger will 
stop recording data once the memory is full. If you select "Never (wrapping)," the logger will record 
data continuously until either the logger battery runs out or you stop it. Once the logger is full, the 
newest data will overwrite the oldest data. 

 Push button. When this option is selected, the logger will stop recording data when you press the 
Start/Stop button on the logger itself for 3 seconds. If you also configured a Push Button start, then 
you must wait 5 minutes after logging begins before you can use the button to stop logging. 

 Specific stop date. Select the date you want the logger to stop recording data. Choose either a 
preset time or set your own custom date and time. 

 Options. Select "Turn LCD off" if you want the logger to operate in "stealth mode" with the LCD 
screen turned off. You can override this temporarily by pressing the Start/Stop button on the 
logger. The LCD will then remain illuminated for 10 minutes. 
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Skip launch window next time (HOBOware Pro)  

Check this box if you would like to bypass the Launch Window the next time you choose Launch from the Device 
menu or click the Launch icon. This will cause the next logger to be launched with either the previous launch 
settings or the current logger settings as set in the Launch Time-Saving Options subcategory of the General 
preferences. 

Important: After you choose the launch settings in this window and click Start, the settings are then loaded into 
the logger. The LCD screen on the logger will display "LOAD" during this process. If you disconnect the logger from 
the USB cable before this process is finished, "Err" will appear on the LCD screen instead. If you see "Err" at any 
point during launch configuration, check the USB connection between the computer and the logger, reopen the 
Launch Logger window and click Start again. 

Launch Options for the HOBO 4-Channel Pulse Input Data Logger 
(UX120-017x) 
The following launch options are available for the HOBO 4-Channel Pulse Input Data Logger (UX120-017x). Note 
that the Launch Logger window may vary from the example shown below. 

 

Logger Information 

• Description. Enter a description for the launch, up to 40 characters, in this field. This description is 
used as the default file name when you read out and save the data recorded by the logger. It is also 
the default title of the plot. 

• Serial Number. This is the serial number for the logger. Note that some external sensors or devices 
also have serial numbers, which are not listed here. 

• Deployment Number. This is the number of times (including this time) the logger has been 
launched. Each time you start a new launch, the deployment number increases by one. 
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• Battery Level. This shows the current battery level in the logger. 

• Status. Click the Status button to check the logger settings from the previous launch. 

Sensors 

The Sensors List displays all internal sensors and external channels available for recording data. Choose the 
sensors, or channels, that you wish to log in this deployment. To configure a channel: 

1. If you are using the logger with an E50B2 Power & Energy Meter, then select “for E50B2 Power 
& Energy Meter” in the Configure Sensors drop-down list at the top of the Sensors pane. This will 
automatically preselect the appropriate channels and pulse scaling factors, which you can then 
customize further in the following steps. 

For all other sensors/devices, select “Manually” in the Configure Sensors drop-down list.  

2. Make sure the checkbox is enabled for the external channel you wish to log. 

3. Choose either Pulse, State, Event, or Runtime from the drop-down list. 

4. For Pulse channels, click the button for the corresponding channel in the sensor list to select the 
sensor type as shown below. If you select Raw Pulse for the sensor type, you can use Data Assistants 
to set up kWh and pulse scaling information as necessary (HOBOware Pro only). You can also adjust 
maximum pulse frequency and lockout time by clicking the Advanced button. Note that sensors that 
support Data Assistants at launch time display the Scaling and/or kWh icon next to their name. 

 
For State and Runtime channels, type a name and select a description. 

For Event channels, type a name, adjust the increment, and type a unit description (or accept the 
default "units" for the description). 

5. Type a label for the sensor, if desired. 

6. Repeat steps 1 through 4 for each channel you wish to configure. 

Notes on configuring sensors: 

• Although it is helpful to see the connected sensors/devices when setting up the launch, it is not 
required that you physically connect them while selecting sensor type options. You may set up the 
launch for a delayed or push button start, then connect the sensors/devices later, before logging 
begins. Important: Sensors that are connected after logging begins may not log accurate data. 

• Click the Filters button to create additional filtered series for any of the channels you configured. The 
filtered series will then be automatically calculated when you read out the logger and plot the data. 

• You have the option to record the logger's battery voltage at each sample time; this is the last channel 
in the sensors list. Like the other data channels, logging the internal battery channel consumes some 
of the logger's memory. Unless you suspect abnormal battery performance, you do not need to log 
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the battery voltage. You can also disable the battery channel with Series preferences (in Preferences, 
select Display, then Series). 

• Note that labels do not apply to calculated or derived channels, such as filtered series. 

Deployment 

• Logging Interval. Select how often the logger will record data. You can choose either one of the 
preset logging intervals or specify a custom logging interval. The minimum logging interval is one 
second and the maximum for most loggers is 18 hours, 12 minutes, and 15 seconds. The shorter the 
logging interval, the more quickly memory fills and battery power is consumed. If you did not select 
any channels to log, this field will be disabled. 

• Logging Duration. This lists the approximate time it will take to fill the logger memory based on the 
logging interval and sensors currently selected. This is a theoretical estimate only; battery life and 
frequent state and event logging will affect your deployment. If you are logging only state changes 
and events, no estimation is possible. 

• Start Logging. Select when to launch the logger. This defaults to the setting for the logger's previous 
launch (you can change this in HOBOware Pro with the Launch Time-Saving Options subcategory of 
the General preferences). You can choose to launch this logger: 

 Now. Logging begins as soon as you click the Start button. 

 At Interval. Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when 
you choose a one-hour logging interval). The exact start time depends on the logging interval you 
choose. 

 Push Button. Logging will not start until you press the button on the logger and hold it down for at 
least three seconds. The Waiting LED will blink on the logger until you press the Start/Stop button.  

 On Date/Time. Logging will begin at a date and time you specify, up to approximately six months 
from the present. The Waiting LED will blink on the logger until logging begins on the selected 
date/time. 

• Stop logging. Select when you want the logger to stop logging. You can choose: 

 When memory fills or Never (wrapping). If you select "When memory fills," then the logger will 
stop recording data once the memory is full. If you select "Never (wrapping)," the logger will 
record data continuously until either the logger battery runs out or you stop it. Once the logger is 
full, the newest data will overwrite the oldest data. 

 Push button. When this option is selected, the logger will stop recording data when you press the 
Start/Stop button on the logger itself for 3 seconds. If you also configured a Push Button start, 
then you must wait 5 minutes after logging begins before you can use the button to stop logging. 

 Specific stop date. Select the date you want the logger to stop recording data. Choose either a 
preset time or set your own custom date and time. 

• Options. Select "Turn LEDs off" if you want the logger to operate in "stealth mode," which disables 
the Logging LED on the logger. The Waiting LED and the Test button/Activity lights will still remain 
operational when this option is selected. 

Skip launch window next time (HOBOware Pro)  

Check this box if you would like to bypass the Launch Window the next time you choose Launch from the Device 
menu or click the Launch icon. This will cause the next logger to be launched with either the previous launch 
settings or the current logger settings as set in the Launch Time-Saving Options subcategory of the General 
preferences. 
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Launch Options for Other U-Series Loggers 
The following launch options are available for USB U-Series loggers other than the UX90, UX100, and UX120-017x. 
Note that the Launch Logger window may vary from the example shown below. 

 

Logger Information 

• Description. Enter a description for the launch, up to 40 characters, in this field. This description is 
used as the default file name when you read out and save the data recorded by the logger. It is also 
the default title of the plot. 

• Serial Number. This is the serial number for the logger. Note that some external sensors also have 
serial numbers, which are not listed here. 

• Deployment Number. This is the number of times (including this time) the logger has been 
launched. Each time you start a new launch, the deployment number increases by one. 

• Battery Level or State. This shows the current battery level in the logger or whether the battery 
state is good or bad (depending on the logger model). 

• Status. Click the Status button to check the logger settings used in the previous launch. 

Sensors 

The Sensors List displays all internal sensors and external channels available for recording data. Choose the 
sensors, or channels, you wish to log in this deployment. To configure an external sensor: 

1. Make sure the checkbox is enabled for the external channel you wish to configure. 

2. Click the button for the corresponding channel in the sensor list to select the sensor type as shown 
below. If the external sensor has not been configured, the button reads <Sensor Type Not Selected>. 
Otherwise, the previous sensor type selected will be displayed on the button. 

3. Select the measurement category and then the specific sensor part number and range (if applicable). 
Note that the sensor part number must match the part number listed on the shrink tube on the sensor 
cable to record accurate data. 

4. Type a label for the sensor, if desired. 

5. Repeat steps 1 through 4 for each additional external sensor you wish to configure. 

Notes on configuring sensors: 
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• Although it is helpful to see the connected sensors when setting up the launch, it is not required that 
you connect the sensors during launch set-up. You may set up the launch for a delayed or push button 
start, then connect the sensors later, before logging begins. Important: Sensors that are connected 
after logging begins will not log any data. Alternatively, if you select an external channel, but do not 
plug the sensor in, false data will be recorded for that channel. 

• Some loggers with RH or pressure sensors require that you also select the internal temperature sensor 
to log relative humidity or pressure. The dependency may be noted in the sensors list (see Relative 
Humidity channel in the example above). Refer to the manual that came with your logger for 
additional information. 

• When both the internal temperature and RH sensors are selected, dew point will be calculated 
automatically. 

• If external events or states are available for your logger, you can enter names to identify the event 
and state channels that are in use. You can also rename the Open and Closed descriptions for each 
state, and enter increments and units for each event channel. 

• HOBOware Pro Data Assistants let you create new data series by combining data recorded by the 
logger with additional data. When you use a Data Assistant from the Launch Logger window, the 
parameter set is saved and applied to data every time you read out a logger or open the resultant 
data file. The derived data is also shown when you check the latest readings in the Status window. 
Click the Scaling button to access the Data Assistants window and choose the Linear Scaling or Pulse 
Scaling Assistant. Click the Create button to run the assistant. After you enter values, click Save. 
Sensors that support Data Assistants at launch time display the Scaling icon next to their name. 

• Some loggers have alarm functionality. Click the Alarms button, if available, to set alarms as desired. 
Sensors that have alarm functionality display the Alarms icon next to their name. 

• Click the Filters button to create an additional filtered series, such as average temperature per day, 
automatically when you read out the logger and plot the data. 

• You have the option to record the logger's battery voltage at each sample time; this is the last channel 
in the sensors list. Like the other data channels, logging the internal battery channel consumes some 
of the logger's memory. Unless you suspect abnormal battery performance, you do not need to log 
the battery voltage. You can also disable the battery channel with Series preferences (in Preferences, 
select Display, then Series). 

• Note that labels do not apply to calculated or derived channels, such as filtered series. 

Deployment 

• Logging Interval. Select how often the logger will record data. You can choose either one of the 
preset logging intervals or specify a custom logging interval. The shorter the logging interval, the more 
quickly memory fills and battery power is consumed. If you did not select any channels to log, this 
field will be disabled. See also Multiple Logging Intervals and Fast Logging Intervals. 

• Logging Duration. This lists the approximate time it will take to fill the logger memory based on the 
logging interval and sensors currently selected. This is a theoretical estimate only; battery life and 
frequent state and event logging will affect your deployment. If you are logging only state changes 
and events, no estimation is possible. 

• DO Sensor Cap Expires (HOBO U26 Dissolved Oxygen logger only). If a DO sensor cap is 
installed on the U26 logger, the date the cap expires is listed. The logger will not collect any data after 
the cap expires. For more details on the DO sensor cap, see Working with the HOBO U26 Dissolved 
Oxygen Logger. 
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• Start Logging. Select when to launch the logger. This defaults to the setting for the logger's previous 
launch (you can change this in HOBOware Pro with the Launch Time-Saving Options subcategory of 
the General preferences). For U-Series loggers, you can choose to launch the logger: 

 Now. Logging begins as soon as you click the Start button. 

 At Interval. Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when 
you choose a one-hour logging interval). The exact start time depends on the logging interval you 
choose. 

 Push Button/Using Coupler. (Available only on certain loggers.) Logging will not start until you 
press the button on the logger and hold it down for at least three seconds, or return the logger to 
the coupler without the base station for at least three seconds (refer to your logger manual for 
more information). If the logger has a light, it will flash quickly when logging begins. 

 On Date/Time. Logging will begin at a date and time you specify, up to approximately six months 
from the present. 

Skip launch window next time (HOBOware Pro)  

Check this box if you would like to bypass the Launch Window the next time you choose Launch from the Device 
menu or click the Launch icon. This will cause the next logger to be launched with either the previous launch 
settings or the current logger settings as set in the Launch Time-Saving Options subcategory of the General 
preferences. 

Launch Options for HOBO U30 and Other Station Loggers 
The following launch options are available for Station loggers, which connect to the computer via serial cable 
instead of USB cable. Note that the Launch Logger window may vary from the example shown below. 
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Logger Information 

• Description. Enter a description for the launch, up to 40 characters, in this field. This description is 
used as the default file name when you read out and save the data recorded by the logger. It is also 
the default title of the plot. 

• Serial Number. This is the serial number for the logger. Note that some external sensors also have 
serial numbers, which are listed in the Sensors pane. 

• Deployment Number. This is the number of times (including this time) the logger has been 
launched. Each time you start a new launch, the deployment number increases by one. 

• Battery Level. This shows the current battery level in the logger. 

• User Notes. Click this button to type up to 2000 characters of information about the deployment. 
This text will be displayed in the Details pane after you read out the logger and plot the data. 

• Status. Click the Status button to check the logger settings from the previous launch. 

Sensors 

Only the sensors that are currently plugged in or built into the logger are listed. Sensors are listed in ascending 
order by serial number, regardless of their physical position in the logger. If you add or remove sensors, click the 
Refresh button to make sure your changes are seen by the logger and displayed in this list.  

You can assign a name to each sensor (up to 30 characters). This is helpful if you want to specify a location where 
the sensor will be placed or if you need to differentiate multiple sensors of the same type. 

Sensors must be connected prior to launching if you will be entering a name for the sensor or configuring 
FlexSmart modules or Analog Sensor Ports (use the Configure button to the right of the Label field). Otherwise, 
sensors do not have to be connected when setting up the launch. You may set up the launch for a delayed or push 
button start, then connect the sensors later before logging begins. 

Notes about configuring sensor channels: 

• Do not attach more than 15 channels of sensors. The logger cannot accommodate more than 15 
channels. 

• In addition to logging up to 15 channels, the HOBO Energy Logger and HOBO U30 Station can record 
their internal battery channel (other sensors must be attached; the logger cannot log battery alone). 
The logger's battery voltage is recorded at each interval. However, logging the internal battery 
channel consumes some of the logger's memory. Unless you are using excitation power or suspect 
abnormal battery performance, you probably do not need to log the battery voltage in loggers other 
than the HOBO U30 Station. 

• Always enable the logger's internal battery channel when logging with excitation power. This will help 
you determine whether and when excitation power was turned off during a deployment. 

• HOBOware Pro Data Assistants let you create new data series by combining data recorded by the 
logger with additional data. When you use a Data Assistant from the Launch Logger window, the 
parameter set is saved and applied to data every time you read out a logger or open the resultant 
data file. The derived data is also shown when you check the latest readings in the Status window. You 
can use the following Data Assistants from the Launch window (others can only be used from the Plot 
Setup window): Pulse Scaling, Linear Scaling, and kWh. This feature is available for the HOBO U30, the 
HOBO H21 (Weather Station and Micro Station) and the HOBO H22 (Energy Logger) loggers. Click the 
kWh or Scaling button to access the Data Assistants window. Select the desired assistant and click the 
Create button to run the selected assistant. After you enter values, click Save. Sensors that support 
Data Assistants at launch time display the Scaling and/or kWh icon next to their name. 

• Click the Filters button to create an additional filtered series, such as average temperature per day, 
automatically when you read out the logger and plot the data. 
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• Note that labels do not apply to calculated or derived channels, such as filtered series. 

Deployment 

• Logging Interval. Select how often the logger will record data. You can choose either one of the 
preset logging intervals or specify a custom logging interval. The minimum logging interval is one 
second and the maximum for most loggers is 18 hours, 12 minutes, and 15 seconds. The shorter the 
logging interval, the more quickly memory fills and battery power is consumed. Some sensors 
(specifically, the FlexSmart TRMS modules) require a logging interval of two seconds or greater. If you 
choose a faster logging interval, erroneous data will be logged on these channels. 

• Sampling Interval. The sampling interval allows you to take multiple measurements within the 
logging interval, then average them together to create a single logged measurement. The sampling 
interval is optional and is valid only for sensors that support measurement averaging. Refer to the 
sensor's user manual to determine whether measurement averaging is available on the sensor. If you 
have at least one sensor that supports measurement averaging, click the Enable button, then set the 
sampling interval at less than or equal to the logging interval (up to four minutes). Rapid sampling 
(faster than one minute) will reduce the logger's battery life. If you do not have any sensors with 
measurement averaging or wish to turn off the sampling interval, click the Disable button. 

• Logging Duration. This lists the approximate time it will take to fill the logger memory based on the 
logging interval and sensors currently selected. This is a theoretical estimate only; battery life and 
frequent state and event logging will affect your deployment. If you are logging only state changes 
and events, no estimation is possible. If you add or remove sensors while viewing the Launch window, 
click the Refresh button to get an updated Logging Duration. 

• Start Logging. Select when to launch the logger. This defaults to the setting for the logger's previous 
launch (you can change this in HOBOware Pro with the Launch Time-Saving Options subcategory of 
the General preferences). You can choose to launch the logger: 

 Now. Logging begins as soon as you click the Start button. If you do not have at least one sensor 
attached, the logger will not launch. 

 At Interval. Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when 
you choose a one-hour logging interval). The exact start time depends on the logging interval you 
choose. 

 Push Button. Logging will not start until you press the button on the logger and hold it down for at 
least three seconds. If the logger has a light, it will flash quickly when logging begins. This is not 
available for the U30 Station. 

 On Date/Time. Logging will begin at a date and time you specify, up to approximately six months 
from the present. 

 Save Settings in Logger. Logging will not start, but the launch settings will be saved so that you do 
not have to re-enter them when you are ready to launch at a later time. The next time you view 
the Launch window for this logger, the settings you entered will still be in place. 

• Stop Logging. There are two options for stopping the logger: either "when memory fills" or "never 
(wrapping)." If you select "when memory fills," then the logger will stop recording data once the 
memory is full. If you select "never (wrapping)," the logger will record data continuously until either 
the logger battery runs out or you stop it. Once the logger is full, the newest data will overwrite the 
oldest data. 

Skip launch window next time (HOBOware Pro)  

Check this box if you would like to bypass the Launch Window the next time you choose Launch from the Device 
menu or click the Launch icon. This will cause the next logger to be launched with either the previous launch 
settings or the current logger settings as set in the Launch Time-Saving Options subcategory of the General 
preferences. 
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Note: For additional details on launching the HOBO U30 Station, see Working with the HOBO U30 Station. 

Multiple Logging Intervals 
Some loggers can be configured with multiple logging intervals, which allow you to define separate intervals for 
different phases of the deployment. 

To configure multiple logging intervals: 

1. From the Device menu, select Launch. 

2. In the Launch Logger window, click the Add New Interval button for each interval you wish to add (the 
maximum number of intervals allowed varies by logger model). If there is no Add New Interval button, 
then the logger does not support multiple logging intervals. 

3. Set the hours, minutes, and seconds for each interval, and the number of samples you want the logger 
to record at each interval.  

4. Use the Start and End times in the Duration column to decide how many samples to record at each 
interval. Note: Because internal logger events, such as coupler events, do take up some of the 
logger's memory, the number of samples and end times are only estimates. Frequent events will 
cause the logger to fill up sooner. 

5. Set any other launch options and click Start. 

To delete an interval, click the Remove button next to the interval in the Launch Logger window. 

Fast Logging Intervals 
Some loggers can be configured with fast logging intervals, which allow you to log more than once per second, up 
to 100 measurements per second (hertz).  

To use fast logging intervals: 

1. From the Device menu, select Launch. 

2. In the Launch Logger window, click the Fast button. If there is no Fast button, then the logger does not 
support fast logging intervals. 

3. Choose a logging frequency from the Hertz drop-down list or enter the logging interval in decimal 
form in the Sec field. 

4. Set any other launch options and click Start. 

Notes: 

• A logger cannot communicate with a computer or shuttle while it is logging at a fast interval. The 
logger will stop logging if you connect the logger to a computer, base station, or shuttle while it is 
logging in fast interval mode. 

• Be aware that a fast logging interval typically means a very short logging duration. Make sure the 
logger will run long enough to collect the data you need. Disabling unnecessary channels can extend 
the logging duration and help to compensate for decreased duration while operating in fast interval 
mode. 

• Because fast logging deployments are so brief, the logger must be launched with a coupler or button 
start. Follow the instructions that came with your logger for a trigger (coupler or button) start. If the 
logger has a light, it will flash quickly when logging begins. 
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Setting a Default Action on Multiple U-Series Devices 
By default, HOBOware does not take any action when you connect a device. You can change this behavior by 
setting a default action to Launch, Readout, or Get Status. This can save you time when working with multiple 
loggers of the same type. Note: This feature is only available with HOBOware Pro and U-Series loggers. 

To set a default action: 

1. From the Device menu, select Default Action. 

2. Select Launch, Readout, or Get Status. 

If you set the default action to launch, you can also change the preferences to automatically populate the Launch 
Logger window with the same settings as the previous launch. This is helpful if you are launching numerous loggers 
of the same type with the same settings. To set this preference: 

1. Select Preferences from the File menu in Windows or the HOBOware menu in Macintosh. 

2. Select General and then select Launch Time-Saving Options. 

3. For the "Fill launch window with contents of" setting, select Previous Launch. 

4. Click OK. 

When a device is connected, the default action you set will take place automatically. For example, if you chose 
Readout, HOBOware Pro will read out the logger immediately. You can then disconnect that logger, connect 
another logger, and the next logger will be read out automatically. If you connect a shuttle, the shuttle's new files 
will be offloaded automatically. Similarly, if you chose Launch for the Default Action, the Launch Logger window 
will open automatically when you connect the logger. The next time you connect a logger of the same time, the 
Launch Logger window will open automatically and be populated with the previous launch settings if you 
configured the Launch Time-Saving Options in the Preferences. A note will appear in the Launch Logger window 
when this preference is in use. 

Important Note for Windows: The first time you connect a device, the Default Action may not be triggered. After 
the device has been connected to the computer and disconnected at least once, the Default Action should then be 
triggered.  

Using Launch Utilities 
There are several utilities available from the Launch Logger window for setting up customized data series, 
configuring alarms, and setting advanced logger options. These utilities vary depending on the type of logger you 
are using. They include: 

• Scaling 

• Filters 

• Alarms 

• Advanced Sensor Properties: Pulse Frequency and Lockout Time 

• Advanced Sensor Properties: Calibration 

• Advanced Sensor Properties: Occupancy 

• Statistics: Maximum, Minimum, Average, and Standard Deviation 

• Filtered Series vs Statistics Logging 

• Burst Logging 
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Filter Series at Launch 
As part of the launch setup, you can create a filtered series that automatically calculates additional values, such as 
maximum, minimum, average, or total, for a set interval upon readout of the logger. The filtered series is saved as 
an additional series in the datafile so it is always available when plotting your data. This saves you the time of 
manually filtering data for each series after readout using the regular HOBOware filter tool, although this tool is 
still available should you need to further filter data later. 

To set up a filtered series at launch: 

1. Select the channel, or sensor type, you wish to filter. 

 

2. Select the type of filter and the interval you wish to use. In this example, the type of filter is "Average 
Temperature" in every hour. Filters vary depending on the channel's measurement type. 

 

3. Edit the Resultant Series Name as desired and click Create New Series. In this example, the Resultant 
Series Name is edited to be "Avg Hourly Temperature." 

 

4. The newly created series is added to the Filtered Series list as shown below. 

To make a change to a filtered series, either double-click the series name or select the series name and 
click Edit. 

To delete a filtered series, select the series name and click Delete. 
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5. Repeat steps 1 through 4 to create additional filtered series. Not only can you create filtered series for 
all channels, but you can also create multiple filtered series on a single channel (for example, you can 
show the maximum, minimum, and average temperature for a single temperature channel). 

6. Click Done when finished. The number of filtered series that you created is displayed on the Filter 
button in the Logger Launch window. 

7. After you launch the logger and read it out, the filtered series will automatically be listed in the Plot 
Setup dialog, from which you can select the series you wish to plot. Note: If you change the 
GMT offset for the filtered series, the data points will not reflect that change. They will continue to be 
filtered based on times within the original GMT offset at launch. 

Notes: 

• Loggers launched in HOBOware 3.2 with series created by the Pulse Scaling, Linear Scaling, and kWh 
Data Assistants or with filtered series cannot be read out in earlier versions of HOBOware. 

• Filtered series created at launch time are not available for use with the Barometric Compensation, 
Grains Per Pound, and Conductivity Data Assistants. 

See also: 

• Filtered Series vs. Statistics Logging 

Data Assistants Window (Scaling) 
When you run a Data Assistant from the Launch Logger window, you can create a derived series, which is an 
additional data series automatically calculated each time you read out the logger. The Data Assistants window lists 
only those assistants available for the currently selected sensor and logger at launch time. There may be other 
Data Assistants available for use after reading out the logger. 

To set up a derived series with a Data Assistant: 

1. Select the Data Assistant you wish to use and click Create. 

2. Select the information, or scaling parameters, you want the series to contain and click Save. 

3. The new series appears in the My Derived Series list. Create additional series as desired. 

To make a change to a derived series, either double-click the derived series name or select it and then 
click Edit. 
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To delete a derived series, select the series and then click Delete. 

4. After you have finished creating or editing the derived series, click Done. Depending on the type of 
logger you are using, the total number of derived series created appears on the kWh and/or Scaling 
buttons in the Launch Logger window. Derived series are also listed in the Status window. 

After you launch the logger and read it out, the derived series will automatically be listed in the Plot Setup 
dialog, from which you can select the series you wish to plot. 

Notes: 

• Loggers launched in HOBOware 3.2 with series created by the Pulse Scaling, Linear Scaling, and kWh 
Data Assistants or with filtered series cannot be read out in earlier versions of HOBOware. 

• When setting up kWh or scaling for UX90 series loggers, the scaled series information will appear on 
the LCD screen on the logger. In addition, only the Energy series appears on the LCD screen when 
configuring kWh. Average power and cost series will not display on the screen; they are available in 
HOBOware only. 

• Although it is possible to set up more than one scaling value for each sensor on the HOBO 4-Channel 
Analog logger (UX120-006M), only the first scaling value for that sensor will be used. 

Configure Alarms 
You can set an alarm to trip when a sensor reading rises above or falls below a specified value on certain logger 
models, including the UA-001, U14-00x, UX100 series and UX120-014M loggers. Note: The U30 Station also has 
alarms capability; see Setting Alarms on a HOBO U30 Station for more details. 

To set an alarm: 

1. If the Alarms window is not already open, click the Alarms button from the Launch Logger window. If 
there is no Alarms button, then the logger does not have alarm capability. If the Alarms button is 
disabled, be sure you have enabled logging on a sensor that supports alarms. If the Alarms button is 
disabled for a UX100 series or UX120-014M logger, make sure the Logging Mode is not set to Burst. 
Alarms are not available for UX100 series and UX120-014M loggers when the Logging Mode is set to 
Burst in the Launch Logger window. 
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2. In the Alarms window, select the sensor that you want to have an alarm. Note: The example below is 
for a UX100 series logger. Any differences for other logger models are noted in these steps. 

  

3. Select the High Alarm checkbox if you want an alarm to trip when the sensor reading rises above the 
high alarm value. Type the reading next to the High Alarm checkbox or drag the red upper slider. In 
this example, we've set an alarm to trip when the temperature rises above 85°F. 

4. Select the Low Alarm checkbox if you want an alarm to trip when the sensor reading falls below the 
low alarm value. Type in the reading next to the Low Alarm checkbox or drag the blue lower slider. In 
this example, we've set an alarm to trip when the temperature falls below 32°F. 

Note: The actual values for the high and low alarm limits are set to the closest value supported by the 
logger. For example, the closest value to 85°F that the UX100 series logger can record is 84.990°F and 
the closest value to 32°F is 32.043°F. In addition, alarms can trip or clear when the sensor reading is 
within the logger specifications of 0.02°C resolution. This means the value that triggers the alarm may 
differ slightly than the value entered. For example, if the High Alarm is set to 75.999°F, the alarm can 
trip when the sensor reading is 75.994°F (which is within the 0.02°C resolution). 

5. Set the "Number of out-of-range samples <displayed> (UX100 series, UX12-014M, and U14-00x) 
<logged> (UA-001) before alarm is raised," which is the number of samples that are needed to trigger 
each alarm. For example, we've set this number to 5. This means there will need to be 5 sensor 
readings above 85°F or below 32°F before the alarm will trip. The time indicates how long it would 
take for the alarm to trip based on the number of samples you entered and the logging interval (UA-
001 loggers) or the LCD refresh rate (UX100 series, UX120-014M, and U14-00x). In the example above, 
it would take 1 minute for the alarm to trip (only if Consecutive is selected as described in the next 
step). Note: The UA-001 and U14-00x loggers have two "Number of out-of-range samples...." fields: 
one for the high alarm and a separate one for the low alarm.  

6. UX100 series, UX120-014M, and UA-001 loggers only: Select either Cumulative or Consecutive for the 
Sensor Alarm Mode. If you select cumulative, then the alarm will trip after a specific number of 
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samples (as set in the previous step) are outside the limits (the high or low samples do not need to be 
consecutive). If you select Consecutive, then the alarm will trip after a specific number of samples (as 
set in the previous step) outside the limits are logged in a row. In the example above, if there are 5 
readings in a row above 85°F, then an alarm will trip. If we had chosen Cumulative, the 5 readings 
could have taken place at any time during the deployment for the alarm to trip. 

7. UX100 series, UX120-014M, and U14-00x loggers only: Choose how long the logger should maintain 
the sensor alarm once it has tripped. Select "Host has relaunched logger" if you want the alarm to 
remain visible on the LCD until the next time you relaunch the logger. Select "Sensor reading within 
limits" if you want the alarm to clear once the sensor reading returns to the normal range between 
the high and low alarm limits. UX100 series and UX120-014M loggers have an additional option; select 
"Cleared with button press" if you want the alarm to remain on and visible on the LCD until you press 
the Alarm button on the logger. 

8. U14-00x loggers only: You can set the Relay Contacts to Normally Open or Normally Closed as 
described in the logger manual. Click the Test Set Alarm button to test the relay switches. Deselect the 
"Set Alarm on Low Battery" checkbox if you do not want an alarm to trip when the logger's battery is 
running low. 

9. Click OK to save the alarm settings and return to the Launch Logger window. 

Once the logger is launched, alarms will trip as determined by these settings. Logger alarms will display on the LCD 
screen for UX100 series, UX120-014M, and U14-00x loggers. For UA-001 loggers, a "high" or "low" LED will blink 
when an alarm is tripped. Note for UX100 series, UX120-014M, and U14-00x loggers: The alarm limits are only 
checked when the logger's LCD screen refreshes. This is every 15 seconds for UX100 series and UX120-014M 
loggers and every 30 seconds for U14-00x loggers. Therefore, if you set the logging interval to less than 15 seconds 
on a UX100 series or UX120-014M logger or less than 30 seconds on a U14-00x logger and the sensor reading falls 
outside the alarms limits, the alarm will not trip until the next refresh cycle. (UA-001 loggers check the alarm 
alarms at every logging interval.) 

When you read out the logger, high and low alarm levels will be displayed on the plot. In the example below, the 
temperature rose above 85°F so those readings are in the red, or high alarm, portion of the plot. The temperature 
never fell below the low alarm limit, which is the blue portion at the bottom of the plot. UX100 series and UX120-
014M loggers also display alarm events showing when the alarm tripped (and cleared if applicable). In this 
example, there are "Chan 1 Alarm Tripped" and "Chan 1 Alarm Cleared" events showing when the temperature 
alarm tripped and cleared. The "Chan 1 Alarm Cleared" event contains the value that was furthest out of range for 
the sensor before the alarm cleared (see the Points table for the actual value). 
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Advanced Sensor Properties: Pulse Frequency and Lockout Time 
Use the Advanced Sensor Properties window to set the maximum pulse frequency for raw pulse channels and to 
specify a lockout time for raw pulse and event channels, which prevents false readings from mechanical sensors as 
their relay state changes. 

Setting maximum pulse frequency is not required, but it can help optimize logging duration. The maximum pulse 
frequency, multiplied by the logging interval, determines the maximum count of pulses possible within each 
interval. The logger then can use this value to adjust the amount of memory (bits) used to log each data point. This 
means the logger uses memory as efficiently as possible, which in turn maximizes logging duration. 

To configure maximum pulse frequency and lockout time: 

1. Select the sensor that corresponds with the pulse channel you wish to configure. 

2. Set the maximum pulse frequency, which controls how many pulses per second can be processed by 
the logger on a single pulse channel. The option to set the maximum pulse frequency is only available 
for raw pulse channels (sensors for which you have selected Raw Pulse as the sensor type in the 
Launch Logger window). Refer to the specifications in your sensor or device documentation for 
recommended maximum pulse frequency values. In general, the larger the maximum pulse frequency, 
the shorter the logging duration will be for the deployment. Note that the pulse frequency ranges in 
this window vary depending on the logger model. 

 

3. Click the "Apply lockout time" checkbox if you wish to specify a time period when pulses will be 
ignored. Select the lockout time value from 1 to 10. On sensors with both pulse frequency and lockout 
time settings, lockout time will affect the maximum pulse frequency: the higher the lockout time, the 
lower the maximum pulse frequency will be.  

Notes: 

• If the logger has multiple sensors, then all sensors will have the same lockout time. 
This means if you are using multiple sensors with different lockout time requirements, 
this may result in lost pulses or false pulses. 

• Lockout time is only available for raw pulse channels and event channels. 

• When lockout time is enabled, you can specify a value from 1 to 10 (with a default of 
5), which is then multiplied by 100 milliseconds for a range of 0.1 to 1 second. The 
available range for the maximum pulse frequency is automatically recalculated based 
on the lockout time. For example, if the lockout time is set to 2, the maximum pulse 
frequency range changes to 0.01 to 5 Hz. The maximum pulse frequency also varies 
depending on the logger model. Refer to the specifications in the logger 
documentation for maximum pulse frequency (documentation is also available at 
http://www.onsetcomp.com/support/manuals). 
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4. Click Save. Note that the selections will not take effect in the logger until you launch it. 

Advanced Sensor Properties: Calibration 
Use the Advanced Sensor Properties window to set the calibration method used for internal light or motor sensors 
in UX90 series data loggers. The default calibration method is to "calibrate from logger," which is an auto-
calibration procedure using the Calibrate button on the logger. Alternatively, you can set the calibration method to 
a maximum or minimum sensitivity level as defined by HOBOware. To change the calibration method: 

1. Select the sensor that corresponds with the internal light/motor channel you wish to configure. 

2. Select "Calibrate from logger" to use auto-calibration or select "Set to maximum or minimum 
sensitivity" to use HOBOware for calibration. See below for more details on both procedures.  

 

3. Click Save. Note that the selections will not take effect in the logger until you launch it. 

Calibrate from Logger 
Calibrating from the logger with the calibration button, also called auto-calibration, is used to calibrate the ON and 
OFF threshold of the logger to achieve reliable readings in an environment where motor or light levels are 
unknown prior to deployment or where logger light levels are variable. In the auto-calibration process, the light 
level or the AC magnetic field for a motor sensor is measured via a built-in analog-to-digital converter and the 
resulting value is used to generate a calibration threshold.  

The logger has a built-in hysteresis level of approximately 12.5% for the light sensor and 6.25% for the motor 
sensor to prevent the sensor from toggling between ON and OFF when the signal level is near the calibration 
threshold. This plot shows how the logger handles hysteresis. The logger interprets the signal as ON until it drops 
below the lower level of the calibration threshold. Once it switches to off, the signal will not switch back to ON 
until it bypasses the upper limit of the calibration level. 
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When auto-calibrating from the logger (button calibrating): 

1. Deploy the logger near the light/motor to be monitored. Turn the light or motor on. 

2. Press the Calibrate button for 1 second. The LCD screen will display the signal strength of the 
light/motor. The signal strength should ideally be at least 3 bars. Orient the logger as necessary to 
increase the signal strength. The signal strength indicator will remain on the display for ten minutes or 
until calibration is complete. 

3. Press the Calibrate button for 3 seconds while “HOLD” appears on the LCD screen. For the light sensor, 
move your hand away from the logger to prevent shadowing. The logger will count down to the auto-
calibration and then display either “PASS” or “FAIL” after calibration is complete. 

4. If the auto-calibration fails, point the sensor directly at the light or position it closer to the motor 
source and then repeat these steps. 

Set to Maximum/Minimum Sensitivity 
If you cannot manipulate the light source or access the motor, you can set the calibration level in this window. The 
lower the light/magnetic field level, the higher the sensitivity needs to be to record changes between ON and OFF 
conditions. For light sensors, the maximum sensitivity is approximately 100 lux (for rooms with low light levels, 
such as residential environments) and the minimum sensitivity is approximately 500 lux (for rooms with high light 
levels, such as retail environments). For motor sensors, the maximum sensitivity is approximately 40 mG (for a 
weak magnetic field) and the minimum sensitivity is set to approximately 100 mG (for a strong magnetic field). 

Advanced Sensor Properties: Occupancy 
Use the Advanced Sensor Properties window to set the timeout value for an occupancy sensor (UX90-005x/006x 
models). The timeout value is the period of inactivity required for the sensor to consider the area unoccupied. The 
timeout value is set to 1 minute by default. You can change this to one of the preset values or enter a custom 
value.  

To change the timeout value for an occupancy sensor: 

1. Select the sensor that corresponds with the occupancy channel you wish to configure. 

2. Select a preset timeout value as shown in the example below or select Custom and enter your own 
value in minutes and seconds. 
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 3. Click Save. Note that the selections will not take effect in the logger until you launch it. 

Statistics: Maximum, Minimum, Average, and Standard Deviation  
You can configure UX100 series and UX120-014M loggers to calculate maximum, minimum, average, and standard 
deviation statistics for all enabled sensors during logging at each logging interval based on samples taken at a rate 
you specify. This will result in up to four additional series per sensor that record the following information at each 
logging interval: 

• The maximum, or highest, sampled value, 

• The minimum, or lowest, sampled value,  

• An average of all sampled values, and 

• The standard deviation from the average for all sampled values. 

For example, let’s say both the temperature and RH sensors have been enabled, the logging interval is set to 5 
minutes and the sampling interval is set to 30 seconds (with maximum, minimum, average, and standard deviation 
all enabled). Once logging begins, the logger will measure and record the actual temperature and RH sensor values 
every 5 minutes. In addition, the logger will take a temperature and RH sample every 30 seconds and temporarily 
store them in memory. The logger will then calculate the maximum, minimum, average, and standard deviation 
using the samples gathered over the previous 5-minute period and log the resulting value(s). When reading out the 
logger, this would result in 10 data series (not including any derived series, such as dew point): two sensor series 
(with temperature and RH data logged every 5 minutes) plus eight maximum, minimum, average, and standard 
deviation series (four for temperature and four for RH with values calculated and logged every 5 minutes based on 
the 30-second sampling). 

Notes:   

• Statistics are not available for logging if Normal or Burst has been chosen as the Logging Mode in the 
Launch Logger window. 

• On thermocouple loggers, statistics are only available on thermocouple channels and not on the 
internal temperature channel. 

To configure statistics: 

1. If the Statistics window is not already open, select Statistics from the Logging Mode drop-down menu 
in the Launch Logger window. Or, if Statistics has already been configured, click the Edit button. 

2. Click the Maximum, Minimum, Average, and Standard Deviation checkboxes for each of the statistics 
you want to calculate during logging. Note that Average is automatically selected when selecting 
Standard Deviation. Important: Statistics apply to all enabled sensors; every selected statistic will be 
calculated for all sensors (except battery voltage). For example, if both the temperature and RH 
sensors have been selected in the Launch Logger window and you select Average, then the average 
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will be calculated for both temperature and RH. In addition, the more statistics you record, the 
shorter the logger duration and the more memory is required. 

3. Set the sampling interval, which must be less than and a factor of the logging interval. Choose either a 
preset sampling interval or select Custom and enter your own sampling interval. Keep in mind that the 
more frequent the sampling rate, the greater the impact on battery life.  

 

4. Click OK when done. This will return you to the Launch Logger window. Click the Edit button next to 
Logging Mode in the Launch Logger window to make additional changes. 

Once logging begins, press the Alarm/Stats button on the logger for 1 second to cycle through the current 
maximum, minimum, average, and standard deviation data (as applicable) on the LCD screen (it is not available in 
the HOBOware Status window). You can plot the statistics series once you read out the logger.  

See also: 

• Filtered Series vs. Statistics Logging 

• Launch Options for HOBO UX100 Series Loggers and the HOBO 4-Channel Thermocouple Logger 
(UX120-014M) 

Filtered Series vs. Statistics Logging 
UX100 series loggers support filtered series and statistics logging, both of which involve calculating maximum, 
minimum, and average values that you can plot after the logger is read out. Both are accessed from the Launch 
Logger window; for filtered series, click the Filters button and for statistics logging, select Statistics as the Logging 
Mode. However, there are some key differences between the two features. The following table compares filtered 
series to statistics logging so that you can choose the best solution for your deployment. Note: There is also 
another filtering option available after you read out the logger, which is available from the Filter button on the 
toolbar. This allows you to create filtered series based on the data in the plotted datafile. For more information on 
filtering after reading out a logger, see Filtering a Series. 

 Filtered Series Statistics Logging 
What logger models work 
with this feature? 

All logger models. Only UX100 series loggers.

Which sensors does this 
apply to? 

Only those that you select; you must set up 
individual filters for each sensor. 

Automatically calculated for all 
enabled sensors (each sensor 
selected in the Launch Logger 
window except for Battery). 

Which measurement types 
are compatible? 

All measurement types, including state, 
event, pulse, and runtime. 

Only those supported by the UX100 
series (temperature and RH). 

Can I view the data on the No, filtered series are only available after Yes, you can press the Alarm/Stats
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 Filtered Series Statistics Logging 
logger's LCD screen (if 
available)? 

the logger is read out. button on the logger to cycle 
through each of the enabled 
statistics. 

What kind of data can be 
calculated with this feature? 

Maximum, minimum, and average; 
standard deviation is not available. 

Maximum, minimum, average, and 
standard deviation. 

How often can data be 
calculated? 

By day, hour, minute, or second using 
samples taken at the logging interval. The 
filter interval should be greater than the 
logging interval. It is also recommended 
that it is a multiple of the logging interval 
so that every filter interval has an equal 
number of samples. 

Data is calculated at each logging 
interval using samples taken at the 
sampling interval. The sampling 
interval must be less than and a 
factor of the logging interval (i.e., if 
the logging interval is set to 10 
minutes, statistics cannot be 
calculated every hour; the sampling 
interval would have to be less than 
and a factor of 10 minutes). 

Can I select different 
intervals for each calculated 
series? 

Yes, you can select a different interval for 
each filter you set up. 

No, the logging and sampling 
intervals apply to all selected 
statistics. 

How is the data recorded? Sensor data is recorded at every logging 
interval and filtered data points are 
calculated at the rate you specified (for 
example, the average temperature is 
calculated every hour). This requires more 
memory as every sample is recorded. 

The logger takes a sample at every 
sampling interval, but only records 
statistics data at the logging 
interval. This requires less memory 
as every sample is not recorded. 

 

Burst Logging  
Burst logging is a logging mode available for UX100 series and UX120-014M loggers that allows you to set up more 
frequent logging when a specified condition is met. For example, let's say the logger is recording data at a 5-minute 
logging interval and burst logging is configured log every 10 seconds when the temperature goes above 85°F (the 
high level) or falls below 32°F (the low level). This means the logger will record data every 5 minutes as long as the 
temperature remains between 85°F and 32°F. Once the temperature reaches 90°F, for example, the logger will 
switch to the faster logging rate and record data every 10 seconds until the temperature falls back below the high 
level (or 85°F in this case). At that time, logging then resumes every 5 minutes at the normal logging interval. 
Similarly, if the temperature falls to 30°F, for example, then the logger would switch to burst logging mode again 
and record data every 10 seconds. Once the temperature rises back to 32°F, the logger will then return to normal 
mode, logging every 5 minutes. 

Notes: 

• Burst logging is not available if alarms have been enabled for the logger. 

• The Stop Logging option "Never (wrapping)" is not available when burst logging is configured on a 
UX100 series logger. 

• The actual values for the burst logging levels are set to the closest value supported by the logger. For 
example, the closest value to 85°F that the logger can record is 84.990°F and the closest value to 32°F 
is 32.043°F. 

• Burst logging mode can begin or end when the sensor reading is within the logger specifications of 
0.02°C resolution. This means the value that triggers burst logging may differ slightly than the value 
entered. For example, if the High Level for a temperature alarm is set to 75.999°F, burst logging can 
start when the sensor reading is 75.994°F (which is within the 0.02°C resolution). 
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• Once the high or low condition clears, the logging interval time will be calculated using the last 
recorded data point in burst logging mode, not the last data point recorded in "normal mode." For 
example, let's assume the logger has a 10-minute logging interval and logged a data point at 9:05. 
Then, the high level was surpassed and burst logging began at 9:06. Burst logging then continued until 
9:12, when the sensor reading fell back below the high level. Now back in normal mode, the next 
logging interval will be 10 minutes from the last burst logging point, or 9:22 in this case. If burst 
logging had not occurred, the next data point would have been at 9:15. 

• A New Interval event will appear on the plot (if you select events for plotting in the Plot Setup 
window) each time the logger enters or exits burst logging mode. 

• On thermocouple loggers, burst logging is only available on thermocouple channels and not on the 
internal temperature channel. 

To set up burst logging: 

1. If the Burst Logging window is not already open, select "Burst logging" from the Logging Mode drop-
down menu in the Launch Logger window. Or, if Burst logging has already been configured, click the 
Edit button. 

2. Select the sensor you want to configure for burst logging. 

3. Select the High Level checkbox if you want to set up a condition in which burst logging will occur when 
the sensor reading rises above the high level value. Type in the value or drag the red upper slider. 

4. Select the Low Level checkbox if you want to set up a condition in which burst logging will occur when 
the sensor reading falls below the low level value. Type in the value or drag the blue lower slider. 

In this example, both the high and low levels were selected. You may choose only one if you wish. 

 

5. Set the burst logging interval, which must be less than the logging interval. Select either a preset burst 
logging interval or select Custom and enter your own interval. Keep in mind that the more frequent 
the burst logging rate, the greater the impact on battery life and the shorter the logging duration.  

6. Click OK when done. This will return you to the Launch Logger window. Click the Edit button next to 
Logging Mode in the Launch Logger window to make additional changes. 
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Once the logger is launched, the high and low burst logging levels are only checked when the logger's LCD screen 
refreshes once every 15 seconds. Therefore, if you set the logging interval to less than 15 seconds and the sensor 
reading falls outside the levels, the burst logging will not log until the next 15-second refresh cycle. 

Important: If high and/or low levels have been configured for more than one sensor, then burst logging will begin 
when any high or low condition goes out of range. Burst logging will not end until all conditions on all sensors are 
back within normal range. 

Checking Device Status 
The Status window displays real-time information about the attached logger, including the current state of the 
logger, logging start time, current readings, and memory used. You can check the status for a logger whether it is 
waiting for logging to begin, actively logging (unless it is logging at a fast logging interval), or stopped. 

To check the status of a logger: 1. Connect the logger to the computer. 2. Click the Status icon  on the toolbar, or select Status from the Device menu. You can also check 
the status by clicking the Status button on the Launch window, but this will show details from the 
previous launch. 

This is an example of the Status window. The information displayed varies depending on the logger that is 
connected. See Status window for details on the type of information displayed. 

 
Important: Battery power is drained more rapidly while checking status. Keep this in mind when frequently 
checking status during a deployment. You can significantly reduce the demand on the battery by adjusting the 
Screen Refresh Interval to five seconds or higher (not available on all loggers). 
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The Status Window 
The Status window displays the current status of the logger. If you clicked Status from the Launch Logger window, 
then details from the previous launch is displayed. The Status window is divided into three panes: Device 
Identification, Device Details, and Current Readings. 

Device Identification 
The Device Identification pane shows the logger selected for status. It lists the device name and model number, 
description entered when the logger was last launched (which is also used as the default file name and title in the 
plot), serial number, and firmware number. 

Device Details 
The Device Details pane shows detailed information about the logger deployment including the following items. 
Note that not all of these items are displayed for every logger model. 

• Battery Level/Battery State. This is the condition of the battery. Consult the logger documentation 
for specifics on battery capacity. 

• Memory Used. This is the percentage of logger memory used so far in the deployment. Consult the 
logger documentation for specifics on memory capacity. Note that if the battery died during logging, 
the Memory Used will be 100% even if only a small amount of the memory was used. 

• Stops Logging. This displays the date/time or the condition under which the logger will stop logging. 

• Last Launched. This is the date and time, including the offset to Greenwich Mean Time (GMT), when 
the logger was last launched. This is not necessarily the time when the first sample was recorded; it is 
the time all the launch settings were loaded in the logger. 

• Delayed Start (if applicable). If the logger has been launched, but is waiting to start on a particular 
date/time or at the next interval, the scheduled start time is shown here in local time. 

• Deployment Number. This is the number of times the logger has been launched, including the most 
recent launch. 

• Logging Interval (if applicable). This is the rate at which the logger was set up to record data. If 
multiple logging intervals are available, the interval currently in use (if the logger is logging) will be 
shown in bold. 

• Sampling Interval (if applicable). This is the rate at which sensors are sampling data in between 
the logging interval. 

• DO Sensor Cap Information (HOBO U26 Dissolved Oxygen logger only). For HOBO U26 
Dissolved Oxygen loggers, the DO sensor cap expiration date, initialization date, and manufactured 
date is shown. For more details about the DO sensor cap, see Checking Dates for the HOBO U26 
Dissolved Oxygen Logger Sensor Cap. 

• Current Status. This is a message that describes the state of the logger. Messages include: 

 Awaiting Button/Coupler Start. The logger has been launched with a coupler or push button start 
(if available). Press and hold down the button on the logger for three seconds to begin logging, or 
follow the instructions that came with your logger if it offers a triggered (coupler) start but does 
not have a button. 

 Awaiting Delayed Start. The logger will begin recording data at a specific time because the logger 
was configured to start on a specific date/time or at the next interval. 

 Launched, Logging. The logger has been launched is actively recording data. 

 Logger Is Full. The logger has reached its memory capacity and is no longer recording data. 
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 Logger Is Stopped. The logger is not logging, is not full, and is not awaiting a start. 

 On Hold for Later Launch. The logger has been launched with a Save Settings start (if available). 
Logging is not scheduled to begin, but the launch settings have been entered and saved. 

 Relay is open/Relay is closed. For the HOBO U30 Station, the current state of the relay is also 
displayed. 

• Current States, if applicable. This is the current condition of the logger button(s). Refer to the 
logger documentation for details on logger operation, buttons, and interval events. 

Current Readings 
The Current Readings pane lists the latest measurement for each data series. Sensors that measure state changes 
do not show current readings. To change the order of series displayed in the Status window, go to the Preferences 
and select Display and then Series. 

You can also set the Screen Refresh Interval for some loggers. This is the frequency the current readings are 
updated, up to 3,600 seconds (one hour). A higher number results in less drain on the logger's battery. 

A Contact HOBOlink button also appears at the bottom of the Status window for the HOBO U30 Station only. Click 
this button when you want the HOBO U30 Station to connect to HOBOlink. When you click Contact HOBOlink, a 
confirmation message is displayed. Once you click Yes, the Status screen will close and then the HOBO U30 Station 
will attempt to connect to HOBOlink within 30 seconds. A warning may appear in the event that a live connection 
with HOBOlink is already underway. 

Notes: 

• Readings are displayed for all available sensors, even if they are not being logged. Sensors not being 
logged are dimmed. 

• If a logger has channels for external sensors, a description and reading will be given for the external 
channels even if no sensors are plugged in. 

• For event loggers, the event count displayed in Current Readings will always start at zero, even if many 
events have already been logged. 

• Sensor labels (if applicable) are displayed following the sensor name. 

• For station loggers, the location (if defined) is displayed next to the reading. 

• If a HOBO U30 Station has an Analog Sensor Port, readings for one or both channels are displayed. 

• When a Station logger is logging, the last sample taken by the logger at the last interval will be 
displayed. 

• The RSSI (Signal Level) is displayed for the HOBO U30/GSM Station. This helps you determine if there 
is enough signal strength in the current location for the HOBO U30 Station to contact a cellular tower 
for connecting with HOBOlink. Signal level is measured on a scale of 0 to 10, with 0 being no signal, 1 
being a weak signal, and 10 being a strong signal 

• Battery voltage is displayed for some loggers. 

• For acceleration loggers only, color-coded tilt meters display X, Y, and Z-axis tilt graphically (relative to 
vertical, assuming that the only acceleration force on the logger is gravity). 

Stopping a Device 
A logger automatically stops recording data when the memory is full (unless it has been configured to never stop 
logging) or when the battery runs down. Depending on the launch settings selected, you can also press the 
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Start/Stop Logging button to stop logging on certain logger models. In addition, you can use HOBOware to stop the 
logger manually at any time. 

To stop a logger: 

1. Connect the logger to the computer. 

2. Click the Stop icon  on the toolbar, or select Stop from the Device menu. 

After the logger has been stopped, the data remains in the logger until the next launch. Be sure to read out the 
logger before setting up the next launch. 
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Chapter 3 
Reading Out, Plotting, and Analyzing Data 
After a logger has recorded data, you can then do the following: 

• Read out the data from the logger 

• Plot the data 

• Modify the plot if desired 

• Use Data Assistants 

• Export the data 

• Import data 

Reading Out Data 
To retrieve data recorded by a logger, you must read out the logger. Reading out the logger copies data from the 
logger to your computer, allowing you to save the data and plot it. During readout, the logger continues to record 
data unless you have stopped it or it is full. 

You can also read out many logger types to a shuttle and then offload the datafiles from the shuttle to your 
computer. See Offloading and Saving Shuttle Files for more details. 

To read out a logger to the computer: 

1. Connect the logger to the computer. 

2. Click the Readout icon  on the toolbar or select Readout from the Device menu. If the logger is still 
logging, confirm whether to stop the logger. Click either Don't Stop or Stop as desired. 

3. A progress bar displays while the data is being read out. Once the readout is complete, choose a 
location and/or a new filename or accept the default location and name to save the data. The default 
location is:  

• C:\Documents and Settings\<user>\My Documents\HOBOware  
(for Windows XP) 

• C:\Users\<user>\Documents\HOBOware  
(for Windows 7 or Windows 8) 

• Users/<user>/Documents/HOBOware 
(for Macintosh OS X) 

If you save the file to a different folder, that folder will be the new default save location for future 
readouts. 

4. Click Save. Most datafiles have a .hobo extension. Station loggers read out with HOBOware Pro have a 
.dtf extension. If you are using HOBOware Pro in secure mode, the file extensions will be .hsec (U-
Series loggers) or .dsec (Station loggers). 

5. After saving the data, select the sensors and/or events you wish to display in a graph and click Plot. 
See the Plotting Data for more details on the options available when plotting. 
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Notes:   

• Once a logger is read out, the data will remain in the logger memory until the next time the logger is 
launched. Logger memory is therefore never empty. 

• You can read out some U-Series loggers when the batteries are low if the logger can be powered by a 
USB cable. In this case, a warning appears before the readout begins indicating the battery is very low 
and that you may experience communications problems. Once the readout is complete, be sure to 
replace the batteries as suggested. 

• You can bypass the Save window during the readout process by setting the Readout Time-Saving 
Options in the General subcategory of Preferences. 

Plotting Data 
After you read out a logger or open a saved file, you can plot the data with the Plot Setup window like the 
following example.  

 
To plot the data: 

1. Use the existing description or type a new one. The default description matches the one used when 
launching the logger and will be used for the plot title.  

2. Select the series you wish to view on the plot. Click the All or None button to select or deselect all 
series, or click the checkboxes to select or deselect individual series. Series types can include:  
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• Logged data series, which is a series containing the sensor measurements, state changes, or 
statistics (select loggers only) recorded by the logger. 

• Derived series, which is a series calculated based on one or more logged data series. This could 
be an automatically generated series for a measurement type, such as Dew Point when 
temperature and RH is logged. Or, it could be a filtered or scaled series if you configured a 
filters or scaling with a data assistant in the Launch Logger window (select loggers only). 

• Battery voltage, which lists the logger battery voltage recorded at each logging interval. 

3. Change the default units for selected series if desired. You can also change the units for a series after 
it is plotted. 

4. Select the internal logger events to view on the plot. Click the All or None button to select or deselect 
all events, or click the checkboxes to select or deselect individual events. Internal logger events are 
individually logged occurrences that can be recorded at any time during deployment, regardless of the 
logging interval. These events can include started or stopped logging, low battery, or an alarm trip. 
Refer to the logger manual for a complete list of internal events if applicable.  

5. Adjust the time zone offset, if necessary. By default, data is shown in the offset used to launch the 
logger with HOBOware (not a shuttle). To select a different offset, enter the hours offset from GMT 
(UTC) in decimal form. You may find this useful if you logged in multiple time zones, or if you took the 
logger to a different time zone after launching it. 

6. HOBOware Pro Only: If data assistants are available, you can use them to create additional series. 
Select an assistant from the list and click Process to create a new series. 

7. Click the Plot button to generate a plot. The plot is drawn and includes a title, a time axis (x-axis), one 
or more value axes (y-axis), and a legend. The data for each series are listed in a points table above 
the plot. Details about each series, such as the type of logger and deployment information are listed in 
the Details pane to the left of the plot. You can show or hide these elements using the View menu. To 
organize several plots, use the Window menu to switch between Tabbed View, Tile Horizontally, or 
Tile Vertically. 

 
Notes: 

• To change the order of series displayed in the Plot Setup window, open the Preferences, select Display 
and then Series. 
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• To change the series and events that are selected by default in the Plot Setup window or to control 
whether four possible Light/Occupancy series are derived on supported loggers, open the 
Preferences, select Plotting and then Plot Setup. 

• To bypass the Plot Setup window when opening a datafile, open the Preferences, select General and 
then select Open File Time-Saving Options. 

• If a pie chart icon appears in the Plot Setup window, this means the data in the file you are plotting 
can also be plotted in a pie chart. See Viewing a Pie Chart for more details. 

• On some loggers, the Started and Stopped internal events can only occur once. However, UX100 series 
loggers can start and stop logging multiple times in a single deployment (as configured in the Launch 
Logger window). Multiple stopped and started events in a single file are not only displayed on the plot 
if selected in the Plot Setup window, but the resulting gap that occurs in the data is also represented 
in the series. In this example, the logger was stopped at 1:19 and then started again at 2:35; both 
events are on the plot. The temperature series shows a break between those two times. That 
represents the gap between when logging was stopped and when it resumed, both using the button 
on the logger. 

 

Opening Files 
HOBOware Pro and HOBOware Lite can open .hobo files. The following files can be opened by HOBOware Pro:  

• .hsec, which are secure files (21 CFR Part 11 Conformance) from U-Series loggers. 

• .hproj, which is HOBOware Project file. 

• .dtf, which are files from a HOBO U30 Station, Weather Station, Micro Station, or Energy Logger. Other 
.dtf files are not compatible with HOBOware Pro. 

• .dsec, which are secure files (21 CFR Part 11 Conformance) from Station loggers. 

• .txt, .csv, and most ASCII files can be imported. 

To open a file: 
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1. Double-click a compatible file from Windows Explorer or Mac Finder. Or in HOBOware, click the Open 

icon  on the toolbar or select Open Datafile from the File menu. 2. Select one or more files and click Open. 3. Select the series and/or events you wish to view in the plot and click the Plot button. If you selected 
multiple files to open, you will be prompted with a Plot Setup window for each file (unless you have 
set the preference to automatically plot data as described in General Preferences). 

For details on verification failure when opening a file in HOBOware Pro, see Working in Secure Mode. 

To open a project file: 1. From the File menu, select Open Project. 2. Select a project (.hproj) file and click Open. 

Recently opened files are listed in the File menu. From the File menu, select Recent Files and then choose the file 
you wish to open. To empty the recent file list, select Recent Files from the File menu and then select Clear Recent 
Files. 

Opening Files from Unsupported Loggers 
Although the following loggers cannot be launched or read out using HOBOware, datafiles from these loggers can 
be opened and plotted by HOBOware Pro. All graphing tools, filters, and Data Assistants can be used with the files 
and data can be exported to text and project files. 

H08 (8-bit) 

• H08-001-04 
• H08-002-04 
• H08-003-04 
• H08-004-04 
• H08-006-04 
• H08-008-04 

TBI/WTA 

• TBI32-05+37 

• TBI32-20+50 

• WTA08-05+37 

• WTA08-39+75 

• WTA32-05+37 

• WTA32-39+75 

H08 (12-bit) 

• H08-030-08 

• H08-031-08 

• H08-032-08 

H20 

• H20-001 
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H06 

• H06-001-02 

• H06-002-02 

• H06-003-02 

• H06-004-02 

H07 

• H07-001-02 

• H07-001-04 

H14 

• H14-001 

• H14-002 

H12 

• H12-001 

• H12-002 

• H12-003 

Working with Plots 
There are several tools available for working with plots. 

Tools 

There are five tools available on the toolbar for viewing the plot and isolating data. 

 

• Use the Arrow tool to point to and select items on the graph to edit their properties (through a right-
click menu). 

• Use the Crosshair tool to zero in on a specific date and time in the plot and any data points associated 
with that date and time. Click the Crosshair icon and then place your cursor anywhere on the plot to 
draw a red vertical line at a particular point. 

• Use the Hand Drag tool to move different areas of the graph into view (panning) or adjust the position 
of one series so it can be viewed more easily. This is particularly useful when you are zoomed into the 
graph and want to see another section of the graph without zooming out and then zooming back in on 
the new location. 

• Use the Zoom tool to focus on one area of the graph, allowing you to see more detail. 
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• Use the Subset Statistics tool to view statistics for a particular time span (HOBOware Pro only). 

Actions 

Use the Actions buttons on the toolbar to perform a number of actions on a plot or a series. 

 

• Use the Zoom In/Zoom Out buttons to keep the plot centered as you zoom. 

• Click the Grow Graph at Full Scale button to return to the original, full-scale version of the plot when 
the datafile was first opened. 

• Click the Open Properties button to open the properties window the plot element that is currently 
selected, such as axis, series, legend, or title. 

• Use the Gridline buttons to toggle all horizontal or vertical gridlines on and off. You can also toggle 
gridlines on and off for each axis individually. Using the arrow tool, double-click an axis to get the Axis 
Properties window. Select or deselect the Show Gridlines checkbox to toggle the gridlines for that 
axis. 

• Click the Point Markers button to toggle the point markers for all series on and off. To show or hide 
markers for an individual series, right-click the series to open the Series Properties window. Select or 
deselect the Mark Points checkbox to toggle the markers for that series. 

• Click the Convert Units button to open the Convert Plot window, which allows you to convert the units 
on certain series on the plot to other units (for example, from degrees Fahrenheit to degrees Celsius). 

• Click the Filter Series button the Filter Series window, which allows you to add a statistical series to 
the plot. 

• Click the Pie Charts button if a pie chart is available for the plot (only available on loggers that support 
state series) 

• Click the Add Graph Label button to open the Graph Label Properties window. 

Menus 

Use the Edit and View menus to access various controls when working with a plot. You can also right-click an 
element in the plot to access many of the same options available from the Edit and View menu and to open 
properties windows. 

Using the Arrow Tool 
Use the Arrow tool to select items on the plot. Click the Arrow icon  on the toolbar or press A to select the arrow 
tool.  

If you are currently using another tool and do not want to switch tools, press N on your keyboard to select each 
graph item (including hidden items, such as value axes for states or events) in sequence.  

The selected item (if visible) is shaded or boxed. You can then right-click the selected item, double-click it, or press 
the Enter key on your keyboard to open the Properties window for that item. 
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To deselect, click an area within the axes that does not have series data. Click the View menu and choose Select 
None or press D. 

Using the Crosshair Tool 
Use the crosshair tool to zero in on a specific date and time in the plot and any data points associated with that 
date and time. To use the crosshair: 

1. Click the Crosshair icon  on the toolbar or press C. 

2. Click a point on the graph to mark it.  

3. Click another point to move the marker.  

When you click on a graph, the nearest data point is selected. When series are very close together and the location 
you click is between two points, it is possible that the nearest point is not on the series you clicked.  

You can also mark the point on the graph by clicking the corresponding cell in the Points table. If you are zoomed 
in and click a point in the Points table that is outside the zoom area, the plot will scroll to that area of the graph. To 
prevent scrolling in this situation, go to the Preferences, select Plotting and then Points Table & Details Pane. 
Deselect the "When selected value in table is out of plot range, drag series to that value. 

The plot changes in several ways when the crosshair is in use. The Points table shifts to the row that contains the 
data point. Where the crosshair intersects a data point, a square surrounds the data point. The intersection points 
are also marked by small color-coded arrows on the left and right value axes.  

If the legend is displayed next to the graph, the point values for each series are updated to reflect the crosshair 
location. Values are listed in the legend differently depending on whether the data is a logged sample, state, or 
event: 

• Values that are not in parentheses are actual data points logged at the time selected by the crosshair. 

• Values in parentheses are estimated because there were no exact values for the series at the time 
selected by the crosshair. Zoom in or move the crosshair to see actual values. 

• A value of "…" indicates that there is no series data during the time selected. This is seen most 
frequently for events. If the time selection falls within an event series, but does not contain an event, 
parentheses surround the "…" value. 

• A value of "logged" indicates an internal logger event happened at the selected time. 

The legend must expand in height to list the point values. If your application window is too small to accommodate 
the expanded height, the values will not be added to the legend. You can still refer to the Points table to find the 
values of the selected points. 

To remove the crosshair from the graph, right-click the plot and select Remove Crosshair or choose remove 
Crosshair from the View menu. 

Zooming, Panning, and Smart Scaling Plots 
You can adjust the viewing area of the plot by zooming, panning, and smart scaling. 

Zooming 

There are two ways to zoom: either by using the zoom tool  (or pressing Z) or by selecting Zoom In or Zoom 

Out  from the toolbar or the View menu. Use the zoom tool to zoom anywhere on the plot that you select, 
clicking the right-mouse button to zoom in or out. Use the Zoom In/Zoom Out icons to keep the plot centered as 
you zoom. 
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When zooming: 

• Right-click to toggle between zoom in and zoom out. 

• Check the symbol inside the zoom tool to determine the direction you are zooming. A plus sign (+) or 
arrows pointing outward will zoom in, while a minus sign (-) or arrows pointing in will zoom out. 

• Click an area on the graph inside the axes to zoom one level (a factor of two). Continue clicking to 
zoom multiple levels. 

• Hold down the left mouse button in one location to zoom continuously. Release the mouse button to 
stop zooming. 

• Hold down the left mouse button while drawing a rectangle around the area you wish to zoom in on, 
then click inside the rectangle. The area inside the rectangle expands to fill the whole graph. 

• To constrain the zoom to horizontal or vertical zooming, place the cursor over the axis you want to 
zoom and click the mouse button. Hold the mouse button down to continue to zoom. Or, press the X 
key while zooming to restrict motion horizontally and press the Y key while zooming to restrict motion 
vertically. 

• If you are currently working with the crosshair, arrow, or hand tool, you can click the Zoom In/Out 
icons on the toolbar to quickly zoom into and out of the middle of the display without changing tools. 

• Zooming will not work on an axis that is locked. To unlock an axis, double-click the axis with the arrow 
tool and deselect the Lock Axis Scaling and Tick Marks in the Axis Properties window. 

Panning 

Use the hand drag tool  or press H to pan the graph, which is dragging the plot viewing area along the x- or y-
axis. Panning is especially helpful when you are zoomed into a detailed plot and want to focus on a different area 
without zooming out. Click within the graph and hold down the left mouse button to pan a different section of the 
graph into view. The graph follows the movement of the mouse, and the axes are continuously updated in 
response to the movement. To stop dragging, release the left mouse button. 

To limit dragging to horizontal or vertical panning, place the cursor over the axis you want to drag, hold down the 
mouse button, and drag in the direction you want the plot to move. Or, press the X key will dragging to restrict 
motion horizontally and press the Y key while dragging to restrict motion vertically. Similarly, click the axis 
associated with a series and hold down the left mouse button. Only the series connected with the axis will follow 
the movement of the mouse. 

Use the hand tool to move different areas of the graph into view or adjust the position of one series so it can be 
viewed more easily. This is particularly useful when you are zoomed into the graph and want to see another 
section of the graph without zooming out and then zooming back in on the new location. 

Panning will not work on an axis that is locked. To unlock an axis, double-click the axis with the arrow tool and 
deselect the Lock Axis Scaling and Tick Marks in the Axis Properties window. 

Smart Scaling 
When you first display a graph, the numerical bounds of the axes are on tick marks. After you have panned or 
zoomed, this may no longer be the case. Use smart scaling to correct that. With the hand drag, arrow, or crosshair 
tool, right-click anywhere on the graph and select SmartScale Graph. This will automatically adjust the axes to end 
on tick marks. 

Note: You can always return to the original plot view by clicking the View at Full Scale  from the toolbar or the 
View menu. 
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Copying Data Points and the Plot 
To copy the data points from the Points Table to paste into other software:  

1. Select the data you wish to copy in the Points Table. 

2. Press Ctrl+C in Windows or Command-C in Macintosh to copy the data. 

Windows: press Ctrl + C 

Mac: press Command - C 

3. Open any text editor, word processor, or spreadsheet software. 

4. Press Ctrl+V in Windows or Command-V in Macintosh to paste the data into the other application. 
Fields are delimited by tabs, and records are separated by paragraph returns. 

You can also copy the plot as a bitmap for pasting into other programs and documents. To copy the plot: 

1. From the Edit menu, select Copy Graph to Clipboard. 

2. Go to the other application and paste the plot. 

Closing a Plot 
To close a single plot, click the  on the tab or toolbar, or choose Close from the File menu. On Macintosh, click 
the red button in the upper-left corner of the internal frame containing the plot when in Tabbed View. To close all 
open plots, select Close All from the File menu. 

Important: Any changes you made to the plot are not saved when you close the datafile. You must save the plot as 
a project file to preserve the changes. Either select Save Project from the File menu before closing the plot or close 
the file and click Save when prompted. If you only want to save an image of the plot, you can paste a bitmap of the 
graph into another program and save it there. 

Note: If you do not want HOBOware to prompt you to save the plot as a project file when you close it, open the 
Preferences. Select Warnings and then select General. Deselect the "Prompt me if there is any remaining unsaved 
data when closing plot or application" checkbox. 

Viewing a Pie Chart   
Pie charts are available for plotted state series, such as those from the UX90 data loggers. This provides you with a 
graphical representation of the data for viewing, saving, and printing in addition to the default line graph. This is 
particularly useful for the UX90 Occupancy/Light Data Logger (UX90-005x/-006x) because it allows you to quickly 
compare when the: 

• Lights were on and the room was unoccupied 

• Lights were on and the room was unoccupied 

• Lights were off and the room was occupied 

• Lights were off and the room was unoccupied 

To view a pie chart: 

1. Open a file from a logger with state series and plot the state series and derived series (as applicable) 
that you want to view in the pie chart. Note that a pie chart icon appears in the Plot Setup window if 
the file you are opening can be plotted in pie chart. 

2. Click the Pie Chart button on the toolbar. 
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3. A pie chart is drawn based on the selected series. In this example, light & occupancy are plotted in the 
pie chart. The legend at the bottom of the chart indicates what series each piece of the pie 
represents. Percentages for each pie wedge are shown in the yellow boxes. 

 

• To change the series used to generate the pie chart, click the "Select a Series" drop-down 
arrow and then click the Update Chart button. 

• To change the timeframe used to create the pie chart, change the Start and End Date/Time as 
necessary and then click the Update Chart button. 

• To reset the pie chart to use the Start and End Date/Time for the current selected series, click 

the Reset/Show at Full Scale  button. 

• To save the pie chart as an image (.png file), click the Save  button. 

• To print the pie chart, click the Print  button. 

4. When you are done viewing pie charts, click the Close  button. 

Notes: 

• The pie chart button on the toolbar will only be enabled when one or more state series is plotted. If 
you have plotted data and the pie chart button is not enabled as expected, close the plot. Reopen the 
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file and make sure you select the state series from the Plot Setup window. Note that if the sensor 
channels were configured as runtime instead of state, then pie charts will not be available. 

• If you merge datafiles, pie charts may not function properly if the time overlaps between merged 
series. If you are having difficulty viewing a pie chart for a merged file, try returning to the original 
separate files to view the individual pie charts from each file. 

• If you are working with a plot that has two series, such as Light and Occupancy and you crop one of 
those series, the time range for the pie chart data will be constrained to the shorter of the two series. 

• If you paste a new state series into the plot, it will also be available from the Select a Series pull-down 
list. You will need to select the series to view it in a pie chart; it will not display automatically. 

Printing Plot Elements 

Printing a Graph 
You can simply print the graph, or you can set up the page and preview it before printing. 

To set up the paper for printing the graph: 

1. From the File menu, choose Page Setup. 

2. Change the paper type, orientation, and margins as necessary and click OK. 

3. From the File menu, choose Print Preview.  

4. Zoom as necessary. 

5. Click the Print icon  to print directly from Print Preview. Or, click Close to exit the preview window 
without printing. 

To print the graph: 

1. From the File menu, select Print or click the Print icon  on the toolbar. 

2. Select the appropriate printer, if applicable, and click OK. 

Printing Points and Details 
You can print all the data in the Points or Details panes. From the File menu, select Print Points (available only with 
Java 1.5 or higher) or Print Details. 

If you highlight a selection of points with your mouse before choosing Print Points, you will also be given the 
option to print only the selected points. 
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Chapter 4 
Modifying a Plot 
Once data is plotted, there are many things you can do to further refine the plot. This includes: 

• Setting Properties for Plot Elements 

• Adding a Graph Label 

• Selecting a Subset of the Plot (Subset Statistics Tool) 

• Moving a Series from Front to Back on a Plot 

• Filtering a Series 

• Cropping a Series 

• Removing a Series from the Plot 

• Copying a Series to Another Plot 

• Merging Files 

• Converting Units 

• Undoing or Redoing Plot Changes 

• Saving Project Files 

Setting Properties for Plot Elements 
You can set the properties for all the plot elements, including the axes, series, title, and legend. You can access the 
properties window for a plot element by selecting the Arrow tool and then right-clicking that element. Or, right-
click anywhere on the plot and select Other Graph Items and then choose a particular item. 

• Setting Axis Properties 

• Setting Series Properties 

• Setting Legend Properties 

• Setting Title Properties 

• Setting View Properties 

There are also plotting preferences that control the global properties for all plots. To modify these settings, open 
the Preferences and select Plotting. With Plotting preferences, you can: 

• Show or hide the Points table by default 

• Show or hide the Details pane by default 

• Include the sensor label in the Points table and Details pane by default 

• Customize series lines for specific measurement types 

• Set default minimum and maximum values for specific series types on the Value Axis 
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• Enable auto-scrolling to keep marked points in view while zooming 

• Automatically select all data series and/or events 

• Automatically label the time axis 

• Mark all points in a plot by default 

• Include the sensor label in the legend 

• Control whether horizontal and/or vertical gridlines are displayed automatically 

• Set the font style and point size used in plots 

• Enable or disable the undo/redo feature 

You can also use the Display preferences to set the default unit types and date/time format. 

Setting Axis Properties 
You can change the appearance of the time axis (x axis) and the value axis (y axis) on the plot. You can customize 
the axis name, change the location, bounds, tick marks, color, and more.  

To change the axis properties: 

1. Double-click the axis in the plot with the arrow tool, or select the axis and click the Properties icon 

 to open the Axis Properties window. 

 

2. In the Name field, enter up to a 40-character name for the axis. The default name for a value axis is 
the unit type (for example, "°F" is the name for a temperature axis and "%" is the name for an RH 
axis). The time axis does not have a default name. To add "Time" as the default name for this axis, 
open Preferences. Select Plotting and then select Other Options. Enable the "Label the time axis" 
checkbox. 

3. Change the location of the axis. The value axis can be located on the left or right while the time axis 
can be located at the top or bottom 

4. By default, tick marks are auto-calculated. Numbers or values are listed next to major tick marks and 
minor tick marks are not numbered. To change the default tick marks, select Custom Tick Marks and 
then choose the values for Major and Minor tick marks as desired. 
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5. Change the default bounds used on each axis. For the time axis, select the dates and times you want 
the axis to display. For the value axis, type the minimum and maximum value you want the axis to 
display. 

6. You can also modify the appearance of the axis with these options: 

• Show Gridlines. This toggles whether gridlines are displayed in the background. Gridlines are 
shown by default for the time axis, but not for the value axis. 

• Hide Axis. This controls whether the axis is displayed or temporarily hidden. 

• Lock Axis Scaling and Tick Marks. This controls whether the axis and associated tick marks 
remain in their original position when zooming or navigating with the hand tool. Locking the 
axis and tick marks helps to avoid inadvertently zooming or navigating to an area on the graph 
without data. 

• Color. Black is the default color for the time axis. The color of the value axis matches the series 
color by default. You can change the color for either axis as desired. 7. Click Apply to update the plot and keep the Axis Properties window open. Click Done to update the 

plot and close the window. 

Setting Series Properties 
A series is the group of data points you selected to display in the plot. You can change the appearance of a series 
on the plot including the line style, point marker, alarm values, associated axes, and color.  

To change series properties: 

1. Double-click the series you wish to modify or select the series and click the Properties icon  to 
open the Series Properties window. 

 

2. Change the default description. Type up to a 40-character name for the series. The series name will be 
updated in the legend, series pane, and details pane to the new name you entered. 

3. Change the default units. Enter a different unit type as needed. The unit type will be updated in the 
legend, series pane, and details pane to the new unit type. Note that if you subsequently convert the 
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units while viewing the plot, your custom unit type will no longer be displayed. For example, let's say 
you change the unit type for a temperature series from °F to "degrees." Then, while viewing the plot, 
you decide to convert the data points to Celsius. The unit type for the temperature series 
automatically changes to °C instead of the custom "degrees" unit that you had entered.  

4. Adjust the appearance of the lines with the following options: 

• Connect Points. This controls whether the plotted data points in the series are connected with 
a line. 

• Style. This changes the appearance of the line used to connect the points in a series. 

• Width. This changes the width of the line used to connect the points in a series. 

• Connect as Steps. This controls whether the lines between the points in a series are connected 
as a curve or a step. When this option is selected, the line drawn between points keeps the 
value of the previous point until the next point in the series. Connecting as steps is useful 
when plotting state or event series. 

5. Set High Alarm and/or Low Alarm thresholds. Enabling alarms will show lines on the plot for the series 
to indicate a visual threshold over or under which data may be falling (for example, if you want to 
quickly see how many points fall below 32 degrees). Alarms are available for sensor measurement 
series only, not for state or event series. Select the High Alarm checkbox and type a value relative to 
the series where you want the maximum (red) alarm line to appear. Select the Low Alarm checkbox 
and type a value relative to the series where you want the minimum (blue) alarm line to appear. 

6. Select the Mark Points checkbox to add a marker for each data point in the series. To avoid cluttering 
the plot, this option is only enabled by default for series with event data or that have only one data 
point. If you enable Mark Points, you can change the shape of the marker and the point size. 

7. You can also modify the following: 

• Time Axis. This allows you to create an additional time axis for this series. This is useful for 
comparing data from two different time periods. 

• Value Axis. This changes the axis being used for the series. Choose one of the axes already in 
view or select New Value Axis from the dropdown list to create your own. 

• Color. This changes the color used for the series. 

8. Click Apply to update the plot and keep the Series Properties window open. Click Done to update the 
plot and close the window. 

Setting Legend Properties 
You can modify the Legend displayed on the plot. To change the Legend properties: 

1. Double-click the Legend or right-click the plot with the arrow tool and select Other Graph Items > 
Legend Properties. 

2. In the Legend Properties window, type a name for the Legend if desired. 
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3. Set the location to either the left or right of the plot. 

4. Select the Show Border checkbox to have a box around the legend. Deselect this if you do not want 
the box around the legend. 

5. Click Apply to update the plot and keep the Legend Properties window open. Click Done to update the 
plot and close the window. 

Setting Title Properties 
You can modify the title displayed on the plot. To change the Title properties: 

1. Double-click the plot title or right-click the plot with the arrow tool and select Other Graph Items > 
Title Properties. 

2. In the Title Properties window, change the default name if desired. The name originated from the Plot 
Setup window. 

 

3. Set the location of the title to either the top or bottom of the plot. 

4. Adjust the font, point size, and style. 

5. Click Apply to update the plot and keep the Title Properties window open. Click Done to update the 
plot and close the window. 

Setting View Properties 
You can show or hide certain plot elements. To change the View properties for the plot: 

1. Right-click the plot and select View Properties. 

2. In the View Properties window, select the Show Legend checkbox if you want the Legend to be 
displayed on the plot. Deselect this checkbox if you do not want to see the Legend on the plot. 
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3. Select the Show Title checkbox if you want a title to be displayed on the plot. Deselect this checkbox if 
you do not want to see a title. 

4. Select the Show Border checkbox if you want a border to be drawn around the plot. Deselect this 
checkbox if you do not want a border around the plot. 

5. Click Apply to update the plot and keep the Title Properties window open. Click Done to update the 
plot and close the window. 

Adding a Graph Label 
You can add multiple labels to a graph to identify specific points or call attention to a region of the graph. To add a 
graph label: 

1. Right-click the graph at the desired location and choose Add Graph Label from the pop-up menu to 
open the Graph Label Properties window. Or, select Add Graph Label from the Edit menu. Note: To 

change an existing label, double-click the label or select the label and click the Properties  icon on 
the toolbar. 

 

2. Type up to a 24-character name for the label. 
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3. Select the Attach to Series checkbox to attach the label to a point on the series. Choose the name of 
the series to attach it to from the drop-down list. Select the Include Data Value in Label checkbox to 
display the value of the point in the label. Select the compass point to described the preferred 
location of the label relative to the labeled point. Important: This indicates the preferred location of 
the label (space permitting) with respect to the data point it references. This is only available when 
the label is attached to a series. 

4. Adjust the appearance of the label with these options: 

• Draw Label Over Colored Background. Select this option if you want the label to appear in a 
box with a colored background. 

• Label Color Background. If you chose to give the label a colored background, click this button 
to select a background color. 

• Label Color Text. Click this button to select a color for the label text. 

• % Transparency. Adjust the label's transparency, which refers to the ability to see the graph 
through the label. At 0%, the label is opaque and you cannot see the graph through it. At 
100%, the label is invisible and only the graph can be seen. 

• Font. Select a font for the label text. 

• Font Size. Select a font size for the label text. 

5. Click Apply to update the plot and keep the Graph Label Properties window open. Click Done to 
update the plot and close the window. 

Use the hand tool  to drag the label to another location if necessary. If the label is attached to a series, you can 
drag the label to attach it to any other point on the graph. (The hand tool must be close enough to a point to 
attach the label.) Labels that are attached to a point will move with that point during zooming and panning. Free-
floating labels do not move during zooming and panning. 

To delete a label from the graph, select the label you wish to remove and press the Delete key, or right-click the 
label and choose Remove from the menu that appears. 

Selecting a Subset of the Plot (Subset Statistics Tool) 
The Subset Statistics tool allows you to select a subset, or a range of data, of a graph, and display the maximum, 
minimum, average, and standard deviation for the measurements in that range. 

To use the Subset Statistics tool: 

1. Select the Subset Statistics tool  from the toolbar. The mouse cursor will change to the Subset 
Statistics Tool icon . 2. Draw the subset on the plot. With the left mouse button, click within the graph to define the start 
time of the subset and drag to the right. Release the mouse button when you reach the end time of 
the subset. 

The graph subset appears in the graph and the subset statistics pane appears beneath the Details pane as in the 
example below. Two black vertical indicators appear on the graph to show the range of the subset with date/time 
labels marking the start and end of the range. To move the vertical indicators and date/time labels, press the up or 
down arrow keys (make sure the Subset Statistics Tool is selected first). 

A subset bar is added to the time axis. Double-click this bar to toggle between showing and hiding the vertical 
indicators and date/time labels. If the plot has one than more time axis, this bar is attached to the one that was 
created when you first displayed the plot. Click inside the subset bar to drag it to a different time axis.  
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To quickly adjust the start or end of the subset, click and drag the left or right end of the subset bar on the time 
axis (make sure the Subset Statistics Tool is selected first). You can also use the arrow keys to move the left 
boundary and Ctrl+arrow key (or Command-arrow key on Mac) to move the right boundary. Place the cursor in the 
middle of the subset bar and drag it to move the entire range left or right. 

 
To further refine the subset range: 

1. Click the checkmark icon  in the Subset Statistics pane. 

 

2. The two checkboxes are enabled by default. Deselect "Show subset statistics for time bounds below" 
if you want to remove the subset from the current time axis. Note that only one time axis can have a 
subset. If you enable subset statistics for one time axis when another time axis already has a subset, 
the other time axis's subset will be removed. 

Deselect the "Show times, duration, & vertical indicators on graph" checkbox to toggle the display of 
subset indicators and labels on the plot. If you disable this option, the Subset Statistics pane and the 
shaded subset statistics bar on the time axis will still remain visible. 

3. The easiest method to set a range for the subset is to indicate a fixed Start Date/Time or End 
Date/Time and then indicate the duration. Alternatively, you can enter both a Start Date/Time or End 
Date/Time without specifying a duration. 

For example, to set a range beginning at 8:00 a.m. on 3/18/13 with a duration of 2 hours, set the Start 
Date to 3/18/13 and the Start Time to 8:00:00.000 AM. Select the Anchor Start Point checkbox and set 
the Duration to 2 hours as shown below.  
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As another example, to set a range of 1 day ending at 10:00 PM on 3/18/13, set the End Date to 
3/18/13 and the End Time to 10:00:00.000 PM. Select the Anchor End Point checkbox and set the 
Duration to 1 day.  

 
To remove the subset and related elements:  

• Right-click the plot and select Remove Subset Stats, 

• From the View menu, select Remove Subset Stats, or 

• Click the X icon in the upper-right corner of the Subset Statistics pane. 

Moving a Series from Front to Back on the Plot 
You can shuffle the order of series by moving a series to the front or back on the plot. This is helpful if one series is 
hidden behind another. It also changes the order of series in the Details pane, Points table, and the legend.  

To change the order of the series: 

1. Select the arrow tool  . 

2. Select the series you wish to move. 

3. Right-click and select either Bring Series to Front or Send Series to Back. 

Filtering a Series 
You can filter data from existing series in the plot to create a new statistical series showing calculated data such as 
average, minimum, and maximum values over a specified period of time. This filter applies to existing data files 
only; there is an additional filter tool available when launching most loggers. 

To filter a series in a plot: 

1. Select the series with the arrow tool  , right-click it and select Filter Series. Or from the Edit menu, 
select Filter Series. 
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2. Select the statistic to use for the filter and the interval. The options available vary depending on the 
series type. In the example below, "Maximum Temp" in each day is selected.  

 

3. Type a Resultant Series Name or use the default name entered based on the filter type. 

4. Click OK. The new series is added to the graph, the Details pane, and the Points table. Note that when 
you apply a filter, the graph rescales to accommodate all the displayed data. 

Cropping a Series 
You can crop one or more series in a plot to focus on a particular date/time range instead of the default range. To 
crop a series: 

1. With the arrow tool , right-click the series you wish to plot and select Crop Series. To crop multiple 
series, right-click anywhere in the plot (without a series selected). 

2. In the Crop Series window, make sure the series you want to crop is selected. Deselect any series you 
do not want to crop. 

 

3. Enter the new Start Date/Time and End Date/Time for the series. The boundaries are limited to the 
minimum and maximum date/time of the Time Axis. If subset statistics have been added to the plot, 
the start and end points on the subset will be redefined automatically based on how it is affected by 
cropping. 

4. Click the Crop button. The plot displays the cropped series. The Details pane and Points table are both 
updated to reflect the new cropped series. 

Removing a Series from a Plot 
You can remove sensor, state, and event data series from the plot. This is helpful if the datafile contains multiple 
series and you cannot easily view them all together. 

To remove a series from a plot: 
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1. Select the arrow tool  from the toolbar. 

2. Click the series you wish to remove and press the Delete key, or right-click the series and select 
Remove. 

3. A warning appears, indicating that the only way to add the series back to the plot is to reopen the 
plot. Click Yes. 

The series is removed from the graph, the Details pane, and the Points table. 

Copying a Series to Another Plot 
To copy a series from one plot to another:  

1. Open the source plot (the plot that includes the series you want to copy) and the destination plot (the 
plot where you want to paste the series). 

2. In the source plot, choose the arrow tool  and select the series you want to copy. From the Edit 
menu, select Copy Series or right-click the series and select Copy Series. Or, press Ctrl+C on Windows 
or Command-V on Macintosh. 

3. Switch to the destination plot. From the Edit menu, select Paste Series or right-click the plot with the 
arrow tool and select Paste Series. Or, press Ctrl+V on Windows or Command-V on Macintosh. 

The new series is added to the graph, the Details pane, and the Points pane. 

Overlaying Series 
If the series you want to copy to the plot was logged at a different time, you will need to make some adjustments 
to the plot in order to view the series together.  

1. Display the source plot(s) and the destination plot. 

2. On the destination plot, choose the arrow tool  

3. Double-click the time axis to access the Axis Properties window. 

4.  In the Axis Properties window, time a unique name in the Name field and click Done. 

5. Copy a series from a source plot (right-click the series and select Copy Series). 

6. Paste the series into the destination plot (from the Edit menu, select Paste Series).  

7. Double-click the new time axis for the pasted series to open the Axis Properties window. 

8.  Type a unique name in the Name field, different than the name used in step 4, and click Done. 

9. Repeat steps 5 through 8 for each series you want to paste. 

10. Identify the periods of interest in each series you want to combine and note the times for each. Also, 
determine which period is the longest; this should be the length of time shown on each axis. 

11. Double-click a time axis and adjust its Min and Max bounds. The new bounds should include the 
period of interest for the series, and be the same length as the longest period identified in the original 
time axis in the destination plot. Repeat for each time axis. 

12. Use the hand tool  on each time axis to adjust the series horizontally as needed. 
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Merging Files 
This feature allows you to combine multiple datafiles one file. Note that only series of the same type and name can 
be merged and there cannot be an overlap in the time in the series. 

1. Open the first file (oldest). 

2. From the File menu, select Merge Datafile(s). 

3. Select the datafiles you want to merge and click Open. 

4. Select the series to plot. All series available in the selected datafiles are listed in the Select Series to 
Plot section. Click the checkbox to add or remove series as necessary, or select the All or None 
buttons in that section to select all series or no series accordingly. 

 

5. All matching series available in the selected series will be populated with the corresponding series 
listed in the Merge With column. Each new series can only be merged with the series of the same 
measurement type and units. If no matching series is available in the plot, the Merge With column will 
display No Series for that series. If a matching series is found, you can still append the series without 
merging by choosing No Series from the corresponding drop-down list in the Merge With column. The 
series will be appended to the plot without being merged with any series. 

6. Select any internal logger events to plot, if applicable. Click the checkbox to add or remove each event 
as necessary, or select the All or None buttons in that section to select all events or no events 
accordingly. 

7. Click the Plot button to merge the selected series with their matching series. Save the new plot as a 
project file if desired. 

There will be a gap between the last sample in the older series and the first sample in the next series as shown 
here in both the Temperature and RH series. 
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After the series have been merged, the Details Pane will be regenerated and the Series Statistics will be 
recalculated. The Points Table will be regenerated and will show samples of both series in one column. The new 
logger information is added to the Details Pane, showing the specific information about the different loggers that 
collected the data samples. 

Converting Units 
Plots display data points in either SI or US units as defined within the Preferences (select Display and then Default 
Unit System). You can switch between SI and US units on a single series or an entire plot without changing the 
overall system preferences. 

To change the units for a single series, right-click the series with the arrow tool and select Convert Series Units and 
then select the unit you want to use.  

To change the units for multiple series within the plot, click the Units icon  on the toolbar or select Convert Units 
from the Edit menu. 

If a series can be configured with multiple units, there will be drop-down list in the units field as in the example 
below. Select the desired units from the drop-down list for all the series you wish to change and then click Convert. 
This changes the units displayed on the axis, in the legend, in the Details pane, and in the Points table. 
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1. For each series that supports unit options, select the desired units from the drop-down list 

2. Click Convert.  

This changes the units displayed on the axis, in the legend, in the Details pane, and in the Points table. 

Undoing and Redoing Plot Changes 
You can undo and redo changes made to the plot display, including zooming, panning, crosshair placement, graph 
and axis properties modifications, and more. 

To undo the most recent change, click the Undo Action  icon on the toolbar or select Undo Action from the Edit 
menu. 

To redo the most recent change that had previously been undone, click the Redo Action  icon on the toolbar or 
select Redo Action from the Edit menu. 

When using the Edit menu for Undo or Redo, the most recent change is listed with the menu choice. In the 
following example, the most recent change that can be undone is to "Zoom Out." 

 
HOBOware keeps track of the changes that you make within each plot window and temporarily stores them as 
"undoable actions." To see a complete list of all the actions that can be undone or redone, click the down arrow to 

the right of either icon on the toolbar.  
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The number of undoable actions stored is set within the plot preferences. You can configure HOBOware to either 
store a specific number of undoable actions or an unlimited number. In addition, you can enable or disable the 
feature altogether. Note that storing an unlimited number of actions can impact HOBOware performance on 
slower computers. 

Saving Project Files 
A project file (.hproj) is a plot that you have customized using the various features and tools of HOBOware. When 
you open a project file, the plot appears as it did when you saved the project file and contains all of the same data. 

To save your current data with a customized view of the plot, click the Save icon  on the toolbar, or choose 
Save Project from the File menu. To open an existing project file, choose Open Project from the File menu. 

Using Data Assistants 
With Data Assistants, you can create new series by combining data recorded by the logger with additional data for 
analysis. For example, the kWh Assistant converts logged pulse data from an energy transducer to kWh, average 
kW, and energy cost.  

When you read out a logger or open a datafile, all available assistants are listed in the Data Assistants section at 
the bottom of the Plot Setup window. To use a Data Assistant, click the assistant name to select it, and then click 
the Process button. 

For some data loggers, you can also run the Linear Scaling, Pulse Scaling, and kWh Data Assistants from the Launch 
Logger window to create additional data series that are automatically available each time you read out the logger 
and open the resultant data file. To use an assistant from the Launch Logger window, click the Scaling or kWh 
button and then double-click the desired assistant, or select the assistant and click the Create button. 

The following Data Assistants are available in HOBOware Pro: 

• Barometric Compensation Assistant. Use the Barometric Compensation Assistant to compensate 
for barometric pressure and create a water level or sensor depth series. The BCA uses water pressure 
data from a HOBO U20 Water Level logger and additional information you provide.  

• Conductivity Assistant. Use the Conductivity Assistant to apply compensation to absolute 
conductance data from a HOBO U24 Conductivity logger. 

• Dissolved Oxygen Assistant. Use the Dissolved Oxygen Assistant to generate a series adjusted for 
salinity and a series for percent saturation based on data from a HOBO U26 Dissolved Oxygen logger. 
Also use this assistant to enter field calibration readings to compensate for fouling. 

• Grains Per Pound Assistant. Use the Grains Per Pound Assistant to calculate the absolute amount 
of water in the air, based on temperature, humidity, dew point, and altitude. You can also create an 
altitude-corrected dew point series. 

• Growing Degree Days Assistant. Use the Growing Degree Days Assistant to calculate growing 
degree days based on temperature data spanning at least one full calendar day (midnight to 
midnight). Growing degree days are used for agricultural and turf management applications, such as 
estimating harvest time or pest growth. 

• kWh Assistant. Use the kWh Assistant to convert logged pulse data from a WattNode, Veris, or other 
energy transducer to kWh, average kW, and energy cost. The kWh Assistant can be run during Plot 
Setup or at Launch. 

• Linear Scaling Assistant. Use the Linear Scaling Assistant to convert a data series from a compatible 
sensor to some other measurement. You enter two raw values and their corresponding measurement 
values. The conversion must be based on a linear relationship. Nonlinear scaling is not available. 
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• Pulse Scaling Assistant. Use the Pulse Scaling Assistant to convert a data series from a compatible 
sensor to some other measurement. You enter a raw value and its corresponding measurement value. 
The Pulse Scaling Assistant can be run during Plot Setup or at Launch. 

 Default Settings 
The parameters last entered into any given Data Assistant will be the default used the next time the Data Assistant 
is run, unless it is being used to edit existing series. If you run a Data Assistant at Plot Setup time and then later you 
run it from the Launch Logger window, the default values are the value you entered at Plot Setup time. 

Hiding Assistants 
To prevent unwanted assistants from appearing in the Plot Setup window, or to bring back assistants that you have 
previously hidden, click the Manage button. This will open the Preferences window to allow you to change these 
settings. 

Software Updates 
If you have an Internet connection, HOBOware Pro can periodically check the Onset website for software updates. 
This includes updates to your data assistants. 

The default is to check once per week, but you can configure HOBOware Pro to check daily or monthly. In 
Preferences, go to the General pane and select Startup. In the Check for HOBOware Updates drop-down list, select 
how frequently you want the software to check for updates. 

You may also check for updates manually at any time. Choose Check for Updates from the Help menu. 

Installing a Data Assistant 
Data Assistants are automatically installed (they require a HOBOware Pro license key). There may also be times 
when a new Data Assistant is available between HOBOware releases and needs to be installed manually. To do 
this, click the Load button on the Plot Setup window and select the assistant's .jar file. Note: On Windows, you 
must be an administrator to load a new Data Assistant. To temporarily run HOBOware as an Administrator, right-
click the HOBOware icon and select Run as Administrator. Enter the Administrator name and password as 
prompted. 

License Agreement 
This software is furnished in accordance with a separate license agreement included with the software, and 
subject to any restrictions set forth therein. For more information about Onset's licensing terms and policies, 
contact Onset Customer Service at 1 800 LOGGERS, or visit http://www.onsetcomp.com/corporate/legal. 

Barometric Compensation Assistant 
The Barometric Compensation Assistant uses water pressure data from a HOBO U20 Water Level Logger and 
additional information from you to compensate for barometric pressure and create a water level or sensor depth 
series. 

After you use the assistant and display the plot, you may apply filters to the new series. 

To create a water level or sensor depth series: 

1. Read out a logger or open a datafile that contains water pressure data from a U20 Water Level Logger. 

2. From the Plot Setup window, select Barometric Compensation Assistant and click Process. 

3. Provide Fluid Density information by choosing a water type (fresh, salt, or brackish), entering a specific 
constant value, or using the temperature series (if logged) to use temperature-compensated density 
assuming fresh water. 
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4. To enter a reference water level, check the Use a Reference Water Level box, enter the water level, 
and indicate whether it is in feet or meters. 

• Enter the water level as a positive number if it is measured upward from a reference point 
below the water's surface, such as the water's height above sea level. 

• Enter the water level as a negative number if it is measured downward from a reference point 
above the water's surface, such as a well cap. 

Then, from the drop-down, select the logged time and value that is closest to the time when you measured 
the water level. 

• When selecting a logged value and time to link to the reference level, make sure the logger 
readings have stabilized. When a logger is first deployed in water, it takes some time for its 
temperature to reach equilibrium. You will get the best accuracy if you link your reference 
reading to a stabilized logger reading. 

• When using a reference water level, the resulting series data will contain water level values 
relative to this reference level. If you do not use a reference water level, the resulting series 
data will contain values for absolute sensor depth. 

5. You can either use a barometric data file from another source, or enter a fixed barometric pressure. For 
the most accurate water level results, use a reference water level and a barometric data file. The 
barometric data can come from another HOBO U20 Water Level Logger in air; a HOBO Weather 
Station, HOBO Micro Station, HOBO U30, or HOBO Energy Logger; or a text file from another source. 

• To use another file to provide barometric information, click the Use Barometric Datafile button 
and enter (or browse to) the name of a .hobo, .hsec, .dtf, .dsec, or .txt file that contains a 
barometric pressure series from an overlapping time period. You will have the option to 
display this series on the plot. Important: To use a .txt file, see Import Text Files Requirements. 
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• To use a constant pressure value, click the Use Constant Barometric Pressure button. Enter the 
constant value and indicate whether it is in psi or kPa. (You cannot use a constant pressure 
value in combination with a reference water level.) 

6. Keep the default Resultant Series Name, or enter a new one. You may also enter User Notes 
concerning the series you are creating. 

Note: Your settings are retained, so you do not need to re-select your density and barometric file each 
time you use the Barometric Compensation Assistant as long as they still apply to the new water level 
data set. 7. Click Create New Series. The new series is listed and selected in the Plot Setup window. You can click 
Process on the Plot Setup window again to create another series using different barometric 
compensation parameters. 8. Click the Plot button. The scaled series will appear in the plot and the settings for the scaled series are 
listed in the Details pane: 

 
After the plot is displayed, you may apply minimum, maximum, and average filters to the new water level or 
sensor depth series as you would for any sensor data series in HOBOware Pro. 

Conductivity Assistant 
The Conductivity Assistant converts raw conductivity data from a U24 logger to Specific Conductance and/or 
Salinity. You can also use it to enter field calibration measurements recorded at the beginning and end of a 
deployment for calibration and to compensate for drift and sensor fouling effects. 

1. Read out a U24 series logger or open a datafile from a U24 logger. 

2. From the Plot Setup window, select the Conductivity Assistant and click the Process button. 

3. In the Conductivity Assistant window, select the conductivity series that corresponds to the range of 
your data. Note: If you only selected one range at launch time, only one series will be listed. 

• For the U24-001 logger, select either Conductivity Low Range when the data is always less than 
1,000 µS/cm or select Conductivity Full Range (default) when the data goes above 1,000 µS/cm 
as shown below. 



HOBOware User’s Guide 

1-800-LOGGERS 84 www.onsetcomp.com 

 

• For the U24-002-C logger, select either Conductivity Low Range when the data is always less 
than 10,000 µS/cm or select Conductivity High Range (default) when the data goes above 
10,000 µS/cm as shown below. 

 
4. Select your desired Temperature Compensation method. 

• Use "Non-linear, Natural Water Compensation per EN27888" for freshwater lakes and streams. 

• Use "Linear compensation default at 2.1 %/°C" or "Linear compensation at <your own value>" 
for NaCl solutions or other linear solutions. 

• Use "Non-linear, Sea Water Compensation based on PSS-78" for salt water or salt marshes. 

5. Select a Calibration Method. By default, data is calibrated using the factory calibration. To enter your 
own calibration values, select "Use measured points for calibration" and then enter temperature and 
actual conductivity (not specific conductance) values from your calibration readings taken with a field 
meter. These field measurements will be used to provide calibrated conductivity and salinity data 
series by adjusting the data as a percentage of the reading. See Calibration below for more 
information. 
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• Starting and Ending Value: This method calibrates your data and adjusts for sensor drift or 
fouling. This assumes there is a linear change in calibration adjustment required. 

• Starting value only: All readings are adjusted up or down by a fixed percentage of the reading 
based on this calibration point. 

• Ending Value Only: The factory calibration value is used as the starting point. This assumes 
there is a linear change in calibration adjustment required. 

Note: You cannot use a zero-point calibration solution for starting and ending values. The first data 
point cannot be used as the ending value; consider using that as the starting value instead. 

6. Select the Only Report Data Between the Selected Points checkbox if you want readings from before 
or after the calibration points to be removed from the resulting series. 

7. In the Series Name field, keep the default name or type a new one. 

8. Type any User Notes concerning the series you are creating (optional). 

9. Click the Create New Series button. 

10. The Plot Setup dialog lists a series called Specific Conductance (or the name you entered for Series 
Name). The default units are microSiemens/cm (µS/cm). You can change the units to milliSiemens/cm 
(mS/cm) if desired. The default units for salinity are ppt (parts per thousand) and this cannot be 
changed. 

 

11. Click the Plot button to plot the data. The Details Pane will show the series selected in the Plot Setup: 

 
After the plot is displayed, you may apply minimum, maximum, and average filters to the scaled series 
as you would for any sensor data series in HOBOware Pro. 

12. Save this plot as a Project to preserve this processed data. 
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Calibration 
It is important to take temperature and conductivity calibration readings with a portable conductivity meter at 
both the beginning (launchtime) and end of a deployment (readout) because these readings are necessary for data 
calibration and to compensate for any measurement drift during deployment. The temperature and conductivity 
calibration readings should be the actual conductivity values (not in specific conductance at 25°C), and should be 
recorded in a notebook with the time and location of the reading. See the logger manual for details on different 
methods of obtaining water samples to record these values. 

1. Once the logger is deployed and logging, record in a notebook the temperature and actual 
conductivity meter readings along with the date and time which will be entered into the Conductivity 
Assistance to correct the field data. 

2. Before you remove the logger and read out its data, take another temperature and conductivity 
reading with the meter and record the exact date and time. 

3. Enter these values under the "Use measured points for calibration" option in the Conductivity 
Assistant. 

Notes: 

• Whenever a logger is removed for downloading data, clean the sensor window using a cotton swab 
with a mild detergent and rinse. 

• If the water in the field is not accessible to the conductivity meter sensor, such as in a deep well, a 
bailer can be used to fetch a water sample for testing. See the logger manual for more details. 

Dissolved Oxygen Assistant 
The Dissolved Oxygen Assistant corrects for measurement drift from fouling and provides salinity-adjusted DO 
concentration as well as percent saturation data. 

1. Read out a U26 series logger or open a datafile from a U26 logger. 

2. From the Plot Setup window, select the Dissolved Oxygen Assistant and click the Process button. 

3. With the Dissolved Oxygen Data Assistant, you can adjust the data for salinity (step 4), enter 
barometric pressure information for percent saturation calculation (step 5), select the resultant series 
you wish to generate (step 6), and enter field calibration data (step 7). 
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4. Adjust for salinity. If you deployed the logger in saltwater, you must adjust for salinity to get either 
a DO concentration or percent saturation. To do this, select the "Adjust for Salinity" checkbox (you will 
also need to select the checkboxes under Resultant Series Information for the series you would like). 
Select whether the series should be adjusted based on salinity or specific conductance. 

• If you chose salinity: Select "Salinity value" if you have a specific value from a conductivity 
meter reading or other source; type the value in ppt as shown below. This works well if the 
salinity is constant during the deployment. If the salinity changes during the deployment, 
select "Salinity datafile" to use a data file from a U24 conductivity logger or a text file. Click the 
Choose button and select the file. (See the Important note for more details about using files.) 

 

• If you chose specific conductance: Select "Sp. cond. value" if you have a specific conductance 
value from a meter reading or other source; type the value in either µS/cm or mS/cm as shown 
below. This works well if the specific conductance is constant during the deployment. If it is 
not constant, select "Specific conductance datafile" to use a data file from a U24 conductivity 
logger or a text file. Click the Choose button and select the file. (See the Important note for 
more details about using files.) 
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Important: When using a file for salinity or specific conductance data, you can select either a .hobo 
file from a HOBO U24 Conductivity Logger or a .txt file from a U24 logger after it has been calibrated 
with the Conductivity Assistant. Using a U24 .hobo file is the easiest while a calibrated U24 text file 
provides the highest accuracy. Follow these steps to create a text file from a U24 Conductivity Logger 
in the proper format: 

A. Click Cancel to close the DO Assistant and Plot Setup windows if they are open. 

B. From the File menu, select Preferences. 

C. In the General Preferences, select Export Settings. 

D. Click the "Use default BoxCar Pro export settings" button and click OK. This will ensure the text 
file you create is the proper format for the Dissolved Oxygen Assistant. 

E. From the File menu, select Open Datafile and select the U24 .hobo file. 

F. In the Plot Setup window, select the Conductivity Assistant and click Process. 

G. In the Conductivity Assistant, create a calibrated specific conductance or salinity data series. 

H. Back in the Plot Setup window, select the specific conductance or salinity series only. Click 
None under Select Internal Events to Plot so that no events are plotted. 

I. Click the Plot button. 

J. From the File menu, select Export Table Data. Choose "Export to single file" if prompted. 

K. To use the calibrated conductivity file, open the DO file again. In the Plot Setup window, select 
the Dissolved Oxygen Assistant and click Process. Select the text file you just created in the 
previous step for the salinity or specific conductance datafile. This file will be used to generate 
the series adjusted for salinity. 

5. Use barometric pressure (for percent saturation). Check the "Use barometric pressure (for 
percent saturation)" box if you want to generate a DO percent saturation series (you will also need to 
select the DO Percent Sat. checkbox under Resultant Series Information). For the best accuracy, use a 
data file from a HOBO Water Level logger deployed in the air or a nearby weather station. Select 
"Barometric Datafile" and click the Choose button to select the .hobo or .txt file. Important: If you 
are using a .txt file from a non-HOBO device, it must follow specific requirements as described in 
Import Text File Requirements. 

If you do not have a barometric pressure file, then select "Barometric data value" and type in the 
average barometric pressure during your deployment in one of the five available units. 

If the barometric pressure readings are from barometric data that has been adjusted to sea level 
readings (such as those taken from a National Weather Service weather station), then you must also 
select the "For sea level barometric pressures, enter elevation" checkbox and type the elevation 
where the logger was deployed in either meters or feet. Absolute pressure values, such as those 
obtained from a HOBO Water Level logger, do not need to be adjusted for elevation. 
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6. Resultant Series Information. Make sure the series you want to plot are selected in the Resultant 
Series Information pane. To generate a series for adjusted DO concentration, check the "DO Adj 
Conc." box. To generate a series for percent saturation, check the "DO Percent Sat." box. The default 
series names display automatically to the right of the selected series. Edit those series names as 
needed. You can also type up to 250 characters of optional user notes. 

 

7. Perform Field Calibration. Use field calibration to compensate for measurement drift due to fouling 
or if the logger was not lab calibrated. (Lab calibration typically remains accurate for the full 6-month 
life of the sensor cap if there is no fouling.) Check the "Perform field calibration" checkbox and select 
the type of field calibration: either "Using Dissolved Oxygen Meter or Dissolved Oxygen Titration" or 
"Using 100% Water-Saturated Air." 

• For calibration using a dissolved oxygen meter or titration: Select the "Starting calibration 
point" checkbox and select the date/time of the calibration reading. View the logged data 
values shown in the drop-down box to be sure that the logger readings have stabilized. It is 
more important that you use a good stabilized logger reading than exactly matching the times. 
Type in the Meter/Titration DO Measurement in mg/L taken at that date/time. If using an 
ending calibration reading, or, if desired, select the "Ending calibration point" checkbox and 
select the date/time of that calibration reading. Make sure the logger reading you use for 
calibration is one from when the logger was in the water, keeping in mind that the logger time 
may be slightly different from the time used for your field readings. You can usually see the 
data points that were recorded when the logger was out of the water. Type in the 
Meter/Titration DO Measurement in mg/L for this ending calibration point.  
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Note: If only an “Ending calibration point” is entered (“Starting calibration point” not checked), 
then the assistant will use the logger calibration for the starting calibration. This assumes you are 
starting with an accurately calibrated logger and saves you from having to do your own starting 
point calibration. However, if you select a “Starting calibration point” and no “Ending calibration 
point,” the series will be adjusted for the one calibration point. This may be accurate enough for 
applications where there is no significant fouling during the deployment time. 

• For calibration using 100% water-saturated air: Select the "Starting calibration point" 
checkbox and the "Ending calibration point" checkbox and select the date/time for the first 
calibration reading. View the values shown in the drop-down list to be sure the readings are 
stable at this calibration point (using a calibration point from when the logger is in air or has 
not reached temperature equilibrium will result in incorrect calibration). Select the source of 
the barometric pressure readings. From the Barometric Pressure drop-down list, select "from 
the left" to use the barometric pressure data file already entered in the assistant or select 
"entered here" to enter a specific barometric pressure value in one of five available units. If 
you are using an ending calibration reading, select the “Ending calibration point” checkbox and 
select the date/time of that calibration reading following the same guidelines as you did for 
the starting calibration point. For the ending point, enter the barometric pressure information 
(select “from the left” or “entered here” as described above). 
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Check the "Only report data between selected points" if you want the new series to only include data 
between the selected calibration points. Leave this option unchecked to include all data. 

8. Click the Create New Series button when finished entering information in the data assistant. 

9. Depending on which series you selected to add, the Plot Setup dialog lists two news series: DO Adj 
Conc and DO Percent Sat (or the names you entered for Series Names). The default units for the 
DO Adj Conc series are mg/L. You can change the units to ppm if desired. 

 10. Click the Plot button to plot the data. After the plot is displayed, you may apply minimum, maximum, 
and average filters to the scaled series as you would for any sensor data series in HOBOware Pro. 11. Save this data and plot setup as a Project to preserve the new series you created for future use. 
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Field Values 
These are the minimum and maximum values allowable in the fields in this assistant. 

Measurement, Units Minimum Maximum 

pressure, mm Hg 380.00 836.00
pressure, in Hg 14.9700 32.9100
pressure, millibars 507.0 1,114.0
pressure, kPa 51.000 112.000
pressure, Pa 51,000 112,000
pressure, psi 7.3480 16.1600
elevation, m -304.80 2 2,438.40
elevation, ft -1000.00 8,000.00
salinity, ppt 0.0000 42.0000
sp. cond., µs/cm 0.0 65,000.0
sp. cond., ms/cm 0.0000 65.0000
meter/titration DO conc, mg/L 0.00 30.00

Grains Per Pound Assistant 
The Grains Per Pound Assistant calculates the absolute amount of water in the air, based on temperature, 
humidity, dew point, and altitude. You can also create an altitude-corrected dew point series. 

To create a grains per pound and altitude-corrected dew point series: 

1. Read out a logger or open a datafile that contains temperature, humidity, and dew point series. 

2. From the Plot Setup window, select the Grains Per Pound Assistant and click the Process button. 

3. In the Grains Per Pound Assistant window, choose the data series you want to convert from the 
Temperature, Relative Humidity, and Dew Point Series drop-down lists. 

 

4. To correct for the Altitude above Sea Level (optional), enter the altitude and use the drop-down menu 
to indicate whether this number is in feet or meters. 

5. Select the Add Altitude-Corrected Dew Point Series to Graph checkbox to plot an altitude-corrected 
dew point series. 

6. In the Resultant Series Name field, keep the default name or type a new one.  

7. Type any User Notes concerning the series you are creating (optional). 

8. Click the Create New Series button. The new grains per pound series (and altitude-corrected dew 
point series, if applicable) is listed and selected in the Plot Setup window. 
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9. Click the Plot button. 

The scaled series will appear in the plot and the settings for the scaled series are listed in the Details pane: 

 
After the plot is displayed, you may apply minimum, maximum, and average filters to the grains per pound and 
altitude-corrected dew point series as you would for any sensor data series in HOBOware Pro. 

Growing Degree Days Assistant 
The Growing Degree Days Assistant calculates growing degree days based on temperature data spanning at least 
one full calendar day (midnight to midnight). Growing degree days are used for agricultural and turf management 
applications, such as estimating harvest time or pest growth. 

One growing degree day (GDD) is equivalent to a one degree increase above a minimum threshold temperature for 
a period of one day. For example, assuming no horizontal cutoff, if the minimum threshold temperature is 70°F 
and the temperature was a constant 85°F for the day, the GDD for that day is 15 GDD. 

A single GDD value is calculated for each full calendar day of temperature data, and plotted at noon for that day. 
GDD values are cumulative; that is, the GDD for each day adds to the previous days’ GDD value. 

Important: Time of day is a factor in the GDD computation. When you launch a logger, be sure that your 
computer’s clock is set to the proper time zone for the area where the logger will be deployed. If you try to correct 
it later by entering a different offset in the Plot Setup window, you may get confusing or misleading results. 

To create a series for growing degree days: 

1. Read out a logger or open a datafile that contains data from a temperature sensor. 

2. From the Plot Setup window, select Growing Degree Days Assistant and click the Process button. 

3. In the Growing Degree Days Assistant window, choose the data series you want to convert from the 
Temperature Series drop-down list. 
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4. Select the Calculation Method you want to use. 

• Average Method: Calculates the average of the high and low temperatures for the day 
(adjusted to the lower and upper thresholds, if necessary), then subtracts the low threshold to 
compute the GDD. 

• Single Triangle (no Cutoff): Uses the low and high daily temperatures to compute a set of two 
linear equations to generate a triangle. The area between the curve and the low threshold is 
then used to compute the GDD. 

• Single Triangle (with Horizontal Cutoff): Uses the low and high daily temperatures to compute 
a set of two linear equations to generate a triangle. Then it adjusts any temperatures above 
the upper threshold to the upper threshold. The remaining area between the curve and the 
low threshold is then used to compute the GDD. 

• Single Sine (no Cutoff): Uses the low and high daily temperatures to compute a sine wave that 
assumes the low temperature occurred at midnight and the high temperature occurred at 
noon. The area between the curve and the low threshold is then used to compute the GDD. 

• Single Sine (with Horizontal Cutoff): Uses the low and high daily temperatures to compute a 
sine wave that assumes the low temperature occurred at midnight and the high temperature 
occurred at noon. Then it adjusts any temperatures above the upper threshold to the upper 
threshold. The remaining area between the curve and the low threshold is then used to 
compute the GDD. 

• Actual Temperature Method (no Cutoff): Uses the logging interval of the temperature data to 
perform a numerical integration. The area between the curve and the low threshold is used to 
compute the GDD. 

• Actual Temperature Method (with Horizontal Cutoff): Adjusts any temperatures above the 
upper threshold to the upper threshold. Then it uses the logging interval of the temperature 
data to perform a numerical integration. The area between the curve and the low threshold is 
then used to compute the GDD. 

• Actual Temperature Method (with Vertical Cutoff): Uses the logging interval of the 
temperature data to perform a numerical integration. Any interval in which the temperature 
exceeds the upper threshold is excluded from the calculation. The remaining area between the 
actual curve and the low threshold is then used to compute the GDD. 

5. Select lower and upper Development Threshold values. These are the minimum and maximum 
thresholds that will be used in the GDD calculation. Use the sliders to set these thresholds, or enter 
the values manually. If the calculation method you chose does not use an upper threshold, the upper 
threshold option will be disabled. Temperatures are in degrees Fahrenheit if your default unit 
preference is US, and in degrees Celsius if your default unit preference is SI. 

6. In the Biofix Parameters panel, choose a date that marks the beginning of the development phase for 
the Biofix date. The dates in this list are the full days contained in the datafile. 

7. In the Degree Days to Event, enter the number of degree days needed to reach an event of interest 
(harvest time, pest emergence, etc.). This will create an alarm line on the graph to indicate when the 
event took place. Degree days are in Fahrenheit (DDf) if your default unit preference is US, and in 
Celsius (DDc) if your default unit preference is SI. 

8. In the Event Description field, type any text to identify the event (optional). 

9. In the Resultant Series Name field, keep the default name or type a new one.  

10. Type any User Notes concerning the series you are creating (optional). 

11.  Click the Create New Series button. 
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12.  The new series is listed and selected in the Plot Setup window. Click the Plot button. 

The scaled series will appear in the plot and the settings for the scaled series are listed in the Details pane: 

 

kWh Assistant 
The kWh Assistant converts logged pulse data to kWh, average kW, and energy cost with WattNode, Veris, or 
other energy transducers, and from Raw Pulse sensors attached to a HOBO 4-Channel Pulse Input Data Logger 
(UX120-017x). 

This assistant can be applied to logged data from a S-UCA-xxxx or S-UCC-xxxx Electronic Switch Pulse Input 
Adapter. It is not compatible with the S-UCB-xxxx or S-UCD-xxxx Contact Closure Pulse Input Adapter. 

After you use the assistant and display the plot, you may apply filters to the new series. 

This data assistant is one of several launch utilities that can also be used at launch time for certain loggers. 

Using the kWh Assistant 

1. At launch time: Using a logger or sensor that supports scaling at launch time, click the Launch icon 
on the toolbar. Click the Scaling button. Double click the assistant name or select the assistant and 
click the Create button. 

At plot setup: Read out a logger or open a file that supports kWh scaling. Select the kWh Assistant 
and click the Process button. 

2. In the kWh Assistant window, choose the data series you want to convert from the Pulse Series drop-
down list. 
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3. In the Setup panel, select the Energy Transducer that was used, and choose the model number from 
the drop-down list. (Since the Veris transducers have a switch to define kWh/pulse, you must specify 
that here as well.) If your transducer is not listed, select Other and enter the conversion factor. 
Choose the type of conversion (Wh/pulse per CT Rated Amp, Wh/pulse, or kWh/pulse) from the drop-
down list. Refer to the manual that came with your energy transducer for help with identifying the 
conversion factor 

4. Enter the current transformer size (in Amps) in the CT Size field. (Veris transducer CT sizes are 
predefined.) 

5. In the Output Series panel, select one or more series you wish to create. For each series, you may 
keep the default Resultant Series Name or type a new one. 

• To create a series that shows energy in kWh, check the Energy box. 

• To create a series that shows average power, check the Average Power per interval box. 

• To create a cost series, check the Usage Cost box and enter the cost per kWh. 

6. Type any User Notes concerning the series you are creating (optional).  

7. Click Create New Series. 

8. If you are running this assistant at launch time, the kWh button displays the number of newly created 
series. If using this assistant while plotting, the new series is listed and selected in the Plot Setup 
window. Click the Plot button to display the series. 

9. The scaled series will appear in the plot immediately or when you read out the logger if configuring 
this at launch time. The settings for the scaled series are listed in the Details pane of the plot: 

 



HOBOware User’s Guide 

1-800-LOGGERS 97 www.onsetcomp.com 

After the plot is displayed, you may apply filters to the new series as you would for any other series in HOBOware 
Pro. In addition to the minimum, maximum, and average filters that are available for most series, the energy and 
cost series allow you to create new series showing totals over a period of time. 

Linear Scaling Assistant 
The Linear Scaling Assistant converts a data series from a compatible sensor to some other measurement when 
you enter two raw values and their corresponding measurement values. The conversion must be based on a linear 
relationship. Nonlinear scaling is not supported. 

Supported Sensors 

This assistant is available for the following sensors: 

• CABLE-2.5-STEREO Voltage Input Cable (for U12 loggers) 

• CABLE-4-20-mA Input Cable (for U12 loggers) 

• CABLE-ADAP5 (for U12 loggers) 

• CABLE-ADAP10 (for U12 loggers) 

• S-CIA-xxxx 12-bit 4-20mA Input Adapter 

• S-VIA-xxxx 12-bit Voltage Input Adapter 

• S-FS-CVIA FlexSmart™ Analog Module 

• S-FS-TRMSA FlexSmart TRMS Module 

• U30 Analog Sensor Port 

• S-LWA-xxxx Leaf Wetness 

• S-SMx-xxxx Soil Moisture 

The Linear Scaling Assistant can be applied only to logged data from these sensors.  

Other Types of Scaling 

There are also other types of scaling available within HOBOware Pro which may apply to your configuration: 

• FlexSmart™ modules are set up for scaling prior to launch, as part of the module configuration 
process. You can later rescale these scaled series using the Linear Scaling Assistant if you need to 
create a different measurement. See Configuring an Analog Module/Port. 

• The Pulse Scaling Assistant is similar to the Linear Assistant, but only allows scaling of pulse data.  

Using the Linear Scaling Assistant 

1. At launch time: Using a logger with a sensor that supports scaling at launch time, click the Launch 
icon on the toolbar. Click the Scaling button. Double click the assistant name or select the assistant 
and click the Create button. 

At plot setup: Read out a logger or open a file that supports linear scaling. Select the Linear Scaling 
Assistant and click the Process button. 

2. In the Linear Scaling Assistant window, choose the data series you want to convert from the Raw 
Series drop-down list. 
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3. In the Scaled column of the Parameters panel, type the units name for the scaled series and enter the 
scaled values in the Scaled column to correspond with the numbers in the Raw column. (The default 
values in the Raw column are based on the high and low values supported by the sensor, but you may 
use different values, as long as those values fall within the sensor's range.) These numbers establish a 
linear relationship between raw and scaled values. 

4. In the Resultant Series Name field, keep the default name or type a new one. 

5. Type any User Notes concerning the series you are creating (optional). 

6. Click the Create New Series button.  

7. If you ran the assistant from the Launch window, the Scaling button displays the number of newly 
created series. If using this assistant while plotting, the new series is listed and selected in the Plot 
Setup dialog. Click the Plot button to display the series. 

8. The scaled series will appear in the plot immediately or when you read out the logger if configuring 
this at launch time. The settings for the scaled series are listed in the Details pane of the plot: 

 
After the plot is displayed, you may apply minimum, maximum, and average filters to the scaled series as you 
would for any sensor data series in HOBOware Pro. 

Pulse Scaling Assistant 
The Pulse Scaling Assistant converts a data series from a compatible sensor to some other measurement when you 
enter a raw value and its corresponding measurement value. The conversion must be based on a linear 
relationship. Nonlinear scaling is not supported 
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The Pulse Scaling Assistant can be run from the Launch window (Pre-set Parameters) or from the Plot Setup 
window. If you run the assistant from the Plot Setup window, you must run the assistant each time you readout 
the logger or open a datafile. 

Supported Sensors 

This assistant is available for the following sensors: 

• S-UCA-xxxx and S-UCC-xxxx Electronic Switch Pulse Input Adapter 

• S-UCB-xxxx and S-UCD-xxxx Contact Closure Pulse Input  

• Raw Pulse sensors connected to HOBO UX series loggers that support pulse logging 

Other Types of Scaling 

There are also other types of scaling available within HOBOware Pro which may apply to your configuration: 

• FlexSmart™ modules are set up for scaling prior to launch, as part of the module configuration 
process. See Configuring an Analog Module/Port. 

• The Linear Scaling Assistant is similar to the Pulse Scaling Assistant, but has slightly different input 
options and is compatible with a different group of sensors. See the Linear Scaling Assistant for more 
information. 

Using the Pulse Scaling Assistant 

1. At launch time: Using a logger with a sensor that supports scaling at launch time, click the Launch 
icon on the toolbar. Click the Scaling button. Double click the assistant name or select the assistant 
and click the Create button. 

2. At plot setup: Read out a logger or open a file that supports pulse scaling. Select the Pulse Scaling 
Assistant and click the Process button. 

3. In the Pulse Scaling Assistant window, choose the data series you want to convert from the Raw Series 
drop-down list. 

 

4. In the Scaled column of the Parameters panel, enter the units name for the scaled series and enter a 
scaled value in the Scaled box to correspond with the number in the Raw box. These numbers 
establish the relationship between the raw and scaled values. 

5. In the Resultant Series Name field, keep the default name or type a new one.  

6. Type any User Notes concerning the series you are creating (optional). 

7. Click the Create New Series button.  
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8. If you ran the assistant from the Launch window, the Scaling button displays the number of newly 
created series. If using this assistant while plotting, the new series is listed and selected in the Plot 
Setup window. Click the Plot button to display the series. 

9. The scaled series will appear in the plot immediately or when you read out the logger if configuring 
this at launch time. The settings for the scaled series are listed in the Details pane of the plot: 

 
After the plot is displayed, you may apply filters to the scaled series as you would for any other series in 
HOBOware Pro. In addition to the minimum, maximum, and average filters that are available for most series, the 
scaled pulse series allows you to create a new series showing totals over a period of time. 

Exporting Data 
While HOBOware offers many tools for analyzing data, there may be instances where you need to export data for 
use in other software. Refer to the following for exporting data and other related topics: 

• Exporting Table Data 

• Exporting Data in Classic (BoxCar Pro) Format 

• Exporting Details 

• Copying Points Data into Another Application 

• Formatting the Date/Time Column in Excel 

• The Bulk Export Tool 

Exporting Table Data 
You can export the data shown in the points table to a Microsoft Excel file or to a text file (.csv or .txt) for 
importing into other applications. You can also export the data points gathered in a ZW wireless network via the 
Plot/Export Wireless Data window.  

To export data: 

1. From HOBOware files: Open a data or project file. Make sure the points table includes the series you 
want to export. This might include series pasted from other datafiles or series derived through filters 
or Data Assistants. Make any changes as necessary. 

From the Plot/Export Wireless Data window: Make the changes necessary to select the desired series 
and then click the Export button. Skip to step 3. 

2. From the File menu, select Export Table Data or click the Export icon  on the toolbar. 



HOBOware User’s Guide 

1-800-LOGGERS 101 www.onsetcomp.com 

 

3. To change the export settings, click the Preferences button . Make any changes to the settings 
and then click OK in the Preferences window to return to the Export window. Note: Changes to the 
"Use export ordering rules" preference are not automatically displayed in the Export window; they 
will take effect the next time you open the Export window.  

4. Select the series you wish to include in the exported file. Use the All and None buttons or the 
checkboxes in the Select column to make your changes. Note: Only the series that are listed in the 
points table in a plotted HOBOware file or selected from the Plot/Export Wireless Data window are 
available to export from this window. To make additional series appear in this window, click Cancel 
and go back to step 1. 

5. The data will be exported in the order displayed in the Export window. To change this sort order, click 
a column header in the Export window. You can sort the Measurement, Units, sensor S/N, and Label 
columns in both ascending and descending order. Or, click a row to drag that series to a different 

position in the list. To return to the original sort order, click the Restore Order button . Note that 
if you have the export preferences set to "Use export ordering rules," then the series will be listed in 
the order defined in that preference when you click the Restore Order button. If the datafile contains 
series with measurement types that are not defined in the export ordering rules preference, then 
those series will be listed after the defined series. 

6. Click the Export button and then select where you want to save the file.  

7. Click Save. You can now open the exported file in Excel or another software application. Note that if 
you have the export preference "Include plot details in exported file" enabled, then any information in 
the Details pane of the plot will be included in the exported file along with the sensor data. 

Exporting Data in Classic (BoxCar Pro) Format 
BoxCar Pro is legacy software from Onset Computer. HOBOware includes a preference setting that allows you to 
export and import data in a format compatible with Onset's Box Car Pro software. To change the export 
preferences to use settings compatible with BoxCar Pro: 

1. From the File menu in Windows or the HOBOware menu on Macintosh, select Preferences. 

2. Select the General category and then click Export Settings. 

3. Click the "Use classic export settings" button and then click OK. 

See Export Settings for details on all export preference settings. 



HOBOware User’s Guide 

1-800-LOGGERS 102 www.onsetcomp.com 

Exporting Details 
You can export the information in the Details pane to a text file, which can be opened in any text editor or 
imported into numerous applications, such as Microsoft Word or Excel. 

To export details: 

1. Make sure the Details pane includes the series you want to export. This might include series pasted 
from other datafiles or series derived through filters or Data Assistants. 

2. From the File menu, select Export Details. 

3. Accept the default file name, or type a new name. 

4. Click Save. 

If you would prefer to have the information in the Details pane and sensor data in the same file, select Preferences 
from the File menu in Windows or the HOBOware menu in Macintosh and click the General category. Click Export 
Settings and then enable the "Include plot details in exported file" checkbox and click OK. The next time you use 
the Export Table Data feature, the plot details will be included in the exported file along with the sensor data. 

Formatting the Date/Time Column in Excel 
In Excel, dates and times for each data point may initially appear as ####### and times may not have seconds 
listed. To display the full date and time with seconds in Excel: 

1. Adjust the time column width so you can see the whole date and time.  

2. Select the time column from row 3 down. 

3. From the Format menu, click Cells. 

4. Select the Custom category and then select "m/d/yyyy h:mm" as the type. 

5. Add ":ss" (or ":ss.000" if you used a fast logging interval) to the end of the string in the Type field: 

m/d/yyyy h:mm:ss (normal logging interval) 
m/d/yyyy h:mm:ss.000 (fast logging interval) 

6. Click OK. The seconds should be listed automatically. 

To export the date and time in separate columns, go to Preferences> General > Export Settings and enable the 
"Date and time format: Separate into two columns" option.  

The Bulk Export Tool 
The Bulk Export Tool is a plug-in tool for HOBOware Pro that exports HOBOware files to text or Microsoft Excel 
format for use in other programs. This tool is particularly helpful when you need to export multiple files at once. 

With the Bulk Export Tool, you can export the following file types: 

• .hobo 

• .dtf 

• .hsec 

• .dsec 

Any naming conflicts are automatically resolved to prevent overwriting any pre-existing files. A log summarizing 
the export results is saved in the same directory as the newly exported files. 
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The Bulk Export Tool uses the general export settings for HOBOware Pro. To configure the Export Settings, go to 
the File menu in Windows or the HOBOware menu in Macintosh and select Preferences. In the General category, 
select Export Settings. 

Using the Bulk Export Tool 
To export files with the Bulk Export Tool: 

1. From the Tools menu, select Bulk File Export and then Select Files to Export ... 

2. In the Select Files to Export dialog, select the files you wish to export and click Continue. 

 

3. In the Choose Exports Folder dialog, navigate to the directory where you want the files to be exported 
and click Export. 

 

4. A progress bar indicates the status of the export (if this happens very quickly, you may not see the 
bar). A message appears when the export is complete. Click OK. 

The exported files are saved to the specified directory. 
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The native file extension is removed and appended with the file type selected in the export preferences (.txt, .csv, 
or .xls). For example, if the Export File Type preference is set to Excel, then exportfile.hobo is renamed 
exportfile.xls. If a file name already exists, new files will be appended with "_0", "_1" etc. For example: 

exportfile.xls 

exportfile_0.xls 

exportfile_1.xls 

A log file showing the result of each exported file is also saved to the same directory. The log file lists either the 
successful export with the resulting file names or an error message if there was a problem. The log file has the date 
and time of the export in its file name like this: 

Export_<day>_<month>_<year>_<hour>_<minute>_<second>.log 

Important: The Bulk Export Tool will not export files properly if the "Show export dialog" setting is selected in the 
export preferences. To disable this setting, select Preferences from the File menu in Windows or the HOBOware 
menu in Macintosh. In the General category, select Export Settings. Make sure "Show export dialog" is not 
selected. Even if the "Automatically export table data upon readout of logger" option is disabled, the "Show export 
dialog" must not be selected for the Bulk Export Tool to export files properly. Your preferences must look like this: 

 

or this: 

 

but not like this: 
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for files to export correctly. 

YAML 
You can choose to have YAML ("YAML Ain't a Markup Language") headers added to the exported files (they are not 
inserted by default). If enabled, YAML headers are inserted at the front end of the file. You can remove the YAML 
header using any text editor. 

YAML™ (rhymes with “camel”) is a human-friendly, cross language; Unicode based data serialization language 
designed around the common native data structures of agile programming languages. For more information see 
yaml.org. 

To enable YAML headers: 

1. Go to the File menu in Windows or the HOBOware menu in Macintosh and select Preferences. 

2. Scroll down to the Bulk Export category and select YAML. 

3. Check the Export with YAML Headers box. 

 

Importing Text Files 
You can plot non-HOBOware data by importing data from certain text files including:  

• Text files that were created by Onset’s Alarm & Readout Tool version 2.0 or higher.  

• Text files that were exported from Onset's BoxCar Pro 4.3 software using the default BoxCar export 
settings. This allows you to view data from legacy Onset loggers that cannot be read out using 
HOBOware Pro. 

• With some adjustments, you can open text files that were exported from other software or that you 
create. See Importing Text File Requirements for more details. 

Note: This feature is only available in HOBOware Pro. 

To import data from a properly formatted text file: 
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1. From the File menu, select Import Text Data.  

2. Select a text file (.txt) and click Open.  

3. If the text file was created by the Alarm & Readout Tool, go to step 8. Otherwise, HOBOware Pro 
attempts to parse the text file and displays the Text Import Information window. To conserve system 
resources, it displays only the first several records in the file. 

4. Check the Delimiter Preview area to be sure the date, time, and data columns are separated correctly. 
If they are not, use the Data Separator, Date/Time Separator, and Decimal Separator pull-down 
menus to choose other delimiters until the data looks correct. You can resize the columns by clicking 
and dragging the dividers between the column headers. 

For text files that were not exported in BoxCar's default format, click the Edit Date/Time Format 
button and ensure that the import function is interpreting incoming date, time, and year formats and 
separators correctly. Use the current date and time displayed in the Sample panel as a guide. 

5. When the Delimiter Preview is correct, click OK.  

6. Depending on the file's contents, the Plot Setup window may be displayed at this time. If so, go to step 
8.  

Otherwise, the Text File Information window is displayed. This window allows you to add optional 
information and change units, if needed.  

• Type a description, which will become the plot title and be included in the Details pane. 

• Select a model from the list. If you select Other/3rd Party, you can enter a description (up to 
20 characters) of the logger or other data source in the next field. 

• Type the logger's serial number, if applicable. 

• Verify the units are correct for the data in the file. 

7. Click OK.  

8. The Plot Setup window opens. Select the series you wish to view in the plot and click Plot. The plot is 
displayed. You may want to save your work in a project (.hproj) file for quick viewing later. 

Import Text Files Requirements 
When you import a text file, the file must meet certain requirements. You can view or edit text files in a text editor 
or word processor. To delete, rearrange, or reformat columns of data, you may need to use a spreadsheet 
program. Remember to save the corrected file in text (.txt) format. This feature is only available in HOBOware Pro. 

Serial Number 

The file can contain an optional header for serial number information located at the beginning of the file, before 
the column headings. The header must have the phrase "Serial Number:" followed by a space, then the serial 
number, then two dashes: 

Serial Number: 733329 -- 

Note: Text files originating from HOBOlink and the Alarms & Readouts Tool may also contain YAML headers at the 
top of the file. 

Contents 

Below the header (if any), there should be the data, starting with column headings. There must be no other text in 
the file other than the optional header, column headings, and data. The first column must be date, the next must 
be time, and the rest must be data. 
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Delimiters 

Valid delimiters for separating date and time and other data are commas, tabs, and semicolons. The delimiter used 
to separate the date from the time may be different from the delimiter used to separate the data. Do not use a 
space as a delimiter; there cannot by any spaces in the data. 

Date 

The date column must have the heading, "Date" and date values should be formatted as mm/dd/yy. If they are in a 
different format, remember to indicate the correct format in the Edit Date/Time Format window when you import 
the file. 

Date 
12/31/04 
12/31/04 
01/01/05 
01/01/05 

Time 

The time column must have the heading, "Time" and time values should be formatted in 24-hour format as 
hh:mm:ss.sss (decimals are optional). If they are in a different format, remember to indicate the correct format in 
the Edit Date/Time Format window when you import the file. UTC offset is assumed to be the same as your 
computer's current time zone. 

Time 
23:59:59 
23:59:59.5 
00:00:00 
00:00:00.5 

• No thousands separator can be used. 

• Rows of data must be separated with a paragraph return. 

• There must be a last blank row. 

Measurements 

Data column headings must have the format "Measurement (Units)". Additional information (such as channel 
number or serial number) can follow, but is optional. Only spaces can be used between the end of the 
measurement name and the opening parenthesis. An example is "RH (%)".   

RH (%) 
38.7 
38.9 
39.0 
39.0 

If the column header and units of an imported series exactly matches the text in the table below, HOBOware will 
recognize the measurement and be able to perform unit conversions, apply data assistants, etc. to that series.  

Measurements listed below that either have only one unit type, or can be any unit type, cannot have their units 
converted, but may still be used with applicable data assistants.  

Measurement Type Column Header Units 
Acceleration x accel, y accel, z accel g, m/s2, ft/s2 
Carbon Dioxide co2 ppm 
Conductivity low range, full range, high range µS/cm, mS/cm 
Counts counts [any units] 
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Dew Point dew point F, C 
Gust Speed gust speed m/s, km/hr, mph, knots 
Leaf Wetness leaf wetness [any units] 
Light Intensity intensity lux, lum/ft2 
PAR par [any units] 
Pressure pres kPa, Pa, mbar, mm Hg, psi, in Hg 
Rain rain mm, in 
Relative Humidity rh % 
Salinity salinity ppt 
Soil Moisture soil moisture [any units] 
Specific Conductance conductance µS/cm, mS/cm 
Sum Vector sum vector g, m/s2, ft/s2 
Temperature temp F, C 
Tilt x tilt, y tilt, z tilt deg, rad 
Wind Speed wind speed m/s, km/hr, mph, knots 
Wind Direction wind dir [any units] 

 

Measurements that are not listed in the table (or do not exactly match the text below) can be exported, but 
without any units conversions or use of Data Assistants. These include: 

• Air Velocity 

• Battery 

• Compressed Airflow 

• Conductance 

• Current 

• Gauge Pressure 

• Power 

• Solar Radiation 

• Temperature for Thermocouples 

• Water Flow 

• Volatile Organic Compound 

• Voltage 

• Asynchronous Events/Readings 

• State 

• Runtime 

Importing Files from HOBOlink 
This feature allows you to import the current data file for a remote HOBO U30 Station from HOBOlink directly into 
HOBOware for analysis. Note: This feature is only available in HOBOware Pro. 
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To import a file from HOBOlink into HOBOware: 

1. From the File menu, select Import Data File from HOBOlink. 

 

2. Type the serial number for the HOBO U30 Station.  

3. Type the Username and Password for the HOBOlink account. 

4. Select the "Save this information" checkbox if you want to HOBOware to retain the username and 
password for future use. 

5. Click Go to import the file into HOBOware. 
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Chapter 5 
Hardware Reference 
Refer to the following topics for more information on using HOBOware with specific devices: 

• Working with the HOBO U30 Station 

• Configuring FlexSmart Modules/Analog Sensor Ports 

• Working with a Shuttle 

• Configuring Loggers with the E50B2 Power and Energy Meter 

• Checking Dates for the HOBO U26 Dissolved Oxygen logger Sensor Cap 

• Using the Lab Calibration Tool with the HOBO U26 Dissolved Oxygen Logger 

• Updating UX Series Logger Firmware 

• Fixing "Read Header Failed" Error 

Working with the HOBO U30 Station 
There are four models of the HOBO U30 Station: USB, cellular, ethernet, and wi-fi. The USB model works with 
HOBOware Pro only. The cellular, ethernet, and wi-fi models are designed primarily for use with internet-based 
HOBOlink software, but can also work with HOBOware for specific tasks. This section describes when to use each 
of the four U30 Station models with HOBOware. 

HOBO USB U30 Station (U30-NRC) 
Use HOBOware Pro for all tasks with the USB model, including launching, reading out, and checking status. You can 
also configure alarms, control the relay, configure excitation power, and set the scaling parameters. 

HOBO Cellular (U30-GSM), Ethernet (U30-ETH), and Wi-Fi (U30-WIF) U30 Stations 
Use HOBOlink to launch, read out, check status, configure alarms, and set up sensor scaling for cellular, ethernet, 
and wi-fi models. Although it is possible to perform these tasks with HOBOware Pro, any parameters set in 
HOBOware Pro will be overridden by the settings in HOBOlink. If you do attempt to launch, read out, or check the 
status using HOBOware Pro, you may see a message indicating there is already a live HOBOlink session underway. 
You can choose to override the HOBOlink connection and use HOBOware Pro instead. Alternatively, you may see a 
message indicating the HOBO U30 Station is busy and a HOBOware Pro session cannot begin. Try again in a few 
minutes. 

These models connect to HOBOlink on a schedule that you determine. Data is automatically read out from the U30 
Station and uploaded to HOBOlink. There may be circumstances in which you want to override this schedule and 
contact HOBOlink immediately. For example, if you moved the HOBO U30 Station to a different location and you 
want to make sure it can still connect to HOBOlink, but you don’t want to wait until the next connection. To force 
an immediate connection to HOBOlink, connect the U30 Station to a USB port. Click the Contact HOBOlink button 
in the Status window. 

HOBOlink displays data read out from the HOBO U30 Station in line graphs and shows the readings from the last 
connection. The data is also saved in datafiles that can be downloaded and opened in HOBOware Pro for additional 
analysis.  

While most tasks should be done using HOBOlink, the following tasks can only be completed in HOBOware: 
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• Configuring the analog sensor port. This can only be done in HOBOware Pro and is accessed through 
the Launch window. See Configuring FlexSmart Modules and Analog Sensor Ports for details. 

• Changing the default relay setting or testing the relay. The default relay setting for the HOBO U30 
Station is normally open and can only be changed in HOBOware Pro. You can also use HOBOware Pro 
to test the relay. See Controlling the Relay on the HOBO U30 Station for details. 

• Testing the accuracy of individual smart sensors. Unplug all the sensors when the logger is not logging. 
Plug one sensor back in and check the current reading for the sensor in the Launch Logger window. 
Repeat this for the remaining sensors. Note: Sensors are listed in ascending order by serial number, 
regardless of their physical position in the logger. 

• Checking cellular signal strength. Open the Status window in HOBOware Pro to check the cellular 
signal for the HOBO U30 Station in its current location. This will help you determine if you need to 
reposition the station for optimal signal strength. 

Controlling the Relay on the HOBO U30 Station 
The U30 Station relay contact is a latching relay that can be configured as either Normally Open or Normally 
Closed. The factory-default setting is Normally Open. Note: This is a HOBOware Pro feature. 

To change the relay from the Device menu:  

1. Connect the HOBO U30 Station to the computer with the USB cable.  

2. From the Device menu, select Manage U30. 

3. Select Control U30 Relay.  

4. Select "Set default (deactivated) state." 

5. Select either Open or Closed.  

To conduct an immediate test of the relay from the Device menu:  

1. Connect the HOBO U30 Station to the computer with the USB cable.  

2. From the Device menu, select Manage U30. 

3. Select Control U30 Relay.  

4. Select "Activate (close) relay." You should hear a click in the HOBO U30 Station. 

5. Select "Deactivate (open) relay." You should hear the click again. 

To change the relay and test it using the Sensor Alarms window: 

1. From the Device menu, select Manage U30. 

2. Select Configure U30 Alarms and select Configure Alarms to open the Sensor Alarms window. 

3. In the Relay Contacts section, select Normally Open or Normally Closed. 

4. If you are setting an Alarm Action of Pulse Relay, you can set the Relay Pulse Width in milliseconds.  

5. To test the relay, click the Close Relay or Open Relay button in the Sensor Alarms window. You should 
hear a click in the HOBO U30 Station. Click the button again to return to the default state. Use a digital 
multimeter to check for continuity to confirm that the relay is opened and closed as expected.  

6. Click Set to send the alarm configuration to the U30 Station.  
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Setting Alarms on a HOBO U30 Station 
You can set alarm to trip for individual sensors on a HOBO USB 30 Station (U30-NRC). Note: This is a HOBOware 
Pro feature. 

1. From the Device menu, select Manage U30 > Configure U30 Alarms > Configure Alarms. 

2. Select a sensor and click Add. 

 

3. In the Alarm Configuration window, select the High Alarm checkbox if you want an alarm to trip when 
the sensor reading goes above a value you specify. Type a High Alarm value or drag the top slider to 
set a value. and/or the Low Alarm checkboxes. Type a value for the alarm in the box(es) or use the 
sliders.  

Select the Low Alarm checkbox if you want an alarm to trip when the sensor reading goes below a 
value you specify. Type a Low Alarm value or drag the bottom slider to set a value. 

Note: If you type a High or Low Alarm value, the software may adjust them slightly to the nearest 
values supported by the logger. 
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4. Set the number of samples that will be logged before the alarm trips. Note: To avoid unintended 
activation of the relay contact, set the number of samples to allow for anticipated breaches of the 
alarm threshold. If the measurement is still out of range when the number of samples is reached, the 
relay contact will be activated. 

5. Select an action to occur when the alarm is triggered: Activate Relay (Open/Close), Deactivate, Pulse, 
Toggle, Open, Close. 

6. Select the Deactivate on Alarm Clear checkbox if you want the alarm action to stop automatically once 
the alarm condition clears. 

7. Click OK to save the changes. The alarm will now appear in the Sensor Alarms window. Select the 
alarm and click Edit if you need to make changes or click Delete to remove an alarm. 

8. Click Set in the Sensor Alarms window when finished configuring alarms. 

Configuring FlexSmart Modules/Analog Sensor Ports 
You can configure HOBO Energy Logger FlexSmart modules and the HOBO U30 Station analog sensor port to 
accommodate a wide range of Onset and third-party sensors. You can set up these modules/ports while selecting 
launch settings or you can create and save different configurations to be loaded into the modules/ports whenever 
needed. 

Notes: 

• Modules, ports, and sensors are listed in ascending order by serial number regardless of their physical 
position in the logger. 

• This procedure is for creating a new configuration and sending it to a port. To send an already saved 
configuration to a port, see Loading a Saved Configuration. 

• This is a HOBOware Pro feature. 

To configure an analog module or port, perform the following steps:  

1. From the the Device menu, choose Configure Modules/Ports. 2. In the Select Sensor to Configure window, click the + sign to see the available modules/ports. If you 
are using the HOBO Energy Logger, you can attach additional modules while viewing this window. 
Click Refresh to update the module list. Note: The default channel names Voltage and Current can 
both be configured to measure voltage or current. For example, both channels can be used to monitor 
sensors with 4-20 mA output. 

 

3. Select a sensor and then click the Configure button to open the Configure Sensor window. Note: You 
can also access this window from the Launch Logger window. Select the sensor and double-click the 
module/port name to expand it. Click the sensor name to select it and then click the Configure button. 



HOBOware User’s Guide 

1-800-LOGGERS 114 www.onsetcomp.com 

4. In the Configure Sensor window, select the Sensor Name. Choose either a default name or select 
Custom and enter your own 16-character name, which you can also save to the list for future use. 
Note that a saved name is stored as a preference and removed when you restore preference defaults. 

 

5. Set the excitation power, measurement type, and scaling as desired (options may vary depending on 
the sensor). For details on excitation power, see Configuring Excitation Power. If the module/port 
offers more than one type of input, select the correct the measurement type for the sensor. For 
details on scaling, see Setting Voltage Ranges and Scaling Parameters. 

6.  Although you do not have to save the configuration if you are going to send it to the module/port 
right away, you may find it convenient to save it for future use, especially if you have defined custom 
sensor settings. Click Save, type a name for the configuration file, and click Save again. 

By default, the file is saved to the following location with an extension of .hcfg. 

Windows: My Documents\HOBOware\Configs 

Mac: Users/<username>/Library/Application Support/HOBOware/Configs 

7. Click Configure to send the currently displayed configuration to the module/port. The module/port 
will remain in this configuration until you send it a different configuration. 

Configuring Excitation Power 
You can configure sensor excitation power and warm up on the Analog Sensor Ports. Sensor excitation is a voltage 
output provided by the HOBO U30 Station to power a sensor that is connected to it. This power may be needed 
because the sensor is not self-powered or because the sensor’s power capacity cannot support a long deployment. 
Note: This is only available in HOBOware Pro.  

When sensor excitation is required, the logger can provide 12 V DC sensor excitation voltage up to 200 mA total for 
transducers that require external power for proper operation. The excitation voltage has a programmable warm up 
time and is controlled by the Analog Sensor Port.  

A warm up time can be up to 120 seconds. If the warm up required is longer than 120 seconds, or if you are not 
concerned with battery life, you may choose the Continuous option, which will power the sensor for the entire 
deployment.  
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Providing excitation power drastically decreases the logger's battery life (consult the logger manual for more 
information). To save battery power, you may specify the minimum time needed to power the sensor before 
taking a measurement. For example, if you specify a Warm Up of one second and set the logging interval in the 
logger to one minute, the logger will power the external sensor for one second, log data and then turn off the 
excitation power for the next 59 seconds. 

 Always enable the logger's internal battery channel when logging with excitation power. If the battery becomes 
too low to provide excitation power, excitation power is turned off, but logging continues as long as the battery 
can power the logger. This will cause the further readings on that channel to become inaccurate. If you are logging 
the internal battery channel when this happens, an Excitation Off event will be shown in your datafile to mark the 
point at which excitation power was disabled. 

To configure excitation power: 

1. From the Configure Sensor window, click the Set Excitation Power button. For information on 
accessing the Configure Sensor window, see Configuring FlexSmart Modules/Analog Sensor Ports.  

2. Select the Excitation Power Used checkbox. 

 

3. Select either Warm Up or Continuous mode. If you select Warm up, select the warm up time in 
seconds. 

In Warm up mode, the logger supplies excitation power for a brief period prior to each measurement. 
This mode allows you to select the minimum warm up time needed to allow for sensor stabilization, 
while conserving battery power. For example, if you specify a warm up of one second and set the 
Logging Interval to one minute, the HOBO U30 Station will power the external sensor for one second, 
log a measurement, and then turn off the excitation power for the next 59 seconds. The warm up 
time can be up to 120 seconds. If the warm up time selected is greater than the logging interval 
selected, the logger will interpret the excitation mode as continuous.  

In Continuous mode, the logger supplies constant excitation power to the sensor for the entire 
duration of the deployment. This mode will result in reduced battery life. Continuous mode is 
required if the sensor needs more than two minutes of warm up time. 

4. Click OK. 

5. Select Save to save these settings in a configuration for future use. Click Configure to send this 
configuration to the port immediately. 
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Setting Voltage Ranges and Scaling Parameters 
You can set voltage ranges and scaling parameters for the HOBO Energy Logger FlexSmart modules and the 
HOBO U30 Station in the Scaling Parameters panel of the Configure Sensor window. For information on accessing 
this window, see Configuring FlexSmart Modules/Analog Sensor Ports. Note: This is only available in HOBOware 
Pro. 

 
To set the scaling or voltage range: 

1. Check the Raw Units. This is the type of output the sensor has; either V or mA, corresponding to the 
type of sensor selected. Raw Value 1 and Raw Value 2 should be input in these units. For example, if 
the external sensor has an output of 4 – 20 mA, the raw units would be in mA. 

2. Set Raw Value 1, which is the low raw value given by the external sensor. In the previous example, this 
would be 4 mA. 

3. Set Raw Value 2, which is the high raw value given by the external sensor. In the previous example, 
this would be 20 mA. 

Important: The number entered for Raw Value 2 determines the voltage range the analog port will use. Use this 
table to determine what the range will be depending on the number entered in the Value 2 field. 

If the raw voltage entered in  
the Value 2 field is: 

The voltage range for  
the analog port will be: 

Less than 2.5 2.5V 

Greater than 2.5 and less than or 
equal to 5 

5V 

Greater than 5 and less than or 
equal to 10 

10V 

Greater than 10 and less than or 
equal to 20 

20V 

4. Select the Scaled Units. Choose one of the predefined units from the pull-down list or select Custom 
to define units for other types of sensors. If you select Custom, type up to eight characters of the units 
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associated with the sensor. For example, if you are using a flow meter, you could specify CFS (Cubic 
Feet per Second) as the scaled unit. If you want to see data in particular SI or US units, you need to 
enter the appropriate scaling values in the next steps. Select the "Save this value for next time" 
checkbox to add this name to the Scale Units drop-down menu for future use. Note that a saved unit 
name is stored as a preference and removed when you restore preference defaults. Custom unit 
values do not allow for conversion between SI to US units. It is only a reference used to indicate how 
the module is configured and how the resulting data should be labeled. Click OK to save the changes 
and return to the Configure Sensor window. 

 

5. Set Scaled Value 1, which is the value that will be displayed on the graph when the sensor reports a 
raw value equal to Raw Value 1. This value should be entered based on the Scaled Units selected in 
the previous step. 

6. Set Scaled Value 2, which is the value that will be displayed on the graph when the sensor reports a 
raw value equal to Raw Value 2. This value should be entered based on the Scaled Units selected in 
Step 4. 

7. Click the Save button to save this configuration for future use or click Configure to send these settings 
to the module/port immediately. 

Loading a Saved Configuration 
If you have created and saved a sensor configuration for a HOBO Energy Logger FlexSmart modules and the 
HOBO U30 Station analog sensor port, you can load it into any module/port of the same type. For example, a 
configuration for a FlexSmart TRMS module can be loaded into any other FlexSmart TRMS module, but not into a 
FlexSmart Analog module. Note: This is only available in HOBOware Pro. 

To load a saved configuration: 

1. From the Device menu, select Configure Modules/Ports. 

2. Click the Load button to see a list of all defined configurations in the currently selected folder that are 
compatible with the module/port.  

3. Choose a configuration. To use one of the defined configurations, click the button next to Use 
Configuration File, then click the button next to the name of the configuration file you want to use. To 
get a file from a different location, click Choose Folder and browse to the desired directory. If you are 
experiencing problems with the module, you can reset the channel to its default configuration. Select 
Use Default Module Configuration. 

4. Click Continue. 

5. To send the currently displayed configuration to the module/port, click Configure. The module/port 
will remain in this configuration until you send it a different one. 

Resetting a Module to the Default Configuration 
If you are experiencing problems with a module, you can reset it to the default configuration. 

1. From the Device menu, select Configure Modules/Port. 
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2. Select a sensor and click Configure.  

3. In the Configure Sensor window, click the Load button to view a list of all defined configurations in the 
currently selected folder that are compatible with the module/port.  

4. Select Use Default Module Configuration and click Continue.  

5. To send the currently displayed configuration to the module/port, click Configure. The module/port 
will remain in this configuration until you send it a different one. 

The following examples show the default configuration for the analog modules. The configuration is the same for 
both channels.  

 

Working with a Shuttle 
HOBO shuttles provide a convenient way to read out and relaunch loggers in the field. The HOBO U-Shuttle 
features a text display and is compatible with all loggers that can be used with HOBOware Pro. The HOBO 
Waterproof Shuttle communicates with optic loggers. Note: To use a U-Series logger (other than the HOBO U30 
Station) with a shuttle, the logger must first be launched with HOBOware version 2.2 or higher at least once. 
Consult the shuttle user guide for details. 

After you read out a logger to the shuttle, you can then connect the shuttle to the computer and offload and save 
the files to view in HOBOware Pro. From the Device menu, select Manage Shuttle to open the Shuttle 
Management window to check the status and work with the shuttle. See Offloading and Saving Files from a Shuttle 
and Deleting shuttle files for more information on using the shuttle.  

Note: While the Shuttle Management window is displayed, the U-Shuttle remains on battery power for up to an 
hour. After one hour, or any time the U-Shuttle's main battery level becomes low, the window closes and the 
shuttle powers down.  To further conserve the shuttle's battery life, you should close the window, disconnect the 
shuttle, and turn the shuttle off as soon as you finish working with it. 

U-Shuttle Firmware Updates  

Occasionally, a firmware update may be available for the U-Shuttle. To check whether an update is available or if 
you are directed to update the firmware from Onset Technical Support: 

1. Connect the U-Shuttle to the computer. 
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2. From the Help menu, select Update Device Firmware and then select U-DT-1/U-DT-2 from the 
submenu. 

3. Follow the instructions on the screen to complete the upgrade process. 

Offloading and Saving Shuttle Files 
To offload datafiles from a shuttle to a compute:  

1. Connect the shuttle to the computer. Note: HOBO Shuttles require HOBOware Pro. 

2. From the Device menu, select Manage Shuttle. Or, to quickly offload all the new datafiles on the 
shuttle, select Readout from the Device menu. 

3. In the Shuttle Management window, choose files to offload. 

• On the U-Shuttle, all files are selected by default if the shuttle has not been offloaded before. 
To deselect all files, click the Uncheck All button. To deselect individual files, click the checkbox 
next to each file. 

• On the Waterproof Shuttle, only the files that have not been offloaded AND saved previously 
are selected by default. To select or deselect individual files, click the chexbox next to each file. 
Use the Check All and Uncheck All buttons next to Previously Offloaded Files and New Files 
(Not Offloaded) to control the selection of these groups of files. To automatically delete files 
after you offload and save them, select the Delete Contents Upon Offload checkbox.  

 

4. Click the Offload Checked button when you are ready to begin offloading the files from the shuttle. 
Once offloading begins, the Offload Checked button will change to Cancel Offload. When offloading is 
complete, the Files on Shuttle panel in the Shuttle Management window will change to a Files 
Offloaded From Shuttle panel. 
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5. The Save Folder indicates where the offloaded files will be saved. To change the location where these 
files are saved, click Choose and browse to another folder. 

6. To open the folder automatically after they are saved, select the Open Folder in Windows Explorer 
after Save checkbox on Windows or the Open Folder in Finder after Save checkbox on Macintosh. 

7. Select the files to save. By default, all the offloaded files are selected for saving. To deselect individual 
files, click the checkbox next to each file. To deselect all files, click the Uncheck All button. To save all 
files if you already deselected a few, click the Check All button. 

8. Make any changes to the listed datafile names if desired for the files you are saving. 

9. Click the Save Checked buttons to save all selected files in the folder specified in step 5. 

10. Click the Launch Shuttle to reset the shuttle clock and delete all files from the shuttle. See Deleting 
Files from a Shuttle for more information. 

The Shuttle Management Window 
Use the Shuttle Management window to work with the HOBO U-Shuttle and Waterproof Shuttle. 

Notes: 

• HOBO Shuttles require HOBOware Pro. 

• While the Shuttle Management window is displayed, the U-Shuttle remains on battery power for up to 
an hour. After one hour, or any time the U-Shuttle's main battery level becomes low, the window 
closes and the shuttle powers down.  To further conserve the shuttle's battery life, you should close 
the window, disconnect the shuttle, and turn the shuttle off as soon as you finish working with it. 

•  The Waterproof Shuttle is powered by the USB port, and does not need to be turned off. 

The Device Details panel displays the following information about the shuttle: 

• Device Type. The shuttle model and description. 

• Serial Number. Serial number of the shuttle. 

• Firmware Version. Version number of the shuttle's firmware. 

• Main Batt Level (AA) (U-Shuttle only). The condition of the shuttle's main batteries. Consult the 
U-Shuttle manual for specifics on battery capacity. 
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• Clock Batt Level (CR1225) (U-Shuttle only). The condition of the battery that provides backup 
power to the shuttle's clock. Consult the U-Shuttle manual for details. 

• Battery Level (Waterproof Shuttle only). Condition of the shuttle's batteries when you opened 
the Waterproof Shuttle Management window. If the batteries are low, remember to change them 
before going into the field. Consult the Waterproof Shuttle manual for specifics on battery capacity. 

• Last Launched. Date, time, and offset to Greenwich Mean Time (GMT, also known as UTC) when the 
shuttle was last launched. 

• Computer clock. Time reported by the computer's clock. 

• Shuttle clock. Status of the shuttle's clock in relation to the computer's clock. If the difference is 
more than five seconds, the shuttle clock label and icon will flash red. The shuttle's clock is 
synchronized to the computer when you launch the shuttle. Click the Sync Shuttle Clock button to 
synchronize the shuttle's clock to the computer clock without launching the shuttle. (Exit HOBOware 
Pro if you need to update the computer's clock first. Important: If the difference between the 
shuttle's clock and the computer's clock is more than 59 minutes, the Sync Shuttle Clock button is not 
available. You must launch the shuttle to correct the time difference 

The Files on Shuttle panel lists the logger datafiles that are available to be offloaded from the shuttle. If the shuttle 
is empty, this panel displays "No Files Available on Shuttle." Use the Check All/Uncheck All buttons to select or 
deselect all files. The details for each file are: 

• Status. The message that describes the state of the datafile on the shuttle. The status message is 
replaced by a progress bar while the file is actively being offloaded. For the U-Shuttle, the status 
message "Awaiting Offload" appears when HOBOware Pro is offloading files from the shuttle and 
"Finished" after each file is offloaded. For the Waterproof Shuttle, files have the status message 
"Offloaded" only if the file has been offloaded from the shuttle and saved as a datafile. If the files has 
not been offloaded, or it has been offloaded but not saved, its status is listed as "Not Offloaded." 

• Logger Type. Model and description of the logger where the datafile originated. 

• Serial No. Serial number of the logger where the datafile originated. 

• Launch Desc. Description in place when the logger was launched. This description will be the default 
datafile name. 

• Launch Time. Date, time, and offset to Greenwich Mean Time (GMT, also known as UTC) when the 
shuttle was last launched. 

• File Size. Actual size of the datafile. 

After clicking the Offload Checked button, the Files on Shuttle panel will change to a Files Offloaded from Shuttle 
panel. This panel lists the folder where the files will be saved (or click Choose to select a different directory). You 
can also select to a checkbox to automatically open the folder in Windows Explorer or Finder (Macintosh) after the 
files are saved. The serial number, Launch Description, and default file name is listed for each datafile. Click the 
Save Checked button to save all the selected files. 

Use the Launch Shuttle button to delete all files (whether saved or not) from the shuttle and to reset the clock. 
Launching the shuttle also repairs a corrupted header. 

Deleting Files from a Shuttle 
You can delete files from a shuttle after they have been offloaded and saved. Note: HOBO Shuttles require 
HOBOware Pro. 

To delete files from a shuttle: 

1. From the Device menu, select Manage Shuttle.  
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2. Offload and save any files if necessary. You must at least offload all files before deleting (click Cancel 
Save if you do not want to save the files). If you are offloading a Waterproof Shuttle, select the Delete 
Contents Upon Offload checkbox to automatically delete all files after you offload and save them.  

3. To delete ALL files regardless of whether they have been offloaded and saved, click the Launch Shuttle 
button. This will reset the shuttle's clock and its Last Launched time. 

To delete individual files from a Waterproof shuttle (you cannot delete individual files from a U-
Shuttle), click the checkbox for each unwanted file. To select all files that have already been offloaded, 
click the Check All button next to Previously Offloaded Files. Click Delete Checked after you have 
selected all the files you want to delete. 

Note: The maximum amount of free memory available on a U-Shuttle is 3.94 MB because the header information 
on a HOBO U-Shuttle occupies 64 KB. 

Configuring Loggers with the E50B2 Power & Energy Meter 
When the E50B2 Power & Energy Meter (T-VER-E50B2) is combined with a supported logger, there is a custom 
setting available to quickly configure the applicable channels or sensor types. To access this setting: 

1. Connect a logger to the computer that supports the meter, such as the HOBO 4-Channel Pulse Input 
Data Logger (UX120-017x), and select Launch from the Device menu. 

2. In the Launch Logger window, select "for E50B2 Power & Energy Meter" in the Configure Sensors 
drop-down list. The first three sensors, or data channels, listed will automatically be updated to 
display the appropriate settings for the E50B2 Power & Energy Meter as shown below. 

 
When these settings are selected, the logger will record the default values from the Onset Power Meter. 
This means that when you read out the logger, the first three data channels will record the following by 
default:  
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• Reactive energy, at a rate of 1 pulse equal to 1 VARh 

• Real energy, at a rate of 1 pulse equal to 1 Wh 

• Amp hours, at a rate of 1 pulse equal to 0.01 Ah 

You can change the scaling for these three channels. Click one of the channel or sensor buttons and select 
the measurement type, sensor name, and then scaling factor. The example below shows changing scaling 
on channel 2 after clicking the "T-VER-E50B2 Wh (1000 Wh per pulse)" button. Note: The scaling factor 
must be the same for VARh and Wh channels. WARNING: If you change the default scaling parameters, 
you must also change the settings on the Onset Power Meter. Similarly, if you change the scaling on the 
device itself, you must also change the scaling in the software to match. Refer to the Compact Power and 
Energy Meter (T-VER-E50B2) Full Install Guide for details on how to change the settings on the device. 

 

3. Select any other Launch settings as desired and then click Start to launch the logger with the Onset 
Power Meter settings (note that the Start button name changes depending on when you chose to 
begin logging). 

Additional Series for Plot Setup 
Datafiles from a logger with Onset Power Meter settings not only list logged sensor data, but they also contain 
additional derived series automatically calculated in relevant units. HOBOware uses the logged data from each of 
the three enabled sensors (reactive energy, real energy, and amp hours) to derive, or calculate, up to six additional 
data series that you can plot. These derived series are numbers 9 through 14 in the Plot Setup dialog box example 
below. Select the series you wish to view and then click Plot. These series are always available for plotting any time 
you open the datafile. 
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The following table lists the calculations for all derived series. It also specifies which of the three Onset Power 
Meter sensors/channels must be enabled at launch time for these series to be available upon readout. 

Derived Series 
Name 

Calculated By Requires these Channel(s) 
to be Enabled at Launch 

VAR VARh / (logging interval in seconds / 3600) Reactive Energy (VARh) 

VA VAh / (logging interval in seconds / 3600), where VAh 
= SQRT (Wh² + VARh²) 

Reactive Energy (VARh) and 
Real Energy (Wh) 

Volts (V) VAh / Ah, where VAh = SQRT (Wh² + VARh²) Reactive Energy (VARh) and 
Amp Hours (Ah) 

Power Factor (PF) Wh / VAh, where VAh = SQRT (Wh² + VARh²) Reactive Energy (VARh) and 
Real Energy (Wh) 

Power (W) Wh / (logging interval in seconds / 3600) Real Energy (Wh) 

Power (kW) Wh / (logging interval in seconds / 3600) / 1000 OR W 
/ 1000 

Real Energy (Wh) 

Amps (A) Ah / (logging interval in seconds / 3600) Amp Hours (Ah) 

Checking Dates for the HOBO U26 Dissolved Oxygen Logger Sensor 
Cap 
The HOBO U26 Dissolved Oxygen logger has a replaceable DO sensor cap intended for six months of use plus a 
one-month grace period. Once the cap is initialized, an internal clock within the logger will count down to the 
seven-month expiration date. 

A new sensor cap can be initialized several ways: 
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• When the logger is launched, it will automatically be initialized when logging begins.  

• You will be prompted to initialize it when checking the Status. 

• You will be prompted to initialize it when using the Lab Calibration tool. 

• If you replace an existing sensor cap while the logger is logging, it will automatically be initialized. 

Once the 7-month countdown begins, you can see information about the sensor cap in the Status window as 
shown below. 

 
In the Device Details pane, three key DO sensor cap dates are displayed: 

• Expiration date, at which time you'll need to replace it with a new cap. Important: The logger will not 
collect any data after the cap has expired. 

• Initialization date, which is the date the cap was initialized and the date the 7-month countdown 
began. 

• Manufactured date; the cap has a shelf life and must be used within two years of this date.  

For details on installing or replacing the DO sensor cap, see the logger manual.  

Using the Lab Calibration Tool with the HOBO U26 Dissolved Oxygen 
Logger 
Lab calibration is available for HOBO Dissolved Oxygen (U26-001) loggers. Use this tool when you need to calibrate 
the logger before deploying it or after replacing an expired sensor cap. The tool sets the gain and offset adjustment 
values for the logger by: 

• Restoring logger calibration values to the factory defaults, 

• Using your own gain and offset adjustment values, or 

• Calculating the values with a three-step calibration procedure. 

In the three-step procedure, the logger is first calibrated to 100% saturation by placing it in water-saturated air. 
Then, you can calibrate the logger to 0% saturation by placing it in sodium sulfite or another 0% oxygen 
environment (recommended if the logger will be deployed in water with DO levels of 4 mg/L or less). 

Important: Lab calibration only affects future launches; any data saved in the logger will be based on the previous 
calibration values. 
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To complete these steps, you will need fresh water, the calibration boot and sponge supplied with the logger, and 
a source for current barometric pressure at your current location. You will also need sodium sulfite solution and a 
3 inch beaker if you will be calibrating to 0% saturation. 

The fresh water, logger, and sodium sulfite (if applicable) should be left out in the lab where the calibration is 
being done long enough so that they are at room temperature. If the logger had been deployed previously, make 
sure the sensor is clean and dry (see the logger manual for more details). 

To use the Lab Calibration tool: 

1. Connect a HOBO Dissolved Oxygen logger to the computer. Stop the logger if it is currently logging or 
awaiting a coupler or delayed start. 

2. From the Device menu, click Lab Calibration. Note: If the sensor cap is installed and it has not yet 
been initialized, you will be prompted to do so. Follow the instructions on the screen. The sensor cap 
will expire in seven months once initialized. 

3. The current gain and offset adjustments are displayed in the top pane of the window, along with the 
date and time the last lab calibration was completed (if applicable). Completing Steps 1 through 3 in 
this window will result in new gain and offset adjustment values based on the current logger 
conditions. Continue to the next section for details on how to complete these steps.  

If you already know what the gain and offset values should be (for example, the values from a previous 
calibration that you want to use again) or want to return to the default factory values, click the “I know 
my values, skip to Finish” button. This will automatically move you to “Step 3: Finish.” Either click the 
“Reset to Factory Defaults” button or type in new gain adjustment and new offset adjustment values and 
click the “Send Calibration to the Logger” button. Note: If you decide you do not need to change the 
calibration, click Close to cancel the calibration and revert back to the last saved logger values. 

Step 1: 100% Saturation 

1. Enter the barometric pressure for your current location in one of five available units. If the barometric 
pressure reading has been adjusted for sea level (such as a reading taken from the National Weather 
Service weather station), select the "If using sea level barometric pressure, enter elevation" checkbox 
and enter your elevation in either meters or feet. 

2. Make sure the logger either has the protective guard or the anti-fouling guard installed (whichever 
guard you plan to use in the deployment) so that the sensor is covered. 

3. Wet the small sponge that shipped with the logger with fresh water. Squeeze out any excess water. 

4. Place the sponge in the end of the calibration boot. 

5. Insert the logger in the calibration boot so that there is approximately a 1 cm (0.5 inch) overlap 
between the end of the boot and the body of the logger. This will ensure there is enough space 
between the end of the logger and the sponge (the logger should not be pressed up tightly against the 
sponge). 

6. Wait for approximately 15 minutes until the logger reaches temperature equilibrium. Important: The 
logger will "go to sleep" if there is no activity for 30 minutes. To avoid this, click the "Get DO value 
from the logger" button as described next in step 7 well before 30 minutes have passed. If the logger 
does go to sleep, a message will appear indicating that there was a communication failure. You may 
need to close and reopen the Lab Calibration window to reactivate the logger. Follow the instructions 
on your screen. 

7. Click the "Get DO value from the logger" button to display the 100% saturation results. You can click 
this button as often as needed. The results are updated each time you click the button. To check for 
equilibrium, click the “Get DO value from the logger” button several times in a row to check the 
current “DO Conc from logger at 100% Saturation” value. If the value remains the same or varies very 
little with each button click, then temperature equilibrium has likely been reached. 
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8. When you are satisfied with the results displaying, click the Next button to proceed to "Step 2: 0% 
Saturation." 

 
Step 2: 0% Saturation (optional) 

If the logger will be deployed in water with DO levels greater than 4 mg/L, click the “Skip this Step” button. 
Otherwise, continue with the following procedure. 

1. Make sure the logger either has the protective guard or the anti-fouling guard installed (whichever 
guard you plan to use in the deployment) so that the sensor is covered. 

2. Pour the sodium sulfite into the beaker so that it is about two-thirds full. 

3. Place the sensor end of the logger into the solution so that the entire protective cap or anti-fouling 
guard and at least 2.5 cm (1 inch) of the logger body are submerged in the beaker. Allow it to rest on 
the bottom of the beaker. 

4. Wait a few minutes until the logger reaches temperature equilibrium. Important: The logger will "go 
to sleep" if there is no activity for 30 minutes. If this happens, you will need to close and reopen the 
Lab Calibration window to reactivate the logger and, as a result, repeat the calibration for 100% 
saturation. To avoid this, click the "Get DO value from the logger" button as described next in step 5 
well before 30 minutes have passed. 

5. Click the “Get DO value from the logger” button to display the 0% saturation results. As with the 100% 
calibration, you can click this button as often as needed. The results are automatically updated each 
time you click the button. If the value remains the same or varies very little with each button click, 
then temperature equilibrium has likely been reached. 

6. When you are satisfied with the results displaying in the Step 2: 0% Saturation tab, click the Next 
button to proceed to "Step 3: Finish."  
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Step 3: Finish 

The results from the first two steps are displayed as well as the overall calibration results and the new gain and 
offset adjustment values. If you are satisfied with the results, click the "Send Calibration to Logger" button. The 
logger will then be calibrated based on the new values. Click the Back button to return to a previous step if you 
wish to repeat Step 1 or Step 2. These values will not take effect until the logger is launched. If you do not want to 
save these values, click Close to cancel the calibration and revert back to the last saved logger values. Or, click 
"Reset to Factory Defaults” to return to the original values. If you performed Step 2, then remove the logger from 
the solution and thoroughly rinse it with fresh water to remove any excess sodium sulfite. See the logger manual 
for additional details on cleaning the logger. 
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Updating UX Series Logger Firmware  
You can update the firmware in a UX series logger as needed with HOBOware. You may see that an update is 
available when opening the Launch Logger or Status window, or Onset Technical Support will notify you when this 
is necessary. 

To update UX series logger firmware: 

1. Connect a UX series logger to the computer. 

2. Important: Stop and read out the logger and save the file before updating the firmware. 
The update process will delete all existing data in the logger so be sure to stop and read out the logger 
before continuing with the next step. 

3. From the Help menu, select Update Logger Firmware and then select Update UX Series Logger 
Firmware. Note: This is not necessary if a message indicates that a firmware update is available after 
opening the Launch Logger or Status window. Continue with the next step instead. 

4. If there is a newer firmware version available than the version currently installed in the logger, a 
message appears indicating a firmware update is available. Click Yes to continue.   

If a newer firmware version is not detected, then a message appears indicating there are no updates 
available for this logger. There may be instances where you have downloaded a firmware .hex file 
from the Onset website and need to locate this file. If so, click Yes when this message appears to find 
the file. Otherwise, click No to close the message and exit the update process. 

5. In the Update UX Series Logger Firmware window, the suggested firmware file for use with the current 
logger is displayed. The logger model number will be listed within the file name for you to double-
check that it is the correct version for the logger you are updating. If the file listed is the one you wish 
to use, then click Continue. If it is not the correct file or you wish to locate a different file based on 
instructions from Onset Technical Support, click Select Firmware and locate the appropriate file. 
Note: If you click Cancel, you may still be prompted for an additional firmware update in some 
instances. Click Cancel again to completely exit the procedure. 

6. A message appears warning you not to disconnect the logger until the update process is complete. 
The update process should take a couple of minutes. If you have not already read out the logger and 
saved the data, then click No to cancel the update and return to step 2. Otherwise, if you are ready to 
update the firmware in the logger, click Yes to continue. 

7. As the firmware update process takes place, "Boot" will display on the logger LCD screen. Do not 
disconnect the logger during this process. Once the update is complete, a message will appear 
indicating the update was successful. UX100 series loggers require an additional firmware update. A 
message will appear automatically if a second update is necessary. Repeat steps 4–7 if another 
firmware update is available. Note: If "Boot" remains on the logger LCD screen after this is complete, 
the device may need to be reset. From the Device menu, select Utilities, and then select Reset 
UX Logger. If "Boot" still remains on the LCD screen, contact Onset Technical Support. 

8. After the firmware update process is complete, you will need to launch the logger before you can use 
it again. If you'd like to launch the logger immediately, click Yes. Otherwise click No to close the 
message and click Launch from the Device menu to launch the logger at a later time. 

Note: Selecting the preference "Only show Select Device window if a device has not been selected" (available 
within Preferences > General > Selecting Devices) can prevent auto-update notifications. If this occurs, access the 
firmware update from the Help menu as described in step 3. 
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Fixing "Read Header Failed" Error 
Occasionally, when trying to launch, check status, or read out a U-Series logger (other than a HOBO U30 Station), 
HOBO Waterproof Shuttle, or HOBO U Shuttle, you may receive the following error: "Read Header Failed." These 
messages occur when a device's header cannot be read, usually because of a communication error or corrupted 
header. Disconnect the device from the computer, then reconnect it and try to launch, check status, or read out 
again.  

If you receive the message again, the header has probably become corrupted. The most common cause of header 
corruption is a communication problem during launch, such as the USB cable coming loose or an optical logger 
slipping out of its base station/coupler while the Launching Logger progress bar is displayed. In that case, there is a 
possibility that valid data has been logged, but cannot be read out. 

You can restore the header by launching the logger or shuttle. This will reset the device's launch options to factory 
defaults. However, it will also cause any logged data or offloaded data from a shuttle to be lost. If you receive a 
"Read Header Failed" message and are unable to read out the logger or offload a shuttle, please contact the 
vendor that sold you the device. It may be possible to retrieve the logged data. 
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Chapter 6 
HOBOnode Manager 
HOBOnode Manager is the software tool within HOBOware Pro for setting up and managing a ZW wireless data 
network, which consists of a receiver, data nodes, and router nodes. 

For information about setting up a network, refer to the ZW Series Wireless Network Quick Start Guide available 
on www.onsetcomp.com. 

For help with deploying a network in your facility, refer to the HOBO Data Node Deployment Guide also available 
at www.onsetcomp.com. 

To open HOBOnode Manager for the first time, select the Device menu and choose Manage HOBO Data Node 
Network. 

Notes about operating HOBOnode Manager: 

• When HOBOnode Manager is open, two HOBOware icons appear in the Windows taskbar. 

• You cannot access HOBOnode Manager if a HOBOware window, such as Logger Launch or Status, is 
open. 

• You can close HOBOnode Manager and leave HOBOware running, but you cannot close HOBOware 
and leave HOBOnode Manager running. If you close both HOBOnode Manager and HOBOware, device 
communication can continue to run, which allows incoming data from the network to be uploaded to 
the computer. A HOBOware icon appears in your system tray when device communication is running. 
Note that the next time you open HOBOnode Manager, it could take several minutes for the real-time 
plots to reflect all the stored data. 

To stop device communication, right-click (or left-click on a Mac) the system tray HOBOware icon to 
access the Device Communication menu, which shows the receiver status and has options for 
stopping device communication and starting HOBOnode Manager. Device communication must be 
stopped when updating HOBOware software. 

 

• An icon appears in the status bar at the bottom of the main HOBOware window to show whether the 

receiver is currently connected. If the receiver is connected, you'll see this  
in the bottom right corner of the HOBOware window. If the receiver is disconnected, you'll see this 

 instead. The "No devices connected" message next to the receiver icon 
does not refer to devices within your data node network; it indicates that other devices, such as 
loggers and shuttles, are not currently connected. If you were to connect a logger or a shuttle, that 
message is updated independently of the receiver icon. 
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A Tour of HOBOnode Manager 
This topic provides a description of the elements in HOBOnode Manager. 

 

1. Tabs. Click the tabs to toggle between the Plots, Map, and Alarms pages. 

2. Device Table. The Device Table displays information about the receiver and each node and configured 
sensor in your network. Use the Device Table to: 

• Select a device by checking the appropriate box in the Select column. 

• Double-click the <Enter label here> field to assign a name, or label, to the node or sensor. Type 
in the name and press Enter. 

• See a list of all network devices in the Type column, which lists the device by part number, 
followed by sensor part number as applicable. 

• View the serial number for the device in the S/N column. 

• Check the current status of the device, listed in the Status column. Data nodes and router 
nodes are listed as either Active (communicating with the receiver) or Missing (not 
communicating with the receiver). As with data notes and router nodes, sensor status can be 
Active or Missing, but it also be listed as Off if it is an external sensor that has not been 
configured. Receiver status is either listed as Connected or Not Connected. 

• See what the sensor is configured to measure in the Meas. type column. The measurement 
type is automatically filled in for internal sensors. The measurement type listed for external 
sensors is determined by the selections in the Configure Sensor dialog. 

• Check the latest reading for each sensor in the Reading column, and the time that reading was 
taken in the Time column. 

• View device readings in a real-time plot. Check the box in the Plot column to generate a real-
time plot for that device. 

• See what group(s) the sensor has been assigned to in the Group column. 
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• Add the device to a map. Check the box in the Map column to add that device to the map. 
Drag the icon to the desired location on the map click the mouse button. 

• Check whether an alarm has tripped for a specific device in Alarm column. A grey alarm icon 
means an alarm has not been set up for the device. A green alarm icon means an alarm has 
been set up, but has not tripped as of the latest reading. A red alarm indicates the alarm for 
that sensor has tripped. 

• Check the signal strength between the device and receiver or the device and the nearest 
router in the Signal column. If the signal is low, there may be obstructions or other 
interference preventing the device from communicating to the receiver or router. 

• Check the battery level for a specific device in the Battery column. 

You can change the sort order in a column by clicking the column header. Right-click anywhere in the 
Device Table to restore the sort order. You can also show or hide individual columns by clicking the 
icon above the vertical scroll bar in the Device Table. 

3. Configuration Bar. Use the Configuration Bar to select all or none of the devices, to quickly change the 
sensor type for external sensors, to assign sensors to groups, or to open the Configure window for 
additional sensor settings. 

4. Help button. Click this button to access HOBOnode Manager help. Click the Open topic with 
navigation link to open the full Help table of contents. 

5. Actions button. From the Actions button, you can print a copy of the device table, edit preferences, or 
create a new deployment. 

6. Plot/Export Data button. Click this button to open the Plot/Export Wireless Data window, from which 
you can select sensor data to plot in HOBOware or export to a .csv or .txt file for use in another 
program. 

7. Form Network button. Click this button to create a network and add data nodes and router nodes to 
it. 

Viewing Real-Time Plots 
In the plots window, you can view sensor data in real-time plots. You can plot a maximum of 20 sensors at once. 

To view the real-time plot for sensors:   

1. Select the Plot box in the Device Table for each sensor you want to view.  

2. Select Sensor or Measurement view tab. 

In Sensor View, there is a separate plot for each sensor. 

In Measurement View, there is one plot for each Measurement Type (such as temperature), which 
may contain separate entries for multiple sensors. 

3. Change the time frame of the plot using the Time Frame tabs. 
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• Use the Sort Plots By drop-down list to change the order of the plots. 

• Use the Reorder Plots arrow to reverse the order of plots. 

• Use the Plot Toolbar to zoom in or out, pause the plot, or print the plot. 

Plotting Preferences 
To change preferences that apply to real-time plots only, see Setting HOBOnode Manager Preferences. 

Use the general HOBOware Plotting Preferences to change the appearance of plots. To apply changes to real-time 
plots, re-start HOBOnode Manager or uncheck the sensor Plot box and then re-check. To open the Plotting 
Preferences, from the main HOBOware menu select File > Preferences and then click the Plotting tab. 

Determining Data Node Type 
There are three types of devices displayed within HOBOnode Manager: the data receiver (ZW-RCVR), end-point 
data nodes (ZW-0xx), and node/routers. A node/router can be either a data node (ZW-0xx) that was initially 
powered by an AC adapter instead of batteries or a router node (ZW-ROUTER) that routes data only and does not 
have recording capability. Use the icons in the device table to identify data node types. This is particularly helpful if 
you need to verify whether a data node (ZW-0xx) is acting as a data node only or if it also has routing abilities. 
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For another way to see whether the device is a data node only or a data node/router, double-click the device to 
open the Configure Node dialog. Check the Device Type for the device part number and description. In the 
example below, the device is operating as a both a data node and a router so the Device Type is listed as "ZW-006 
(Node/Router)." If this device was powered by batteries only, then it would be operating as a data node and not a 
router, and listed as "ZW-006 (Node)." 

 

Changing Logging and Connection Intervals 
There are two types of intervals associated with data nodes: 

• the logging interval, which is how often the node records data and 

• the connection interval, which is how often the node transmits data to the receiver. 

When a data node joins a network, it uses the default logging and connection intervals that are set within the 
general preferences (upon installation of the software, the default logging interval is 1 minute and the default 
connection interval is 10 minutes). However, you can also define logging and connection intervals on a per-node 
basis, which gives you the flexibility of having data nodes logging and transmitting data at different rates. 

Changing Default Values in Preferences 
To change the default logging and connection intervals, click the Actions button in HOBOnode Manager and select 
Edit HOBO Data Node Preferences. Or, within HOBOware, select File > Preferences on Windows or HOBOware > 
Preferences on Macintosh and click Data Nodes. The default logging and connection intervals are under the 
General category of the data node preferences. 

Select a preset value or set a custom interval. The minimum logging interval is 1 minute, and the minimum 
connection interval is 2 minutes. 

 
These default values will only be used for new data nodes that join the network. Changes to these default intervals 
will not affect data nodes that are already logging or that have been previously configured with their own 
individual logging or connection interval. 

Changing Intervals for Individual Data Nodes 
To change the logging and connection intervals on an individual data node: 

1. Double-click the data node entry in the Device Table to open the Configure Device window.  
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2. Change the logging interval and connection interval as required. 

3. Click OK. 

The changes will take effect the next time the data node connects to the receiver; they will only apply to that 
particular data node and its sensors. All other data nodes in the network will continue logging and connecting at 
their current intervals. 

Setting up External Sensors 
Important: Refer to the documentation that came with your sensor for specific connection and wiring information. 

Data nodes support various external sensors that plug into one of two kinds of ports: 

 
Most external sensors are not automatically configured. You must assign a sensor type for any external sensors 
connected to the data node (except for the External Temp/RH sensor). If you do not assign a sensor type, the 
device will not record any data for that sensor. 

The ZW-005 and the ZW-007 support the External Temp/RH sensor (Part # CABLE-TEMP/RH), which plugs into the 
External Temp/RH Sensor Port (#1 in the photo above). This sensor is preconfigured and you do not have to select 
a sensor type. Separate rows appear under the node for the Temperature and RH channels with corresponding 
entries in the Type column. 

 
Some data nodes support up to four configurable external sensors, which plug into one of the 2.5mm Stereo Ports 
shown (#2 in the photo above).  

You must select a Sensor Type in HOBOnode Manager for these sensors. When the data node appears in the 
Device Table, configurable external sensors will not have an entry in the Type column. 
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To select a Sensor Type for an external sensor: 

1. Double-click the row for the sensor in the Device Table. 

2. Select the Sensor Type from the drop-down list. 

3. Add a label for the sensor (optional). 

4. Click OK. 

Once you select a sensor type, the Status will change to ACTIVE and the appropriate measurement type will appear 
in the Measurement Type column. 

Some sensors must be scaling to give you meaningful data. Refer to Configuring Scaling on a Sensor for more 
details. 

Configuring Scaling on a Sensor 
Some sensors need to be scaled to provide meaningful data. Scaling is set through the Configure Scaling window. 
To open this window: 

1. Double-click the sensor in the Device Table to open the Configure Sensor window. 

2. Select the Sensor Type if not already selected.  

3. Click the Configure button. 

To set scaling for the sensor: 

 

1. Check the scaling type is correct. The scaling type is automatically selected based on the type of 
sensor selected. Linear scaling is enabled for analog sensors; pulse scaling is enabled for pulse sensors. 
Note: Click the View Scaling Factors button to see scaling factors by sensor. 

2. Enter the scaled measurement type. The Raw Measurement is the source measurement type, such as 
Current, Voltage, or Counts. 
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3. Enter the scaled units. The Raw Units is the type of output the sensor uses, either V or mA, 
corresponding to the type of sensor selected. Raw Value 1 and Raw Value 2 should be entered using 
these units. 

4. Type in the Raw and Scaled numbers for Value 1. For Raw Value 1, enter the low raw value given by 
the external sensor. For Scaled Value 1, enter the value in the same units that were specified in the 
Scaled Units box. The Scaled Value 1 is the value that will appear on the plot when the sensor reports 
a raw value equal to Raw Value 1. 

5. Type in the Raw and Scaled numbers for Value 2. For Raw Value 2, enter the high raw value given by 
the external sensor. For Scaled Value 2, enter the value in the same units that were specified in 
the Scaled Units box. The Scaled Value 2 is the value that will appear on the plot when the sensor 
repors a raw value equal to Raw Value 2. 

6. Click OK when done. 

Once scaling is configured on a sensor, the scaled icon will appear in the Meas. Type column in the Device Table. 

Scaling Factors 
Click the link below to see the scaling factors for your sensor model. 

• Wattnode: T-WNB-3Y-208/ T-WNB-3D-240 / T-WNB-3D-480 

• Veris: T-VER-8051-300/ T-VER-8053-800 

• Veris: T-VER-H970-200 

• Veris: T-VER-971BP-200 

• Veris: T-VER-PXU-L/ T-VER-PXU-X 

• Ion: T-ION-TVOC 

Wattnode Scaling Factors: T-WNB-3Y-208/T-WNB-3D-240/ 
T-WNB-3D-480 
Use the table below to find the Kilowatt-hours per pulse for your CT Size and WattNode model and enter it in the 
Scaled Value 1 box. 

Cable Required/Sensor Type: CABLE-2.5-STEREO 

Example 
This example shows the values you would enter in the Configure Scaling window for a Wattnode 3Y-208 with a 5 
amp CT. Pulse should be selected automatically. In the Scaled column, type "Energy" for Measurement and "kWh" 
for Units. For this example, the Raw Value 1 is "1" and the Scaled Value 1 is "0.000125."  
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Kilowatt-hours per pulse 
 Kilowatt-hours per pulse 

CT Size (amps) Model #: 3Y-208/3D-240 Model #: 3D-480 

5 0.000125 0.0002885 

15 0.000375 0.0008656 

20 0.0005 0.0011541 

30 0.00075 0.0017313 

50 0.00125 0.0028854 

60 0.0015 0.0034625 

70 0.00175 0.0040396 

100 0.0025 0.0057708 

150 0.00375 0.0086563 

200 0.005 0.011542 

250 0.00625 0.014427 

300 0.0075 0.017313 

400 0.01 0.023083 

600 0.015 0.034625 

800 0.02 0.046167 

1000 0.025 0.057708 

1200 0.03 0.06925 

1500 0.0375 0.086563 

2000 0.05 0.11542 

3000 0.075 0.17313 
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Veris Scaling Factors: T-VER-8051-300/T-VER-8053-800 
The consumed energy in kilowatt-hours (kWh) per pulse for these sensors is determined by the DIP switch setting 
on the transducer. The default is “1.00” kWh / pulse, at which the scaling factor is 1 = 1. If you change the default 
DIP switch settings, adjust your scaling factors accordingly, as shown below. 

The data recorded by the data node will be the number of counts (pulses) per sampling interval. 

Cable Required/Sensor Type: CABLE-2.5-STEREO 

1.0 kWh Per Pulse (Default) 

 

0.5 kWh Per Pulse 
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0.25 kWh Per Pulse 

 

0.10 kWh per Pulse 

 

Veris Scaling Factors: T-VER-H970-200 
The T-VER-H970-200 has a selectable range for Linear Scaling: mA or Volts -> Amps. An AC-DC power adapter with 
a minimum of 6W @ 35mA is required for excitation power. 

Cable Required/Sensor Type 

Use the appropriate cable to connect the sensor to the data node and select the corresponding cable in the Sensor 
Type drop-down when configuring the External Sensor in HOBOnode Manager. 

• For 4-20mA output, use CABLE-4-20mA.  
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• For 0-5vdc output, use CABLE-ADAP5. 

0-50 Amps 

 

0-100 Amps 

 

0-200 Amps 

 

Veris Scaling Factors: T-VER-971BP-200 
The T-VER-971BP-200 has a selectable range for Linear Scaling of mA to Amps for current flow in both directions. 

Cable Type/Sensor Type 

Use a CABLE-4-20mA to connect the sensor to the data node and select CABLE-4-20mA in the Sensor Type drop-
down when configuring the External Sensor in HOBOnode Manager. 

Notes: 
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• Requires 12-24VDC @ 35 to 110 mA excitation power depending on DC current load.  

• An AC-DC power adapter with a minimum of 6W @ 65mA is required. 

• For currents over 120 Amps, supply voltage to CT must be at least 15V to maintain accuracy. 

• Minimum Warm-up Time is 8-10 seconds. 

Span Setting 
The H971 comes preset at the maximum (0-200A) span. To adjust the H971 to a different span, locate the 
potentiometer on the top of the device. This potentiometer is a multi-turn device, taking about 23 turns to adjust 
the span from ±20A to ±200A. Use the potentiometer to adjust the maximum amperage range used by the sensor. 

The smallest amperage range (0 to ±20 A) is set by turning the potentiometer fully counterclockwise; the greatest 
amperage range (0 to ±200 A) is set by turning the potentiometer fully clockwise. 

To determine the best amperage range for an application, first set the load to the maximum amperage that will be 
used. Use the LED as a guide to adjust the potentiometer to its optimum setting. Verify the measured output 
current matches the load current using a current clamp meter. 

LED Activity Potentiometer Adjustment 

Steady green blink Turn CCW until LED blinks rapidly, then slowly turn CW just until blink returns to 
steady rate. 

Rapid green blink Turn CW until LED blinks at a steady rate. 
 

For an alternate method, see the Veris Installation Manual:  

http://www.veris.com/docs/Installs/h971_971SP_i0d2.pdf 

Scaling Graph 
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0-20mA 

 

0-100mA 
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0-200mA 

 

Veris Scaling Factors: T-VER-PXU-L/T-VER-PXU-X 
These Veris differential pressure transducers use Linear Scaling, mA or Volts -> "WC". 

 The analog output for these Veris sensors is determined by which screw terminals are connected either to a 
CABLE-4-20mA or to CABLE-ADAP5 or to CABLE-ADAP10. See the documentation that came with the hardware for 
details. 

Both models have switch-selectable ranges and scales. The examples below show the scaling parameters you enter 
in the Configure Scaling window for the supported output ranges and raw values. 
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0 - 0.1 in. W.C. 

 

0 - 0.25 in. WC 
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0 - 0.5 in. WC 

 

0 - 1.0 in. WC 

 



HOBOware User’s Guide 

1-800-LOGGERS 148 www.onsetcomp.com 

0 - 2.5 in. WC 

 

0 - 5.0 in. WC 
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0 - 10.0 in. WC 

 

Ion Scaling Factors: ION-TVOC 
The ION-TVOC uses Linear Scaling, mA -> ppm. 

Cable Required/Sensor Type: CABLE-4-20mA 

NOTES 

• Requires Loop power of 22 mA. Lamp and electronics require 65 mA.  

• An AC-DC power adapter with a minimum of 6W @ 35mA is required for excitation power. 

0-10 ppm 
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0-100 ppm 

 
0-1000 ppm 

 

Setting HOBOnode Manager Preferences 
You can change preferences for several features within HOBOnode Manager. You can access HOBOnode Manager 
preferences one of two ways: 

• In HOBOware, select File > Preferences on Windows or HOBOware > Preferences on Macintosh and 
click Data Nodes. 

• At the bottom of the HOBOnode Manager window, click the Actions button and select Edit HOBO Data 
Node Preferences. 

General Preferences 
The following general preferences are available: 

 

• Default Logging Interval. This is how often data nodes will log data. The default is 1 minute. 
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• Default Connection Interval. This is how often data nodes will send data to the receiver. The 
default is 10 minutes. 

• Timeout when forming network. This is the amount of time that you can add a data node to the 
network after you click the Form Network button. By default, Form Network mode will remain active 
until you click the X on the Form Network progress indicator. 

• A node is MISSING when it is late by. This is how long a node must go without sending data to 
HOBOnode Manager for it to be marked as missing. When a data node is missing, its status in the 
Device Table will be MISSING, and a MISSING NODE alarm will be tripped (if configured). The default is 
10 minutes. 

• When the HOBOnode Manager is closed, keep device communication running. This controls 
whether device communication automatically remains running when you exit HOBOnode Manager. 
The default is to keep it running. 

• Start the HOBOnode Manager and device communication automatically when HOBOware 
starts. This controls whether HOBOnode Manager and the device communication automatically starts 
immediately upon opening HOBOware. The default is to not automatically open HOBOnode Manager 
and the device communication when HOBOware is opened. 

• Highlight row in table when clicking on a sensor or data node in the map. This controls 
whether the corresponding row in the device table is automatically highlighted when you select a 
device in the HOBOnode Manager map. This is enabled by default. 

• Show informational popups in the device table when new nodes are added. This controls 
whether a message is displayed every time a new device is added to the device table. This is enabled 
by default. 

Alarms Preferences 
See Setting Alarms Preferences. 

Real-Time Plots Preferences 
You can customize the plots that appear in HOBOnode Manager by increasing the number of sensors you can plot 
at one time, adding the ability to view monthly data, displaying alarm thresholds, and more. These preferences are 
specific to real-time plots only. See Plotting Preferences for details on how to change general plot appearance, 
such as changing font type and size, adding gridlines, or modifying axis details. 

 

• Maximum number of sensors to plot. Select how many data node sensors you want to be able to plot 
at one time within HOBOnode Manager. You can select from 1 sensor to 100, with a default of 20. 

• Enable MONTH view in real-time plots. Select this checkbox to add a Month button to the Plots tab in 
HOBOnode Manager. You can then plot data by hour (4 hours), day, week, or month. The Month view 
is disabled by default. 



HOBOware User’s Guide 

1-800-LOGGERS 152 www.onsetcomp.com 

 

• Maximum number of days of observations to plot. Select how many days worth of data you want to 
view in the plot, up to 31. The default is 7 days. 

• Show alarm thresholds on real-time sensor plots. Select this checkbox to add a visual indicator, or 
reference point, when a sensor alarm has tripped. 

 Select Show alarm threshold as line to display the alarm threshold on the real time plots 
as a horizontal line. An example of this type of reference point is the red line in the 
following plot where an alarm was configured to trip at above 95 degrees Fahrenheit. 

 
 Select Show alarm threshold as interval to display the alarm threshold as a shaded 

area: red when the alarm is above the specified threshold and blue when it is below. 
Using the same example, there is a red shaded area from above 95 degrees on the 
following plot instead of a single red line. 

 

Data Storage 
This lists the current location of the HOBOnode Manager database. For more information, see Data Storage 
Location. 

Sharing 
This provides options for sharing HOBOnode Manager data via HOBOnode Viewer or automatic data delivery. See 
Enabling HOBOnode Viewer and Setting up Data Delivery. 
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Working with HOBOnode Manager Data 
There are several ways you can analyze data gathered in HOBOnode Manager. In addition to the viewing the real-
time plots and information in the Device Table, you can: 

• Plot or export data for use in HOBOware or external programs 

• Set up groups to organize data 

• Set up a HOBOnode Viewer web page for viewing on a local area network 

• Automatically send data to others via email or FTP, or save it to a computer on a local area network 

Plotting or Exporting Wireless Data 
With HOBOnode Manager, you can view data and plots from your HOBO data node wireless network in real time, 
but you also have the ability to plot or export previously logged data. Using the Plot/Export Wireless Data 
capability, you can plot data directly in HOBOware or you can export it to a text or .csv file to open in another 
program for further analysis. You can pinpoint the exact data you wish to plot or export, allowing you to view data 
from: 

• Current and/or previous network deployments, 

• Specific data nodes, 

• A subset of certain sensors from selected data nodes, 

• Groups of data nodes as configured in HOBOnode Manager, and  

• A specific date range or timeframe. 

In addition, you can save frequently used settings for quick plotting and exporting in the future and for use with 
data delivery, which allows you to share data automatically via email, FTP, or saved to a drive on a regular 
schedule. 

To open the Plot/Export Wireless Data tool, click the Plot/Export Data button in HOBOnode Manager (or from the 
File menu in HOBOware, select Plot/Export Wireless Data). 

 
To use the Plot/Export Wireless Data tool: 

1. Select the deployment that contains the data you wish to plot or export. 

 

2. Select the data nodes with the sensors whose data you wish to plot or export. 
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3. Each sensor for the data node that you selected in Step 2 will appear in a list as shown below. Click the 
down arrow icon for each sensor you wish to plot or export, or click the Include All Sensors button if 
you want to plot or export data from all sensors in the list. Note: If you have set up groups in 
HOBOnode Manager, you can also sort and select sensors within those groups. See Using Groups in 
the Plot/Export window. 

 
The sensors that you selected will move from the top half of the Step 3 pane to the bottom half as 
shown below. In this example, all sensors were included and are now shown in the "Sensors to 
plot/export" list. If you wish to make changes, you can either click the up arrow icon remove a specific 
sensor from the list, or click the Exclude all sensors button to move all the sensors back to the top 
(you'll then need to select the sensors you wish to plot or export again). 

 

4. Choose the time range for the data you wish to plot or export. Select Custom and specify your own 
start and end time, or select Preset and choose one of several pre-defined ranges from the drop-down 
list. 



HOBOware User’s Guide 

1-800-LOGGERS 155 www.onsetcomp.com 

 

5. Once you have all the settings selected, click the Export or Plot button. Clicking the Export button will 
open the Export window. Clicking the Plot button opens the Plot Setup window, where you can select 
the series that will appear in the graph in HOBOware. 

 
Notes: 

• If you want the current settings to always appear in the Plot/Export Wireless Data window, then select 
the "Use these settings as window default" checkbox. 

• You can save different combinations of settings to a configuration file in the Plot/Export Wireless Data 
window for future use, or for use by the data delivery feature. Click the Save Settings button, type a 
name, and press Enter. Then click the Load Settings button and choose the configuration file you wish 
to use for the current plot or export. 
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Using Groups to Sort Sensors 
You can assign sensors to groups in the Device Table and then use them to sort rows in the table, or to refine a list 
of sensors in the Plot/Export Wireless Data window. 

 

Creating Groups and Adding Sensors 

1. In the Device Table, select the sensor(s) you want to add to a group. 

2. Click Groups. 

3. In the <New Group> box, enter a name for the group and press Enter. 

 
The Group Name appears in the table for each sensor selected. 

Adding Sensors to a Group 

To add a sensor to an existing group: 

1. Select the sensor(s). 

2. Click Groups. 

3. Check desired groups(s). 

4. Click Apply Selected Groups. 
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See Using Groups in the Plot/Export Data Window. 

Sorting by Group 

Click the Group(s) column header to sort rows by groups. 

 

Deleting or Renaming a Group 

Select Manage Groups from the Groups drop-down.  
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The Manage Groups window appears. 

 

• To change the name of the group click the Edit icon and enter the new name. 

• To delete a group, click the X. 

Using Groups in the Plot/Export Wireless Data Window 
Once you have set up groups in the Device Table, you can use them to refine the list of available sensors in the 
Plot/Export Wireless Data window. 

To set up groups, see Using Groups to Sort Sensors. 

 

1. Check the "Use Groups to filter list" box. 

2. Click the Match any Group button. 

3. Select Groups. Select the groups you want to include in the list. 

4. Select the Match Criteria. Select "Match any selected Group" and any sensors that are a member of 
any of the groups selected will appear. Select "Match all selected Groups" and only sensors that are a 
member of all of the groups selected will appear. 

5. Select OK. 

Only the sensors that match the group criteria will appear in the Node Sensors list. 
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Viewing Current Sort Criteria 

 

Enabling HOBOnode Viewer 
You can view plots and data from your HOBO data node network on your local area network with HOBOnode 
Viewer. While HOBOnode Manager requires a direct connection on a dedicated PC to monitor your network, 
HOBOnode Viewer gives you the flexibility to see data node plots and network status anywhere. This allows you to: 

• Look at real-time data from your local area network with any browser 

• Check on the data node network remotely to make sure it is running properly and that no devices are 
missing or alarms have tripped 

• Share data with others by sending them a link to HOBOnode Viewer 

HOBOnode Viewer is a locally hosted website easily configured within HOBOware preferences. Once HOBOnode 
Viewer is enabled, HOBOware will create a link for your own web page that displays the real-time plots and data 
for your data node network. The HOBOnode Viewer web page will always be available as long as HOBOnode 
Manager remains open on the computer with your HOBOnode database. 

To access HOBOnode Viewer, you must first enable that feature within HOBOware preferences on the computer 
running a data node network. This will create a link to a HOBOnode Viewer web page that you can use and share 
with others. If you have not already set up a data node network using HOBOnode Manager, you must do that first 
and then you will be able to activate HOBOnode Viewer from the same computer. 

Windows note: If Windows Firewall is enabled on your computer, you may need to adjust the security settings to 
allow access to HOBOware before enabling HOBOnode Viewer. To check this, open Control Panel, go to Security, 
and select Allow a program through Windows Firewall (or click Windows Firewall and click the Exceptions tab on 
some versions of Windows). Make sure HOBOware is selected in the allowed access/exceptions list. Note that you 
must be administrator to make these changes.  

To enable HOBOnode Viewer: 

1. Open the preferences for data nodes. From HOBOnode Manager, click the Actions button and select 
Edit HOBO Data Node Preferences. Or, to access preferences within HOBOware, select File 
> Preferences on Windows or HOBOware > Preferences on Macintosh and click Data Nodes. 

2. Click Sharing within the Data Nodes preferences, and then click HOBOnode Viewer. 

3. Select the Enable HOBOnode Viewer checkbox. 
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4. By default, the port number assigned for HOBOnode Viewer is 8080. You may use this one or change it 
to any other available port. In most cases, the default 8080 port number will be available. However, if 
this number is already in use by another web service application on the same computer, then you can 
change it to any other available port. There are 0 to 65,535 ports. Port numbers 0 to 1023 are 
restricted ports reserved for use by system services, such as FTP, Telnet, and HTTP. You may use any 
other available port number from 1024 to 65,535 for HOBOnode Viewer. 

5. Click OK in preferences and then restart HOBOnode Manager (close HOBOnode Manager and then 
from the Device menu in HOBOware, select Manage HOBO Data Node Network to reopen it). 
HOBOnode Viewer will not be fully enabled until you restart HOBOnode Manager.  

6. After HOBOnode Manager has restarted, return to the HOBOnode Viewer preferences. Click the link, 
or URL, to go to your HOBOnode Viewer web page. 

The URL has the following structure: 

htttp://<IP address>:<port number>/HOBOnodeViewer 

where <IP address> is the IP address for the computer where your data node network is running and <port 
number> is the port assigned for the HOBOnode Viewer in preferences.  

To share the URL with others, click the link and then copy the URL from your browser and paste it an email 
message to send to others who would like to view your data node network. 

Note: HOBOnode Viewer is only available while HOBOnode Manager is running. If you close HOBOnode Manager 
and then attempt to access HOBOnode Viewer, the web page will not open. Also note that the HOBOnode Viewer 
will not be available outside your local area network unless you expose that computer outside of the network. 
Contact your IT department if you would like to expose the HOBOnode Viewer. 

To disable HOBOnode Viewer: 

1. Open the preferences for data nodes. From HOBOnode Manager, click the Actions button and select 
Edit HOBO Data Node Preferences. Or, to access preferences within HOBOware, select File 
> Preferences on Windows or HOBOware > Preferences on Macintosh and click Data Nodes. 

2. Click Sharing within the Data Nodes preferences, and then click HOBOnode Viewer. 

3. Deselect the Enable HOBOnode Viewer checkbox. 

4. Click OK in preferences and restart HOBOnode Manager. 

Using HOBOnode Viewer 
Many of the elements in HOBOnode Viewer are the same as HOBOnode Manager. Specifically, you can do the 
following with HOBOnode Viewer just as you would with HOBOnode Manager: 

• Organize plots by sensor or by measurement type 

• View plot data hourly, by day, by week, or by month (the month view must be enabled in the 
preferences for real-time plots) 

• Sort the plots several ways, including by serial number, current reading, and alarm state 
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• View a map of your network devices 

• Check the device table for details on each device in your network 

• Change the device table view by sorting the columns 

 
There are, however, some key differences between HOBOnode Manager and HOBOnode Viewer. 

• HOBOnode Viewer, as its name implies, is a viewer only. Any changes you wish to make to your 
network, including updates to alarms or modifications to the map, need to be done directly in 
HOBOnode Manager. 

• With HOBOnode Manager, you can see all available sensor channels on all devices, including those 
without a sensor type selected. HOBOnode Viewer displays enabled sensor channels only. If a device 
in HOBOnode Manager has a channel listed as “OFF,” then that channel will not appear in HOBOnode 
viewer. 

• There may be some minor differences in plot appearance if you are comparing the plots in HOBOnode 
Viewer to HOBOnode Manager. In general, plots are nearly identical, but there could be slight 
differences in scaling. 

• If you set up data delivery and chose to have files saved to your computer or a network drive, then a 
Data tab will be visible in HOBOnode Viewer with a list of all files delivered through that service as 
shown below. Click a file name to open or save the file. 
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Note: If you change the file directory location in the data delivery settings, then you must restart HOBOnode 
Manager before you can access the files from the Data tab in HOBOnode Viewer. 

Any changes you make to your network with HOBOnode Manager will be reflected in the HOBOnode Viewer upon 
the next refresh, or update. HOBOnode Viewer refreshes every 30 seconds. You can also use your browser’s 
refresh feature if you want to see a change immediately. 

Important: HOBOnode Viewer is only available while HOBOnode Manager is running. If you close HOBOnode 
Manager and then attempt to access HOBOnode Viewer, the web page will not open. Always keep HOBOnode 
Manager running to ensure anyone accessing HOBOnode Viewer can see the real-time plots and data. 

Setting up Data Delivery 
With data delivery, you can automatically save recorded sensor data from nodes in your network to a single .txt, 
.csv, or .xls file on a regular schedule. This allows you to: 

• Store data from your current data node network deployment for future reference and analysis, 

• Access data remotely when you are away from the network, and 

• Share data with others in a file that is distributed automatically via FTP or email, or saved to a 
computer or network drive. 

Before you can set up data delivery, you must first select which nodes and sensors you wish to include in the file by 
saving the configuration settings. To do this: 

1. From HOBOnode Manager, click the Plot/Export Data button. 

2. Select the deployment name from the list. 
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3. Select the individual nodes you would like to include in the file or click the All button to select all 
nodes. 

 

4. Select the sensors you would like to include in the file or click the Include all sensors button. 

 

5. Make sure all the sensors you wish to share in your datafile appear in the Sensors to plot/export list. 

 

6. Select Preset and choose a preset time range to determine how much data will be exported each time 
data delivery runs. In this example, we chose "Past 12 hours," which means only data from the past 12 
hours will be exported via data delivery. The most recent 12 hours worth of data is shown for 
reference. Note: Do not choose a custom time range. This is for immediate exports only. If you 
choose a custom time range for data delivery, then data from that custom time-range only will be 
exported every time data delivery runs. 
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7. Click the Save Settings button and type a name, which will also be used for the data delivery file name, 
and press Enter. Your configuration settings will be saved. 

 
After you have selected the sensors you wish to include in the shared data file, you can then set up data delivery 
within Preferences. 

To do this: 

1. Open HOBOnode Manager. 

2. Click the Actions button and select Edit HOBO Data Node Preferences. 

 
3. Select Sharing, and then select Data Delivery. 

 
Note: If you have not yet selected the sensors you wish to export, then you will see a message 
indicating you need to create and save a settings file. You must select the sensors in Plot/Export 
Wireless Data before continuing. 

4. Select how often you want to save the data from your network, from 1 minute to 7 days. This will 
determine what schedule you use to share the data. 
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5. Select the name of the saved settings that you created in Plot/Export Wireless Data, such as 

"Warehouse Zone A" in the example above. 

6. Select how you would like to share the file: via email, FTP, or saved to a computer or network location. 
You may select more than one method of sharing the file. 

Email: 

Type the email address where you want to send the file and select the checkbox if you want to compress the file 
before emailing it. Note: Data delivery uses the same email settings configured for alarm email notifications. If you 
have never configured an alarm email, you must do that first, even if you don’t plan on setting any alarms. 

 
FTP: 

Enter the FTP server name, the directory name (remote folder), username, and password for the FTP location 
where you want to place the file. Test the FTP Connection to make sure it successfully delivers the file to the 
specified location. Select the checkbox if you want to compress the file before delivering it via FTP. Choose 
whether you want to overwrite the existing file at that FTP location each time a new file is transferred, or if you 
want to create a new time-stamped file each time. 

 
Saving it to a hard drive or network: 

Select the directory where you want to save the files. Choose whether you want to overwrite the file each time a 
file is saved, or if you want to create a new file each time. 
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When you are done configuring your data delivery settings, click OK in the main Preferences window.  

 
The sensor data from your data network will then be saved and shared on the schedule that you selected. The data 
will be saved as a .txt, .csv, or .xls file that you can import into HOBOware, Microsoft Excel, and other programs for 
analysis. The file type is determined by the export settings in Preferences.  

Notes: 

• Data delivery will not run unless device communication is also running. This means if you opt to stop 
device communication when you close HOBOnode Manager, then data delivery will also stop. Once 
you restart the device communication, then data delivery will commence again on the previously 
configured schedule. 

• The preferences for data delivery may include the names of settings files from old network 
deployments. If you enable data delivery and use the saved settings from an old deployment, you will 
see a message indicating "No data found for selected sensors." Choose a settings file from the current 
deployment, or create a new one with Plot/Export Wireless Data. 

Important: Data Delivery will not work properly if the "Show export dialog" setting is selected in the export 
preferences. To disable this setting, select Preferences from the File menu in Windows or the HOBOware menu in 
Macintosh. In the General category, select Export Settings. Make sure "Show export dialog" is not selected. Even if 
the "Automatically export table data upon readout of logger" option is disabled, the "Show export dialog" must not 
be selected for Data Delivery to work properly. Your preferences must look like this:  

 

or this: 

 

but not like this: 

 

for Data Delivery to work correctly. 

Tip: You can also share data from your HOBO data node network by enabling a HOBOnode Viewer webpage. When 
data delivery is configured to save files to your computer or a network drive, the files will also be available on the 
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Data tab in HOBOnode Viewer. Note that if you change the file directory used for data delivery when HOBOnode 
Viewer is enabled, you will need to restart HOBOnode Manager before you can access the files from the Data tab. 

Data Storage Location 
The HOBOnode Manager database is stored in the directory shown in the Data Storage Location field. This 
database includes all data recorded by the data nodes, settings for all deployments, alarm information, and other 
details related to your data node network. 

Onset recommends that you periodically back up the database to secure your data in case of a database or 
computer failure. You can back up the database to an external hard drive or network server using third-party 
backup software. You will also be asked to back up your database before running the HOBOnode Manager 
Database Upgrade Utility in HOBOware 3.2.2 or later. 

Important: The database must be closed during a backup or restore. Before copying or restoring a database, close 
HOBOware, HOBOnode Manager, and Device Communication. Right-click (Windows) or left-click (Macintosh) the 
HOBOware system tray icon and select Stop Device Communication. 

The database is stored at the following location, as shown in the Data Storage Location field: 

• Windows 7 and Windows 8 

C:\Users\<user name>\AppData\Local\OnsetComputerCorporation\cosmos\db 

• Windows XP 

C:\Documents and Settings\<user name>\Application Data\Local\OnsetComputerCorporation\cosmos\db 

• Macintosh OS 10.5 and 10.6 

/Users/<user name>/Documents/OnsetComputerCorporation/cosmos/db 

Be sure to back up the entire "db" directory. 

To restore the database: 1. Obtain the "db" directory from your backup source. 2. Replace the "db" directory as shown in the Data Storage Location field with the backup copy. 

Alarms 
There are two types of alarms in HOBOnode Manager: sensor alarms and system alarms. With sensor alarms, you 
can set an alarm to trip when a sensor reading is out of a range you specify. With system alarms, you can set an 
alarm to trip when a node is missing from the network or has a low battery. You can also configure a heartbeat 
alarm, which periodically notifies you the receiver is active and communicating with the nodes in the network. You 
can also set alarm actions, or notifications, to alert you via email, text, and/or audible/visual cue on your computer 
when an alarm trips. Note: When an alarm trips, HOBOnode Manager is opened, if it is not already. 

Click the Alarms tab to access the following: 
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1. Tabs. Click the Sensor tab to set or view sensor alarms. Click the System tab to set Missing Node, 
Heartbeat, and Low Battery alarms. 

2. Add Sensor Alarm button (Sensor tab only). Click this button to go to the Add Sensor Alarms window. 

3. Configured Alarms. Configured sensor alarms appear here. Use the filter to control what alarms shown 
in the sensor alarms pane. Note: If an alarm you configured is not appearing in the Alarms window, 
make sure the filter is set to show all. 

4. Controls (Sensor tab only). Use the controls to apply an action to multiple alarms, including delete, 
copy, enable/disable, and apply default actions. 

5. Tripped Alarms Log. All tripped alarms appear here. Click the Clear Log button to delete all tripped 
alarms. 

Alarms that have been configured, but not tripped, display as green alarm clock icons in both the Sensor and 
Systems tab as well as the Device Table (sensor alarms only). Once the alarm is tripped, the alarm clock icon 
changes to red. 
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Adding a Sensor Alarm 
A sensor alarm trips when a sensor reading is outside a threshold that you configure. You can set up actions so that 
you are notified by email, text message, or by an audio or visual alarm in HOBOnode Manager when a sensor alarm 
trips. Once you create an alarm, you can copy it to multiple sensors of the same measurement type or the same 
measurement type and group. 

Note: Sensor data is sent to the receiver periodically (based on the Connection Interval) and not continuously. 
Therefore, there is a delay between the time the alarm condition occurs and is recorded by the sensor and when 
you are alerted by any notifications you have configured. The default Connection Interval is 10 minutes. For critical 
applications, you may want to decrease the Connection Interval so that you are alerted to alarm conditions more 
frequently. See Changing the Logging Interval and Connection Interval. 

Opening the Add Sensor Alarm window 

The first time you add an alarm for a sensor, you can click the alarm icon for the sensor in the Device Table. This 
will open the Add Sensor Alarm window with the sensor already selected.  

Otherwise, click the Alarms tab, then the Sensor tab, and then the Add Sensor Alarm button. With this method you 
will then need to select the sensor from a drop-down list. 

 

1. Make sure the "Enable sensor alarm" checkbox is selected. 

2. Select the sensor (if not already selected). If you accessed the Add Sensor Alarm window by clicking on 
the alarm icon in the Device Table, the sensor will automatically be populated. Otherwise, select the 
sensor you want to add the alarm to. 

3. Configure Alarm Parameters.  a. Select the threshold: Above, Below, or Outside Range. a. Enter the value for the alarm. b. Enter the Number of Data points. This is the number of readings that must be outside of the 
limits for the alarm to be tripped or cleared. 

4. Configure Alarm Actions (Notifications).  

5. Click Save. 

Note: Any time you edit an existing alarm, the alarm state is reset to untripped and the logged data points are 
reset to zero. 

Copying an Alarm to Other Sensors 
To copy an alarm to other sensors: 
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1. Select Alarm(s). Select the alarms you want to copy. You can select alarms for multiple measurement 
types and each alarm will only be copied for sensors of that type. 

2. Click the Copy to button. 

3. Select the copy option. You can copy the alarm to all sensors of the same Measurement Type, or to 
Measurement Type and Group(s). 

The alarms are copied to the sensors, as shown below. 

 

Enabling a Missing Node Alarm 
A Missing Node alarm trips when a data node has not connected to the receiver within the specified timeframe. 
The default period to determine that a node is missing is 10 minutes. You can change this in the Preferences. 

To enable a missing node alarm: 

1. Click the Alarms tab. 

2. Click the System tab and select the checkbox in the Enable column for Missing Node. If alarm actions 
have already been configured by a previous edit, then the Status icon for Missing Node will change to 
an active alarm icon (green) as shown below. This means the alarm is enabled. If an Edit Missing Node 
Alarm dialog box appears or you wish to make additional changes to this alarm, then proceed to next 
step. 

 

3. An Edit Missing Node Alarm dialog box may open automatically. If it does not and you wish to change 
the settings, then click the Edit icon for Missing Node as shown above. 
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4. Make sure the "Enable missing node alarm" checkbox is selected. 

5. By default, the alarm will trip after the node is missing for 10 minutes. Click the Preferences button if 
you wish to change the default time period. 

6. Add one or more alarm actions, which is how you will be notified when the alarm trips. You can be 
notified via email or text, or by a visual cue or audible sound on the computer where HOBOnode 
Manager is running. 

7. Click Save. The changes you made to the missing node alarm are displayed on the System tab. 

Note: Nodes may temporarily go missing after upgrading their firmware as described in Upgrading the Firmware 
for a Receiver or Single Data Node or Updating the Firmware for Multiple Data Nodes. In most instances, the node 
will not be reported as missing after upgrading its firmware. However, depending on how long the upgrade 
process takes and the length of the connection interval, the node may occasionally be reported as missing. If a 
node is reported as missing after updating its firmware, wait one or two connection intervals for the node to 
reappear. For example, if the connection interval is set to 20 minutes, wait for 40 minutes to make sure the node 
reappears. If the node is then still reported as missing, add it back to the network by following these steps: 

1. Click the Form Network button in HOBOnode Manager. 

2. Press the reset button with a quick 1-second push to reactivate the data node. 

3. Verify that the data node appears in the HOBOnode Manager table and is identified as a router or 
data node as expected (see Determining Data Node Type). To change the type of data node, see 
Converting an End-Point Node to a Router Node or Converting a Router Node to an End-Point Node. 

Enabling a Heartbeat Alarm 
If you enable a Heartbeat alarm, a heartbeat is generated every 12 hours (configurable) to let you know that the 
system is up and running. If you do not receive a heartbeat notification, check the status of your receiver and 
restart HOBOware if necessary.  

To configure a heartbeat alarm: 

1. Click the Alarms tab. 

2. Click the System tab and select the checkbox in the Enable column for Heartbeat. If alarm actions have 
already been configured by a previous edit, then the Status icon for Heartbeat will change to an active 
alarm icon (green) as shown below. This means the alarm is enabled. If an Edit Heartbeat dialog box 
appears or you wish to make additional changes to this alarm, then proceed to next step. 
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3.  An Edit Heartbeat dialog box may open automatically. If it does not and you wish to change the 
settings, then click the Edit icon for Heartbeat as shown above. 

 

4. Make sure the "Enable heartbeat alarm" checkbox is enabled. 

5. Select how often you want to generate a heartbeat and what time you want to start. 

6. Add one or more alarm actions, which is how you will be notified when the alarm trips. You can be 
notified via email or text, or by a visual cue or audible sound on the computer where HOBOnode 
Manager is running. 

7. Click Save. The changes you made to the heartbeat alarm are displayed on the System tab. 

Enabling a Low Battery Alarm 
You can set an alarm to trip when the battery level in a data node or a router drops below a specific threshold. This 
can help you determine when it is time to change the batteries for devices in your network. The low battery alarm 
is a system-wide alarm, which means it applies to all devices (either all nodes or all nodes and routers) in the 
network. You cannot set a low battery alarm for some nodes and not others. 

To configure a low battery alarm: 

1. Click the Alarms tab. 

2. Click the System tab and select the checkbox in the Enable column for Low Battery. If alarm actions 
have already been configured by a previous edit, then the Status icon for Low Battery will change to 
an active alarm icon as shown below. This means the alarm is enabled. If an Edit Low Battery dialog 
box appears or you wish to make additional changes to this alarm, then proceed to next step. 
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3.  An Edit Low Battery dialog box may open automatically. If it does not and you wish to change the 
settings, then click the Edit icon for Low Battery as shown above. 

 

4. Make sure the "Enable low battery alarm" checkbox is enabled. 

5. Select the battery level at which you want the alarm to trip, from 10 to 50%. For example, if you 
choose 20%, then the alarm will trip once the device's remaining battery power drops below 20%. 

6. Select whether the battery alarm should trip for nodes only or for both nodes and routers. Notes: You 
cannot set a low battery alarm for a receiver because it should always be powered by an AC adapter. 
In addition,you should not set a low battery alarm for routers that do not have batteries installed. If 
your routers are powered by AC adapters only and do not have backup batteries installed, then you 
should set the battery alarm for nodes only. 

7. Add one or more alarm actions, which is how you will be notified when the alarm trips. You can be 
notified via email or text, or by a visual cue or audible sound on the computer where HOBOnode 
Manager is running. 

8. Click Save. The changes you made to the low battery alarm are displayed on the System tab. Note: If 
the low battery alarm was previously configured and had tripped, then clicking Save will clear the 
tripped state. If the newly saved settings result in an alarm condition, then the alarm will trip at the 
next connection interval. 

Adding Alarm Actions (Notifications) 
An alarm action is a notification when an alarm trips or and/or clears. You can configure the alarm action to notify 
you in four ways: 

• Via email 
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• Via text message 

• With a visible message on your computer 

• With a sound on your computer 

Before you set up email or text notifications, you must configure your SMTP settings. See Setting Alarm 
Preferences. 

 

1. Click the Add New Action button. A new action is added. Tip: To save time, you can configure default 
alarm actions. See Setting Alarm Preferences for information. 

2. Select the type of notification: Email, Text Message, Visible, or Audible. 

3. Enter information or make a selection depending on the type of notification. Note: If you add an 
email or text notification and you have not already set up your SMTP settings, you will be prompted to 
do so. 

• Email: Enter the email address where you want the alarm notification sent. 

• Text Message: Enter the email address where you want the alarm notification sent. 

• Visible: No further configuration required. A pop-up window will appear in HOBOnode 
Manager if the alarm trips. 

 

• Audible: Select the sound that you want to play when an alarm trips. Click the Play icon to hear 
the alarm.  

Note: If multiple audible alarms are set, only the most recent will play. Any other actions configured 
for the alarm will be sent. 

4. Check the "Perform on clear" box if you want a notification when the alarm clears. If you only want a 
notification when the alarm clears and not when it is tripped, change the drop-down selection to 
"only." 

5. Add Notes to be included in the alarm notification (optional). 

6. Click Save. 

To add another action, repeat the procedure. 
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Setting Alarm Preferences 
Before you add sensor alarms, set up your Alarm Preferences for email notifications and create default actions 
(notifications). To open the Preferences window, click Actions at the bottom of the HOBOnode Manager window 
and select Edit Data Node Preferences. 

 

1. Enter SMTP settings for email or text notifications. To receive email or text message alarm 
notifications, enter the Server IP Address for your mail server, and enable SSL or authentication if 
required by your network. See your Network Administrator or your Internet Service Provider for 
information; see also Alarm Email/Text Configuration for more information. 

2. Send a test email. Enter your email address and click the Send Test Email button to verify that your 
settings are correct. Make sure you check your Junk Mail or Spam folder for the email if it is not in 
your email inbox. 

3. Add default alarm actions (optional). Entering default alarm actions simplifies alarm configuration. For 
example, instead of entering the same email address for every alarm, you can select an address from 
a list of drop-down entries when you add the alarm action. For more details on alarm actions, see 
Adding Alarm Actions. 

If you check "For new sensor alarms, automatically add all default actions" when you click the Add Sensor 
Alarm button, the alarm actions you configured are automatically added, as shown below. This is helpful if 
you want the same actions for every alarm. 

 

Alarm Email/Text Configuration 
You must configure the SMTP Settings to allow email from the data node network to get to your email recipients. If 
your data node network is within a corporate network environment, you should contact your Network 
Administrator (IT/MIS dept.) for this information. Also, they may need to add the receiver to a White List to allow it 
to relay email through the corporate email server. 
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If you use a private mail account such as Yahoo or Google, or if you do not know your corporate information, you 
can get the outgoing mail parameters from your mail provider. The following are links to this information for some 
providers. For other providers, search the Internet for “SMTP Settings for <provider name>." 

• Gmail 

http://mail.google.com/support/bin/answer.py?hl=en&answer=13287 

• Hotmail 

http://liveunplugged.spaces.live.com/blog/cns!F92775FC46A390CA!422.entry 

Sending an Alarm to a Cell Phone 

To send an email to your cell phone when an alarm occurs, enter the email address for your cell phone. These are 
the formats for some cell phone providers. For others, contact your provider. 

Alltel 

[10-digit phone number]@message.alltel.com 

Example: 2125551212@message.alltel.com 

AT&T 

[10-digit phone number]@txt.att.net 

Example: 2125551212@txt.att.net 

Boost Mobile 

[10-digit phone number]@myboostmobile.com 

Example: 2125551212@myboostmobile.com 

Nextel (now part of Sprint Nextel) 

[10-digit telephone number]@messaging.nextel.com 

Example: 7035551234@messaging.nextel.com 

Sprint PCS (now Sprint Nextel) 

[10-digit phone number]@messaging.sprintpcs.com 

Example: 2125551234@messaging.sprintpcs.com 

T-Mobile 

[10-digit phone number]@tmomail.net 

Example: 4251234567@tmomail.net 

Verizon 

[10-digit phone number]@vtext.com 

Example: 5552223333@vtext.com 

Virgin Mobile USA 

[10-digit phone number]@vmobl.com 

Example: 5551234567@vmobl.com 
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The Network Map 
Place icons on the Network Map to help you keep track of your devices. You can expand Information Balloons on 
the device to view status information and sensor readings. You can also import a custom background image, such 
as a floor plan. 

 

1. Map Tab. To view the Network Map, click the Map tab. 

2. Information Balloons. Click a device in the Network Map to open a pop-up that shows current readings 
and other device information. To have pop-ups appear automatically, click the Configure Map icon 
and select "Show Information Balloon when adding new data nodes and on startup." You can also 
adjust how much information is included in the balloon. See Configuring the Network Map for more 
information. 

3. Imported Map Image. To customize your map background image, see Customizing the Network Map 
Background. 

4. Add Device to Map. To add a device to the map, check the Map box in the Device Table and then click 
in the map where you want to place the icon. 

5. Connection Path. Lines on the map show the path each device takes to the receiver. You can monitor 
the communication between a data node and the data receiver by checking the connection paths 
between devices. If a device has missed a scheduled connection, the path will become a dotted line. 
To change the path color, see Configuring the Network Map. 

6. Tools. Use the Zoom tools to zoom in and out of the map. Click the Configure Map button to access 
additional map settings. Use the Refresh Network Paths button to see the latest path that the devices 
are taking to get to the receiver. Paths can change if a data node is moved or because the original 
path was obstructed. 
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Note that if an alarm has tripped on a node, the node icon on the network map will have a red ring around it like 

this:  

Adding a Device to the Network Map 
To add a device to Network Map. 

1. In the Device Table, check the Map box for the receiver to add it to the map. 

2. Move the icon to the location of the receiver and click the left mouse button. 

3. Check the Map box for a node to add it to the map. 

4. Move the icon to the location of the device and click the left mouse button. 

5. Repeat steps 3 and 4 for each node you want to add to the map. 

 

Configuring the Network Map 
You can customize the paths and information balloons on the Network Map, and you can use your own  

Click the Configure icon  in the top left of the Network Map to open the Network Map Configuration window. 
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In the Node Paths pane, select the Show Path to Receiver checkbox Paths to show or hide connection paths 
between nodes. To change the path color, click the Choose button. Select a new color from the Swatches tab, or 
enter HSB or RGB values and click OK. 

 
In the Information Balloons pane, select the Information Balloon Type, as either: 

• Simplified to show only label and readings, or 

 

• Expanded to show all device information. 

 
To change the background color on the balloon, click the Information Balloon Color drop-down arrow and select a 
color.  

 
Select the "Show Information Balloon when adding new data nodes and on startup" checkbox to automatically 
display the balloons any time you open HOBOnode Manager or add a new icon to the map. 

To change the map image, see Customizing the Network Map Background. 

Customizing the Network Map Background 
You can upload a custom image to the Network Map to represent your floor plan. 
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 1. Click the Configure icon in the top left corner of the map . 2. Click the Choose button in the Network Map Configuration window. 3. Select the image file from the Open window. 4. Click Open. 5. Click OK to close the Network Map Configuration window and display the new image. 

To revert to the default image, click Restore. 

If you don't have an image to upload, you can create one using any drawing program following these guidelines: 

• There are 3 scale levels available for an image in the Network Map, depending on the size of the 
image you upload. The larger the size, the more zoom levels you will have. 

 1,000 x 1,000 (minimum size) - 1 zoom level 

 2,000 x 2,000 - 2 zoom levels 

 3,000 x 3,000 (maximum size) - 3 zoom levels 

• All images are converted to squares in the Network Map, so for best results your overall image should 
be a square. 

• Inside the main square, add a smaller square or rectangle to roughly represent your building. 

• Add squares or rectangles to represent rooms in your building where you will place nodes. Add 
descriptive labels to each room such as "Office," "Cooler," or "Boiler Room." Some programs will also 
have other images you can add to the room such as desks and computers to help you narrow the 
location of the node. 

• Set the properties of the image to your desired resolution. For best results enter 4,000 x 4,000 pixels.  

Maintenance & Troubleshooting 
Once your ZW Wireless Data Node Network is running, refer to the following topics for maintenance and 
troubleshooting tips: 

• Changing External Sensor Type 

• Moving or Removing a Data Node 

• Converting a Router Node to an End-Point Node (Switching from AC Power to Battery Power) 

• Converting an End-Point Node to a Router Node (Switching from Battery Power to AC Power) 
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• Database Backup and Restore 

• HOBOnode Manager Database Upgrade Utility 

• Creating a New Deployment 

• Updating Firmware for a Receiver or Single Data Node 

• Updating Firmware for Multiple Data Nodes 

• Troubleshooting 

Changing External Sensor Type 
Many types of HOBO data nodes can be configured with external sensors. One of the benefits of using external 
sensors is that you can swap them out when necessary for different ones if you want to modify your wireless 
network. Or, you can disable the external sensor channel if you don't need it for your current network deployment. 

To change the type of external sensor associated with a data node: 1. Double-click the external sensor you wish to change in the HOBOnode Manager device table. 2. Select the sensor from the Sensor Type drop-down list. 

 3. Make any other changes as necessary and click OK. 

Note: While the HOBOnode Manager device table will display the change to the sensor type immediately, data for 
the new sensor will not display until the next connection interval . 

To deselect, or turn off, an external sensor: 

1. Double-click the external sensor you wish to change in the HOBOnode Manager device table. 

2. Scroll to the end of the Sensor Type drop-down list and select <No sensor attached>. 
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 3. Make any other changes as necessary and click OK. 

The HOBOnode Manager device table will then change the status for that external sensor to OFF as shown below. 
Any plots and alarms associated with that sensor will also be removed from HOBOnode Manager. 

 
Shortcut: In the device table, click the checkbox next to the external sensor, then click the Sensor Type button and 
select the sensor from the list. This can be done for many sensors at once by selecting more than one sensor at a 
time in the device table. 

For details on setting up a HOBO data node with an external sensor for the first time, see Setting Up an External 
Sensor. For details on scaling sensor data, see Configuring Scaling on a Sensor. 

Moving or Removing a Data Node 
If you will not be using a data node for an extended period of time, you may want to deactivate it to stop 
measurements and save batteries. To deactivate a data node, use a paper clip to press the Activate button as 
shown in the photo below for 5 seconds until the red LED starts flashing.  
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To later reactivate the data node, select Form Network from HOBOnode Manager and briefly depress the Activate 
button on the node. 

If you do not want a data node to appear in HOBOnode Manager, double-click the device row in the Device Table 
and then click Remove Node in the Configure Node window. 

If you move a data node to a new location, make sure the green LED is still blinking once per 10 seconds to indicate 
that the node still has a connection to the receiver. If the red LED is blinking, the connection path is broken. Try 
adjusting the orientation of the data node or moving it closer to the receiver to minimize obstructions. You may 
need to add a router to re-establish a connection.  

If moving a data node changes the primary power source, see the following: 

• Switching from AC Power to Battery Power 

• Switching from Battery Power to AC Power 

Converting a Router Node to an End-Point Node (Switching from AC Power to Battery Power) 
If you initially power up a node using an AC adapter, it will operate as a router node. If you need to convert the 
router node into an end-point node that operates on battery power only, follow this procedure. 

1. Deactivate the data node by pressing the reset button on the data node with a paper clip until the red 
LED starts flashing repeatedly (about 5 seconds). 

2. Disconnect the data node from AC power. 

3. If batteries are installed, remove them. 

4. Wait at least 30 seconds to clear the memory. 

5. Reinstall the batteries. Do not plug in the AC adapter. 

6. Click Form Network in HOBOnode Manager. 

7. Press the reset button with a quick 1-second push to reactivate the data node. 

8. Verify that the data node appears in the HOBOnode Manager table and is identified as a node (no 
routing capabilities). See Determining Data Node Type. 

Converting an End-Point Node to a Router Node (Switching from Battery Power to AC Power) 
If you initially power up a node using batteries, it will operate as an end-point node with no routing capabilities. If 
you need to convert the end-point node into a router node that operates on AC power, follow this procedure so 
that HOBOnode Manager recognizes the data node as having routing capabilities. 

1. Deactivate the data node by pressing the reset button on the data node with a paper clip until the red 
LED starts flashing repeatedly (about 5 seconds). 

2. Remove the batteries from the data node. 

3. Wait at least 30 seconds to clear the memory. 

4. Plug the data node into an AC power outlet. 

5. Click Form Network in HOBOnode Manager. 

6. Press the reset button with a quick 1-second push to reactivate the data node. 

7. Verify that the data node appears in the HOBOnode Manager table and is identified as a router. See 
Determining Data Node Type. 

8. Reinstall the batteries for backup purposes. 
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Database Backup and Restore 
It is recommended that you periodically back up your database to secure your data in case of a database failure. 
You can back up your database to an external hard drive or network server using third-party backup software.  

If you should ever need to restore your database, simply replace the primary database with the backup.  

Important: The database must be closed during a backup or restore. Before copying or restoring a database, close 
HOBOware, HOBOnode Manager, and Device Communication. Right-click (Windows) or left-click (Macintosh) the 
HOBOware system tray icon and select Stop Device Communication. 

The database is stored at the following location: 

• Windows 7 and Windows 8 

c:\Users\<user name>\AppData\Local\OnsetComputerCorporation\cosmos\db 

• Windows XP 

c:\Documents and Settings\<user name>\Application Data\OnsetComputerCorporation\cosmos\db 

• Mac OS 10.5 and 10.6 

/Users/<user name>/Documents/OnsetComputerCorporation/cosmos/db 

To rename the database, modify the name of the db folder by adding the deployment location or the date 
(example: "db-11-10"). Note: HOBOnode Manager will be empty after renaming the database. You will need to 
form a new network. 

HOBOnode Manager Database Upgrade Utility 
HOBOnode Manager databases created in HOBOware 3.2.1 or earlier must be upgraded with the HOBOnode 
Manager Database Upgrade Utility to improve performance and response time. This utility is automatically opened 
the first time you access the HOBOnode Manager database in HOBOware 3.2.2 or later. 

Before you can upgrade the database with the utility, you must first go to the data storage location to back up the 
database (and the entire db directory). After the backup is complete, click Start in the utility to begin the upgrade 
process. Progress will be displayed while the upgrade takes place. 

Important: The larger your database, the longer it will take the upgrade to complete. Please be prepared for the 
utility to run for an hour or more. You will not be able to access any features in HOBOnode Manager or HOBOware 
while the utility is running. Any data recorded while the upgrade is running will be saved and available in 
HOBOnode Manager once the upgrade is complete. In addition, this utility requires free disk space equivalent to 
double the size of the current database. For example, if your database is 450 MB, then you will need at least 900 
MB free disk space on the computer for the utility to complete its process. Once the upgrade is complete, the 
database will be close to its original size. 

Creating a New Deployment 
The first time you form a HOBO data node wireless network, the initial deployment, or network configuration, is 
created automatically for you. This first deployment can continue indefinitely. However, you also have the option 
to create a new deployment if you need to move your current network to a new location or if you'd like to 
configure a different set of sensors in a new network, for example. This allows you to more easily distinguish 
between two separate networks or deployments of nodes when they are plotted or exported from HOBOware. 

You have the option of either creating a new deployment that is an exact copy of the previous one (all devices, 
alarms, and settings will be copied as currently configured) or consists of a new network (only system alarms and 
alarm logs are copied). 

Note: Creating a new deployment does not create a new database. All data recorded in the previous deployment is 
saved and can be accessed through Plot/Export Data. 

To create a new deployment: 
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1. Click the Actions button in HOBOnode Manager and select Create New Deployment. 

 

2. Type a name for the new deployment. Select the Copy the current network to the new deployment 
checkbox if you want to use the current deployment as the basis for the new deployment (HOBOnode 
Manager will automatically be filled in with your current network devices, alarms, and settings). If you 
do not copy the current network, then you will need to form a new network (only system alarms and 
alarm logs will appear in HOBOnode Manager). Click OK. 

 

3. A message appears indicating that the current network deployment will end and a new deployment 
will be started. Click Yes to continue, or click No to return to the Create New Deployment dialog. 

4. From the Device menu in HOBOware, select Manage HOBO Data Node Network to restart HOBOnode 
Manager. 

5. If you chose to copy the current network to the new deployment, then HOBOnode Manager opens 
with all devices listed. Plots will begin displaying the new network data at the next scheduled 
connection interval. If you did not copy the old network, then you will be prompted to form a new 
network. 

Both the newly created deployment and the previous deployment are listed in the Plot/Export Wireless Data 
window. Click the Plot/Export button in HOBOnode Manager to see the deployment list as shown in the example 
below. 

 
Deployments are listed from newest to oldest. The initial deployment is labeled "First Deployment" by default. Any 
subsequent deployments are listed with the name you entered in the Create New Deployment dialog. 

The start time for the current deployment (the deployment at the top of the list) is the time the new deployment 
was created, which is also the end time for the previous deployment on the list.The end time for the current 
deployment is the current time. 

Updating Firmware for a Receiver or Single Data Node 
Occasional firmware updates may be necessary for the devices in your network. Follow these steps if you are 
directed by Onset Computer to upgrade the firmware in the receiver or a single data node. To update several data 
nodes in the network at once, see Updating Firmware for Multiple Data Nodes. 

Important Notes Before you Begin: 
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• Updating the firmware generally takes two to three minutes for a receiver and four to six minutes for 
a data node. You cannot cancel the update process once it starts. 

• If you need to update both the receiver and data nodes, update the receiver first to provide the best 
network performance. After the receiver update is complete, wait for HOBOnode Manager to display 
the latest data from all the nodes. Once each node has communicated with the newly updated 
receiver and the latest data appears in the device table, then you can continue with updating the 
firmware in the nodes.  

• When updating the receiver firmware, the entire network will automatically shut down and restart. 

• A data node should be powered the same way as it was when it was originally configured to ensure it 
remains a part of the network once the update is complete. This means a router node must be 
plugged into an AC adapter and an end-point data node must have batteries installed and not be 
plugged into an AC adapter. See Determining Data Node Type for details on identifying routers and 
end-point nodes in HOBOnode Manager. 

To update firmware: 

1. Place the firmware .hex file(s) in the appropriate directory. Do not rename the files. 

For Windows 7 and Windows 8: C:\Users\Public\Documents\HOBOware Public Files\FWUpdates 

For Windows XP: C:\Documents and Settings\All Users\Shared Documents\HOBOware Public 
Files\FWUpdates 

For Macintosh: /Users/<user>/Documents/HOBOware/FWUpdates 

2. HOBOware, HOBOnode Manager, and ZW Device Communication must be restarted to correctly 
identify the firmware files. Close HOBOware and HOBOnode Manager if open. If prompted to leave 
the device communication running in the background, click No. If HOBOware and HOBOnode Manager 
were already closed, but device communication was running, right-click (or left-click on a Mac) the 
HOBOware icon in the system tray select Stop Device Communication. 

 

3. Open HOBOware and HOBOnode Manager again. Wait for new data to be updated in HOBOnode 
Manager. 

4. In HOBOnode Manager, double-click the receiver (ZW-RCVR) or node you want to update in the 
Device Table (or select the receiver or node and click Configure). 

5. Click the "Update device firmware" button in the Configure Receiver or Configure Node window 
(Configure Receiver is shown in the following example).  
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Notes: 

• If the "Update device firmware" button is disabled, HOBOnode Manager is still being updated 
after its restart. Keep the Configure window open and wait for a few more minutes for the 
button to become enabled. 

• If the "Update device firmware" button does not appear, double-check that the firmware .hex 
file is in the correct directory as described in Step 1. 

• A battery-powered end-point node with a current firmware version of 64 must be temporarily 
converted to an AC-powered router node before you can update the firmware. If a message 
displays indicating you cannot complete the update, follow the steps in Converting an End-
Point Node to a Router Node first and then repeat Steps 2 and 3 again. 

6. A message appears listing details about the device and any notes about the update process. Click 
Cancel if you do not want to update the device at this time. Otherwise, click Continue. 

 

7. The firmware is updated in the device; check the progress on the screen during the update as shown 
in the following example of a node being updated. 
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When the firmware is saved to the device, the LED will flash red on the receiver and green on a data node. 
A message appears at the end when the update is successfully completed. 

Notes: 

• After a data node has been updated, it may to take one or two connection intervals before new data is 
displayed in HOBOnode Manager. For example, if the connection interval is set for 10 minutes, it may 
take two connection intervals, or about 20 minutes, for new data to appear. If new data still isn't 
appearing after two connection intervals have passed, power cycle the data node (unplug the adapter 
and/or remove the batteries then plug the adapter back in and/or reinstall the batteries).  

• If HOBOnode Manager still is not displaying data after power cycling the data node as described above 
or if the data node is listed as missing in HOBOnode Manager after updating the firmware, add it back 
to the network by following these steps: 

1. Click the Form Network button in HOBOnode Manager. 

2. Press the reset button with a quick 1-second push to reactivate the data node. 

3. Verify that the data node appears in the HOBOnode Manager table and is identified as a router 
or data node as expected (see Determining Data Node Type). To change the type of data node, 
see Converting an End-Point Node to a Router Node or Converting a Router Node to an End-
Point Node. 

Updating Firmware for Multiple Data Nodes 
Occasional firmware updates may be necessary for the data nodes in your network. If new versions of firmware 
files are detected in the HOBOware FWUpdates directory (exact location described below), then an Update 
Firmware in Data Nodes option appears in the Actions drop-down menu in HOBOnode Manager as shown below. 

 
Follow these steps if you are directed by Onset Computer to upgrade the firmware in multiple data nodes. To 
update the firmware in the receiver or in a single data node at a time, see Updating Firmware for a Receiver or 
Single Data Node. 

Important Notes Before you Begin: 

• Firmware .hex files must be present in the appropriate directory. (Do not rename the files.) 

For Windows 7 and Windows 8: C:\Users\Public\Documents\HOBOware Public Files\FWUpdates 

For Windows XP: C:\Documents and Settings\All Users\Shared Documents\HOBOware Public 
Files\FWUpdates 

For Macintosh: /Users/<user>/Documents/HOBOware/FWUpdates 
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• If you need to update the firmware in both the receiver and data nodes, update the receiver first for 
best network performance. Follow the steps in Updating Firmware for a Receiver or Single Data Node. 
After the receiver update is complete, wait for HOBOnode Manager to display the latest data from all 
the nodes. Once each node has communicated with the newly updated receiver and the latest data 
appears in the device table, then you can continue with updating the firmware in data nodes.  

• A data node should be powered the same way as it was when it was originally configured to ensure it 
remains a part of the network once the update is complete. This means a router node must be 
plugged into an AC adapter and an end-point data node must have batteries installed and not be 
plugged into an AC adapter. 

• A battery-powered end-point node with a current firmware version of 64 must be temporarily 
converted to an AC-powered router node before you can update the firmware. These nodes will not 
be displayed in the list of data nodes waiting for an update. Follow the steps in Converting an End-
Point Node to a Router Node first, then update the firmware in each of these nodes one at time as 
described in Updating Firmware for a Receiver or Single Data Node. 

• Although data will continue to be transmitted and stored in the receiver while this upgrade takes 
place, it will not be available in HOBOnode Manager until after the upgrade is complete. Therefore, 
select a time to perform the upgrade when you do not need real-time access to your data. 

• Nodes may be temporarily reported as missing after being upgraded. If you have enabled the Missing 
Node alarm for any nodes in your network, consider only upgrading a few nodes at a time to minimize 
the potential for nodes to be reported as missing and the Missing Node alarm to trip. 

Steps 

1. Once the firmware .hex files are in the correct location as described in the Important Notes Before 
you Begin, you must restart HOBOware, HOBOnode Manager, and Device Communication. Close 
HOBOware and HOBOnode Manager if open. If prompted to leave the device communication running 
in the background, click No. If HOBOware and HOBOnode Manager were already closed, but device 
communication was running, right-click (or left-click on a Mac) the HOBOware icon in the system tray 
select Stop Device Communication. 

 

2. Open HOBOware and HOBOnode Manager again. Wait for new data to be updated in HOBOnode 
Manager. 

3. From the Actions menu in HOBOnode Manager, click Update Firmware in Data Nodes. If this option 
does not appear in the menu, wait for a few more minutes for HOBOnode Manager to finish updating 
in Step 2. If it still does not display, double-check that the firmware .hex files are in the correct 
directory and repeat Steps 1 through 3 again. 

4. A list of all nodes waiting to be updated is displayed. Click the checkbox next to each node you want to 
update or click Select All to choose all the nodes in the list. 

5. Click the Updated Checked button to start the update process for all the nodes selected in the list. 
Each node will be updated one by one, with the progress displayed next to the node and a detailed 
progress listed in the bottom pane of the window. Important: Clicking Cancel will not immediately 
stop all updating. When you click Cancel, the node update in progress will continue until finished. The 
Cancel button will also change to read "Cancel requested." Once the update is complete for that node, 
the update for the remaining nodes will be canceled. Click the Update button to restart the update 
process for the remaining nodes. 
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6. Once the update is complete, click the Save button to save the log detailing the update procedure to a 
text file called "FirmwareUpdateLog.txt" (saved in C:\Users\<User Name>\Documents on Windows 
and in the <User Name> folder on Mac). Click Close to return to HOBOnode Manager. 

Notes: 

• After a data node has been updated, it may to take one or two connection intervals before new data is 
displayed in HOBOnode Manager. For example, if the connection interval is set for 10 minutes, it may 
take two connection intervals, or about 20 minutes, for new data to appear. If new data still isn't 
appearing after two connection intervals have passed, power cycle the data node (unplug the adapter 
and/or remove the batteries then plug the adapter back in and/or reinstall the batteries).  

• If HOBOnode Manager still is not displaying data after power cycling the data node as described above 
or if the data node is listed as missing in HOBOnode Manager after updating the firmware, add it back 
to the network by following these steps: 1. Click the Form Network button in HOBOnode Manager. 2. Press the reset button with a quick 1-second push to reactivate the data node. 3. Verify that the data node appears in the HOBOnode Manager device table and is identified as a 

router or data node as expected (see Determining Data Node Type). To change the type of 
data node, see Converting an End-Point Node to a Router Node or Converting a Router Node 
to an End-Point Node. 

Troubleshooting 

General Network Connection Issues 
If you are having problems connecting data nodes to the receiver, or they are losing a connection after they have 
been joined to the network, you may be experiencing issues with a conflicting wireless device. To reset the radio 
channel, double-click the receiver row in the Device Table and in the Configure Receiver window click the Reset 
button. You will then need to form the network again. 
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Receiver Will Not Connect to HOBOnode Manager 
Make sure the USB plug is secure on both ends. Try unplugging and plugging the receiver back in. 

Data Node Cannot Join Network 
Positioning: If you are having trouble getting a data node to join the network, try repositioning the node within the 
space. Move the data node away from any obstacles (such as metal walls, stairwells, elevator shafts) that may exist 
between it and the receiver.  

Distance: The data node may be too far from the receiver to obtain a signal. Try moving the data node closer to the 
receiver, or add a router or router/node between the data node and the receiver. 

Make sure the receiver is in Form Network mode (RED and GREEN LEDs alternating). 

Make sure you have pressed the button on the bottom of the node and that the RED and GREEN LEDs are 
alternating. Try pressing the button again. 

Debugging 
There are a number of debugging and logging options in HOBOnode Manager. If you are working with Onset 
Technical Support on an issue, you may be asked to enable debugging options and send a log file to Onset. 

No readings for a sensor 
For external sensors, make sure the connection to the data node is secure and that you have assigned a Sensor 
Type (does not apply to the External Temp/RH Sensor).  

No Plot Appears for a Sensor 
Make sure you have checked the Plot box in the Device Table for the sensor. 

Extreme Sensor Readings 
If you are seeing extreme sensor readings, make sure the sensor cable is securely plugged into the node. 

Alarms 
If an alarm you configured is not appearing in the Alarms window, make sure the filter is set to Show all. 

Security Connection Messages on Macintosh 
If the firewall setting is enabled in the security system preferences on a Macintosh, you may encounter a security 
warning message every time you open HOBOnode Manager. To turn off this message, go to System Preferences, 
select Security, and turn off the firewall. Note: Keeping the firewall turned on and adjusting the advanced settings 
to allow all incoming connections for HOBOware does not resolve the problem. 

Firewall Messages on Windows 
Windows Firewall must allow access to HOBOware.exe for HOBOnode Viewer to run properly. To allow HOBOware 
access, open Control Panel, go to Security, and select Allow a program through Windows Firewall (or click 
Windows Firewall and click the Exceptions tab on some versions of Windows). Make sure HOBOware is selected in 
the allowed access/exceptions list. 

Changing Locale 
The language in use at the time the original HOBO data node network database was created is the only language 
that can be used for that database. You cannot switch to another language. If you need to change the locale on the 
computer that contains your HOBO data node network database, you will need to: 
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1. Back up and then move or rename the database.  2. Change the locale on the computer. 3. Form a new network to create a database that operates in the new locale. 
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Chapter 7 
Reference 

• Setting Preferences 

• Menus 

• The Toolbar 

• Tips for Working with Multiple Loggers 

• Setting the Language Format on Your Computer 

• Alarm & Readout Tool 

Setting Preferences 
You can change the default behavior of HOBOware in the categories listed below. Preference settings are unique 
for each user login on your computer. The following categories are available: 

• General. Set preferences for Launch Time-Savings Options, Readout Time-Savings Options, Open File 
Time-Saving Options, Export Settings, Selecting Devices, File Associations, Startup, Data Verification, 
and Data Encoding. 

• Communications. Set preferences for Device Types , Serial Ports, Device Speeds, and Other Options. 

• Plotting. Set preferences for Fonts, Lines, Value Axis, Layout, Points Table and Details Pane, Gridlines, 
Plot Setup, Other Options, Undo & Redo. 

• Data Assistants. Set show/hide preferences for HOBOware Pro Data Assistants. 

• Display. Set preferences for Default Unit System, Date/Time, and Series. 

• Warnings. Set preferences for various warning types. 

• Data Nodes. Set preferences for HOBOnode Manager, including General, Alarms, Real-Time Plots, 
Data Storage, and Sharing (HOBOware Pro only). 

• Alarms. Set preferences for the Alarms & Readout Tool, including Alarm Conditions, Readouts, 
Notifications, Messages, and Warnings (HOBOware Pro only). Important: The Alarm & Readout Tool 
is no longer installed with HOBOware as of version 3.4. Information in the help system is included for 
reference only for existing Alarm & Readout Tool users. 

• Bulk Export. Set YAML preference for Bulk Export Tool (HOBOware Pro only). 

Some preferences have one of the following icons next to them, indicating a difference in behavior between 
HOBOware and HOBOnode Manager (HOBOware Pro only). 

 
You can save preference settings and reload them as needed (HOBOware Pro only). Click the Save Preferences 
button at the top of the Preferences window and type a name in the pop-up field to save all currently selected 
preferences. You can then click the Load Preferences button and select the name you typed in to load those 
preference settings back into the Preferences window. 
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See also: 

• Restoring Default Preferences 

General Preferences 
Use the General category within Preferences to control a variety of HOBOware behavior, including launching, 
reading out, opening files, exporting, selecting devices, and more. 

To change these settings: 1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 2. Select the General category on the left and then click the subcategory you wish to change. 3. Adjust any of the settings described below and then click OK. 

Launch Time-Saving Options (HOBOware Pro only) 

• When launching. Select "Show launch screen" to display the Launch Logger window when you select 

Launch from the Device menu or click the Launch icon  on the toolbar, or select "Automatically 
launch" to bypass this window and launch the logger with the default settings. Selecting 
"Automatically launch" is particularly useful if you want to launch several loggers quickly without 
changing any settings. The default settings are determined by the "Fill launch window with contents 
of" preference. 

For HOBOware Pro only: If you select "Automatically launch" and also set the Default Action from the 
Device menu to Launch, this feature allows you to launch several U-Series loggers in a row simply by 
connecting and disconnecting each logger to the computer. 

• Fill launch window with contents of. Select "Current logger" to show the logger's most recent 
launch settings (as stored in the logger memory) in the Launch Logger window. Select "Previous 
launch" to show the same settings used in the most recent launch. This is helpful if you want to launch 
several loggers of the same type with similar settings or if you want to set up several loggers to start 
at the same time with the same logging interval. An indicator on the Launch Logger window will 
remind you when this preference is use. Note that "Previous launch" does not apply if you are 
launching different types of loggers; instead the settings in the logger's memory will be used. When 
"Previous launch" is selected, you also can select the "Use previous sensor labels" checkbox to 
automatically fill any sensor label fields with the labels from the previous launch. 

• Default launch type. This preference controls what displays by default in the "Start logging" field in 
the Launch Logger window"Previous launch type" is selected, then the "Start logging" field will display 
the same setting used for the logger's last launch. For example, if the logger was last configured to 
start logging "Now" selected, then the "Start logging" field will default to "Now" for the next launch. 
Note that if the previous launch was set to start "At interval," the "Start logging" field will default to 
start "On Date/Time." If "Launch now," "Launch at interval," "On specified date/time," or "Button or 
coupler start" is selected, then that launch type will automatically be selected in the "Start logging" 
field in the Launch Logger window regardless of how the logger was previously launched. Note that if 
you choose "Button or coupler start" and the logger does not support that feature, then the "Start 
logging" field will default to "Now." Important: If you set the "Fill launch window with contents of" 
preference to "Previous launch," then the "Default launch type" preference will be ignored in favor of 
the "Start logging" setting used in the last launch. 

• Logger launch description. This preference controls what displays by default in the Description field 
in the Launch Logger window. If you select "Default launch description," then the Description field will 
display the description used the last time the logger was launched. If you select "Logger S/N," then the 
logger serial number will automatically be listed in the Description field. Selecting "Logger S/N" can 
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help to easily differentiate files when launching and reading out several loggers of the same type. 
Note that whatever is listed in the Description field is also used as the default file name when reading 
out and saving the logger data. 

 

Readout Time-Saving Options (HOBOware Pro only) 

• When saving datafile. This preference controls whether the Save window displays automatically 
when reading out a file. Select "Show save dialog" if you want the Save window to display every time 
you read out a logger and specify a location and name for the file, or accept the default file name. 
Select "Automatically save" if you do not want to display the Save window during the readout process. 
The file will automatically be saved with the default name (the description in the Launch Logger 
window) and in the default location (as described in Reading Out the Logger).  

• When plotting. This preference controls the default plot behavior when reading out a logger. Select 
"Show plot setup" to display the Plot Setup window after reading out and saving the file. Select 
"Automatically plot" if you want to bypass the Plot Setup window and instead automatically plot the 
data after reading out and saving the file. This option is not recommended if you will be using Data 
Assistants, which are accessed through the Plot Setup window. Select "Do not plot" if you do not want 
to plot the data at all. This is useful if you are reading out several loggers and prefer to look at the 
plots later. You can always open the saved datafile and plot it at that time.  

For HOBOware Pro only: You can adjust the Readout Time-Saving Options and set the Default Action 
from the Device menu to Readout to quickly read out several U-Series loggers in a row by connecting 
and disconnecting each logger to the computer. To do this choose "Automatically save" for "When 
saving datafile," choose "Do not plot" for "When plotting," and deselect the "Ask to stop logging 
before reading out a running logger" checkbox. 

• Ask to stop logging before reading out a running logger. When this checkbox is selected, a 
message appears every time you read out a logger that is still recording data. The message asks 
whether you want to stop the logger or let it continue logging data during the readout process. If you 
deselect this checkbox, a logger that is still recording data will automatically continue logging during 
readout. 

 

Open File Time-Saving Options (HOBOware Pro only) 
This preference controls whether the Plot Setup window is automatically displayed when opening a file. Select 
"Show plot setup" if you want the Plot Setup window to display every time you open a file. Select "Automatically 
plot" if you want to bypass the Plot Setup window and automatically generate the plot each time you open the file. 
This is not recommended if you will be using Data Assistants, which are accessed through the Plot Setup window. 
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Export Settings 
See Export Settings for details on the preferences in this subcategory. 

Selecting Devices 
This preference controls when the Select Device window is displayed. If you select "Show Select Device window if 
two or more devices are found, even if one is already selected," then the Select Device window will display any 
time more than one device is connected to the computer. This allows you to choose the device you want to work 
with any time you select Launch, Readout, Status, or Stop from the Device menu. If you select "Only show Select 
Device window if a device has not been selected," then the Select Device window will only display the first time 
you select Launch, Readout, Status, or Stop. That device will then remain selected until you change it with the 

Select Device icon  on the toolbar. 

 

File Associations 

 
Use this preference to control the association of HOBOware file types on Windows. Note: You must have 
administrator privileges on the computer to change file type associations. To temporarily run HOBOware as an 
Administrator, right-click the HOBOware icon and select Run as Administrator. Enter the Administrator name and 
password as prompted. 

By default, files with the extensions of .hobo, .hsec, and .hproj (HOBO files) and .dtf and .dsec (DTF files; 
HOBOware Pro only) are automatically associated with HOBOware. This means that these files are identified by a 
HOBOware icon and can be opened by double-clicking them. Click the Map or UnMap buttons to change the file 
type associations.  

Startup 

• Show splash screen on startup. This preference controls whether the HOBOware graphic, or splash 
screen, appears every time you open the software. 

• Check for HOBOware updates. This setting controls how frequently, if it all, HOBOware 
automatically checks the Onset website for any software updates. The default setting is once per 
week. 

• When checking for HOBOware updates (HOBOware Pro only). These settings control whether 
you are notified about all new software updates or only those that affect the currently installed 
components. The default is to check for any new updates. 
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 Data Verification (HOBOware Pro Only) 
Select this option to enable Secure Mode and have HOBOware Pro add a digital signature to new datafiles when 
you read out loggers (for environments where 21 CFR Part 11 is being employed). The digital signature is indicated 
by a filename extension of .hsec for hobo files and .dsec for dtf files. The signature will be verified each time you 
open the datafile to ensure its integrity. This option is disabled off by default. 

 

Data Encoding 
Data encoding controls how special characters are displayed in files that are imported into and exported from 
HOBOware. The default is to use UTF-8, a common character encoding protocol for software. Select "Windows 
default" if characters are not displaying correctly in imported and exported files in Windows. 

 

Export Settings 
Use the Export Settings preferences to customize how data is formatted when you export the table data from a 
plotted HOBOware file, to set up automatic export upon readout, to include plot details in an exported file, and to 
set export ordering rules. To access these settings: 1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 2. Select the General category and then click Export Settings. 3. Adjust any of the settings described below and then click OK. 
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• Use classic export settings. Click this button to change the export settings to the default settings 
used with BoxCar Pro software, which is Onset legacy software released before HOBOware. 

• Export file type. Select how you want exported data to be saved: either to a text file (.csv or .txt) or a 
Microsoft Excel file (.xls). 

• Export table data column separator. This setting controls the column separator for exported text 
files. (If you selected Excel for the export file type, then this option is disabled.) Select Comma, Tab, or 
Semicolon. When Comma is selected as the column separator, the data will be saved to a .csv file that 
can be imported into Excel. When Tab or Semicolon is selected, the data will be saved to a .txt file. 

• Include line number column. By default, exported files include line numbers. Uncheck this box if 
you do not want line numbers in the file (for example, to export in BoxCar Pro software format). 

• Include plot title in header. Uncheck this box if you do not want the plot title included in the 
header of the exported file. This option is primarily for compatibility with the BoxCar Pro software 
format. 

• Always show fractional seconds. Check this box to show fractional seconds in the time-stamped 
data points. This is primarily for compatibility with the BoxCar Pro software format. 

• Separate date and time into two columns. By default, the date and time of a logged data point is 
exported as a single column to facilitate graphing in spreadsheet programs. Check this box to split the 
date and time into two columns. 

• No quotes or commas in headings, properties in parenthesis. Check this box if you do not want 
quotations marks and commas in the exported file's column headers. Sensor properties, or units, 
(such as °F or RH) will be listed in parenthesis instead of quotation marks when this setting is enabled. 
This option is primarily for compatibility with the BoxCar Pro software format. 

• Include logger serial number. When this setting is enabled, the logger's serial number will be listed 
in each column header in the exported file. This is useful if you are exporting data series that were 
copied and pasted from plots that originally came from different loggers. 
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• Include sensor serial number, or label (if available) (HOBOware Pro only). When this setting is 
enabled, each sensor's serial number or label (if available) will be listed in each column header in the 
exported file. This is especially useful when exporting data from multiple sensors recording the same 
measurement type (for example, three temperature sensors). Note: If "No quotes or commas in 
headings, properties in parenthesis" is selected, the label (if available) will be added to the column 
header instead of the sensor serial number. 

• Date format. Select the format in which you want the date to be shown (Month, Day, Year; Day, 
Month, Year; or Year, Month, Day). 

• Date separator. Select either a slash ( / ) or a dash ( - ) to separate the months, day, and year in the 
date format. 

• Time format. Select whether to show the time in a 12-hour or 24-hour format. 

• Positive number format. Select the format in which positive numbers are displayed (for example: 
1,234.56; 1 234,56; 1.234,56; or 1.234 56). 

• Negative number format. Select the format in which negative numbers are displayed (for example: 
-123, 123-, or (123). 

• Automatically export table data upon reading out a logger. Select this option if you want 
HOBOware to automatically create an export file each time you read out a logger (note that you must 
save and plot the data before the exported file will be created). When this setting is enabled, the 
default option is to export the data to a single file (as controlled by "Bypass export dialog and save as 
single file"). This will result in an exported file saved in the same directory as the datafile offloaded 
from the logger. Both files will also have the same prefix. If you do not want to save it to the default 
directory or use the default name, then select "Show export dialog" instead to select your own 
directory or name. 

• Include plot details in exported file. When this setting is enabled, the information that appears to the 
left of the plot in the Details pane (series information, the type of logger, deployment information, 
etc.) will be included in the exported file along with the sensor data. This option only applies to text 
(.txt or .csv) file type exports, not Excel. It also requires that the file is saved and plotted before 
exporting. Therefore, it is not compatible with exports done via the Bulk Export Tool or HOBOnode 
Manager's Data Delivery and Plot/Export Wireless Data features. Finally, select a tab or semicolon for 
the "export table data column separator" when using this option. If you choose a comma separator, 
then details may span multiple cells. 

• Use export ordering rules. Select this option to define the order that series are listed in the Export 
window by default. Select the measurement type from the drop-down list and then click Add to add it 
to the ordering rules list. In this example, we have set the order to temperature, RH, rain, wind speed, 
and then wind direction. This means the Export window will always show any temperature, RH, rain, 
wind speed, and then wind direction series first in the list, in that order, followed by any series that 
were not defined in the rules. (You can override this order as needed in the Export window by clicking 
the column header or dragging a row.) To delete an item from the ordering rules, click the 
measurement type and then click Remove. To change the order of items, drag them up or down. 
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Communications Preferences  
Use the Communications category within Preferences to set the default device type, serial port, device speed, and 
status window operation. 

To change these settings: 

1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 

2. Select the Communications category on the left and then click the subcategory you wish to change. 

3. Adjust any of the settings described below and then click OK. 

Device Types (HOBOware Pro Only) 
This preference controls the type of devices HOBOware recognizes when connected to the computer: USB, serial, 
or both. If you only use USB loggers or serial loggers, select the corresponding preference. This will save time as 
HOBOware will only check the USB or serial port(s) for a connected device when selecting Launch, Readout, Status, 
or Stop from the Device menu. If you use both USB and serial loggers regularly, select "USB and serial devices." You 

can also quickly change this preference by using the pull-down menu next to the Select Device icon  on the 
toolbar. 

 

Serial Ports (HOBOware Pro Only) 
This preference controls which serial ports you want HOBOware to check for a connected device. Click Select All to 
check all serial ports displayed in this list or choose specific serial ports. Note that if you want to use only one port, 
you can have only one serial logger connected at a time. Alternatively, checking multiple serial ports can cause 
slow performance even when no loggers are connected. 
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Device Speeds 

• Serial port speed. Select "Fast serial enabled" (HOBOware Pro only) to read out a serial logger at a 
speed appropriate for most systems. Disable this option only if you are having communication 
problems with the logger, such as when the logger is connected via a slow serial-to-LAN bridge device. 
Communication between the computer and the logger is slower when this option is disabled. 

• USB logger readout. Select "Fast readout enabled" to read out a USB logger quickly. Disable this 
option only if you are having communication problems with the logger. Communication between the 
computer and the logger is slower when this option is disabled. 

 

Other Options 
Select "Close the status window on logger disconnect or communication error" if you want the Status window to 
close automatically (on the next refresh) if it is open when you remove the interface cable, base station, or coupler 
from the logger, or if communication is interrupted for another reason. Deselect this option if you want to leave it 
open. Note that if the Status window was opened from the Launch Logger window, it will close automatically even 
if this option is not selected. 

 

Plotting Preferences 
Use the Plotting Preferences to control fonts, series lines, Y-axis, and several other plot elements. 

To change these settings: 

1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 

2. Select the Plotting category on the left and then click the subcategory you wish to change. 

3. Adjust any of the settings described below and then click OK. 

Notes: 

• To apply certain preferences to a single series, double-click the series to open the Series Properties 
window. 

• To apply changes to real-time plots in HOBOnode Manager, restart HOBOnode Manager or remove 
the plot for the sensor and then add it back (deselect the Plot checkbox for the sensor to remove it 
and then select the Plot checkbox again to add it back. 



HOBOware User’s Guide 

1-800-LOGGERS 202 www.onsetcomp.com 

Fonts  
Use the Fonts Preferences to control the font size, type, style, and color for most text on the graph (HOBOware 
Lite has font preferences for size only). Note that the plot title font will be two points larger than the selected font 
size.  

 

Lines (HOBOware Pro only) 
Use the lines preferences to define the appearance of lines in the plot for a specific series type. Rules added will 
appear in the panel at the bottom. Only one rule can be added per series type. To delete a rule, click the delete 
button on the row. 

 

• When plotting multiple rules of the same type. If "Use the same color for each series" is 
selected, then multiple series of the same unit type (for example, multiple temperature series) are 
plotted with the same color, but with different line styles (solid, dashed, dotted, etc) to differentiate 
them. If "Use a different color for each series" is selected, then multiple series of the same unit type 
will be plotted in different colors. The series will still be attached to a single, common Y-axis, but only 
one series will match the axis color. 

• Use Rules. Select this box to set up rules for series lines on the plots. Then select the series type for 
the rule you want to set up. Select the size and style of the series line. Click the Choose button to 
select a line color. Click the Add Rule button to create the rule. Line size, style, and color will be 
applied on series lines, the corresponding Y-axis (value axis), and its corresponding representation in 
the legend. This rule will be overridden by any changes you make in the Series or Axis Properties 
window. To add another rule, select a different Series Type, choose the settings, and then click Add 
Rule. To delete a rule, select it and click the Remove button. 

Value Axis (HOBOware Pro only) 
Select the Use Rules box to set up rules about the minimum and maximum values used on the Y-axis (value axis) 
for a specific measurement type. Select the measurement type and then type in the minimum (Bound Min) and 
maximum (Bound Max) you want to use. Select the Unit Type and then click Add Rule to create the rule. This rule 
can be overridden by any changes you make in the Axis Properties window. To add another rule, select a different 
measurement type, choose the settings, and then click Add Rule. To delete a rule, select it and click the Remove 
button.  
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Layout  

• Show the details pane when plotting data. Select this preference to automatically display the 
details pane with the plot. 

• Show the points table when plotting data. Select this preference to automatically display the 
points table with the plot. 

 

Points Table & Details Pane  

• Use sensor Label (if available) in points table and details pane (HOBOware Pro Only). Select 
this preference to display the sensor label (if available) as added in the Launch Logger window with 
corresponding column header in the points table and in the details pane. This is especially useful if 
there are multiple sensors of the same measurement type in the same file (for example, a 
HOBO Micro Station datafile with three temperature sensors).  

• When selected value in table is out of plot range, drag series to that value. Normally, if the 
plot is zoomed in and you select a point in the Points table that is outside the zoom area, the plot will 
scroll so the marked point is in view, while retaining your zoom factor. Clear this box if you do not 
want to scroll to points outside of the current view.  

 

Gridlines  

• Enable horizontal gridlines when plotting data. By default, horizontal gridlines are not displayed 
when you open a plot. Enable this option if you always want a new plot to display gridlines for all 
value axes. 

• Enable vertical gridlines when plotting data. By default, vertical gridlines are always displayed 
when you open a plot. Clear this checkbox if you never want a new plot to display gridlines for the 
time axis. 
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Plot Setup  

•  Automatically select all data series for plotting. By default, some series (such as Dew Point) are 
not selected for display in the Plot Setup window. Enable this option if you want every series to be 
selected automatically in the Plot Setup window.  

• Automatically select internal events for plotting (e.g. Button Up/Down, Host Connected, 
EOF). By default, all internal events are selected for display in the Plot Setup window. Disable this 
option if you do not want these events to be selected automatically in the Plot Setup window. 

• Automatically select pre-defined Data Assistants or Filtered series for plotting instead of 
the source series. This option controls whether any series from Data Assistants and filters that you 
configured in the Launch Logger window are automatically selected in the Plot Setup window. Disable 
this option if you do not want these series selected automatically in the Plot Setup window. 

• When Light and Occupancy are enabled as State on the same logger, derive four possible 
Light/Occupancy state channels. For UX90-005x and -006x series loggers, this option controls 
whether four additional data series are automatically calculated and available for plotting. These 
series are: 

• Lights on & occupied (Light On & Occ) 

• Lights on & unoccupied (Light On & Unocc) 

• Lights off & occupied (Light Off & Occ) 

• Lights off & unoccupied (Light Off & Unocc) 

Disable this option if you do not want these series to be generated when plotting data. 

 

Other Options  

• Mark all points when plotting data. This preference controls whether each data point is marked 
on the series. Point markers are not displayed by default (except for events and for a series with only 
one data point) to avoid cluttering the plot. Enable this option if you want all points to be marked on 
every series whenever you display a plot. Keep in mind, however, that marking all points on a large 
plot takes longer and consumes more system memory. 

• Label the time axis. Select this option if you want the default label "Time" to be displayed with the 
time axis (X-axis). 

• Use sensor labels (if available) in legend. Select this option if you want any available sensor labels 
as added in the Launch Logger window to appear in the legend with the series name.  
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Undo & Redo 
This preference controls whether you can undo and redo the changes you make to plots. When the Undo & Redo 
preference is enabled, you can specify how many changes to plots will be stored within HOBOware. If you select 
"Number of stored undoable actions," then there will be a limit to the number of changes to the plots that you can 
undo. For example, if you choose to store 25 undoable actions, then you will be able to undo the last 25 changes 
that you made to the plots, but not the 26th. You can configure HOBOware to store from 1 to 50 undoable actions 
(changes to the plot) with this setting. If you select "Enable unlimited undoable actions," then there will be no limit 
to the number of changes to the plots that you can undo. Note that storing an unlimited number of actions can 
impact HOBOware performance on slower computers. 

 

Data Assistant Preferences  
Use the Data Assistant category within Preferences to control which Data Assistants are displayed in the Plot Setup 
window. 

To change these settings: 1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 2. Select the Data Assistant category on the left and then click the Data Assistants subcategory. 3. Adjust any of the settings described below and then click OK. 

 
When you read out a logger or open a datafile, all compatible Data Assistants are listed in the Plot Setup window 
by default. Deselect the checkboxes for any assistants that you do not want to display in the Plot Setup window. 
Or, click Show All to display all compatible assistants in the Plot Setup window or Hide All to display none of them. 

Display Preferences 
Use the Display category within Preferences to control the default units, date/time format, and series options 
displayed in plots. 

To change these settings: 1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 
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2. Select the Display category on the left and then click the subcategory you wish to change. 3. Adjust any of the settings described below and then click OK. 

Default Units 
This preference controls the units used throughout HOBOware: either US or SI (Metric). This will change the units 
shown on the axis, legend, points, and details the next time you display a plot. This will also change the current 
readings the next time you open the Status window. 

 

Date/Time 
These settings control how the date and time appears in HOBOware. Changes you make are shown in the date and 
time sample. Any plots that may be open when you make changes to the date and time display will require the 
plots to be redrawn, which may take several seconds. As noted in the preferences, date and time formatting 
beyond what is specified in these settings are determined by the computer operating system. Note: When you 
export a file, the date and time are exported as determined by the Export Settings in Preferences (except for year 
format, which is only controlled by these Date/Time settings in the Display category. If you open the file in Excel, 
the dates and times may be automatically reformatted to Excel's default date and time format, which you may 
customize within Excel. 

 

• Date format. This controls how the date is displayed: Month, Day, Year; Day, Month, Year; or Year, 
Month, Day. 

• Date separator. This controls what character is displayed between the month, day, and year: a slash 
(/) or a dash (-). 

• Year format. This controls whether the year is listed as two of four digits. 

• Time format. This controls whether the time is shown in 12- or 24-hour format. 

• Use locale for all. Click this button to use the default settings for the current locale as configured in 
the operating system. 
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Series 
Use the Series preferences to customize how data series are sorted in the Status and Plot Setup windows and to 
set battery series options. 

 

• Select a sort order. Choose one of the following four ways to sort the series displayed in the Status 
and Plot Setup windows: 

 Logger's default: Series are sorted the same way they were listed in the Launch Logger 
window. 

 Enabled: All series selected, or enabled, for logging are displayed at the top of the list. 

 Label: Series are sorted by their label name, if available. Labels can be sorted in ascending 
or descending order (alphabetically or numerically depending on the label entered). 

 Measurement: Series are sorted by measurement type alphabetically in ascending or 
descending order. 

• Display derived series below their source series. A derived series is one that is calculated rather 
than recorded by a sensor. Some loggers have the capability to create datafiles that not only have 
logged sensor data, but also additional derived series automatically calculated in relevant units. One 
example is a logger with a temperature/RH sensor. The logger records a data series for temperature 
and another for humidity (two source series), which are used to calculate a dew point data series (the 
derived series). In addition, some loggers support filtering at launch time and using data assistants 
before or after launch, which also results in derived series. Select this option if you want any derived 
series to be displayed immediately following its source series in the Status and Plot Setup windows. By 
default, this option is disabled, which means all derived series are displayed at the bottom of the data 
series list. Note that status window support is limited for station loggers, such as the U30 Station. 

• Show the option to log battery. This setting controls whether you have the option to enable or 
disable the battery series in the Launch Logger window when applicable. You can configure some 
loggers to record the battery voltage at every logging interval. When this option is selected, you can 
choose whether to record the battery voltage at launch time. If this setting is not selected, then you 
cannot record the battery voltage and it will not be shown in the Launch Logger window. This setting 
is enabled by default. 

• Display logger's battery series in the last position. This setting controls whether the optional 
battery series is displayed at the bottom of the data series list in the Launch Logger, Status, and Plot 
Setup windows regardless of any other series settings. If this setting is not enabled, the position of the 
battery series in the data series list will vary based on other preferences. This setting is enabled by 
default. 

Warnings Preferences 
Use the Warnings Preferences to disable warning pop-ups that you do not want to appear. Before you do so, 
however, keep in mind that the warnings are intended to help prevent mistakes and inadvertent data loss. Review 
each warning carefully before disabling it. To re-enable a warning, re-select the check box. 
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To disable all of the warnings in a group, click the Select None button for that group. 

To enable all of the warnings in a group, click the Select All button for that group.  

You access the Warnings Preferences by going to File > Preferences > Warnings. 

To change these settings: 1. From the File menu on Windows or the HOBOware menu on Macintosh, select Preferences. 2. Select the Warnings category on the left and then click the subcategory you wish to change. 3. Adjust any of the settings described below. To disable all the warnings in a group, click the Select 
None button for that group. To enable all the warnings in a group, click the Select All button for that 
group. Click OK in the Preferences window to save changes. 

General 

• There is any remaining unsaved data when closing a plot or application. This warning reminds 
you when you made changes to a plot, but haven't saved the changes to a project file. 

• The project file being opened was created with a different version of HOBOware. This 
message warns you if you are opening a project file that was saved in different version of HOBOware 
than you are currently using. In some instances, there may be differences in software versions that 
could affect the project file. 

 

Warnings Before the Launch Screen 
These preferences control warnings that appear when the logger is connected to the computer and you select 
Launch from the Device menu or the Launch icon from the toolbar. If enabled, these warnings will display before 
the Launch Logger window is opened. 

• The logger is waiting for a delayed start. This warning indicates that the logger has already been 
configured to start logging on a specific date and time; logging has not begun. 

• The logger is waiting for a triggered start. This warning indicates that the logger has already been 
configured to launch with a push button or triggered start, but logging has not begun. 

• The logger is currently logging (Station Loggers only). This warning indicates the a station-type 
logger (U30, HOBO Weather Station, HOBO Micro Station) is currently recording data. 

• The logger needs to be readout (USB devices only). This warning indicates the data on the USB 
logger (U-Series) has not been offloaded, or read out, yet. 
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Warning After the Launch Screen 
These preferences control warnings that appear after you click the Start button in the Launch Logger window. 

• The Temperature channel is disabled but required to log Pressure. For some loggers that 
record barometric pressure data, the temperature must also be logged. This message warns you if you 
selected the pressure sensor or channel in the Launch Logger window, but not temperature. 

• The Temperature channel is disabled but required to log Relative Humidity. For some loggers 
that record relative humidity data, the temperature must also be logged. This message warns you if 
you selected the relative humidity sensor or channel in the Launch Logger window, but not 
temperature. 

• The specified delay time is in the past. This warning indicates that you have selected a start date 
or time for logging that is in the past instead of the future. 

• The specified delay time is past the sensor cap expiration. This warning indicates that the date 
or time you selected for the launch to begin is past the U26 Dissolved Oxygen logger sensor cap 
expiration date. 

• The logging duration could extend past the sensor cap expiration. This warning indicates that 
projected logging duration (the amount of time it takes for the logger's memory to fill) lasts beyond 
the U26 Dissolved Oxygen logger sensor cap expiration date. 

• The logging interval specified is too small for the TRMS module (HOBOware Pro only). This 
warning indicates that the logging interval (how often the logger records data) is not supported by the 
TRMS module in a U30 station logger. 

• The Battery channel is disabled but recommended when using excitation power 
(HOBOware Pro only). This warning indicates that the battery channel in the Launch Logger window 
has not been selected on a U30 or FlexSmart logger configured to use excitation power. 

• The logger's battery power is too low to provide excitation to external sensors (HOBOware 
Pro only). This warning indicates the battery is too low for a U30 or FlexSmart logger that has been 
configured to power excitation to external sensors. 

• The Battery channel is enabled but will not log data without other sensors attached 
(HOBOware Pro only). This warning indicates that you have only selected the battery channel in the 
Logger Launch window and no other sensors. 

• The header size of an optic logger may cause problems with older shuttle firmware 
(HOBOware Pro only). This warning indicates that if you will be offloading an optic logger to a 
HOBO shuttle, the shuttle should have the latest firmware installed. Otherwise, the header size (part 
of the logger data file) could cause the offload to fail or result in a corrupted file. 



HOBOware User’s Guide 

1-800-LOGGERS 210 www.onsetcomp.com 

 

Restoring Default Preferences 
To return all preferences to their original settings in both the Preferences and custom-defined Launch Logger 
window settings (State Description, % or Time, Logging Interval), open the Preferences window (click the File menu 
in Windows or the HOBOware menu on Macintosh and select Preferences). Click the Restore Defaults button. 

 
A message appears asking if you are sure you want to restore all preferences to their default values. Click Yes to 
restore the default preferences. In addition to the options configured in the Preferences window, the following 
settings are also affected: 

• Data File Folder Locations.  When you restore the preference defaults, the default folder locations 
for datafiles, text files, and project files is reset to: 

 C:\Documents and Settings\<user>\My Documents\HOBOware 
(for Windows XP) 

 C:\Users\<user>\Documents\HOBOware 
(for Windows 7 or Windows 8) 

 Users/<user>/Library/Application Support/HOBOware 
(for Macintosh OS X) 

• FlexSmart modules or Analog Sensor Ports channel names and units (HOBOware Pro Only). 
Any custom-defined channel names and units for FlexSmart modules or Analog Sensor Ports are 
removed from the pull-down menus in the Configure Channel window. However, this will not affect 
customized channel names and units that you saved in configuration files (.hcfg). 

• HOBOware software updates. The date and time of the most recent check for HOBOware software 
updates will not be retained. A message will appear next time you reopen HOBOware asking if you 
want to check for updates. 

• Custom-defined Launch Logger window menus. Any custom-defined Launch Logger window 
settings, such as State Description, % or Time, Logging Interval, will be cleared. 
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Menus 
The following menus are available in HOBOware: 

• HOBOware (on Macintosh) 

• File 

• Device 

• Edit 

• View 

• Tools 

• Window 

• Help 

The HOBOware Menu 
The HOBOware menu is available on Macintosh only. Some of the menu options available from the File menu in 
Windows are displayed here instead on Macintosh. 

 
The HOBOware menu options are: 

• About HOBOware. Select this option to open a compatible datafile. See Opening Files for more 
information. 

• Preferences. Select this option to open the Preferences window where you can change the default 
settings in HOBOware. See Setting Preferences for more information. 

• Services. This is a Macintosh operating system menu option.  

• Hide HOBOware. This option hides HOBOware from view. 

• Hide Others. This option hides all currently open programs except for HOBOware from view. 

• Show All. This option displays all currently open programs. 

• Quit. Select this option to close HOBOware. 
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The File Menu 
From the File Menu, you can open and close datafiles and projects, import and export data, and print plot 
elements. 

 
The File menu options are: 

• Open Datafile(s). Select this option to open a compatible datafile. See Opening Files for more 
information. 

• Merge Datafile(s). Select this option to add a datafile to the end of another datafile. See Merging 
Datafiles for more information. 

• Open Project. Select this option to open a HOBOware project. See Opening Files for more 
information. 

• Plot/Export Wireless Data. This applies to a ZW series wireless network and is only available in 
HOBOware Pro. See Plotting or Exporting Wireless Data for more information. 

• Recent Files. Select this option to quickly access the last 10 files you opened. 

• Close. Select this option to close the active file or project. 

• Close All. Select this option to close all open files and projects. 

• Save Datafile. Select this option to save the active datafile. 

• Save Project. Select this option to save the active project. 

• Import Text Data. Select this option to import and graph non-HOBOware data in certain text files 
(available in HOBOware Pro only). See Importing Text Files for more information. 

• Import Text File from HOBOlink. Select this option to open a text file generated by HOBOlink for a 
HOBO U30 Station. 

• Export Details. Select this option to export the information in the Details Pane into a text file that 
can be opened in any text editor or imported into many other types of programs (word processors, 
spreadsheets, etc.). See Exporting Details for more information. 
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• Export Table Data. Select this option to export the points shown in the Points table to a text file 
(.csv or .txt) or Microsoft Excel (.xls) file. See Exporting Table Data for more information. 

• Page Setup. Select this option to set up the paper size, margins, and orientation for printing a plot. 

• Print Preview. Select this option to preview the page for printing a plot. 

• Print. Select this option to print a prot. 

• Print Details. Select this option to print the Details Pane. 

• Print Points. Select this option to print the Points Table. 

• Preferences. Select this option to open the Preferences window where you can change the default 
settings in HOBOware. See Setting Preferences for more information. Note that Preferences is 
available from the HOBOware menu on Macintosh. 

• Quit. Select this option to close HOBOware. Note that this is available from the HOBOware menu on 
Macintosh. 

The Device Menu 
Use the Device menu to launch, read out, and stop loggers as well as access HOBOnode Manager and work with 
other features for specific devices. 

 
The Device menu options are: 

• Launch. Select this option to open the Launch Logger window where you can set launch settings and 
start the logger. 

• Readout. Select this option to offload, or read out, data from the logger to your computer, allowing 
you to save the data in a datafile and view the plot in HOBOware. 

• Status. Select this option to view the current status of the logger, including current readings (for 
some sensors), remaining battery, and logger memory. 

• Stop. Select this option to stop a device. 

• Manage Shuttle. Select this option to manage a HOBO shuttle (available for HOBOware Pro only). 
See Working with a Shuttle for more information. 

• Manage HOBO Data Node Network. Select this option to open the HOBOnode Manager where 
you can manage a ZW series wireless network (available for HOBOware Pro only). 

• Configure Modules/Ports. Select this option to configure analog sensor ports on the HOBO U30 
station logger or FlexSmart modules (available for HOBOware Pro only). 
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• Manage U30. Select this option to access features specific to the HOBO U30 Station. From this menu 
option, select Control U30 Relay to configure the default state of a relay or to activate or deactivate 
the relay for testing (available for HOBOware Pro only). See Controlling the Relay on the HOBO U30 
Station for more information. Or, select Configure U30 Alarms to set up alarms on the HOBO U30 
Station (available for HOBOware Pro only). 

• Lab Calibration. Use this option to open the Lab Calibration tool used with the HOBO U26 Dissolved 
Oxygen Logger.  

• Select Device. Use this option to select a device currently connected to the computer. 

• Default Action. Select this option to set up HOBOware to perform the same action (Launch, Readout, 
or get Status) every time a logger is connected (available for HOBOware Pro only). See Repeating an 
Action on Multiple U-Series Devices for more information. 

• Utilities. Use the Utilities submenus to select one of the three Force Offload options only if you are 
having problems reading out your device or as directed from Onset Technical Support. You can also 
select the Reset UX Logger submenu option as directed by Onset Technical Support. 

The Edit Menu 
Use the Edit menu to modify the plot, including filtering series, removing series, setting properties, and converting 
units. 

 
The Edit menu options are: 

• Filter Series. Select this option to create a new series based on statistical analysis of an existing series 
over specified periods of time. See Filtering a Series for more information. 

• Copy Series. Select this option to copy a series and then paste it into another plot. See Copying a 
Series to another Plot for more information. 

• Paste Series. Select this option to paste a series into another plot. See Copying a Series to another 
Plot for more information. 

• Add Graph Label. Select this option to access the Graph Label Properties window to add labels to a 
plot that identify specific points or call attention to a region of the graph. See Adding Labels to a 
Graph for more information. 

• Remove Series. Select this option to remove series from a plot after you have selected it in the 
graph or the Details pane. If you remove a series, it can only be recovered by reopening the original 
datafile or a saved project file that contains the series. 

• Graph Properties. Select this option to access the Series Properties window. See Setting Series 
Properties for more information. 
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• Convert Units. Select this option to access the Convert Plot window, which allows you to convert 
some or all of the series on the currently focused plot to other units (for example, from degrees 
Fahrenheit to degrees Celsius). Note that changing the units will result in the entire plot being 
redrawn. See Converting Units for more information. 

• Undo Action. Select this option to undo the last change made to the current plot. The most recent 
change is listed after the Undo Action menu choice. In this example, the most recent change to the 
plot was to "Zoom Out." See Undo and Redoing Plot Changes for more information. 

• Redo Action. Select this option to redo the last change that was previously undone. See Undo and 
Redoing Plot Changes for more information. 

• Copy Graph to Clipboard. Select this option to copy the graph to the clipboard to paste it into 
another application. 

The View Menu 
Use the View menu to change the appearance of the plot, including zooming, showing or hiding components, 
marking points, and setting gridlines. 

 
The View menu options are: 

• Zoom In. Select this option to zoom in on the plot. 

• Zoom Out. Select this option to zoom out on the plot. 

• View Full Scale. Select this option to view the plot in full scale. 

• Details Pane. Select this option to show or hide the Details Pane. 

• Points Table. Select this option to show or hide the Points Table. 

• Show Title. Select this option to show or hide the title of the plot. 

• Show Legend. Select this option to show or hide the plot legend. 

• Mark All Points. Select this option to mark all points on the plot. 

• Vertical Gridlines. Select this option to show or hide vertical gridlines on the plot.  

• Horizontal Gridlines. Select this option to show or hide horizontal gridlines on the plot.  
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• Select None. Select this option to deselect all elements in the plot. 

• Remove Crosshair. Select this option to remove crosshairs from the graph. 

• Remove Subset Stats. Select this option to remove subset statistics from the plot. 

• Bring Series To Front. Select this option to bring a series to the front on the plot on top of all other 
series. 

• Send Series To Back. Select this option to send a series to the back of the plot behind all other 
series.  

The Tools Menu 
Use the Tools menu to access the Bulk File Export tool, which allows you to export numerous datafiles at one time. 
See the Bulk Export Tool for more information. 

 
Note: The Alarm & Readout Tool is also available from this menu if it was installed in older version of HOBOware 
Pro. This tool is no longer installed as of HOBOware version 3.4. 

The Window Menu 
Use the Window menu to organize several plots.  

 
The Window menu options are: 

• Tabbed View. With this option, plots are layered as tabs so you can see the file name of each open 
plot (or "Untitled*" for an unsaved datafile). You can also get to this view by clicking the Tabs icon in 
the lower left of the window. 

• Tile Horizontally. Select this option to arrange up to five plots horizontally. If six or more plots are 
open, they will be tiled as a grid. You can also get to this view by clicking the Horizontal Tile icon in the 
lower left of the window. 

• Tile Vertically. Select this option to arrange up to five plots vertically. If six or more plots are open, 
they will be tiled as a grid. You can also get to this view by clicking the Vertical Tile icon in the lower 
left of the window. 

Tip: You can open the same datafile multiple times to create different views of the graph, then use the Tile 
commands on the Window menu (or resize and move the windows manually) to see all of them at once. This is 
helpful if you want to zoom in on several different areas and view them side-by-side, see the detail of a small area 
while the full graph is still in view, or view each series in a different window. 

The Help Menu 
Use the Help menu to get more information about HOBOware, upgrade the software and certain devices, and 
request help from Onset Technical Support.  
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The Help menu options are: 

• HOBOware Help. Select this option to open the help system, displaying the full table of contents. 

• Check for Software Updates. Select this option to check if there are any HOBOware updates 
available on the Onset website. You can also set the general startup settings in Preferences to 
automatically check for software updates on a schedule that you select. 

• Update Device Firmware. Select this option to check if there are firmware updates available for 
certain devices. This option is only enabled when either a HOBO U-Shuttle or HOBO UX series logger is 
connected to the computer. Select the appropriate submenu for your device, either "Update U-DT-
1/U-DT-2 Firmware" for a HOBO U-Shuttle or "Update UX Series Logger Firmware" for a logger. You 
likely will only need to do this as directed by Onset Technical Support. Note that firmware updates for 
HOBO ZW series receivers and data nodes are completed within HOBOnode Manager. 

• Manage License Key. Select this option if you need to enter a new license key. This is only necessary 
if you are running a trial version of HOBOware and have a new license key to enter, or if you are using 
HOBOware Lite and have a license key to upgrade to HOBOware Pro. 

• Enable/Disable Logging. Select this option to turn on or off logging within HOBOware. When 
logging is enabled, a series of text files will be generated and saved every time you use HOBOware. It 
is recommended that you only enable logging when requested to do so by Onset Technical Support, 
who may need additional files to troubleshoot any technical problems you may be having with the 
software. 

• Submit Technical Support Request. Select this option if you are having a problem with HOBOware 
and would like to request help from Onset Technical Support. Fill in all the requested information in 
the form, including your name, email address, logger/device model name and serial number, and a 
detailed description of the problem you are encountering. 

• About HOBOware. Select this option to see which version of HOBOware you are using in Windows. 
This option is available from the HOBOware menu on Macintosh. 

The Toolbar 
The toolbar, located at the top of the main HOBOware window, allows point-and-click access to the most 
frequently used functions. Pause the pointer over each icon on the toolbar for a description of each tool. 

 

Launch -  - Opens the Launch window. 

Readout -  - Opens the Readout window. 

Status -  - Opens the Status window, which displays the logger's state and current readings. 
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Stop -  -Stops a logging logger. 

Select Device -  - Opens the select Device window, which displays available devices. For HOBOware Pro, the 
accompanying pull-down menu allows you to specify whether you want HOBOware to look for USB devices, serial 
devices, or both. 

Set Default Units -  - Change the default unit type between US and SI. Any changes you make will take effect 
with the next plotted file. 

Undo Action -  - Undoes the most recent change made to the plot. 

Redo Action -  - Redoes the most recent change that was undone to the plot. 

Open -  - Launches the Open window, from which you can open HOBOware files. 

Save -  - Opens the Save window, from which you can save the plot as a project (.hproj) file. 

Close -  - Closes the currently focused plot. 

Export -  - Opens the Export Options window, from which you can configure settings for exporting a text file of 
the data (in .csv or .txt format) for use in spreadsheet and other applications. 

Print -  - Prints the graph as it appears on your screen. 

Arrow -  - Launches the Arrow Tool, which you can use to point to and select items on the graph to edit their 
properties. 

Crosshair -  - Launches the Crosshair Tool, which you can use to display values for points on the graph and cross-
references them to cells in the Points pane. 

Hand Drag -  - Launches the Hand Drag Tool, which you can use to scroll an axis or the entire graph. 

Zoom -  -Launches the Zoom Tool, which you can use to adjust the scaling of an axis or the entire graph. 

Subset Statistics -  -(HOBOware Pro Only) Launches the Subset Statistics Tool, which you can use to view statistics 
for a particular time span. 

Zoom In -  - Launches the Zoom In Tool, which allows you to zoom in on a smaller area of the graph. 

Zoom Out -  - Launches the Zoom Out Tool, which allows you to zoom out to a larger area of the graph. 

Show Graph at Full Scale -  - Resets the scale of a graph to accommodate all of the displayed data. 

Graph Properties -  - Opens the properties window for the element currently selected (such as series, legend, 
axis). 

Vertical Gridlines -  - Toggles vertical gridlines on or off. 

Horizontal Gridlines -  -Toggles horizontal gridlines on or off. 

Mark Points -  -Toggles point markers on or off. 

Convert Units -  -Opens the Convert Units window, which allows you to convert some or all of the series on the 
currently focused plot to other units (for example, from degrees Fahrenheit to degrees Celsius). 
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Filter Series -  -You can create a new series based on statistical analysis of an existing series over specified 
periods of time. 

Pie Chart -  -Opens the Pie Chart window in which you can view, print, and save a pie chart for plotted state 
series. 

Add Graph Label -  -Opens the Graph Labels Properties dialog, which allows you to add a label to the plot or to 
a specific series, and change the appearance of that label. 

Help -  - Opens the Help. 

Tips for Working with Multiple Loggers 
HOBOware Pro has several built-in features that allow you to bypass some of the repetitive work of launching and 
reading out multiple loggers. These features not only will save you time, but also will help ensure your loggers are 
launched with consistent settings. Follow these tips if you plan to launch or read out many numerous loggers of 
the same type with identical settings. 

General Settings 

• Change the Device Types preference to one device type. Depending on the selections you made 
when installing HOBOware, it may be configured to search for both serial and USB devices. If you are 
only using USB devices you can bypass the Select Device Type and save time. To bypass the Select 
Device Type window, select Preferences from the File menu. Under the Communications preferences, 
select Device Types. Choose either "USB devices only" or "Serial devices only." 

 

Launching Multiple Loggers 

• Check the Description name. Use a logger serial number or your own unique identifier in the 
Description field in the Launch Logger window as shown in the example below. The name of the 
launch description is important because it is also used as the default file name when you read out the 
logger. Using unique names here will eliminate the need to individually name files during readout. 

 

• If you plan on launching multiple loggers of the same type with the same settings (i.e. start 
time, logging interval, etc.), set up and start one logger first. To do this, open the Launch 
Logger window for one logger. Enter your settings for the launch. Double-check that they are correct 
and then start the launch. Setting and starting this one logger will create a model for all the other 
loggers of the same type to follow. The key to success is making sure the settings are exactly as you 
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want so be sure to double-check or even triple-check them. You want to be certain the first logger is 
right! 

• Set the Launch Time-Saving preferences to use the previous logger’s launch settings. From 
the File menu, select Preferences. Select General and then click Launch Time-Saving Options. Under 
"When launching," select "Show launch screen" and under "Launch with contents of," select "Previous 
launch" to use the same launch settings from the last logger that was launched (same logger model 
only). 

 

• Change the Default Action option (USB devices only). Under the Device menu in HOBOware, 
change the Default Action from "Do Nothing" to "Launch." If you also set the launch time-saving 
preferences to "Automatically launch," then this allows you to launch numerous U-Series loggers in a 
row simply by plugging and unplugging individual loggers. If you set the launch time-saving 
preferences to "Show launch screen," this will still save you the step of manually selecting Launch 
from the toolbar or the Device menu for each logger. Change this back to "Do Nothing" when you’re 
done. Note: If this is the first time you have used the logger on the computer, you may have to plug 
the logger in, unplug it, and then plug it back in. 

 

• Test that your changes have taken effect. Connect a different logger of the same type to the 
computer. The Launch Logger window for that logger should immediately open the settings should 
match what you set up in the first logger. Press Enter or click the Start button in the Launch Logger 
window and the logger will start (note that the wording on the Start button may vary depending on 
when logging is scheduled to begin). You can do this repeatedly for loggers of the same type. 

• Optional: Set the preferences to skip the launch window. If you are comfortable with the 
previous steps, you can also set up HOBOware to bypass the Launch Logger window entirely. From the 
File menu, select Preferences. Select General and then click Time-Saving Options. Under "When 
launching," select "Automatically Launch" to skip the launch window. Note: If you need to change the 
launch description for each logger, then select "Show launch screen" instead. 
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Reading Out Multiple Loggers 

• Set the Readout Time-Saving preferences. From the File menu, select Preferences. Select General 
and then click Readout Time-Saving Options. Under "When Saving datafile," select "Automatically 
save" instead of "Show save dialog." Under "When plotting," select "Do not plot." This bypasses the 
save dialog that normally appears during readout and automatically saves the data file to the default 
directory without plotting the data. Note: If you also want the logger to continue logging after 
readout, uncheck the "Ask to stop logging before reading out a running logger" checkbox. If you need 
to stop the logger, keep that option checked. You’ll then see a prompt to stop the logger during each 
readout. 

 

• Change the Default Action option. Under the Device menu in HOBOware, change the Default 
Action to "Readout." This feature will automatically initialize the Readout sequence every time you 
connect a logger to the computer (with HOBOware open). This will still save you the step of manually 
selecting Readout from the toolbar or the Device menu for each logger. 

 

Setting the Language/Format on Your Computer 
The HOBOware user interface has been translated from English into four languages, which are supported by four 
specific formats. These languages and formats are: French (France), Spanish (Spain), Portuguese (Portugal), and 
German (Germany). To change the language displayed in the HOBOware user interface, you must change the 
language/format settings on your computer as described below. 

Notes:  

• The supported languages only work with the specific format or country listed above. For example, 
Portuguese is supported in the Portugal format only and not with Brazil. 

• The HOBOware Help and all related documentation are available in English only. 

• If you are using HOBOnode Manager: The language in use at the time the original HOBO data 
node network database was created is the only language that can be used for that database. You 
cannot switch to another language. If you need to change the locale on the computer that contains 
your HOBO data node network database, you must first back up and then move or rename the 
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database before changing the locale on the computer. Then, form a new network to create a database 
that operates in the new locale. 

On Windows 7 and Windows 8: 

1. Close HOBOware. 

2. Open the Control Panel and select "Region and Language." 

3. Under the Formats tab, select the desired language/format and click OK to save the changes. 

4. Reopen HOBOware. 

On Windows XP: 

1. Close HOBOware. 

2. Open the Control Panel and double-click the "Regional and Language Options." 

3. Under the Regional Options tab, select the desired language/format and click OK to save the changes. 

4. Reopen HOBOware. 

On Macintosh OS X: 

1. Close HOBOware. 

2. Open System Preferences and access the "Language & Text" Preferences. 

3.  Under the Language tab, drag the desired language to the top of the list. If the desired language does 
not appear in the list, click the "Edit List…" button to add it. 

4.  Under the Formats tab, ensure the correct Region is selected in the drop-down menu. Example: For 
Spanish (Spain), Spanish must be first in the Language list, and Spain must be selected under the 
Region drop-down menu. 

5. Reopen HOBOware. 

Alarm & Readout Tool 
IMPORTANT: The Alarm & Readout Tool is no longer installed with HOBOware as of version 3.4. This help 
section is included for reference only for existing Alarm & Readout Tool users. 

The Alarm & Readout Tool is a plug-in tool that works in conjunction with HOBOware Pro to monitor select HOBO 
data loggers, read them out, and notify you when sensor and logger conditions fall outside the limits you specify. 

Notes: 

• Alarm sensor conditions cannot be set on state or event channels. Only logger conditions, such as 
communication, memory, and battery level, can be monitored for state and event loggers (U9-001 
and U11-001).  

• To set up a scheduled readout for a state and event loggers (U9-001 or U11-001 models) with partial 
readouts, the battery channel must be configured to log valid timestamps using any battery logging 
interval. 

• The HOBO 4-Channel Pulse Input data logger (UX120-017) and UX90 series loggers are not supported 
with this tool. 

• Data assistant and filtered series configured at launch time are not compatible with this tool. These 
series will cause the tool to read the data incorrectly. 

• Alarm & Readout Tool email notifications do not support SSL or port configuration. 
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Connecting loggers 
The Alarm & Readout Tool can perform scheduled readouts and monitor sensor conditions, communication status, 
memory usage, and battery level on supported loggers.  

Tip: Loggers that require a base station to communicate will experience more rapid battery drain when left in the 
coupler. Refer to your logger's manual for more information. 

For most reliable operation, it is recommended that you use direct USB or serial port connections for your loggers 
and base stations. If your computer does not have a serial port, you may use a USB port with a Keyspan USB Serial 
Adapter. 

In addition, remote connections to USB loggers are possible with a Keyspan or Tibbo USB Server connected to a 
local Ethernet port. (It is recommended that you use the Tibbo USB Server with Windows only.) The Alarm & 
Readout Tool does not support connecting serial loggers to a USB server via a serial adapter. 

Using the Alarm & Readout Tool: 

1. Connect a logger to the computer. The logger can be logging, waiting for a delayed or button start, or 
stopped. Important: A serial logger that is waiting for a delayed or button start cannot provide an 
updated sensor reading until the logger begins logging. Once a serial logger begins logging, it can only 
provide the last logged value. 

Tip: To avoid disrupting an active deployment, do not attach sensors to a serial logger if it is already 
logging. 

2. If you want to include scheduled readouts in your configuration, launch the logger (if it is not already 
launched) before starting the monitor. The logger must be logging, or waiting for a delayed or trigger 
start, in order to perform scheduled readouts. If you plan to use partial readouts with a wrap-enabled 
logger, the logger must not have wrapped before you start the monitor. If the logger wraps after the 
monitor is started but before the first partial readout, partial readouts will be discontinued. 

3. From the Tools menu, choose Manage Alarms, then choose New Configuration. 

4. Create and save a configuration. You must create at least one alarm condition OR readout schedule 
for each logger in the configuration. 

5. Click Start on the Configure Alarms and Readouts dialog to begin monitoring the logger. 

Software updates 
If you have an Internet connection, HOBOware Pro can periodically check the Onset website for software updates, 
including updates to the Alarm & Readout Tool. The default is to check once per week, but you can configure 
HOBOware Pro to check daily or monthly. In Preferences, go to the General pane. Click Startup and then select the 
how often you want to Check for HOBOware Updates. 

You can also check for updates manually at any time. Choose Check for Updates from the Help menu. 

Related Topics: 

• See Configuration for creating, saving, and exporting configurations. 

• See Monitoring for starting, viewing, hiding, and stopping the Alarm & Readout Tool monitor. 

• See Readout for the numbering scheme for readout files, and describe the format of text files. 

• See Preferences for the customizations that help you get the most out of the Alarm & Readout Tool. 
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Configuration 
IMPORTANT: The Alarm & Readout Tool is no longer installed with HOBOware as of version 3.4. This help 
section is included for reference only for existing Alarm & Readout Tool users. 

The Alarm & Readout Tool uses configuration files to save definitions of groups of loggers, alarm conditions, and 
scheduled readouts. 

• Create and save a configuration 

• Open and edit a saved configuration 

• Export a configuration 

Creating and Saving a Configuration 
To begin, open HOBOware Pro and connect the loggers and sensors you want to include in the configuration. The 
loggers can be logging, waiting for a delayed or button start, or stopped. 

Tip: You must create at least one alarm condition OR readout schedule for each logger in the configuration. 

If you want to include scheduled readouts in your configuration, launch the logger now (if it is not already 
launched). Once you start the monitor, the logger must be launched and either logging, or waiting for a delayed or 
button start in order to perform scheduled readouts. If you plan to use partial readouts with a wrap-enabled 
logger, the logger must not have wrapped before you start the monitor. If the logger wraps after the monitor is 
started, but before the first partial readout, partial readouts will be discontinued. 

Tip: To avoid disrupting an active deployment, do not connect sensors to a serial logger if it is already logging. 

Important: A serial logger that is waiting for a delayed or button start cannot provide an updated sensor reading 
until the logger begins logging. Once a serial logger begins logging, it can only provide the last logged value. 

Then take the following steps: 

1. Use the logger list and Logger pane to select and organize loggers. 

2. Use the Alarms pane to define alarm conditions. 

3. Use the Readouts pane to schedule readouts. 

4. Use the Notifications pane to set up notifications. 

5. Use the Messages pane to construct messages. 

6. Click Save to save the configuration. By default, configurations are saved in the 
Documents\HOBOware\Alarms folder with an extension of .halrm. 

7. To start the monitor now, click Start. If the monitor is already running, you will be warned that the 
monitor will stop the previous configuration before running the new one. 

To close the Configure Alarms and Readouts dialog without saving changes or starting the monitor, click 
Cancel. 

Logger Pane  

1. From HOBOware Pro's Tools menu, choose Manage Alarms & Readouts, then choose New 
Configuration. The Configure Alarms and Readouts dialog is displayed with the Logger pane selected. 

2. Click Add Logger to select the loggers for this configuration. From the resulting Add Loggers dialog, 
select the loggers you want to include, then click OK. 

3. The loggers you chose will appear in the logger list on the left side of the Configure Alarms and 
Readouts dialog. 
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• Click the folder icon  to create "groups" to organize your loggers. Logger groups can help 
you set up alarms or readout schedules for similar types of loggers. To add a logger to a group, 
click the logger's name to select it, then drag it to the group's folder. 

• To delete a logger from the configuration, click the logger's name, then click the trash icon . 

• To delete a group and all the loggers in it, click the group's name, then click the trash icon . 
(If you do not want to delete all of the loggers that are in the group, drag them out of the 
group before deleting it.) 

4. In the Logger pane, enter a Name (up to 25 characters) that will be used to identify the currently 
selected logger in the monitor, scheduled readouts, and notifications. The first 25 characters of the 
logger's most recent Launch Description will be used as the default; if you change the text here, the 
logger's Launch Description will not be affected. 

5. Enter the number of retry attempt(s) (if any) the Alarm & Readout Tool should make if the selected 
logger fails to respond for an alarm check or readout attempt. For most applications, one retry should 
be enough; there is a 60-second delay between retries. If the Alarm & Readout Tool encounters 
frequent logger communication failures during a deployment, you may wish to increase the number 
of retries. 

Tip: If the Interval for alarm conditions or readouts is too short to accommodate all retries, the remaining 
retries will be skipped so as not to delay the start of the next interval. 

Alarms Pane  

1. To define alarm conditions, click the Alarms icon  near the bottom of the Configure Alarms and 
Readouts dialog. 

2. Click a logger's name in the logger list to set the interval at which alarm conditions will be checked, 
and define alarm conditions for that logger. 

3. To copy this logger's alarm settings to other loggers in this configuration, select the setting you want 
to copy (interval, sensor condition(s), logger condition(s), or all Alarm settings) from the first drop-
down next to the Copy button. Then select the destination loggers from the second drop-down. You 
may choose a logger group, an individual logger, or Group: Loggers for all loggers. Click Copy to 
complete this step. 

• Copied intervals and logger conditions replace the destination loggers' alarm settings with 
those of the current logger. 

• Copied sensor conditions are added to the destination loggers' existing conditions, if any. They 
do not replace any sensor conditions that have already been defined for those loggers. When 
copying a sensor condition to a destination logger that is a different model than the source 
logger, the software tries to identify a similar sensor on the destination logger. If it does not 
find one, or if the sensor on the destination logger has a different measurement range than 
the sensor on the source logger, you will receive a warning message. You should then review 
the alarm conditions for each logger to make sure that they are what you expect. 

Alarms Fields 

Logger Selected 

Logger whose alarm settings are displayed. To work with alarm conditions for a different logger, select the logger 
from the logger list to the left. 
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Interval 

How often the Alarm & Readout Tool should check this logger for alarm conditions. The minimum alarm interval is 
one second for USB loggers and five seconds for serial loggers. The maximum is 23 hours, 59 minutes, and 59 
seconds. 

This interval is directly related to the sensor condition durations. If you change the interval after you have set up 
sensor conditions, be sure to adjust the sensor condition durations accordingly. 

Tip: If the logger requires a base station/coupler to communicate, refer to your logger's manual to determine 
whether it will go to "sleep" if the computer does not communicate with it more often than every 30 minutes. 

When loggers are added to a configuration and set to similar alarm intervals, the amount of time needed for the 
monitor to complete a polling cycle increases. (Adding sensor alarm conditions also slightly increases the amount 
of time needed.) This is particularly true of serial loggers. If a polling cycle takes longer than the interval, you will 
see unpredictable behavior in the monitor window and a delay in notifications. 

You may need to experiment to determine the best interval for your needs. If you encounter problems, a longer 
interval is recommended. Longer intervals also put less demand on the logger's battery. 

 (Refresh) 

If you have added sensors to a serial logger (or removed them), click this button to update the sensor list. 

Important: If you have removed a sensor for which a sensor condition has already been defined, the sensor 
condition will be deleted when you click Refresh. Also, if the logger is logging, clicking Refresh will cause the list to 
revert to the sensors that were connected at launch. 

Conditions to trip alarms (Sensors tab) 

Sensor conditions that have been added to this configuration. When any of these conditions are met, the monitor 
sends a notification. Note that a sensor can have more than one condition. 

Important: State and event channel activity cannot trigger alarms. 

To add a condition to this list, click Add Condition and use the dropdown lists to describe the condition. Choose a 
sensor, comparison type, value, units (if applicable), and duration needed to generate an alarm. 

Tip: The units you choose for a sensor condition will always be the units displayed for that condition in the monitor 
window and details, even if you switch units (US/SI) in HOBOware Pro preferences. 

The For Duration is directly related to the Interval. For example, if your Interval is 15 minutes, you can choose a 
Duration of 0, 15 minutes, 30 minutes, etc. With a Duration of 0, the alarm will trip on the first reading that meets 
the sensor condition. If the Duration is equal to the Interval (in this example, 15 minutes), the alarm will trip only if 
the condition is met for two consecutive readings; if the Duration is equal to two intervals (in this example, 30 
minutes), the alarm will trip only if the condition is met for three consecutive readings; and so forth. 

To remove a sensor condition from this list, click the trash icon  next to the condition. 

Conditions to trip alarms (Loggers tab) 

Click the Logger tab to select logger conditions (communication, memory, or battery) that can trip the alarm. These 
conditions are also subject to the Interval for alarms. When any of these conditions are met during an alarm 
interval, the monitor sends a notification. 

• When unable to communicate with logger: This condition occurs only after all logger 
communication attempts, including retries, for a given alarm interval have failed. (It does not apply to 
communication failures that occur during scheduled readouts; this condition can be enabled on the 
Readouts pane.) 

• When memory used is at or above n%: This condition occurs when logger memory reaches a 
threshold you specify. (Note that a serial logger that has been launched with wrapping enabled will 
always be at 100% once it has wrapped.) 
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Tip: If you choose the memory and/or battery conditions, be sure to specify limits for these conditions. 

• When battery level/voltage is at or below n: This condition occurs when battery power reaches a 
threshold you specify. 

Readouts Pane  
Important: To perform a scheduled readout, the logger must be logging, or waiting for a delayed or trigger start 
when you start the monitor. 

Tip: There are many preferences related to the formatting of text files and datafiles. 

1. To schedule readouts, click the Readouts icon  near the bottom of the Configure Alarms and 
Readouts dialog. 

2. Click a logger's name in the logger list to schedule readouts for that logger. 

3. Complete the Readouts pane. Readout options are described below. 

Logger Selected 

Logger whose readout schedule is displayed. To work with the readout schedule for a different logger, select the 
logger from the logger list to the left. 

Mode 

Type of readout, if any, for this logger. 

• Select Disabled if you do not want to schedule readouts for this logger. 

• Full reads out the full contents of the logger. (Refer to Preferences for options.) Performing a full 
readout each time puts more strain on the logger's battery. 

• Partial starts reading out where the last scheduled readout ended. (Refer to Preferences for options.) 
The initial partial readout reads out the full contents of the logger. 

Tips for partial readouts: 

• Partial readouts cannot be performed on loggers that have multiple logging intervals defined. 

• If the logger was launched with wrap enabled, you will not be able to create data (.dtf) files 
with partial readouts. However, you will still be able to create text (.txt) files. 

• The logger must have the same deployment number at readout time as it did when you started 
the monitor. If you relaunch the logger while the monitor is running, the deployment number 
will increase, and partial readouts will fail. 

• If you plan to use partial readouts with a wrap-enabled logger, the logger must not have 
wrapped before you start the monitor. If the logger wraps after the monitor is started, but 
before the first partial readout, partial readouts will be discontinued. 

Interval 

How often the Alarm & Readout Tool should read out the logger. Select a readout frequency from one minute to 
364 days, 23 hours, and 59 minutes. 

Tip: If the logger requires a base station/coupler to communicate, refer to your logger's manual to determine 
whether it will go to "sleep" if the computer does not communicate with it more often than every 30 minutes. 

When loggers are added to a configuration and set to similar readout intervals, the amount of time needed for the 
monitor to complete a readout cycle increases. This is particularly true of serial loggers. If a readout cycle takes 
longer than the interval, you will see unpredictable behavior in the monitor window, and a delay in readouts and 
notifications. 
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You may need to experiment to determine the best interval for your needs. If you encounter problems, a longer 
interval is recommended. Longer intervals also put less demand on the logger's battery. 

Tip: If you launch a serial logger with wrapping enabled, make a note of the logging duration on the Launch 
window in HOBOware Pro to determine how often you need to read out the logger to avoid missing data. For 
example, if the logger will fill and wrap within six days with the connected sensors and you configure the Alarm & 
Readout Tool to read it out every seven days, you will miss a day's worth of data each week. If data loss is 
detected, scheduled readouts will fail, and no further readout attempts will be made. 

File name 

Keep the default File name (the logger name), or enter a new one. 

Tip: Be sure to use a unique file name for each of the loggers in a configuration. 

Local Disk 

Enable Local Disk to store the files on the machine that is running the Alarm & Readout Tool. It is a good idea to 
save files locally, even if you also plan to send them via email or upload them to an FTP site. This will provide you 
with a backup of the data if your network connection is lost. 

When you enable Local Disk, the words "Local Disk" will turn red to remind you to configure local disk settings. 
Click the Edit button and complete the Manage Data Storage dialog. 

• Click Choose to select a file location. The default location for saved files is the 
Documents\HOBOware\Readouts folder. 

• Specify a File format (data or text) for the resulting file. (You may select both data and text; this will 
result in the creation of two files.) Datafiles (.hobo and .dtf) can be opened directly in HOBOware Pro. 
Text files can easily be imported into HOBOware Pro, or used in spreadsheets and many other 
programs. 

Tip: If you selected partial readouts and the logger has wrap enabled, data (.dtf) will not be available. 

Email Attachment 

Enable Email Attachment to have the files sent as an email attachment. When you enable Email Attachment, the 
words "Email Attachment" will turn red to remind you to configure email attachment settings. Click the Edit button 
and complete the Manage Data Storage dialog. 

• In the To field, enter the full email addresses (up to 120 characters), separated by semicolons, where 
you want the email to be delivered. 

• In the From field, enter the full email address where you want the email to originate. 

• In the Subj field, enter up to 30 characters for the subject line of the message. 

• In the remaining fields, enter the information required by your SMTP server. You may be able to find 
this information in your email software. If you do not know which settings to use, contact your system 
administrator or Internet service provider. 

• Click Test to verify that the settings are correct. The Alarm & Readout Tool should confirm that the 
test message was sent, and you should receive a message at the To address. 

• Finally, specify a File format (data or text) for the resulting file. (You may select both data and text; 
this will result in the creation of two files.) Datafiles (.hobo and .dtf) can be opened directly in 
HOBOware Pro. Text files can easily be imported into HOBOware Pro, or used in spreadsheets and 
many other programs. 

Tip: If you selected partial readouts and the logger has wrap enabled, data (.dtf) will not be available. 
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FTP 

Enable FTP to upload the file to an FTP site. When you enable FTP, the word "FTP" will turn red to remind you to 
configure FTP settings. Click the Edit button and complete the Manage Data Storage dialog. 

• Enter the information required by the FTP host. (Do not include "ftp://" in the FTP host field.) If you do 
not know which settings to use, contact your system administrator or Internet service provider. 

• Click Test to verify that the settings are correct. The Alarm & Readout Tool should confirm that a test 
file was uploaded, and you should find a test file named "test.txt" at the FTP site. 

• Specify a File format (data or text) for the resulting file. (You may select both data and text; this will 
result in the creation of two files.) Datafiles (.hobo and .dtf) can be opened directly in HOBOware Pro. 
Text files can easily be imported into HOBOware Pro, or used in spreadsheets and many other 
programs. 

Tip: If you selected partial readouts and the logger has wrap enabled, data (.dtf) will not be available. 

Notify me 

Select the conditions for which you want to be notified. When any selected condition is met, the monitor sends a 
notification immediately. 

• When readout is successful: This condition occurs when a scheduled readout has completed, and 
the resulting file has been saved, emailed, or uploaded to an FTP site. 

Tip: It is possible to be notified of a successful readout, but not receive the expected email with the 
attached datafile or text file. The Alarm & Readout Tool cannot tell if something goes wrong after the 
email was sent. 

• When readout fails: This condition occurs when a scheduled readout (and all retry attempts) failed 
due to a communication error; or if there was an error saving the file, emailing it, or uploading it to an 
FTP server. 

Copy 

To copy this logger's readout settings to other loggers in this configuration, select the setting you want to copy 
(mode, interval, Local Disk settings, Email Attachment settings, FTP settings, or notifications) from the first drop-
down next to the Copy button. Then select the name of a logger group, the name of an individual logger, or Group: 
Loggers (to select all loggers) from the second drop-down. Click Copy to complete this step. 

Notifications Pane  
Tip: There are many preferences for notifications. 

1. To define notifications, click the Notifications icon  near the bottom of the Configure Alarms and 
Readouts dialog. Notification settings apply to all loggers. 

2. Choose one or more notification methods and options. Readout options are described below. 

Tip: In general, the reliability of email and mobile text messaging depends on many factors, including but not 
limited to SMTP servers, wireless service provider, routers, receiving devices, and even environmental forces such 
as solar flares. This variability means that messages may not be delivered in a timely manner, and could even be 
delivered out of order. If you often get messages late or out of order, you may be able to improve your odds by 
using multiple notification methods, and/or multiple addresses (in different domains) in the To: field, separated by 
semicolons. For example: 

john@onsetcomp.com; mary@onsetcomp.com 
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Email 

Enable Email to send email notifications. When you enable Email, the word "Email" will turn red to remind you to 
configure email settings. Click the Edit button and complete the Manage Notification Methods dialog. 

• In the To field, enter the full email addresses (up to 120 characters), separated by semicolons, where 
you want the email message to be delivered. 

• In the From field, enter the full email address where you want the email message to originate. 

• In the Subj field, enter up to 30 characters for the subject line of the email message. 

• In the remaining fields, enter the information required by your SMTP server. You may be able to find 
this information in your email software. If you do not know which settings to use, contact your system 
administrator or Internet service provider. 

• Click Test to verify that the settings are correct. The Alarm & Readout Tool should confirm that the 
test message was sent, and you should receive a message at the To address. 

Text Message to Mobile Device 

Enable Text Message to Mobile Device to send a text message to an SMS-enabled mobile device, such as a cellular 
telephone or a pager. When you enable this notification method, the words "Text Message to Mobile Device" will 
turn red to remind you to configure text message settings. Click the Edit button and complete the Manage 
Notification Methods dialog. 

This setup dialog is similar to the dialog for Email, but there is a 15-character limit for the Subj field. 

Tip: There is a maximum length preference for mobile text messages. 

Launch Program 

Enable Launch Program to have the Alarm & Readout Tool launch a program on the host computer. When you 
enable this notification method, the words "Launch Program" will turn red to remind you to configure program 
settings. Click the Edit button and complete the Manage Notification Methods dialog. 

Click Choose and browse to the program you would like to run. If you want the program to use a file as input, 
enable Pass file into program as argument and enter the file location and name in the File field. 

Host Computer 

Enable this option if you want to the monitor to play a sound and attempt to grab the focus on the host computer. 
You may change the sound in Preferences. 

Notify me 

Specify how often you want to be notified of alarm conditions. You can be notified at the start of each alarm 
condition (once for continuous alarm condition); you can be notified at every duration of a continuous alarm 
condition (every duration for continuous alarm condition); or you can have the monitor notify you just once, at the 
start of the first alarm, and then stop the monitor (at first alarm condition, then stop monitor). 

Tip: These options apply to alarm condition notifications only. Notifications of readout success or readout failure 
are sent once per readout. 

Notify me when an alarm condition clears 

Enable this option if you want to receive a notification when the alarm condition has returned to a non-alarm 
state. 

Send heartbeat every ___ 

You can have the host machine send you regularly scheduled notifications to let you know that the monitor is still 
running and able to communicate while you are away. Enable this option and specify how often you want to be 
notified. 
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Messages Pane  

1. To construct the message that will be sent by certain notification methods, click the Messages icon 

 near the bottom of the Configure Alarms and Readouts dialog. Message settings apply to all 
loggers. 

2. The top portion of this dialog lists the items you can include in a notification message. Select all of the 
items you would like to include. A sample message, based on your choices, appears below this area. 

3. To include additional, customized text in the message, enable "Add text to notification message" and 
type the text in the area below this option. 

Opening and Editing a Saved Configuration 
Once you have created and saved a configuration, you can open it to review settings, change the settings, and start 
the monitor. 

Tip: When the monitor is running, you can access the Configure Alarms and Readouts dialog for the current 
configuration by clicking Configure on the Alarm and Readout Monitor dialog. Changes that you make to the 
configuration will not take effect until the next time you start the monitor. 

1. From the Tools menu, choose Manage Alarms & Readouts, then choose Open Configuration. Select 
the configuration and click Open. The Configure Alarms and Readouts dialog is displayed. 

2. Review the settings and make changes, if desired. 

3. To save changes to the existing configuration file, click Save. To save the changes to a new 
configuration file with a different name, click Save As. 

4. To start the monitor now, connect the loggers and sensors (if applicable) that are defined in the 
configuration. If any loggers in the configuration have scheduled readouts enabled, be sure those 
loggers are launched, and either actively logging, or awaiting a delayed or triggered start. Click Start. If 
the monitor is already running, you will be warned that the monitor will stop the previous 
configuration before running the new one. 

Important: A serial logger that is waiting for a delayed or button start cannot provide an updated 
sensor reading until the logger begins logging. Once a serial logger begins logging, it can only provide 
the last logged value. 

Tip: To avoid disrupting an active deployment, do not connect sensors to a serial logger if it is already 
logging. 

5. To close the Configure Alarms and Readouts dialog without starting the monitor, click Cancel. 

Exporting a Configuration 

To export a configuration to a text file, open the configuration and click Export. By default, exported configurations 
are saved in the Documents\HOBOware\Alarms folder with an extension of .txt. 

Monitoring 

IMPORTANT: The Alarm & Readout Tool is no longer installed with HOBOware as of version 3.4. This help 
section is included for reference only for existing Alarm & Readout Tool users. 

The alarm and readout monitor polls the loggers and sensors at the intervals specified by the configuration, 
compares the values to the alarm conditions, and notifies you if an alarm is triggered. It also performs scheduled 
readouts and stores and/or sends the resulting files, as applicable. 

• Start the monitor 

• View the monitor details 
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• Hide the monitor 

• Stop the monitor 

Tip: The alarm and readout monitor uses your computer's system clock to determine when to poll loggers and read 
them out. If you (or an automated program) adjust the time backwards while the monitor is running, the next 
polling and/or readout time will be delayed until the clock reaches that time. Automatic time changes caused by 
the start and end of Daylight Saving Time, and manual changes to your time zone setting, do not cause a delay in 
the monitor. 

Starting the Monitor 

Tip: The alarm and readout monitor uses your computer's system clock to determine when to poll loggers and read 
them out. If you (or an automated program) adjust the time backwards while the monitor is running, the next 
polling and/or readout time will be delayed until the clock reaches that time. Automatic time changes caused by 
the start and end of Daylight Saving Time, and manual changes to your time zone setting, do not cause a delay in 
the monitor. 

1. From the Tools menu, choose Manage Alarms & Readouts, then choose Open Configuration. Select 
the configuration you want and click Open. The Configure Alarms and Readouts dialog is displayed. 

2. Connect the loggers and sensors (if applicable) that are defined in the configuration. The loggers can 
be logging, waiting for a delayed or button start, or stopped. Any loggers that have scheduled 
readouts must be either logging, or awaiting a delayed or triggered start when you start the monitor. 
The loggers should be logging by the time of the first scheduled readout. Serial loggers that are 
scheduled for partial readouts and have wrap enabled must not wrap before the first scheduled 
readout; if they are wrapped, the readout will fail. 

Important: A serial logger that is waiting for a delayed or button start cannot provide an updated 
sensor reading until the logger begins logging. Once a serial logger begins logging, it can only provide 
the last logged value. 

Tip: To avoid disrupting an active deployment, do not attach sensors to a serial logger if it is already 
logging. 

3. Click Start. If the monitor is already running, you will be warned that the monitor will stop the 
previous configuration before running the new one. The Alarm and Readout Monitor dialog is 
displayed, and an alarm icon appears in the lower right corner of the main HOBOware Pro window. 

4. Each logger has its own panel in the monitor window, which lists the logger name, monitored 
conditions, and a countdown to the next reading. To view details about the logger's status, click the 
logger's panel. 

• Once the monitor is running, if there is a communication failure, any sensor readings are 
italicized and in purple text to indicate that they are not current. 

• If the logger is in an alarm condition, the logger name is displayed in red text. 

• If a sensor is in an "above" alarm condition, its text is displayed in red. If it is in a "below" alarm 
condition, its text is displayed in blue. If it is "okay," its text is black. 

• If a monitored logger condition (communication , memory , battery status , or 
readout ) is in an alarm condition, its icon is displayed in red. Otherwise, the icon is green. 

• A  icon indicates a notification failure. 

• Because different loggers may be read at different intervals, the Next Readout and Next Alarm 
Check at the top of the monitor window lets you know when the next readout and alarm check 
will be taken for the configuration. 
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• To access the configuration dialog for the current configuration, click Configure. Changes that 
you make to the configuration will not take effect until the next time you start the monitor. 

5. You can continue to use HOBOware Pro to work with other loggers and datafiles. In addition, you can 
work with the monitored loggers in HOBOware Pro when the monitor is not taking a reading. 

Tip: A logger cannot communicate with HOBOware Pro and the monitor at the same time. If both 
applications attempt to access the logger at the same time, you will receive communication errors. 

Viewing the Monitor Details 

To view the details of a logger's condition while the monitor is running, click the logger's panel in the Alarm and 
Readout Monitor dialog. The following explains the fields on the Alarm and Readout Monitor - Details window. 

• Monitor started: Time when the monitor was started. 

• Monitor number: Number of times the monitor has been started. Each time you start the monitor, 
the Alarm & Readout Tool's internal counter (the monitor number) increases by one. If the monitor 
performs readouts, the monitor number is added after the file name, before the sequence number (if 
any). 

• Notification method(s): Notification methods in use. This can be any combination of email, mobile 
text message, launch program, or host computer. 

• Last notification at: Time when the most recent notification was sent. If this is "None Sent," no 
notifications have been sent yet. Click View to see the text of the last notification that was sent. 

• Select logger: This box lists the loggers that are being monitored. The information in this dialog 
refers to the logger that is currently highlighted in the logger list. To view details for a different logger, 
click that logger's name. 

• Name: Description that was entered for the logger on the Configure Alarms and Readouts dialog. 

• Device: Model and serial number of the logger. 

• Communication: Communication protocol for this logger (USB or serial). 

• Readout Mode: Readout mode selected for this logger (full, partial, or disabled). 

• Interval (readouts): Frequency with which the monitor is reading out the logger. 

• Readout Storage: Storage method(s) for the resulting datafile or text file (local disk, email 
attachment, or FTP). 

• Last Readout: Time when the last readout was performed. If a scheduled readout has not been 
performed yet, this is "None." 

• Next Readout: Time of the next scheduled readout attempt, if applicable, and a countdown timer. 

If readouts can no longer be performed on the logger (because the logger was relaunched, or has 
stopped, filled up, wrapped more than once between readouts so that data was lost, or wrapped 
before the first partial readout), the countdown timer will read 00:00:00. If you are not sure why 
readouts were cancelled, pause the mouse pointer over the countdown timer for an explanation. 

• Interval (alarms): The frequency with which the monitor is polling the logger for alarm conditions. 

• Last Alarm Check: Time when the last alarm check was performed. 

• Next Alarm Check: Time of the next scheduled alarm check, if applicable, and a countdown timer. 

• Monitored sensor conditions (not labeled): This box lists the sensor conditions, if any, that were 
defined for this logger, along with their current values as of the last reading. 
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If a sensor is in an "above" alarm condition, its text is red. If it is in a "below” alarm condition, its text 
is blue. If it is "okay," its text is black. If there is a communication failure, the current reading is 
italicized and in purple text to indicate that it is outdated. 

• Monitored logger conditions (not labeled): The area at the bottom of the window lists the logger 
conditions (communication , memory , battery status , and readout ), if any, that were 
defined for this logger. The memory icon also displays the amount of memory that has been used. 

If one of these items is in an alarm condition, its icon is red. Otherwise, it is green. 

Hiding the Monitor 

To hide the monitor without stopping it, click the Hide button on the Alarm and Readout Monitor dialog, or choose 
Hide Monitor from the Manage Alarms & Readouts submenu on HOBOware Pro's Tools menu. The alarm clock icon 

 will remain in the lower right corner of the main HOBOware Pro window to remind you that the monitor is 
active, and the icon will turn red and "jump" when an alarm is triggered. In addition, if the configuration is set to 
notify on the host machine when an alarm is triggered, the monitor window will open automatically at that time. 

To restore the monitor window at any time, click the alarm clock icon , or choose Show Monitor from the 
Manage Alarms & Readouts submenu on HOBOware Pro's Tools menu. 

Stopping the Monitor 

To stop the monitor, click the Stop button on the Alarm and Readout Monitor dialog, or choose Stop Monitor from 
the Manage Alarms & Readouts submenu on HOBOware Pro's Tools menu. This ends all readouts and notifications 
until you start the monitor again. 

After all alarm checks and readouts in progress have finished, the Stop button becomes a Start button, and the 
Hide button becomes a Close button. You can restart the monitor by clicking the Start button, or close it by clicking 
the Close button. 

You can define a configuration to stop the monitor immediately after sending the first alarm notification. Enable 
the "at first alarm condition, then stop monitor" option on the Notifications pane. 

There are also preference settings that cause the monitor to stop automatically. In Alarm Preferences, in the 
Notification category, enable "Stop monitor after N notifications sent" if you want the monitor to stop after 
sending a specific number of notifications. Enable "Stop the monitor if sending a notification fails" if you want the 
monitor to stop when it is unable to send a notification. 

Readout Files 

IMPORTANT: The Alarm & Readout Tool is no longer installed with HOBOware as of version 3.4. This help 
section is included for reference only for existing Alarm & Readout Tool users. 

When you use the Alarm & Readout Tool to perform scheduled readouts, you have a choice of creating datafiles 
(.hobo and .dtf) and/or text (.txt) files. Only HOBOware can open datafiles, but text files can be imported easily 
into HOBOware Pro, and be viewed in text editors, spreadsheets, and other kinds of software. 

Note: When reading out files to text file format, the data is in SI units. Preferences set to US in HOBOware are not 
followed. 

Readout file numbering scheme 

The Alarm & Readout Tool employs a simple numbering scheme to avoid overwriting files that have been created 
as a result of scheduled readouts. Each time you start the monitor, the Alarm & Readout Tool's internal counter 
(the monitor number) increases by one. If the monitor performs readouts, the monitor number is added after the 
file name, before the sequence number (if any). 

For example, consider a configuration with two loggers – LoggerA and LoggerB. Each logger will be read out once 
per day, over a period of seven days. LoggerA is configured for partial readouts, which (with default Preference 
settings) results in one file. LoggerB is configured for full readouts, which (again, with default Preference settings) 
results in seven files. 



HOBOware User’s Guide 

1-800-LOGGERS 235 www.onsetcomp.com 

The first time you start the monitor, the monitor number is 1. When you stop the monitor, you should have eight 
files: LoggerA_1.hobo, and LoggerB_1_0000.hobo, LoggerB_1_0001.hobo, LoggerB_1_0002.hobo, etc. 

The next time you start the monitor, the monitor number is 2. When you stop the monitor, you should again have 
eight files: LoggerA_2.hobo, and LoggerB_2_0000.hobo, LoggerB_2_0001.hobo, LoggerB_2_0002.hobo, etc. 

The monitor number advances every time you start the monitor, even if no readouts are performed. If the monitor 
number reaches 99,999, it will roll over to 1. 

Tip: Be careful when renaming files while they are still in their original location. If, for some reason, you rename 
"MyLogger_1.txt" to "MyLogger_2.txt," the file could be overwritten the second time you run the monitor. 

Text File Format 
The first section of the text file contains the header. This header conforms to YAML standards, allowing maximum 
compatibility with other software. The remainder of the file contains the data. 

There are three sections in the text file header: 

• Data Format 

• Logger Info 

• Series Info 

The second section of the text file contains the data. 

Header Section: Data Format 
This section of the header includes detailed information about the way your text file is formatted. 

• dateTimeDelimiter, dataDelimiter, and decimalSeparator identify (between double-quotes) the 
character used to separate date and time; the character used to separate data values from one 
another; and the character that is used as a decimal. 

• dateFormat and timeFormat describe the way dates and times are formatted within the file. These 
formats are determined by the preference settings in HOBOware Pro and the regional format settings 
of your operating system. For example, 07/31/06 would be represented as MM/dd/yy. (Single-digit 
values have leading zeros.) 

 Uppercase HH refers to 24-hour time (e.g., 15:00:00). 

 Lowercase hh refers to 12-hour time (e.g., 3:00:00 PM). This time format should be followed 
with "a" to denote an AM/PM indicator (hh:mm:ss a). 

 Lowercase ss refers to whole seconds. Uppercase SSS refers to milliseconds. 

 Lowercase mm refers to minutes. Uppercase MM refers to months. 

• gmtOffset and daylightSavings indicate the offset, in hours, from GMT on the computer that launched 
the logger, and whether the computer was in Daylight Saving Time when the logger was launched 
(true or false). 

Header Section: Logger Info 
This section of the header contains information about each logger that has data in this file. There is one subsection 
for each logger. (For scheduled readouts, there is only one logger per file.) 

• The first line of each subsection is: 

- &# 
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where "#" is an integer that counts the loggers in this file, beginning with 1. (For scheduled readouts, &1 is 
the only subsection.) 

• The remaining fields in each subsection list the logger's launch description, model, vendor, etc., similar 
to the fields on the Status window in HOBOware Pro. 

Header Info: Series Info 
This section of the header lists each column in the file, excluding the first column ("#") and date/time column. 
There is one subsection for each series. Series are listed in the same order as their columns within the data. 

• The first field of each subsection is name, followed by the series name. 

• The next field is type, which can be value, state, event, or internalEvent. 

• For value, external event, and state series, type is followed by unitName. Values and external events 
have only one unitName. For state series, the two states are listed on two separate lines, with the 
high state listed first. 

• For value series only, OMClassName, OMPartNumber, OMUnitIndex, OMChannelType, and 
OMValuePattern provide additional series information to Onset's software. 

• The location, if any, is the location string for a serial logger sensor. 

• The last field of each subsection is logger. This identifies the logger that logged this series or provided 
the data from which this series was derived (such as dew point). The logger is identified as *# where 
"#" corresponds to the logger number in the Logger Info section. (For scheduled readouts, *1 is the 
only logger.) 

Data Section 

• Data is separated from the file header by a row of hyphens. 

• The first row of data consists of the column headings. Each column heading is enclosed in double 
quotation marks (" ") and separated by the dataDelimiter character. The first column header is "#"; 
the second column header is "Time, GMT-04.00" (or whatever offset is appropriate). 

• The remaining columns identify each series name and unit type, if applicable, in the format "Series 
Name, Unit" (enclosed in double quotation marks). Each series, including states, external events, and 
internal logger events, has its own column. (There are preferences that allow you to include more 
information in the series column headers.) 

• The first column is the point number, as shown in a HOBOware datafile. 

• The date and time are separated by the dateTimeDelimiter character. (There is a preference that 
allows you to split date and time into two columns.) 

• For internal logger events, the field value is Logged; otherwise, there is no field value. 

• No zeros or spaces are used for fields that do not contain values. 

• Rows of data are separated with a paragraph return. 

• Thousands separators are not used. Two thousand (2,000) is expressed as 2000. 

Preferences 
IMPORTANT: The Alarm & Readout Tool is no longer installed with HOBOware as of version 3.4. This help 
section is included for reference only for existing Alarm & Readout Tool users. 

When you install the Alarm & Readout Tool, an Alarms pane is added to the HOBOware Pro preferences dialog. To 
change preferences: 
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1. From the HOBOware Pro (Macintosh) or File (Windows) menu, choose Preferences. 

2. Click the Alarms icon to open the Alarms pane. 

3. Make changes as needed in the Alarm Conditions, Readouts, Notification, Messages, and Warnings 
preference groups and click OK. 

Clicking the Restore Defaults button on the Preferences dialog will restore all preferences, including HOBOware 
Pro and Alarm & Readout Tool preferences. 

Readout Preferences 
The following preferences are available in the Readouts group: 

• For full readouts: If you have configured loggers for full readouts, a new file is normally created at 
every readout, with the file name you entered in the configuration, followed by the monitor number, 
followed by a numeric suffix to identify the sequence (the sequence number). For example, 
LoggerA_X_0000.hobo, LoggerA_X_0001.hobo, etc. where X is the monitor number. 

If you prefer to keep only one file, select "overwrite existing file at each readout." This setting is not 
recommended when performing full readouts to text files for serial loggers that have wrapping 
enabled; once the logger has wrapped, the data from the beginning of the deployment will be lost 
when the original file is overwritten. 

• For partial readouts: If you have configured loggers for partial readouts, a new text file or datafile is 
created with the first readout, and subsequent partial readouts are normally appended to this file. 

To control the size of text files only, enable "for text files, create new file when appended file 
exceeds" and enter the number of rows. This will not split a readout into multiple files; rather, it will 
create a new file only when the existing file has already exceeded this limit. Each file name will have a 
monitor number, followed by a numeric suffix to identify the sequence (the sequence number). For 
example, LoggerB_X_0000.txt, LoggerB_X_0001.txt, etc. where X is the monitor number. 

You can also have the Alarm & Readout Tool create a new text file for every partial readout. Select 
"create new file at each readout." Each file name will have a monitor number, followed by a numeric 
suffix to identify the sequence (the sequence number). For example, LoggerA_X_0000.txt, 
LoggerA_X_0001.txt, etc. where X is the monitor number. 

Tip: When performing scheduled readouts, the Alarm & Readout Tool will use the preference settings that were in 
effect when you started the monitor. If you change any of the following Readouts preferences while the monitor is 
running, the new settings will not take effect until the next time you start the monitor. 

• Text file data column separator: This setting controls how the columns are separated in the text 
file. Choose comma, semicolon, or tab. 

• Text file date and time format: Separate into two columns. By default, date and time are kept in a 
single column in the text file to facilitate graphing in spreadsheet programs. If enabled, this setting 
splits the date and time into two columns. 

• Include logger serial number in column header: This setting adds the logger’s serial number to 
each column header when a text file is saved. This is especially useful if you plan to analyze data from 
different loggers. 

• Include sensor serial number (if available) in column header: This setting adds the sensor’s 
serial number, if it has a serial number, to each column header when a text file is saved. This is 
especially useful if your data includes similar series that were recorded on different sensors; for 
example, three different temperature series. 

• Include sensor location (if available) in column header: This setting adds the sensor’s location 
string, if it had a location defined at the last launch, to each column header when a text file is saved. 
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This is especially useful if your data includes similar series that were recorded on different sensors; for 
example, three different voltage sensors. 

Alarm Condition Preferences 
The following preferences are available in the Alarm Conditions group: 

• Include channel number in sensor description: For USB loggers, you may include the channel 
number in the sensor description. This is especially helpful if you are using external sensors. 

• Include location in sensor description: For serial loggers, you may include the location that was 
defined for the sensor the last time the logger was launched. 

Notification Preferences 
The following preferences are available in the Notifications group: 

• Enable notification logging: Enable this option if you would like the Alarm & Readout Tool to keep 
a log of all notifications that have been created. You may find this helpful if you suspect that you are 
not receiving all of your notifications due to problems with your email or text messaging service. The 
log file will be named NotificationLog.txt, and it will be overwritten each time you start the monitor. 

For Windows users, the notification log will be located in: 

C:\Documents and Settings\username 

For Macintosh users, the notification log will be located in: 

~\Library\Logs 

• For new configurations, remember notification settings from the last started configuration: 
If you generally use the same notification settings for each configuration, enabling this option will save 
you some time when creating new configurations. 

• For text messages...: Some mobile text messaging services have maximum message length limits. To 
ensure that you do not miss any text notifications, enable this option and enter the limit in the Text 
Message Limit box. If a notification exceeds this number of characters, it will be sent in a series of 
shorter messages. 

• Stop the monitor if sending a notification fails: Enable this option if you want the monitor to 
stop if it is not able to send a notification. 

• Stop monitor after N notifications sent: To stop the monitor after a certain number of 
notifications are sent, enable this option and specify the number of notifications. This helps you limit 
unnecessary battery drain on the logger and the expense of frequent text messaging if you will not be 
able to stop the monitor directly at the host system. 

• Enable sound for host notification: By default, notifications on the host machine are accompanied 
by a sound. You can select a different sound file, or disable the sound by unchecking the box. 

To change the sound played with the notification, select a sound from the dropdown list, or click Choose 
to browse to the .wav file you want to use. To preview the sound, click the  icon. 

Message Preferences 
The following preference is available in the Messages group: 

• Select the following Message items by default: If you want to include or exclude certain items 
from most notification messages, select the items you want to include here. These will become the 
default message items when you create a new configuration. 
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Warning Preferences 
Some warning dialogs offer you a checkbox to disable the warning so that you do not see it again. You can also 
disable (and re-enable) these warning preferences here. 

• There are unsaved file changes: If you try to start the monitor or cancel the configuration dialog 
when the displayed configuration contains settings that have not been saved, this warning gives you a 
chance to save the changes before the configuration dialog closes. 

• The configuration file being opened was created with a different version of the Alarm & 
Readout Tool: Configuration files from the previous version of this software ("Real Time Alarm 
Software") are fully compatible with the current version. If you save the configuration file after you 
open it, it will be updated to the current version. If the configuration includes references to serial 
loggers, you should click Refresh  on the Sensors tab of the Alarms pane before saving the file. This 
will add more information about the sensors to the configuration file. 

• The monitor is running when closing the application: If you try to quit HOBOware Pro while the 
monitor is running, this warning reminds you that quitting HOBOware Pro will stop the monitor, and 
gives you a chance to cancel. 

• There may be concurrent logger access: This warning appears if you try to communicate with (add 
or refresh) a logger in the Configure Alarms and Readouts dialog while the logger is included in the 
currently running alarm and readout monitor. 
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The HOBO Waterproof Shuttle performs several major functions: 

• Reads out all logger information (serial number, deployment number, data, etc.) from 
loggers in the field for transfer to host computer, and stores each logger’s data in a 
“bank” 

• Nonvolatile memory preserves data, even if batteries are depleted 

• Relaunches the logger, resetting the logger’s time to the shuttle’s time and 
synchronizing the logging interval on relaunch 

• Can be used as an optic-to-USB base station 

Although the HOBO Waterproof Shuttle is easy to use, Onset strongly recommends that you 
spend a few minutes reading this manual and trying out the procedures described here before 
taking the shuttle into the field. 

Specifications 

Compatibility All HOBO U-Series loggers with optic USB. Not compatible with the HOBO 
U-Shuttle (U-DT-1). 

Data Capacity 63 logger readouts of up to 64K each 

Operating Temperature 0° to 50°C (32° to 122°F) 

Storage Temperature -20° to 50°C (-4° to 122°F) 

Wetted Materials Polycarbonate case, EPDM o-rings and retaining loop 

Waterproof To 20 m (66 feet) 

Time Accuracy ±1 minute per month at 25°C (77°F); see Plot A 

Logger-to-Shuttle Transfer 
Speed 

Reads out one full 64K logger in about 30 seconds 

Shuttle-to-Host Transfer 
Speed 

Full shuttle offload (4 MB) to host computer in 10 to 20 minutes, 
depending on computer 

Batteries 2 AA alkaline batteries required for remote operation 

Battery Life One year or at least 50 complete memory fills, typical use 

Weight 150 g (4 oz) 

Dimensions 15.2 x 4.8 cm (6.0 x 1.9 inches) 

 

The CE Marking identifies this product as complying with all relevant 
directives in the European Union (EU). To maintain CE compliance, this 
product must be used with the supplied USB cable or equivalent (less than 
3 m long). 

 

 

Plot A 
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HOBO Waterproof Shuttle 

U-DTW-1 

Included Items: 
• USB cable 
• Set of couplers; 
 For UA Pendant 

(COUPLER2-A) 
 For U20 Water Level 

(COUPLER2-B) 
 For U22 Water Temp Pro 

v2, U24 Conductivity, and 
U26 DO (COUPLER2-C) 

 For UTBI TidbiT v2 
(COUPLER2-D) 

 For U23 HOBO Pro v2 
(COUPLER2-E) 

Required Items: 
• HOBOware 2.2 or later 
• Compatible logger and 

matching coupler 
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HOBO Waterproof Shuttle Features 

 

 
Preparing to Go on Location 
Before using the shuttle for the first time, you must launch it 
with HOBOware 2.2 or greater. You must also launch any 
compatible loggers that were last launched with an earlier 
version of HOBOware, or have never been launched at all.  

1. Use HOBOware 2.2 or greater to launch each logger you 
wish to read out and relaunch with the shuttle later. (Read 
“Using the shuttle as a base station” for instructions if you 
do not have another base station for the loggers.) The 
shuttle cannot relaunch loggers that were last launched 
with an earlier version of HOBOware. (You only have to do 
this once for each logger.) 

2. Plug the large end of a USB interface cable into a USB port 
on the computer. (Avoid using a USB hub, if possible.) 

3. Unscrew the center cap on the shuttle. If the cap is too tight 
to loosen by hand, insert a screwdriver through the lanyard 
hole and rotate counterclockwise until the cap is loosened.  

4. Plug the small end of the USB interface cable into the USB 
port in the shuttle. (If the shuttle has never been connected 
to the computer before, it may take a few seconds for the 
new hardware to be detected.) 

5. Follow the instructions in the HOBOware User’s Guide to 
access the Manage Shuttle dialog. Make sure the battery 
level is good, and change the batteries now if they are 
weak.  

Important: If you change the batteries in the field, the shuttle’s 
clock will stop, and the shuttle will not read out loggers again 
until you relaunch it in HOBOware. 

6. If you are using the shuttle for the first time, launch the 
shuttle as described in the HOBOware User’s Guide. 
Launching synchronizes the shuttle’s clock to the host 
computer and initializes the shuttle’s header. 

Important: The shuttle’s clock is used to set the logger’s clock 
at relaunch. For most accurate results, make sure the host 
computer’s clock is correct before launching the shuttle. If you 
need to adjust the computer’s clock, quit HOBOware, set the 
computer’s clock, then reopen HOBOware and launch the 
shuttle. 

7. If you have used the shuttle before, make sure there are 
enough banks available to accommodate the loggers you 
plan to read out. 

8. Disconnect the USB cable from the shuttle and replace the 
center cap securely. 

Reading Out and Relaunching Loggers  
in the Field 
After you have ensured that the shuttle’s batteries are good, 
there is sufficient memory available, and the shuttle’s clock is 
synchronized, follow these steps to read out and relaunch a 
logger in the field: 

1. Make sure the shuttle’s large cap and center cap are closed 
securely. Tighten the center cap until it is just flush with the 
large cap, or until the O-ring is no longer visible. 

2. Make sure the communication end of the shuttle is clean. 
Attach the correct coupler for the logger, and ensure that it 
is seated properly. 

3. Insert the logger into the coupler, following the instructions 
that came with the coupler. 

4. Momentarily press the coupler lever (pressing hard enough 
so the lever bends). Readout should begin immediately. The 
amber LED blinks continuously while readout and relaunch 
are in progress. Do not remove the logger when the amber 
LED is blinking. 

5. After reading out the logger, the shuttle synchronizes the 
logger’s clock to the shuttle’s internal clock and relaunches 
the logger, using the description, channels to log, logging 
interval, and other settings that are already in the logger. (If 
the logger was launched with multiple logging intervals, the 
final defined logging interval will be used.) The logger is 
launched with a slight delay that causes its readings to be 
synchronized with those of the previous deployment, as 
shown in the following diagram. 
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Important: If the logger was launched with multiple logging 
intervals, there will be no synchronizing delay. The logger will 
start immediately with the last defined logging interval. 

6. When the relaunch has completed, the green LED blinks for 
15 minutes, or until you momentarily press the coupler 
lever to stop it (press hard enough so the lever bends). If 
the red LED blinks instead, there was an error, and the 
logger may have stopped. Refer to “Troubleshooting” in this 
manual for details. 

7. Remove the logger from the coupler. 

Checking Shuttle Status in the Field 
The shuttle’s memory has 63 “banks.” One logger readout can 
be stored in each bank. To check the shuttle’s memory and 
batteries in the field, remove the logger and press the coupler’s 
lever for at least three seconds (pressing hard enough so the 
lever bends). When you release the lever, the green LED blinks 
once for each unoccupied bank in the shuttle’s memory. (Press 
the lever momentarily to stop the blinking, pressing hard 
enough so the lever bends.) 

If the shuttle’s batteries are running low, all of the shuttle 
banks are full, or the clock has not been set, the red LED blinks. 
(Press the lever momentarily to stop the blinking, pressing hard 
enough so the lever bends) Use HOBOware to check the 
shuttle’s battery level, available memory, and clock. You may 
need to change the batteries, or offload the datafiles to the 
host computer and delete them from the shuttle to free up 
memory before you can continue reading out loggers. 

Offloading Data to the Host Computer 
You can offload the data stored in the shuttle even when the 
batteries are depleted. Take the following steps: 

1. Connect the shuttle to a host computer running HOBOware. 

2. Follow the instructions in the HOBOware User’s Guide to 
offload the new datafiles or access the Manage Shuttle 
dialog. The Manage Shuttle dialog shows you how many 
banks are occupied, and whether they have already been 
offloaded and saved to the host computer.  

3. Offload and save data from the banks of your choice. Refer 
to the HOBOware User’s Guide for details on saving 
datafiles offloaded from the shuttle. 

4. Review the list of banks and delete any that are no longer 
needed. Make sure the battery level is good, and change 
the batteries now if they are weak. (If you change the 
batteries in the field, the shuttle’s clock will stop, and the 
shuttle will not read out loggers.) Update the shuttle’s 
clock, if necessary. 

5. When finished, disconnect the shuttle from the computer 
and close the center cap securely. 

Using the Shuttle as a Base Station 
You can use the shuttle as a base station for any U-Series logger 
with an optic USB interface. (This function is available even 
when the batteries are depleted.) To use the shuttle as a base 
station: 

1. Connect the shuttle to the host computer running 
HOBOware.  

2. Attach a compatible logger and coupler. 

3. Momentarily press the coupler’s lever (pressing hard 
enough so the lever bends). 

4. The amber LED blinks momentarily, then the green LED 
should glow steadily to indicate that the logger is ready to 
communicate with HOBOware. (If the red LED blinks 
instead, the logger was not found. Make sure the logger 
and coupler are aligned and seated properly, and that there 
is no dirt or strong sunlight interfering with 
communications.) 

5. When finished, remove the logger from the coupler. The 
green LED stops glowing when you disconnect the logger or 
the USB cable.  

Important: The Waterproof Shuttle cannot be used as a base 
station with Pendant logger models UA-001 and UA-003 
(including rain gauges RG3 and RG3-M) with serial numbers less 
than 988278. These loggers require a BASE-U-1 for 
communication with the host computer. 

Indicator Lights 

Green “OK” LED 
The green “OK” LED blinks when HOBOware recognizes it as a 
base station; when it finishes reading out and relaunching a 
logger; and when you press the coupler lever to check the 
shuttle’s status (see “Checking shuttle status in the field” for 
details). Momentarily press the coupler lever to stop the 
blinking (pressing hard enough so the lever bends). 

The green LED glows steadily when the shuttle is being used as 
a base station. 

Amber “Transfer” LED 
The amber “Transfer” LED blinks when the shuttle is reading 
out a logger and relaunching it. Do not remove the logger when 
the Transfer light is lit. 

Red “Fail” LED 
The red “Fail” LED blinks whenever the shuttle 
encounters an error condition. Refer to “Troubleshooting” 
for details. 

All LEDs  
All LEDs blink in unison when the shuttle has just been powered 
up, either by installing fresh batteries or (if batteries are not 
installed) by connecting to the computer’s USB port. 

Troubleshooting 
This section describes problems you may encounter while using 
the shuttle.  

Shuttle is not recognized by host computer 
If HOBOware does not recognize the shuttle when you connect 
it to the computer, simply disconnect and reconnect the 
shuttle. 
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Red “Fail” LED blinks 
The red “Fail” LED blinks (for 15 minutes, or until you press the 
coupler lever, pressing hard enough so the lever bends) 
whenever the shuttle encounters an error. There are several 
conditions that might cause an error: 

• Shuttle is full: If the red LED blinks when you try to read 
out a logger, check whether all of the banks are full, as 
described in “Checking shuttle status in the field.” Or, use 
HOBOware to check the shuttle’s memory. 

• Shuttle batteries are low: If you cannot read out any 
loggers at all, check the logger’s status, as described in 
“Checking shuttle status in the field,” or use HOBOware 
to check the shuttle’s batteries. The batteries may simply 
need to be replaced. 

• Compatibility: The shuttle cannot read out or relaunch 
loggers that were last launched from HOBOware prior to 
version 2.2. You will need to read out these loggers on 
the host computer and relaunch them in HOBOware 2.2 
or greater before you can use them with the shuttle. 

• Shuttle clock is not set: The shuttle has experienced a 
power failure that caused the clock to reset. You must 
use HOBOware to offload the files that are already on the 
shuttle, then relaunch the shuttle before you can read 
out another logger. 

• Can’t communicate with logger: Remove the logger and 
coupler. Inspect them and the shuttle to ensure that all 
are free of dirt that could block the optic communication 
sensor. Carefully reassemble the shuttle, coupler, and 
logger, and make sure they are all seated properly. Shield 
the shuttle from strong sunlight, if applicable, which can 
interfere with optic communications.  

• Other logger problems: If you can read out some loggers 
but not others, or if you cannot read out any loggers 
even with fresh batteries in the shuttle, check the loggers 
in HOBOware. Make sure their batteries are at 
acceptable levels and that there is no “corrupted header” 
message.  

Amber “Transfer” LED stays on without blinking 
The amber light is magnetically activated when you press the 
coupler lever. If it glows steadily at any other time, the magnet 
in the lever may be too close to the magnetic switch in the 
shuttle, or another strong magnet may be present. Try bending 
the lever away from the coupler to reduce the magnet’s effect. 

LEDs do not function 
If the LEDs are not functioning at all, the batteries may be 
completely exhausted. To test this, attach the shuttle to the 
host computer and check the battery level. The shuttle should 
be able to communicate with the host computer, blink its LEDs 
normally, and perform as a base station even when the 
batteries are missing or depleted. 

Replacing the Shuttle’s Batteries 
The shuttle’s batteries should last about one year or at least 50 
complete memory fills in typical conditions. When the shuttle’s 
batteries run low (2.2 V or less), any logger data that is already 

in the shuttle will remain safe, but the shuttle will not read out 
another logger until its batteries are replaced. 

To avoid battery problems, always check the shuttle’s batteries 
in HOBOware before going into the field, and replace them if 
needed. If you cannot replace the bad batteries right away, you 
should remove them as soon as possible to ensure that they do 
not leak and damage the shuttle. 

To change the shuttle’s batteries: 

1. Work over a clean surface to provide a safe platform for the 
disassembly. 

2. Unscrew the center cap on the shuttle. If the cap is too tight 
to loosen by hand, insert a screwdriver through the lanyard 
hole and rotate counterclockwise until the cap is loosened.  

3. Use the center cap to help you carefully pull the rubber 
loop free of the large cap. The large cap cannot be removed 
while the rubber loop is in place. 

 

4. Turn the large cap counter-clockwise slightly, then pull it 
off. 

 

5. Turn the shuttle over and tap it gently. The circuit board 
should slide into your hand.  

 



  HOBO Waterproof Shuttle (U-DTW-1) Manual 

 

 
1-800-LOGGERS (564-4377) • 508-759-9500 
www.onsetcomp.com • loggerhelp@onsetcomp.com 

© 2006–2013 Onset Computer Corporation. All rights reserved. Onset, HOBO, and HOBOware are 
trademarks or registered trademarks of Onset Computer Corporation. All other trademarks are the 
property of their respective companies. 

10264-H MAN-U-DTW-1 
 

6. Remove the old batteries and install two new ones in the 
correct orientation. Both batteries should be turned the 
same way, with their positive ends facing the USB port on 
the board. (When the second battery makes contact, all of 
the shuttle’s LEDs will blink in unison.) 

7. Put the board back into the case, taking care not to bend 
the communication LEDs. Align the circuit board with the 
runners in the case. The USB port should face the open end 
of the shuttle, and the LEDs should show through the 
window on the label. 

8. Close the shuttle’s case. Line up the tabs on the large cap 
with the slots on the case, press gently, and turn slightly 
clockwise until the large cap is closed securely.  

9. Replace the rubber loop and center cap. Tighten the center 
cap until it is just flush with the large cap, or until the O-ring 
is no longer visible. 

10. Using HOBOware, offload any datafiles that are on the 
shuttle and launch the shuttle before going into the field 
again. The shuttle will not read out and relaunch loggers 
until the clock has been synchronized. 

 WARNING: Do not install batteries backwards, recharge, 
put in fire, expose to extreme heat, or mix with other battery 
types, as the batteries may explode or leak. Contents of an 
open or leaking battery can cause chemical burn injuries. 
Replace all used batteries at the same time. Recycle or dispose 
of batteries according to applicable federal, state, and local 
regulations. 
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TOP SETTING WADING RODS MODEL TSR 

I  INSTRUCTION FOR SEPARATION OF SPLIT TOP SET ROD 

STEP 1: ALIGN 19 WITH 0 FOR METRIC 

                 (ALIGN 4 WITH 0 FOR IMPERIAL) 
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STEP 2: UNSCREW THE SUSPENSION ROD AS SHOWN 

STEP 3: UNSCREW THE HEX ROD AS SHOWN 

NOTE:  To re-assemble reverse order from Step 3 to Step 1 
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II GENERAL

The model TSR Top Setting Wading Rods were developed to simplify the task of the 

hydrographer while carrying out gauging of small streams. 

The TSR shall only be used in shallow streams, where it is safe for the hydrographer to 

carry out gaugings while wading. 

The TSR is available in Metric and Imperial models and each model is available in lengths 

of  4 feet (1200mm), 6 feet (1800mm) and 8 feet (2400mm) 

      The device:

ensures the stable placement of the rod on the stream bed. 

allows the depth of the stream to be measured.  

enables the hydrographer to precisely position the current meter at 0.2, 0.4, 0.6 and 

0.8 of water depth without removing the rod from the stream bed. 

allows the direct connection of the current meter and pulse counter without external 

cables. 

The Top Setting Wading Rods are manufactured from durable materials selected to meet 

the environmental conditions in the field. 

III UNPACKING 

Remove the packing material from the TSR carry case 

This product has been inspected to ensure compliance with your purchase order and has 

been appropriately packed to ensure the safe transit to your warehouse, however a thorough 

inspection of the product should be carried out upon receipt to confirm compliance and to 

identify any damage that may have occurred during transit. 

Any short supply or damage should be reported to Hydrological Services Pty Ltd within 

seven days of receipt of the product. 

The Hydrological Services Model TSR Top Setting Wading Rods have been pre-assembled 

in the factory and are ready for service. 

This product does NOT include a pulse counter or current meter unless specifically 

requested in the purchase order. 
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IV OPERATION 

Diagram 1 
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Preparation – refer to Diagram 1 above

Position the tail fin on the METER MOUNTING (Item 4) and secure with screw. 

Position the appropriate current meter, complete with fan on the METER MOUNTING (Item 4) 

and secure with screw. 

Connect CABLE (Item 8) to current meter.  

Position the pulse counter (current meter counter) on PIN (Item 9) and connect lead to 

CONTACT (Item 7). 

Depress TRIGGER (Item 6) the SUSPENSION ROD (Item 5), complete with the current meter, 

to slide within the HAND GRIP BODY (Item 3). 

Ensure that the suspension rod slides smoothly for its full length. 

Do not permit the current meter to fall to the foot as damage to the meter may occur.

Power up the pulse counter (current meter counter) and carry out function test as per 

manufacturer’s instructions.  

Rotate the current meter fan to generate pulses then check that the pulses are being received by 

the pulse counter. 

The device is now ready for operation. 

An appropriate stream cross section should have been previously selected and set up for 

gauging.

Operation

Place the Top Setting Wading Rod vertically in the stream at the appropriate point in the cross 

section, ensuring that the base plate is stable and that the meter is directed into the flow. 

Read off the depth of stream on the GRADUATED ROD (Item 2). 

Top Setting Wading Rods are available in both Metric and Imperial models.  The following 

pages shows the use of both models in detail. 

Relationship between the GRADUATED ROD (Item 2) & the SUSPENSION 

ROD (Item 5)
The GRADUATED ROD (Item 2) is designed for measurement of individual soundings across 

the stream section. This rod is graduated with markings every 0.1 feet for the imperial TSR and 

20 millimetres for the metric TSR. 

NB: The graduations on the SUSPENSION ROD (Item 5) and VERNIER SCALE (Item 3) are 

NOT to be used for direct measurement of soundings. These graduations on these Items have 

been designed for accurate setting of the current meter to the required ‘depth of observation’.  
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Imperial Rods 

The GRADUATED ROD (Item 2) is graduated in 0.1 feet.  To assist in the reading, the rod is 

marked with a triple groove at full feet graduations, double groove at half feet graduations and 

single groove at 0.1 feet graduations. 

With respect to the GRADUATED ROD (Item 2), the stream bed is the zero reference. 

The current meter can be readily set at 0.2, 0.4, 0.6 and 0.8 of the sounding by aligning the 

appropriate graduation on the SUSPENSION ROD (Item 5) with the appropriate graduation on 

the VERNIER SCALE (Item 3). 

When a ‘multiplier’ is applied to the measured sounding (i.e. the reading taken from the 

GRADUATED ROD (Item 2), the correct ‘depth of observation’ for a current meter velocity 

measurement is calculated. 

The table below summarises the various multipliers to be used for each required depth of 

observation:

MULTIPLIER TABLE 

Depth of Observation 0.2d 0.4d 0.6d 0.8d 

Multiplier Used 2.0 1.5 1.0 0.5 

Where d = sounding taken from GRADUATED ROD (Item 2) 

Refer to the following examples. 
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Example 1 - The sounding has been read at 2.0 feet on the GRADUATED ROD (Item 2 ). 

Setting at 0.2d 

1. From the table above, the calculated reading is ‘4’ (i.e. multiplier ‘2.0’ * sounding ‘2’) 

2. To set the current meter at 0.2 of the 2.0 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘4’ on the suspension rod 

is in line with graduation ‘0’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 1.6 feet on the GRADUATED ROD  (i.e.: 0.2 of 

sounding)

Setting at 0.4d 

1. From the table above, the calculated reading is ‘3’ (i.e. multiplier ‘1.5’ * sounding ‘2’) 

2. To set the current meter at 0.4 of the 2.0 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘3’ on the suspension rod is in 

line with graduation ‘0’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 1.2 feet on the GRADUATED ROD (0.4 of sounding) 
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Setting at 0.6d 

1. From the table above, the calculated reading is ‘2’ (i.e. multiplier ‘1.0’ * sounding ‘2’) 

2. To set the current meter at 0.6 of the 2.0 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘2’ on the suspension rod 

is in line with graduation ‘0’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 0.8 feet on the GRADUATED ROD (0.6 of sounding) 

Setting at 0.8d 

1. From the table above, the calculated reading is ‘1’ (i.e. multiplier ‘0.5’ * sounding ‘2’) 

2. To set the current meter at 0.8 of the 2.0 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘2’ on the suspension rod 

is in line with graduation ‘0’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 0.4 feet on the GRADUATED ROD (0.8 of sounding)  
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Example 2 The sounding has been read at 2.2 feet on the GRADUATION ROD (Item 2) 

Setting at 0.2d 

1. From the table above, the calculated reading is ‘4.4’ (i.e. multiplier ‘2.0’ * sounding ‘2.2’) 

2. To set the current meter at 0.2 of the 2.2 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘4’ on the suspension rod 

is in line with graduation ‘4’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 1.76 feet on the GRADUATED ROD (0.2 of 

sounding)

Setting at 0.4d 

1. From the table above, the calculated reading is ‘3.3’ (i.e. multiplier ‘1.5’ * sounding ‘2.2’) 

2. To set the current meter at 0.4 of the 2.2 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘3’ on the suspension rod 

is in line with graduation ‘3’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 1.32 feet on the GRADUATED ROD (0.4 of 

sounding)
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Setting at 0.6d 

1. From the table above, the calculated reading is ‘2.2’ (i.e. multiplier ‘1.0’ * sounding ‘2.2’) 

2. To set the current meter at 0.6 of the 2.2 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘2’ on the suspension rod 

is in line with graduation ‘2’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 0.88 feet on the graduated rod (0.6 of sounding) 

Setting at 0.8d 

1. From the table above, the calculated reading is ‘1.1’ (i.e. multiplier ‘0.5’ * sounding ‘2.2’) 

2. To set the current meter at 0.8 of the 2.2 feet sounding, depress the TRIGGER (Item 6) and 

slide the SUSPENSION ROD (Item 5) until the graduation mark ‘1’ on the suspension rod 

is in line with graduation ‘1’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 0.44 feet on the GRADUATED ROD (0.8 of 

sounding)
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Metric Rods 

The rod is graduated in 20 millimetres graduations.  To assist in the reading, the rod is marked 

with a triple groove at 500 millimetre graduations, double groove at 100 millimetre 

graduations and single groove at 20 millimetre graduations. 

With respect to the GRADUATED ROD (Item 2), the stream bed is the zero reference. 

The current meter can be readily set at 0.2, 0.4, 0.6 and 0.8 of the sounding by aligning the 

appropriate graduation on the SUSPENSION ROD (Item5) with the appropriate graduation on 

the VERNIER SCALE (Item 3). 

The correct ‘depth of observation’ for current meter velocity measurement, is based on a 

multiplier, which when applied to the measured sounding (i.e. that taken from the 

GRADUATED ROD (Item 2) requires the application of a multiplier to calculate the correct 

setting to be used on the SUSPENSION ROD (Item 5). The table below summarises the 

various multiplier to be used, based on required depth of observation: 

MULTIPLIER TABLE 

Depth of Observation 0.2d 0.4d 0.6d 0.8d 

Multiplier Used 2.0 1.5 1.0 0.5 

Where d = sounding taken from GRADUATED ROD (Item 2) 

Refer to the following examples. 
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Example 1 – The sounding has been read at 5 decimetres (500mm) on the 

GRADUATION ROD (Item 2). 

Setting at 0.2d 

1. From the table above, the calculated reading is ‘10’ (i.e. multiplier ‘2.0’ * sounding ‘5’) 

2. To set the current meter at 0.2 of the 5 decimetre sounding, depress the TRIGGER (Item 6) 

and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘10’ on the 

suspension rod is in line with graduation ‘0’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 4.0 decimetres (i.e. 400mm) on the GRADUATED 

ROD (0.2 of sounding)

Setting at 0.4d 

1. From the table above, the calculated reading is ‘7.5’ (i.e. multiplier ‘1.5’ * sounding ‘5’) 

2. To set the current meter at 0.4 of the 5 decimetre sounding, depress the TRIGGER (Item 6) 

and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘7’ on the suspension 

rod is in line with graduation ‘5’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 3.0 decimetres (i.e. 300mm) on the GRADUATED 

ROD (0.4 of sounding) 
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Setting at 0.6d 

1. From the table above, the calculated reading is ‘5’ (i.e. multiplier ‘1.0’ * sounding ‘5’) 

2. To set the current meter at 0.6 of the 5 decimetre sounding, depress the TRIGGER (Item 6) 

and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘5’ on the suspension 

rod is in line with graduation ‘0’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 2.0 decimetres (200mm) on the graduated rod (0.6 of 

sounding)

Setting at 0.8d 

1. From the table above, the calculated reading is ‘2.5’ (i.e. multiplier ‘0.5’ * sounding ‘5’) 

2. To set the current meter at 0.8 of the 5 decimetre sounding, depress the TRIGGER (Item 6) 

and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘2’ on the suspension 

rod is in line with graduation ‘5’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 1.0 decimetres (100mm) on the GRADUATED ROD  

(0.8 of sounding)
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Example 2  The sounding has been read at 5.2 decimetres or 520mm on the 

GRADUATION ROD (Item 2) 

Setting at 0.2d 

1. From the table above, the calculated reading is ’10.4’ (i.e. multiplier ‘2.0’ * sounding ‘5.2’) 

2. To set the current meter at 0.2 of the 5.2 decimetre sounding, depress the TRIGGER (Item 

6) and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘10’ on the 

suspension rod is in line with graduation ‘4’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 4.2 decimetres (420mm) on the GRADUATED ROD  

(0.2 of sounding) 

Setting at 0.4d 

1. From the table above, the calculated reading is ’7.8’ (i.e. multiplier ‘1.5’ * sounding ‘5.2’) 

2. To set the current meter at 0.4 of the 5.2 decimetre sounding, depress the TRIGGER (Item 

6) and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘7’ on the 

suspension rod is in line with graduation ‘8’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 3.1 decimetres (310mm) on the GRADUATED ROD  

(0.4 of sounding) 
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Setting at 0.6d 

1. From the table above, the calculated reading is ’5.2’ (i.e. multiplier ‘1.0’ * sounding ‘5.2’) 

2. To set the current meter at 0.6 of the 5.2 decimetre sounding, depress the TRIGGER (Item 

6) and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘5’ on the 

suspension rod is in line with graduation ‘2’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 2.1 decimetres (210mm) on the graduated rod (0.6 of 

sounding)

Setting at 0.8d 

1. From the table above, the calculated reading is ‘2.6’ (i.e. multiplier ‘0.5’ * sounding ‘5.2’) 

2. To set the current meter at 0.8 of the 5.2 decimetre sounding, depress the TRIGGER (Item 

6) and slide the SUSPENSION ROD (Item 5) until the graduation mark ‘2’ on the 

suspension rod is in line with graduation ‘6’ on the VERNIER SCALE (Item 3). 

3. Release the trigger. 

4. This will position the current meter at 1.1 decimetres (110mm) on the GRADUATED ROD  

(0.8 of sounding) 
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V MAINTENANCE 

Because of the excellent durability of the Top Setting Wading Rods it is only necessary to clean 

and thoroughly dry the device after use prior to packing away. This is essential to remove any 

corrosive contaminants that may be present in the water being gauged. 

Periodically it may be necessary to remove oxidization from the electrical contact to ensure 

positive contact. This should be done with superfine emery paper or “scotchbrite” pad. 

VI PART LIST 

Refer to Diagram 1 

ITEM NO.  DESCRIPTION    PART NO.  

 1  Foot Plate      TSR07-02 

 2  Graduated Rod - 48 inch    TSR07-01 

   Graduated Rod - 72 inch    TSR07-02 

   Graduated Rod - 96 inch    TSR07-03 

   Graduated Rod -1200 mm    TSR07-04 

   Graduated Rod -1800 mm    TSR07-05 

   Graduated Rod -2400 mm    TSR07-06 

 3  Hand Grip Body - Imperial    TSR01-01 

   Hand Grip Body - Metric    TSR01-04 

 4  Meter Mounting – Price     TSR05-01             

   Meter Mounting - HS OSS-PC1   TSR05-03 

 5  Suspension Rod - 48 inch    TSR08-01 

   Suspension Rod - 72 inch    TSR08-02 

   Suspension Rod - 96 inch    TSR08-03 

   Suspension Rod -1200 mm    TSR08-04 

   Suspension Rod -1800 mm    TSR08-05 

   Suspension Rod -2400 mm    TSR08-06 

 6  Trigger     TSR03-01 

 7  Contact      SC043-43 

 8  Cable       TSR09 

 9  Contact Block      TSR02-01 

 10  Counter Suspension Pin    TSR02-02 

 11  Contact Body      TSR04-01 

 12  Insulating Sleeve 1     TSR01-02 

 13  Insulating Sleeve 2     TST01-03 

 14  Insulating Washer     TSR05-02 

 15  Carry Case - 48 inch     TSR10 

   Carry Case - 72 inch     TSR11 

   Carry Case - 96 inch     TSR12 



HYDROLOGICAL SERVICES PTY LTD 

TOP SET WADING RODS-MODEL TSR     ISSUE 3:20/08/2007 

COPYRIGHT ©

TSR100-19

VII  Appendix (A) OSS-B1 Installation to TSR 

Figure 1: Initial State 

Figure 2: Unscrew the Foot Plate 
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Figure 3: Loosen the Tail of the OSS-B1 body as shown 

Figure 4: Loop the cable as shown 
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Figure 5: Locate the pin in the OSS-B1 body slot  

& tighten the tail to the rod as shown 

Figure 6: Plug the Angle Plug (AP01) in place by pushing down firmly  

& Secure Clamp in place 
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Figure 7: Screw the Foot Plate back on as shown
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APPENDIX F 
SLUG TEST ANALYSES 
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BGC14-001D FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-001D
Test Date:  04-Apr-2014

AQUIFER DATA

Saturated Thickness:  13.27 m

WELL DATA (BGC14-001D)

Initial Displacement:  0.5071 m Static Water Column Height:  13.27 m
Total Well Penetration Depth:  13.27 m Screen Length:  6.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.699E-6 m/sec Ss  = 0.004603 m-1

Kz/Kr = 1.
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BGC14-001D RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-001D
Test Date:  04-Apr-2014

AQUIFER DATA

Saturated Thickness:  13.27 m

WELL DATA (BGC14-001D)

Initial Displacement:  0.7084 m Static Water Column Height:  13.27 m
Total Well Penetration Depth:  13.27 m Screen Length:  6.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 2.577E-6 m/sec Ss  = 0.003965 m-1

Kz/Kr = 1.
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BGC14-002D FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-002D
Test Date:  21-Mar-2014

AQUIFER DATA

Saturated Thickness:  16.63 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-002D)

Initial Displacement:  0.865 m Static Water Column Height:  16.63 m
Total Well Penetration Depth:  16.63 m Screen Length:  7.92 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 3.838E-6 m/sec y0 = 0.5886 m
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BGC14-002D RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-002D
Test Date:  21-Mar-2014

AQUIFER DATA

Saturated Thickness:  16.63 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-002D)

Initial Displacement:  0.7348 m Static Water Column Height:  16.63 m
Total Well Penetration Depth:  16.63 m Screen Length:  7.92 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 4.088E-6 m/sec y0 = 0.6864 m



0. 400. 800. 1.2E+3 1.6E+3 2.0E+3
0.01

0.1

1.

Time (sec)

N
or

m
al

iz
ed

 H
ea

d 
(m

/m
)

BGC14-002D FH TEST 3

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-002D
Test Date:  21-Mar-2014

AQUIFER DATA

Saturated Thickness:  16.63 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-002D)

Initial Displacement:  0.7351 m Static Water Column Height:  16.63 m
Total Well Penetration Depth:  16.63 m Screen Length:  7.92 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 4.488E-6 m/sec y0 = 0.7393 m
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BGC14-002D RH TEST 4

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-002D
Test Date:  21-Mar-2014

AQUIFER DATA

Saturated Thickness:  16.63 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-002D)

Initial Displacement:  0.7909 m Static Water Column Height:  16.63 m
Total Well Penetration Depth:  16.63 m Screen Length:  7.92 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 4.197E-6 m/sec y0 = 0.728 m
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BGC14-002S FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-002S
Test Date:  20-Mar-2014

AQUIFER DATA

Saturated Thickness:  7.85 m

WELL DATA (BGC14-002S)

Initial Displacement:  0.6666 m Static Water Column Height:  7.85 m
Total Well Penetration Depth:  7.85 m Screen Length:  6.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.44E-7 m/sec Ss  = 7.858E-6 m-1

Kz/Kr = 1.
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BGC14-002S RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-002S
Test Date:  20-Mar-2014

AQUIFER DATA

Saturated Thickness:  8.754 m

WELL DATA (BGC14-002S)

Initial Displacement:  0.6955 m Static Water Column Height:  8.754 m
Total Well Penetration Depth:  8.754 m Screen Length:  6.66 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.077E-7 m/sec Ss  = 2.383E-6 m-1

Kz/Kr = 1.
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BGC14-003D FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-003D
Test Date:  29-May-2014

AQUIFER DATA

Saturated Thickness:  28.68 m

WELL DATA (BGC14-003D)

Initial Displacement:  0.7607 m Static Water Column Height:  28.68 m
Total Well Penetration Depth:  28.68 m Screen Length:  3.04 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.583E-8 m/sec Ss  = 0.000972 m-1

Kz/Kr = 1.
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BGC14-003D RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-003D
Test Date:  30-May-2014

AQUIFER DATA

Saturated Thickness:  28.68 m

WELL DATA (BGC14-003D)

Initial Displacement:  0.7991 m Static Water Column Height:  28.68 m
Total Well Penetration Depth:  28.68 m Screen Length:  3.04 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.583E-8 m/sec Ss  = 0.000972 m-1

Kz/Kr = 1.
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BGC14-003I FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-003I
Test Date:  21-Mar-2014

AQUIFER DATA

Saturated Thickness:  14.63 m

WELL DATA (BGC14-003I)

Initial Displacement:  0.5689 m Static Water Column Height:  14.63 m
Total Well Penetration Depth:  14.63 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 6.318E-6 m/sec Ss  = 7.448E-6 m-1

Kz/Kr = 1.
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BGC14-003I RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-003I
Test Date:  21-Mar-2014

AQUIFER DATA

Saturated Thickness:  14.63 m

WELL DATA (BGC14-003I)

Initial Displacement:  0.7015 m Static Water Column Height:  14.63 m
Total Well Penetration Depth:  14.63 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 6.559E-6 m/sec Ss  = 4.461E-5 m-1

Kz/Kr = 1.
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BGC14-003S FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-003S
Test Date:  5-Mar-2014

AQUIFER DATA

Saturated Thickness:  6.97 m

WELL DATA (BGC14-003S)

Initial Displacement:  0.7289 m Static Water Column Height:  6.97 m
Total Well Penetration Depth:  6.97 m Screen Length:  1.53 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 2.564E-7 m/sec Ss  = 0.006297 m-1

Kz/Kr = 1.
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BGC14-003S RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-003S
Test Date:  5-Mar-2014

AQUIFER DATA

Saturated Thickness:  6.97 m

WELL DATA (BGC14-003S)

Initial Displacement:  0.7393 m Static Water Column Height:  6.97 m
Total Well Penetration Depth:  6.97 m Screen Length:  1.53 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 2.637E-7 m/sec Ss  = 0.003271 m-1

Kz/Kr = 1.
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BGC14-004 FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-004
Test Date:  5-Jun-2014

AQUIFER DATA

Saturated Thickness:  70.7 m

WELL DATA (BGC14-004)

Initial Displacement:  0.7064 m Static Water Column Height:  70.7 m
Total Well Penetration Depth:  70.7 m Screen Length:  6.09 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.817E-7 m/sec Ss  = 0.0008225 m-1

Kz/Kr = 1.
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BGC14-004 RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-004
Test Date:  6-Jun-2014

AQUIFER DATA

Saturated Thickness:  70.7 m

WELL DATA (BGC14-004)

Initial Displacement:  0.7439 m Static Water Column Height:  70.7 m
Total Well Penetration Depth:  70.7 m Screen Length:  6.09 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 8.159E-7 m/sec Ss  = 1.475E-5 m-1

Kz/Kr = 1.
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BGC14-005 FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-005
Test Date:  31-Mar-2014

AQUIFER DATA

Saturated Thickness:  33.49 m

WELL DATA (BGC14-005)

Initial Displacement:  0.2117 m Static Water Column Height:  33.49 m
Total Well Penetration Depth:  33.49 m Screen Length:  3.22 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 9.279E-8 m/sec Ss  = 0.0002371 m-1

Kz/Kr = 1.
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BGC14-005 RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-005
Test Date:  31-Mar-2014

AQUIFER DATA

Saturated Thickness:  33.49 m

WELL DATA (BGC14-005)

Initial Displacement:  0.2298 m Static Water Column Height:  33.49 m
Total Well Penetration Depth:  33.49 m Screen Length:  3.22 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 5.808E-8 m/sec Ss  = 0.003239 m-1

Kz/Kr = 1.
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BGC14-006D RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-006D
Test Date:  2-Jun-2014

AQUIFER DATA

Saturated Thickness:  16.82 m

WELL DATA (BGC14-006D)

Initial Displacement:  0.1666 m Static Water Column Height:  16.82 m
Total Well Penetration Depth:  16.82 m Screen Length:  6.1 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 2.169E-7 m/sec Ss  = 5.027E-6 m-1

Kz/Kr = 1.
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BGC14-006S RH TEST1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-006S
Test Date:  1-Jun-2014

AQUIFER DATA

Saturated Thickness:  4.069 m

WELL DATA (BGC14-006S)

Initial Displacement:  2.08 m Static Water Column Height:  4.069 m
Total Well Penetration Depth:  4.069 m Screen Length:  3.05 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.253E-8 m/sec Ss  = 0.0005556 m-1

Kz/Kr = 1.
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BGC14-008D RH TEST1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-008D
Test Date:  30-May-2014

AQUIFER DATA

Saturated Thickness:  7.071 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-008D)

Initial Displacement:  7.071 m Static Water Column Height:  6.927 m
Total Well Penetration Depth:  6.927 m Screen Length:  3.04 m
Casing Radius:  0.0508 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 1.034E-9 m/sec y0 = 5.805 m
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BGC14-009 FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-009
Test Date:  10-Apr-2014

AQUIFER DATA

Saturated Thickness:  38.66 m

WELL DATA (BGC14-009)

Initial Displacement:  0.7383 m Static Water Column Height:  38.66 m
Total Well Penetration Depth:  38.66 m Screen Length:  6.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.89E-7 m/sec Ss  = 8.394E-6 m-1

Kz/Kr = 1.
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BGC14-009 RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-009
Test Date:  10-Apr-2014

AQUIFER DATA

Saturated Thickness:  38.66 m

WELL DATA (BGC14-009)

Initial Displacement:  0.7842 m Static Water Column Height:  38.66 m
Total Well Penetration Depth:  38.66 m Screen Length:  6.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.927E-7 m/sec Ss  = 6.23E-6 m-1

Kz/Kr = 1.
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BGC14-010 FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-010
Test Date:  4-Apr-2014

AQUIFER DATA

Saturated Thickness:  48.04 m

WELL DATA (BGC14-010)

Initial Displacement:  0.7748 m Static Water Column Height:  48.04 m
Total Well Penetration Depth:  48.04 m Screen Length:  12.2 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 5.949E-8 m/sec Ss  = 0.0007141 m-1

Kz/Kr = 1.
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BGC14-010 RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-010
Test Date:  4-Apr-2014

AQUIFER DATA

Saturated Thickness:  48.04 m

WELL DATA (BGC14-010)

Initial Displacement:  0.8288 m Static Water Column Height:  48.04 m
Total Well Penetration Depth:  48.04 m Screen Length:  12.2 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 4.289E-8 m/sec Ss  = 0.00131 m-1

Kz/Kr = 1.
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BGC14-011D FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-011D
Test Date:  3-Apr-2014

AQUIFER DATA

Saturated Thickness:  23.39 m

WELL DATA (BGC14-011D)

Initial Displacement:  0.7767 m Static Water Column Height:  23.39 m
Total Well Penetration Depth:  23.39 m Screen Length:  6.09 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 2.524E-7 m/sec Ss  = 0.0009631 m-1

Kz/Kr = 1.
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BGC14-011D RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-011D
Test Date:  3-Apr-2014

AQUIFER DATA

Saturated Thickness:  23.39 m

WELL DATA (BGC14-011D)

Initial Displacement:  0.8335 m Static Water Column Height:  23.39 m
Total Well Penetration Depth:  23.39 m Screen Length:  6.09 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 4.297E-7 m/sec Ss  = 0.0002201 m-1

Kz/Kr = 1.
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BGC14-011S FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-011S
Test Date:  3-Apr-2014

AQUIFER DATA

Saturated Thickness:  12.09 m

WELL DATA (BGC14-011S)

Initial Displacement:  0.7132 m Static Water Column Height:  12.09 m
Total Well Penetration Depth:  12.09 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.209E-6 m/sec Ss  = 0.003929 m-1

Kz/Kr = 1.
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BGC14-011S RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-011S
Test Date:  3-Apr-2014

AQUIFER DATA

Saturated Thickness:  12.09 m

WELL DATA (BGC14-011S)

Initial Displacement:  0.8198 m Static Water Column Height:  12.09 m
Total Well Penetration Depth:  12.09 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.797E-6 m/sec Ss  = 0.0007527 m-1

Kz/Kr = 1.
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BGC14-012D FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012D
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  24.71 m

WELL DATA (BGC14-012D)

Initial Displacement:  0.7604 m Static Water Column Height:  24.71 m
Total Well Penetration Depth:  24.71 m Screen Length:  4.57 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 9.108E-7 m/sec Ss  = 6.667E-5 m-1

Kz/Kr = 1.
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BGC14-012D RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012D
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  24.71 m

WELL DATA (BGC14-012D)

Initial Displacement:  0.8255 m Static Water Column Height:  24.71 m
Total Well Penetration Depth:  24.71 m Screen Length:  4.57 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 6.093E-7 m/sec Ss  = 0.0003155 m-1

Kz/Kr = 1.
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BGC14-012D RH TEST 4

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012D
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  24.71 m

WELL DATA (BGC14-012D)

Initial Displacement:  0.7502 m Static Water Column Height:  24.71 m
Total Well Penetration Depth:  24.71 m Screen Length:  4.57 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 9.657E-7 m/sec Ss  = 2.91E-5 m-1

Kz/Kr = 1.
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BGC14-012D RH TEST 4

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012D
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  24.71 m

WELL DATA (BGC14-012D)

Initial Displacement:  0.8012 m Static Water Column Height:  24.71 m
Total Well Penetration Depth:  24.71 m Screen Length:  4.57 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 9.657E-7 m/sec Ss  = 2.91E-5 m-1

Kz/Kr = 1.
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BGC14-012S FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012S
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  2.65 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-012S)

Initial Displacement:  0.5763 m Static Water Column Height:  2.65 m
Total Well Penetration Depth:  2.65 m Screen Length:  0.61 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 0.0006365 m/sec y0 = 0.2473 m
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BGC14-012S RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012S
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  2.65 m

WELL DATA (BGC14-012S)

Initial Displacement:  0.5689 m Static Water Column Height:  2.65 m
Total Well Penetration Depth:  2.65 m Screen Length:  0.61 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 0.001179 m/sec Ss  = 3.706E-12 m-1

Kz/Kr = 1.
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BGC14-012S FH TEST 3

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012S
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  2.65 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-012S)

Initial Displacement:  0.712 m Static Water Column Height:  2.65 m
Total Well Penetration Depth:  2.65 m Screen Length:  0.61 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 0.0008923 m/sec y0 = 0.2658 m
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BGC14-012S RH TEST 4

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-012S
Test Date:  5-Apr-2014

AQUIFER DATA

Saturated Thickness:  2.65 m

WELL DATA (BGC14-012S)

Initial Displacement:  0.6647 m Static Water Column Height:  2.65 m
Total Well Penetration Depth:  2.65 m Screen Length:  0.61 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 0.001118 m/sec Ss  = 3.706E-12 m-1

Kz/Kr = 1.
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BGC14-013 FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-013
Test Date:  5-Jun-2014

AQUIFER DATA

Saturated Thickness:  26.34 m

WELL DATA (BGC14-013)

Initial Displacement:  0.7678 m Static Water Column Height:  26.34 m
Total Well Penetration Depth:  26.34 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.288E-8 m/sec Ss  = 0.003706 m-1

Kz/Kr = 1.
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BGC14-013 RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-013
Test Date:  6-Jun-2014

AQUIFER DATA

Saturated Thickness:  26.34 m

WELL DATA (BGC14-013)

Initial Displacement:  0.6826 m Static Water Column Height:  26.34 m
Total Well Penetration Depth:  26.34 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 2.467E-8 m/sec Ss  = 8.463E-5 m-1

Kz/Kr = 1.
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BGC14-014D RH TEST1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-014D
Test Date:  28-May-2014

AQUIFER DATA

Saturated Thickness:  6.759 m

WELL DATA (BGC14-014D)

Initial Displacement:  5.209 m Static Water Column Height:  6.759 m
Total Well Penetration Depth:  6.759 m Screen Length:  6.09 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 1.043E-9 m/sec Ss  = 6.02E-9 m-1

Kz/Kr = 1.
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BGC14-015D FH TEST 1

Data Set:  \...\BGC14-015D_FH_T1_conf.aqt
Date:  07/15/14 Time:  13:54:15

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-015D
Test Date:  28-May-2014

AQUIFER DATA

Saturated Thickness:  29.65 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-015D)

Initial Displacement:  0.5911 m Static Water Column Height:  29.65 m
Total Well Penetration Depth:  29.65 m Screen Length:  6. m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Confined Solution Method:  Cooper-Bredehoeft-Papadopulo

T = 5.505E-7 m2/sec S = 1.061E-8
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BGC14-015D RH TEST 2

Data Set:  \...\BGC14-015D_RH_T2_conf.aqt
Date:  07/17/14 Time:  09:02:22

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-015D
Test Date:  28-May-2014

AQUIFER DATA

Saturated Thickness:  29.65 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-015D)

Initial Displacement:  0.8885 m Static Water Column Height:  29.65 m
Total Well Penetration Depth:  29.65 m Screen Length:  6. m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Confined Solution Method:  Cooper-Bredehoeft-Papadopulo

T = 1.302E-7 m2/sec S = 0.0003744
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BGC14-015S RH TEST1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-015S
Test Date:  28-May-2014

AQUIFER DATA

Saturated Thickness:  9.502 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-015)

Initial Displacement:  8.112 m Static Water Column Height:  9.502 m
Total Well Penetration Depth:  9.502 m Screen Length:  3.05 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Confined Solution Method:  Cooper-Bredehoeft-Papadopulo

T = 1.34E-6 m2/sec S = 3.522E-11
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BGC14-016 FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-016
Test Date:  2-Apr-2014

AQUIFER DATA

Saturated Thickness:  25.35 m

WELL DATA (BGC14-016)

Initial Displacement:  0.6937 m Static Water Column Height:  25.35 m
Total Well Penetration Depth:  25.35 m Screen Length:  6.09 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 6.22E-8 m/sec Ss  = 1.0E-5 m-1

Kz/Kr = 1.
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BGC14-016 RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-016
Test Date:  2-Apr-2014

AQUIFER DATA

Saturated Thickness:  25.35 m

WELL DATA (BGC14-016)

Initial Displacement:  0.79 m Static Water Column Height:  25.35 m
Total Well Penetration Depth:  25.35 m Screen Length:  6.09 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  KGS Model

Kr  = 3.369E-8 m/sec Ss  = 0.0002312 m-1

Kz/Kr = 1.
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BGC14-017D RH TEST1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-017D
Test Date:  29-May-2014

AQUIFER DATA

Saturated Thickness:  28.65 m

WELL DATA (BGC14-017D)

Initial Displacement:  9.251 m Static Water Column Height:  28.65 m
Total Well Penetration Depth:  28.65 m Screen Length:  6.09 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Confined Solution Method:  KGS Model

Kr  = 3.791E-9 m/sec Ss  = 5.593E-7 m-1

Kz/Kr = 1.
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BGC14-017S RH TEST1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  BGC14-017S
Test Date:  28-May-2014

AQUIFER DATA

Saturated Thickness:  2.856 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (BGC14-017S)

Initial Displacement:  2.856 m Static Water Column Height:  2.78 m
Total Well Penetration Depth:  2.78 m Screen Length:  1.53 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Confined Solution Method:  Cooper-Bredehoeft-Papadopulo

T = 4.568E-7 m2/sec S = 0.04348
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KAX-14-114S FH TEST 1

Data Set:  \...\KAX-14-114S_FH_TEST1_ck.aqt
Date:  07/11/14 Time:  10:52:31

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  KAX-14-114S
Test Date:  3-June-2014

AQUIFER DATA

Saturated Thickness:  28.87 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (KAX-14-114S)

Initial Displacement:  0.5588 m Static Water Column Height:  28.87 m
Total Well Penetration Depth:  28.87 m Screen Length:  9.1 m
Casing Radius:  0.024 m Well Radius:  0.0613 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 9.577E-7 m/sec y0 = 0.2441 m
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KAX-14-114S RH TEST 2

Data Set:  \...\KAX-14-114S_RH_TEST2_ck.aqt
Date:  07/11/14 Time:  11:00:50

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  KAX-14-114S
Test Date:  4-June-2014

AQUIFER DATA

Saturated Thickness:  28.87 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (KAX-14-114S)

Initial Displacement:  0.6914 m Static Water Column Height:  28.87 m
Total Well Penetration Depth:  28.87 m Screen Length:  9.1 m
Casing Radius:  0.024 m Well Radius:  0.0613 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 1.744E-6 m/sec y0 = 0.4054 m
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KAX-14-128S FH TEST 1

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  KAX-14-128S
Test Date:  6-Jun-2014

AQUIFER DATA

Saturated Thickness:  5.123 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (KAX-14-128S)

Initial Displacement:  0.1048 m Static Water Column Height:  5.123 m
Total Well Penetration Depth:  3.1 m Screen Length:  3.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 1.735E-6 m/sec y0 = 0.1007 m
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KAX-14-128S RH TEST 2

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  KAX-14-128S
Test Date:  6-Jun-2014

AQUIFER DATA

Saturated Thickness:  5.123 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (KAX-14-128S)

Initial Displacement:  0.0653 m Static Water Column Height:  5.123 m
Total Well Penetration Depth:  3.1 m Screen Length:  3.1 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 1.499E-6 m/sec y0 = 0.06515 m
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KAX-14-128S FH TEST 1A

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  KAX-14-128S
Test Date:  6-Jun-2014

AQUIFER DATA

Saturated Thickness:  5.123 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (KAX-14-128S)

Initial Displacement:  0.1048 m Static Water Column Height:  5.123 m
Total Well Penetration Depth:  1.523 m Screen Length:  1.523 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 1.098E-7 m/sec y0 = 0.06255 m
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KAX-14-128S RH TEST 2A

PROJECT INFORMATION

Company:  BGC Engineering Inc.
Client:  KJHM Ajax Mining Inc.
Location:  Ajax
Test Well:  KAX-14-128S
Test Date:  6-Jun-2014

AQUIFER DATA

Saturated Thickness:  5.123 m Anisotropy Ratio (Kz/Kr):  1.

WELL DATA (KAX-14-128S)

Initial Displacement:  0.0653 m Static Water Column Height:  5.123 m
Total Well Penetration Depth:  1.523 m Screen Length:  1.523 m
Casing Radius:  0.0254 m Well Radius:  0.0762 m

SOLUTION

Aquifer Model:  Unconfined Solution Method:  Hvorslev

K  = 1.281E-7 m/sec y0 = 0.04199 m
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N OT ES :
1.  AL L  DIMEN S ION S  ARE IN  MET RES  U N L ES S  OT HERWIS E N OT ED.
2.  T HIS  DRAWIN G MU S T  BE READ IN  CON JU N CT ION  WIT H BGC'S  MEMO T IT L ED "AJAX  PROJECT  EA – AJAX  S OU T H
     GROU N DWAT ER AN D S U RFACE WAT ER S IT E IN VES T IGAT ION ", AN D DAT ED AU GU S T  2015.
3.  PROJECT ION  IS  N AD83 U T M Z ON E 10N
4.  U N L ES S  BGC AGREES  OT HERWIS E IN  WRIT IN G, T HIS  DRAWIN G S HAL L  N OT  BE MODIFIED OR U S ED FOR AN Y  PU RPOS E
     OT HER T HAN  T HE PU RPOS E FOR WHICH BGC GEN ERAT ED IT. BGC S HAL L  HAVE N O L IABIL IT Y  FOR AN Y  DAMAGES  OR L OS S
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